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1 About Symantec Encryption Desktop 
10.4 for Windows 

Symantec™ Encryption Desktop, Powered by PGP Technology is a security tool that uses 
cryptography to protect your data against unauthorized access. 

Symantec Encryption Desktop protects your data while being sent by email. It lets you 
encrypt your entire hard drive or hard drive partition—so everything is protected all the 
time—or just a portion of your hard drive, via a virtual disk on which you can securely 
store your most sensitive data. You can use it to share your files and folders securely 
with others over a network. It lets you put any combination of files and folders into an 
encrypted, compressed package for easy distribution or backup. Finally, use Symantec 
Encryption Desktop to shred (securely delete) sensitive files—so that no one can 
retrieve them—and shred free space on your hard drive, so there are no unsecured 
remains of any files. 

Use Symantec Encryption Desktop to create PGP keypairs and manage both your 
personal keypairs and the public keys of others. 

To make the most of Symantec Encryption Desktop, you should be familiar with 
Symantec Encryption Desktop Terminology (on page 9). You should also understand 
conventional and public-key cryptography, as described in Conventional and Public Key 
Cryptography (on page 11). 
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What's New in Symantec Encryption Desktop Version 10.4 for Windows ............ 1
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What's New in Symantec Encryption Desktop Version 10.4 
for Windows 

Building on Symantec Corporation’s proven technology, Symantec Encryption Desktop 
10.4 for Windows includes numerous improvements and new features. For more 
information on what's new in Symantec Encryption Desktop Version 10.4 for Windows, 
see Symantec Encryption Desktop Version 10.4 for Windows Release Notes. 

Using this Guide 
This Guide provides information on configuring and using the components within 
Symantec Encryption Desktop. Each chapter of the guide is devoted to one of the 
components of Symantec Encryption Desktop. 
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Using this Guide 

 

“Managed” versus “Unmanaged” Users 
A Symantec Encryption Server can be used to control the policies and settings used by 
components of Symantec Encryption Desktop. This is often the case in enterprises 
using PGP software. Symantec Encryption Desktop users in this configuration are 
known as managed users, because the settings and policies available in their Symantec 
Encryption Desktop software are pre-configured by a Symantec Encryption Server 
administrator and managed using a Symantec Encryption Server. If you are part of a 
managed environment, your company may have specific usage requirements. For 
example, managed users may or may not be allowed to send plaintext email, or may be 
required to encrypt their disk with Symantec Drive Encryption. 

Users not under the control of a Symantec Encryption Server are called unmanaged or 
standalone users. 

This document describes how Symantec Encryption Desktop works in both situations; 
however, managed users may discover while working with the product that some of the 
settings described in this document are not available in their environments. For more 
information, see Using Symantec Encryption Desktop with Symantec Encryption Server 
(on page 257). 

 

Features Customized by Your Symantec Encryption Server Administrator 

If you are using Symantec Encryption Desktop as a "managed" user in a Symantec 
Encryption Server-managed environment, there are some settings that can be specified 
by your administrator. These settings may change the way features are displayed in 
Symantec Encryption Desktop. 

 Disabled features. Your Symantec Encryption Server administrator can enable or 
disable specific functionality. For example, your administrator may disable the 
ability to create PGP Zip archives, or to create Symantec File Share Encryption 
protected folders (on Windows systems).  

When a feature is disabled, the control item in the left side is not displayed and the 
menu for that feature is not available. The Symantec Encryption Desktop interface 
may look different if your administrator has customized the features available. 

 Customized BootGuard. If you are using Symantec Encryption Desktop in a 
Symantec Encryption Server-managed environment, your Symantec Encryption 
Server administrator may have customized the Symantec Drive Encryption 
BootGuard screen to include additional text or a custom image such as your 
organization's logo. Your actual login screen may look different if your 
administrator has customized the screen. 

 

Conventions Used in This Guide 
Notes, Cautions, and Warnings are used in the following ways. 

Notes: Notes are extra, but important, information. A Note calls your attention to 
important aspects of the product. You will be able to use the product better if you 
read the Notes. 

Cautions: Cautions indicate the possibility of loss of data or a minor security breach. 
A Caution tells you about a situation where problems could occur unless precautions 
are taken. Pay attention to Cautions. 
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Warnings: Warnings indicate the possibility of significant data loss or a major 
security breach. A Warning means serious problems are going to happen unless you 
take the appropriate action. Please take Warnings very seriously. 

 

Conventions Used on Microsoft Windows 8/8.1/10 Systems 

If you are using Symantec Encryption Desktop on a Microsoft Windows 8/8.1/10 
system, the following sections provide information on how to access basic tasks in the 
Windows 8/8.1/10 style interface: 

Naming Conventions 
Use the following table to interpret the terms used in this document in a Windows 
8/8.1/10 environment:  

Term used in this Document In Windows 8/8.1/10 

Start Menu Available as Start Screen 

Windows Explorer Available as File Explorer 

Add or Remove Programs Available as Programs and Features 

Click or Select When using a touch screen system, means tap 

Basic Tasks  
Use the following table to learn how to perform the basic tasks of Symantec Encryption 
Desktop on Windows 8/8.1/10 systems:  

To Do 

Open Symantec Encryption Desktop Do one of the following: 

• On the Start screen, type Symantec 
Encryption Desktop and press Enter. 

• On the Start screen, select the Symantec 
Encryption Desktop tile.  

Open System Tray On the Start screen, click the Desktop tile.  

Open File Explorer On the Start screen, type File Explorer and press 
Enter. 

Open PGP Tray On the Start screen, click the Desktop tile,then click 
the Symantec Encryption Desktop icon located at the 
right side of the task bar. (If you have combined task 
bar items you may need to click the arrow to display 
hidden items.) 

Uninstall Symantec Encryption Desktop
  

In the Control Panel, select Programs and 
Features, select Symantec Encryption Desktop 
and click Uninstall. 
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Who Should Read This Document 

Who Should Read This Document 
This document is for anyone who is going to be using the Symantec Encryption Desktop 
for Windows software to protect their data. 

 

About Symantec Encryption Desktop Licensing 
A license is used within the PGP software to enable the functionality you purchased, 
and sets the expiration of the software. Depending on the license you have, some or all 
of the Symantec Encryption Desktop family of applications will be active. Once you 
have entered the license, you must then authorize the software with Symantec 
Corporation, either manually or online. 

There are three types of licenses: 

 Evaluation: This type of license is typically time-delimited and may not include all 
Symantec Encryption Desktop functionality. 

 Subscription: This type of license is typically valid for a subscription period of one 
year. During the subscription period, you receive the current version of PGP 
software and all upgrades and updates released during this period. 

 Perpetual: This type of license allows you to use Symantec Encryption Desktop 
indefinitely. With the addition of the annual Software Insurance policy, which 
must be renewed annually, you also receive all upgrades and updates released 
during the policy term. 

 

Licensing Symantec Encryption Desktop for Windows 

To license Symantec Encryption Desktop 

Do one of the following: 

 If you are a managed user, you are most likely already using a licensed copy of 
Symantec Encryption Desktop. Check your license details as described in Checking 
License Details (on page 5). If you have questions, please contact your Symantec 
Encryption Server administrator. 

 If you are an unmanaged user, or a Symantec Encryption Server administrator, 
check your license details as described in Checking License Details (on page 5). If 
you need to authorize your copy of Symantec Encryption Desktop, do so as 
described in Authorizing Symantec Encryption Desktop for Windows (on page 5). 
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Checking License Details 

To see the details of your Symantec Encryption Desktop license 

1 Double-click the Symantec Encryption Desktop icon in the system tray. 

2 Select Help > License. The Symantec Encryption Desktop License dialog box 
displays the following details: 

Item Description 

License Type The name of the licensed product. 

License Seats The number of seats available for this license. 

License Expiration The date when the license will expire. 

Product Information The components that are active in your license. Move your 
cursor over the product name to see information about the 
product and to find out if you are currently licensed to use 
it. 

 

 

Note: If you do not authorize your copy of Symantec Encryption Desktop, only 
limited features will be available to you (PGP Zip and PGP Keys). 

 

Authorizing Symantec Encryption Desktop for Windows 

If you need to change to a new license number, or if you skipped the license 
authorization process during configuration, follow these instructions to authorize your 
software. 

To authorize Symantec Encryption Desktop for Windows 

If you purchased Symantec Encryption Desktop, you received an order confirmation 
with licensing information. 

1 Double-click the Symantec Encryption Desktop icon in the System Tray. 

2 Select Help > License. The Symantec Encryption Desktop License dialog box is 
displayed. 

3 Click Change License. The PGP Licensing Assistant dialog box is displayed. 

4 Do one of the following: 

 Type your 28-character license number in the provided fields (for example, 
DEMO1-DEMO2-DEMO3-DEMO4-DEMO5-ABC). 

Note: To avoid typing errors and make the authorization easier, copy the entire 
license number, put the cursor in the first “License Number” field, and paste. 
Your license number will be correctly entered into all six “License Number” 
fields. 

 To use Symantec Encryption Desktop without a license, select Use without a 
license and disable most functionality. The only feature of Symantec 
Encryption Desktop you can use without a license is PGP Zip and PGP Keys. 
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5 Click Next to authorize. 

6 When PGP is authorized, the features enabled by your license will be displayed. 
Click Next, and then click Finish to complete the process. 

 

 

If Your License has Expired 
If your Symantec Encryption Desktop license has expired, you will receive a PGP 
License Expiration message when you launch Symantec Encryption Desktop. See the 
following sections for information on how an expired license affects the functionality of 
Symantec Encryption Desktop. 

Symantec Desktop Email 
 Outgoing email messages are no longer sent encrypted. 

Symantec File Share Encryption 
 Symantec File Share Encryption protected folders can be accessed however the 

protected files remain encrypted. (To view the encrypted files, manually decrypt 
the folders and files.) 

 New Symantec File Share Encryption protected folders cannot be created. 

 Files moved into a protected folder are not encrypted. 

 Keys cannot be added or removed from Symantec File Share Encryption protected 
folders. 

PGP Virtual Disk 
 PGP Virtual Disks are still accessible in Read-Only mode. Read-Only allows data to 

be copied from a PGP Virtual Disk, however no data can be copied to a PGP Virtual 
Disk.  

Symantec Drive Encryption 
 Any fixed disks that have been encrypted with Symantec Encryption Desktop 

using an evaluation license are automatically decrypted 90 days after the 
expiration of the evaluation. 

 

Technical Support 
Symantec Technical Support maintains support centers globally. Technical Support’s 
primary role is to respond to specific queries about product features and functionality. 
The Technical Support group also creates content for our online Knowledge Base. The 
Technical Support group works collaboratively with the other functional areas within 
Symantec to answer your questions in a timely fashion. For example, the Technical 
Support group works with Product Engineering and Symantec Security Response to 
provide alerting services and virus definition updates.  

Symantec’s support offerings include the following: 
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 A range of support options that give you the flexibility to select the right amount 
of service for any size organization  

 Telephone and/or web-based support that provides rapid response and 
up-to-the-minute information  

 Upgrade assurance that delivers software upgrades  

 Global support purchased on a regional business hours or 24 hours a day, 7 days a 
week basis  

 Premium service offerings that include Account Management Services  

For information about Symantec’s support offerings, you can visit our website at the 
following URL:  

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html  

All support services will be delivered in accordance with your support agreement and 
the then-current enterprise technical support policy.  

Contacting Technical Support 
Customers with a current support agreement may access Technical Support 
information at the following URL:  

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html  

Before contacting Technical Support, make sure you have satisfied the system 
requirements that are listed in your product documentation. Also, you should be at the 
computer on which the problem occurred, in case it is necessary to replicate the 
problem.  

When you contact Technical Support, please have the following information available: 

 Product release level  

 Hardware information  

 Available memory, disk space, and NIC information  

 Operating system  

 Version and patch level  

 Network topology  

 Router, gateway, and IP address information  

 Problem description:  

 Error messages and log files  

 Troubleshooting that was performed before contacting Symantec  

 Recent software configuration changes and network changes  

Licensing and Registration 
If your Symantec product requires registration or a license key, access our technical 
support web page at the following URL:  

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html

 

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html
https://support.symantec.com/content/unifiedweb/en_US/contact-support.html
https://support.symantec.com/content/unifiedweb/en_US/contact-support.html
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Technical Support 

Customer Support 
Customer support information is available at the following URL:  

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html

Customer Support is available to assist with non-technical questions, such as the 
following types of issues: 

 Questions regarding product licensing or serialization  

 Product registration updates, such as address or name changes  

 General product information (features, language availability, local dealers)  

 Latest information about product updates and upgrades  

 Information about upgrade assurance and support contracts  

 Information about the Symantec Buying Programs  

 Advice about Symantec's technical support options  

 Nontechnical presales questions  

 Issues that are related to CD-ROMs or manuals  

Support Agreement Resources 
If you want to contact Symantec regarding an existing support agreement, see 
https://support.symantec.com/content/unifiedweb/en_US/contact-support.html.  

 

 

 

https://support.symantec.com/content/unifiedweb/en_US/contact-support.html
https://support.symantec.com/content/unifiedweb/en_US/contact-support.html


 

2 Symantec Encryption Desktop Basics 

This section describes the Symantec Encryption Desktop terminology and provides 
some high-level conceptual information on cryptography. 

In This Chapter 

Symantec Encryption Desktop Terminology .............................................................. 9

Conventional and Public Key Cryptography .............................................................11

Using Symantec Encryption Desktop for The First Time .......................................12

 
 

Symantec Encryption Desktop Terminology 
To make the most of Symantec Encryption Desktop, you should be familiar with the 
terms in the following sections. 

 

Product Components 
Symantec Encryption Desktop and its components are described in the following list. 
Depending on your license, you may not have all functionality available. For more 
information, see Licensing Symantec Encryption Desktop for Windows (on page 4). 

 Symantec Encryption Desktop: A software tool that uses cryptography to protect 
your data against unauthorized access. Symantec Encryption Desktop is available 
for Mac OS X and Windows. 

 Symantec Drive Encryption: Symantec Drive Encryption is a feature of 
Symantec Encryption Desktop that encrypts your entire hard drive or 
partition, including your boot record, thus protecting all your files when you 
are not using them. You can use Symantec Drive Encryption and PGP Virtual 
Disk volumes on the same system. On Windows systems, you can protect 
whole disk encrypted drives with a passphrase or with a keypair on a USB 
token for added security. 

 PGP Messaging: A feature of Symantec Encryption Desktop that 
automatically and transparently supports all of your email clients through 
policies you control. Symantec Encryption Desktop accomplishes this using a 
new proxy technology; the older plug-in technology is also available. 

 Symantec File Share Encryption: A feature of Symantec Encryption Desktop 
for Windows with which you can securely and transparently share files and 
folders among selected individuals. Symantec File Share Encryption users 
can protect their files and folders simply by placing them within a folder that 
is designated as protected. 

 PGP Keys: A feature of Symantec Encryption Desktop that gives you 
complete control over both your own PGP keys, and the keys of those 
persons with whom you are securely exchanging email messages. 
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 PGP Virtual Disk volumes: PGP Virtual Disk volumes are a feature of 
Symantec Encryption Desktop that let you use part of your hard drive space 
as an encrypted virtual disk. You can protect a PGP Virtual Disk volume with 
a key or a passphrase. You can even create additional users for a volume, so 
that people you authorize can also access the volume. The PGP Virtual Disk 
feature is especially useful on laptops, because if your computer is lost or 
stolen, the sensitive data stored on the PGP Virtual Disk is protected against 
unauthorized access. 

 PGP Shredder: A feature of Symantec Encryption Desktop that lets you 
securely delete data from your system. PGP Shredder overwrites files so that 
even file recovery software cannot recover them. 

 PGP Viewer: Use PGP Viewer  decrypt, verify, and display messages outside 
the mail stream 

 PGP Zip: A feature of Symantec Encryption Desktop that lets you put any 
combination of files and folders into a single encrypted, compressed package 
for convenient transport or backup. You can encrypt a PGP Zip archive to a 
PGP key or to a passphrase. 

 Symantec Encryption Server: A tool for enterprises to automatically and 
transparently secure email messaging for their employees. If you are using 
Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment, your messaging policies and other settings may be controlled by 
your organization’s Symantec Encryption Server administrator. 

 PGP Global Directory: A free, public keyserver hosted by Symantec 
Corporation. The PGP Global Directory provides quick and easy access to the 
universe of PGP keys. It uses next-generation keyserver technology that 
queries the email address on a key (to verify that the owner of the email 
address wants their key posted) and lets users manage their own keys. Using 
the PGP Global Directory significantly enhances your chances of finding a 
valid public key of someone to whom you want to send secured messages. 
Symantec Encryption Desktop is designed to work closely with the PGP 
Global Directory. 

 

 
 

Terms used in Symantec Encryption Desktop 
Before you use Symantec Encryption Desktop, you should be familiar with the following 
terms: 

 Decrypting: The process of taking encrypted (scrambled) data and making it 
meaningful again. When you receive data that has been encrypted by someone 
using your public key, you use your private key to decrypt the data. 

 Encrypting: The process of scrambling data so that if an unauthorized person gets 
access to it, they cannot do anything with it. The data is so scrambled, it’s 
meaningless. 

 Signing: The process of applying a digital signature to data using your private key. 
Because data signed by your private key can be verified only by your public key, 
the ability to verify signed data with your public key proves that your private key 
signed the data and thus proves the data is from you. 
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Conventional and Public Key Cryptography  

 Verifying: The process of proving that the private key was used to digitally sign 
data by using that person’s public key. Because data signed by a private key can 
only be verified by the corresponding public key, the fact that a particular public 
key can verify signed data proves the signer was the holder of the private key. 

 Keypair: A private key/public key combination. When you create a PGP “key”, you 
are actually creating a keypair. As your keypair includes your name and your 
email address, in addition to your private and public keys, it might be more helpful 
to think of your keypair as your digital ID—it identifies you in the digital world as 
your driver’s license or passport identifies you in the physical world. 

 Private key: The key you keep very, very private. Only your private key can 
decrypt data that was encrypted using your public key. Also, only your private key 
can create a digital signature that your public key can verify. 

Caution: Do not give your private key, or its passphrase, to anyone! And keep 
your private key safe. 

 Public key: The key you distribute to others so that they can send protected 
messages to you (messages that can only be decrypted by your private key) and so 
they can verify your digital signature. Public keys are meant to be widely 
distributed. 

Your public and private keys are mathematically related, but there’s no way to 
figure out your private key if someone has your public key. 

 Keyserver: A repository for keys. Some companies host keyservers for the public 
keys of their employees, so other employees can find their public keys and send 
them protected messages. The PGP Global Directory (https://keyserver.pgp.com) is 
a free, public keyserver hosted by Symantec Corporation. 

 Smart cards and tokens: Smart cards and tokens are portable devices on which 
you can create your PGP keypair or copy your PGP keypair. Creating your PGP 
keypair on a smart card or token adds security by requiring possession of the 
smart card or token in order to encrypt, sign, decrypt, or verify. So even if an 
unauthorized person gains access to your computer, your encrypted data is secure 
because your PGP keypair is with you on your smart card or token. Copying your 
PGP keypair to a smart card or token is a good way to use it away from your main 
system, back it up, and distribute your public key. 

 

 
 

Conventional and Public Key Cryptography 
Conventional cryptography uses the same passphrase to encrypt and decrypt data. 
Conventional cryptography is great for data that isn’t going anywhere (because it 
encrypts and decrypts quickly). However, conventional cryptography is not as well 
suited for situations where you need to send encrypted data to someone else, especially 
if you want to send encrypted data to someone you have never met. 

Public-key cryptography uses two keys (called a keypair) for encrypting and 
decrypting. One of these two keys is your private key; and, like the name suggests, you 
need to keep it private. Very, very private. The other key is your public key, and, like its 
name suggests, you can share it with the general public. In fact, you’re supposed to 
share. 

 

https://keyserver.pgp.com/


 
12 Symantec Encryption Desktop Basics 

 
 
 

 

Using Symantec Encryption Desktop for The First Time 

Public-key cryptography works this way: let’s say you and your cousin in another city 
want to exchange private messages. Both of you have Symantec Encryption Desktop. 
First, you both need to create your keypair: one private key and one public key. Your 
private key you keep secret, your public key you send to a public keyserver like the PGP 
Global Directory (keyserver.pgp.com), which is a public facility for distributing public 
keys. (Some companies have their own private keyservers.) 

Once the public keys are on the keyserver, you can go back to the keyserver and get 
your cousin’s public key, and she can go to the keyserver and get yours (there are other 
ways to exchange public keys; for more information, see Working with PGP Keys (on 
page 33)). This is important because to send an encrypted email message that only your 
cousin can decrypt, you encrypt it using your cousin’s public key. What makes this work 
is that only your cousin’s private key can decrypt a message that was encrypted using 
her public key. Even you, who have her public key, cannot decrypt the message once it 
has been encrypted using her public key. Only the private key can decrypt data that was 
encrypted with the corresponding public key. 

Your public and private keys are mathematically related, but there’s no feasible way to 
figure out someone’s private key if you just have a public key. 

 

Using Symantec Encryption Desktop for The First Time 
Symantec Corporation recommends the following procedure for getting started with 
Symantec Encryption Desktop: 

1 Install Symantec Encryption Desktop on your computer. 

If you are a corporate user, your Symantec Encryption Server administrator may 
have specific installation instructions for you to follow or may have configured 
your Encryption Desktop installer with certain settings. Either way, this is the first 
step. 

2 Let the Setup Assistant be your guide. 

To help you get started, after you install Symantec Encryption Desktop and reboot 
your computer, the Setup Assistant is displayed. It assists with: 

 Licensing Symantec Encryption Desktop 

 Creating a keypair—with or without subkeys (if you do not already have a 
keypair). 

 Publishing your public key on the PGP Global Directory. 

 Enabling PGP Messaging 

 Giving you a quick overview of other features. 

If your Symantec Encryption Desktop installer application was configured by a 
Symantec Encryption Server administrator, the Setup Assistant may perform 
other tasks. 

3 Exchange public keys with others. 

After you have created a keypair, you can begin sending and receiving secure 
messages with other Symantec Encryption Desktop users (once you have 
exchanged public keys with them). You can also use the Symantec Encryption 
Desktop disk-protection features. 
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Using Symantec Encryption Desktop for The First Time  

Exchanging public keys with others is an important first step. To send them secure 
messages, you need a copy of their public key, and to reply with a secure message, 
they need a copy of your public key. If you did not upload your public key to the 
PGP Global Directory using the Setup Assistant, do so now. If you do not have the 
public key for someone to whom you want to send messages, the PGP Global 
Directory is the first place to look. Symantec Encryption Desktop does this for 
you—when you send email, it finds and verifies the keys of other Symantec 
Encryption Desktop users automatically. It then encrypts your message to the 
recipient public key, and sends the message. 

4 Validate the public keys you get from untrusted keyservers. 

When you get a public key from an untrusted keyserver, try to make sure that it 
has not been tampered with, and that the key really belongs to the person it 
names. To do this, use Symantec Encryption Desktop to compare the unique 
fingerprint on your copy of someone’s public key to the fingerprint on that 
person’s key (a good way to do that is by telephoning the key’s owner and having 
them read you the fingerprint information so that you can compare it). Keys from 
trusted keyservers like the PGP Global Directory have already been verified. 

5 Start securing your email and files. 

After you have generated your keypair and exchanged public keys, you can begin 
encrypting, decrypting, signing, and verifying email messages and files. 

6 Watch for information boxes from the Notifier feature to appear. 

As you send or receive messages, or perform other Symantec Encryption Desktop 
functions, the Notifier feature displays information boxes that appear in 
whichever corner of the screen you specify. These Notifier boxes tell you the 
action that Symantec Encryption Desktop took, or will take. After you grow 
familiar with the process of sending and receiving messages, you can change 
options for the Notifier feature—or turn it off. 

7 After you have sent or received some messages, check the logs to make sure 
everything is working correctly. 

If you want more information than the Notifier feature displays, the Encryption 
Desktop Log provides detailed information about all messaging operations. 

8 Modify your messaging policies, if necessary. 

Email messages are sent and received—automatically and seamlessly—if Symantec 
Encryption Desktop messaging policies are configured correctly. If your message 
recipient has a key on the PGP Global Directory the default Symantec Encryption 
Desktop policies provide opportunistic encryption. Opportunistic encryption 
means that, if Symantec Encryption Desktop has what it needs (such as the 
recipient's verified public key) to encrypt the message automatically, then it does 
so. Otherwise, it sends the message in clear text (unencrypted). The default 
Symantec Encryption Desktop policies also provide optional forced encryption. 
This means that, if you include the text “[PGP]” in the Subject line of a message, 
then the message must be sent securely. If verified keys cannot be found, then the 
message is not sent, and a Notifier box alerts you. 

9 Start using the other features in Symantec Encryption Desktop. 

Along with its messaging features, you can also use Symantec Encryption Desktop 
to secure the disks that you work with: 

 Use Symantec Drive Encryption to encrypt a boot disk, disk partition, 
external disk, or USB thumb drive. All files on the disk or partition are 
secured — encrypted and decrypted on the fly as you use them. The process 
is completely transparent to you. 
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 Use PGP Virtual Disk to create a secure “virtual hard disk.” You can use this 
virtual disk like a bank vault for your files. Use Symantec Encryption 
Desktop or Windows Explorer to unmount and lock the virtual disk, and your 
files are secure, even if the rest of your computer is unlocked. 

 Use PGP Zip to create compressed and encrypted PGP Zip archives. These 
archives offer an efficient way to transport or store files securely 

 Use PGP Shredder to delete sensitive files that you no longer need. PGP 
Shredder removes them completely, eliminating any possibility of recovery. 

 
 

 Use Symantec File Share Encryption to share files and folders securely and 
easily among any number of people—with maximum access control. 

 

 



 

3 Installing Symantec Encryption 
Desktop 

This section describes how to install Symantec Encryption Desktop onto your computer 
and how to get started after installation.  

In This Chapter 

Before You Install ..........................................................................................................15

Installing and Configuring Symantec Encryption Desktop....................................15

Uninstalling Symantec Encryption Desktop.............................................................18

Moving Your Symantec Encryption Desktop Installation from One Computer to 
Another ...........................................................................................................................19

 
 

Before You Install 
Before you install Symantec Encryption Desktop 10.4 on your Windows computer, see 
the System Requirements section available in the Symantec Encryption Desktop 10.4  
for Windows Release Notes. 

 

Installing and Configuring Symantec Encryption Desktop 
This section includes information on installing or upgrading Symantec Encryption 
Desktop, as well as information on the Setup Assistant. 

 

Installing the Software 

Note: You must have administrative rights on your system in order to install 
Symantec Encryption Desktop. 

To install Symantec Encryption Desktop on your Windows system 

1 Locate the Symantec Encryption Desktop installation program. The installer 
program is an .MSI file, which your Symantec Encryption Server administrator 
may have distributed to you using the Microsoft SMS deployment tool. 

2 Double-click the Symantec Encryption Desktop installer. 

3 Follow the on-screen instructions. 

4 If prompted to do so, restart your system. 
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Installing and Configuring Symantec Encryption Desktop 

Note: If you are in a domain protected by a Symantec Encryption Server, your 
Symantec Encryption Server administrator may have preconfigured your Symantec 
Encryption Desktop installer with specific features and/or settings. In addition, if 
your Symantec Encryption Server administrator set up silent enrollment, your 
Windows domain password will be used for all passphrase requirements in Symantec 
Encryption Desktop. If specified by policy, Symantec Drive Encryption may 
automatically start to encrypt your disk when your Windows password is entered. 

 

Upgrading the Software 
If you are upgrading your computer to a new version of the operating system and want 
to use this version of Symantec Encryption Desktop, be sure to uninstall any previous 
versions of the software before upgrading the OS and installing this release. Be sure to 
back up your keys and keyrings before uninstalling.  

Important Note: If you have encrypted your disk, you will need to unencrypt your 
disk before you can uninstall the software. 

Upgrading Symantec Encryption Desktop 
Do one of the following: 

 From version 10.x for Windows: Follow the standard installation process for 
Symantec Encryption Desktop 10.4 for Windows. The previous version is 
automatically uninstalled, and Symantec Encryption Desktop 10.4 for Windows is 
installed. Existing keyrings and PGP Virtual Disk files are usable in the upgraded 
version. 

 From a version prior to 10.x: Follow the instructions at the article HOWTO77632 
https://support.symantec.com/en_US/article.HOWTO77632.html at the Symantec 
Knowledgebase. 

 

 

Checking for Updates 

Note: The option to automatically check for updates is no longer available, starting 
with version 10.1. To check for an update or to install an update, you must manually 
download the file. 

To manually download an update 

 At the Symantec FileConnect site, (https://fileconnect.symantec.com/), select your 
language, and enter your serial number.  

 

 

 

https://support.symantec.com/en_US/article.HOWTO77632.html
https://fileconnect.symantec.com/
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Upgrading From Standalone to Managed Symantec Encryption Desktop Installations 

If you have been using Symantec Encryption Desktop in standalone mode and now will 
be managed by a Symantec Encryption Server, you must install a bound and stamped 
version of Symantec Encryption Desktop over your existing, standalone installation. 
You must also complete the enrollment process. Your Symantec Encryption Server 
administrator will provide an installation file so you can install a bound and stamped 
version. 

Upgrading the Operating System Software 

If you are upgrading your computer to a new major release of the operating system, be 
sure to do the following: 

1 Back up your keys and keyrings before uninstalling. 

2 If you have used Symantec Drive Encryption, decrypt your disk before you 
uninstall Symantec Encryption Desktop.  

3 Uninstall any previous versions of Symantec Encryption Desktop before 
upgrading to the new version of the operating system.  

4 Once you have upgraded your version of the operating system, reinstall Symantec 
Encryption Desktop. Import your keys/keyring and, if necessary, you can then 
encrypt your disk. 

Alternatively, you can use Symantec-provided scripts to upgrade without having to 
decrypt and re-encrypt your disks:  

On client systems with Symantec Encryption Desktop 10.3.2 MP10 and later
installed, if you are upgrading from Windows 7 or later to Windows 10 November
Update, see the article HOWTO119349
https://support.symantec.com/en_US/article.HOWTO119349.html at the
Symantec Knowledgebase. 

On client systems with Symantec Encryption Desktop 10.4.0 MP1 and later
installed, if you are upgrading from Windows 7 or later to Windows 10
Anniversary Update, see the article HOWTO125015
https://support.symantec.com/en_US/article.HOWTO125015.html at the
Symantec Knowledgebase. 

Licensing Symantec Encryption Desktop 
For license information for this release, see the Symantec Encryption Desktop Release 
Notes. 

https://support.symantec.com/en_US/article.HOWTO119349.html
https://support.symantec.com/en_US/article.HOWTO125015.html
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Running the Setup Assistant 
When the installation of Symantec Encryption Desktop is complete, you are prompted 
to restart your computer. Once the computer restarts, as soon as you see the Windows 
Desktop, the Symantec Encryption Desktop Setup Assistant starts automatically. The 
Setup Assistant displays a series of screens that ask you questions—then uses your 
answers to configure Symantec Encryption Desktop for you. 

Based on a number of factors, the Setup Assistant for your system contains only those 
screens that are appropriate for your installation. 

The Setup Assistant does not configure all Symantec Encryption Desktop settings. 
When you finish going through the Setup Assistant screens, you can then configure 
those settings not covered in the Setup Assistant. 

Uninstalling Symantec Encryption Desktop 
You can uninstall Symantec Encryption Desktop using the Symantec Encryption 
Desktop uninstaller, or by using Windows' Add or Remove Programs feature. The 
following procedure describes using the Symantec Encryption Desktop uninstaller 
directly. 

If you are upgrading from version 8.x or later, you do not have to uninstall the software 
first. For more information, see Upgrading the Software (on page 16). 

Note: You must have administrative rights on your system in order to uninstall 
Symantec Encryption Desktop. 

To uninstall Symantec Encryption Desktop 

1 Click the Start menu and select Programs > Symantec Encryption > Uninstall 
Symantec Encryption Desktop. A confirmation dialog box is displayed. 

2 Click Yes to continue with the uninstall process. The Symantec Encryption 
Desktop software is removed from your system. 

Keyring, PGP Virtual Disk, and PGP Zip (.pgp) files are not removed from your 
system, in case you decide to reinstall Symantec Encryption Desktop in the future. 

3 If prompted, restart your computer to complete the uninstall process. 

Note: An alternative to uninstalling Symantec Encryption Desktop is stopping 
Symantec Encryption Desktop background services. Doing this prevents Symantec 
Encryption Desktop from protecting your email, but both PGP Virtual Disk volumes 
and disks or partitions protected by Symantec Drive Encryption are still accessible. If 
you just need to turn off the Symantec Encryption Desktop email proxies, you can do 
that in the PGP Options dialog box (select Tools > Options, click the Messaging tab, 
and deselect the options as needed). 
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Moving Your Symantec Encryption Desktop Installation from One Computer to Another  

Moving Your Symantec Encryption Desktop Installation 
from One Computer to Another 

Moving a Symantec Encryption Desktop installation from one computer to another is 
not a difficult process, although there are a few crucial steps which must be completed 
successfully. The process consists of the following steps: 

To transfer your Symantec Encryption Desktop installation to another computer 

1 Uninstall Symantec Encryption Desktop. For more information on how to 
uninstall Symantec Encryption Desktop, see Uninstalling Symantec Encryption 
Desktop (on page 18).  

Note that this step does not remove the keyring files. 

2 Transfer the keyrings. To do this, copy the keyring files (both pubring.pkr and 
secring.skr) from the old computer to diskette or other removable media, and 
then copy them to the new computer. The default location for the keyring files is 
C:\Documents and Settings\<user>\My Documents\PGP\ in older versions of 
Windows or C:\Users\<username>\Documents\PGP in newer versions of 
Windows. 

If Symantec Encryption Desktop has never been installed on the new computer, 
create this folder first before copying the keyring files to the computer. 

3 Install Symantec Encryption Desktop on the new computer. To do this, download 
Symantec Encryption Desktop by clicking the download link in your original 
Symantec Corporation order confirmation email. 

4 During the installation process, do the following: 

 During the Symantec Encryption Desktop setup wizard on the new computer 
select No, I have existing keyrings and specify the location where you copied 
the keyring files to on the new computer. 

 Use the same name, organization, and license number used when Symantec 
Encryption Desktop was originally authorized. 

 

 

 





 

4 The Symantec Encryption Desktop 
User Interface 

This section describes the Symantec Encryption Desktop user interface. 

In This Chapter 

Accessing Symantec Encryption Desktop Features.................................................21
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Accessing Symantec Encryption Desktop Features 
There are four main ways to access Symantec Encryption Desktop features: 

 Symantec Encryption Desktop Main Window (see "The Symantec Encryption 
Desktop Main Screen" on page 22) 

 PGP Tray Icon (see "Using the PGP Tray Icon" on page 23) 

 Shortcut Menus in Windows Explorer (see "Using Shortcut Menus in Windows 
Explorer" on page 24) 

 Start Menu (see "Using the Start Menu" on page 26) 

For information on how to start and use Symantec Encryption Desktop on Windows 
8/8.1/10 systems, see Conventions Used on Microsoft Windows 8/8.1/10 Systems (on 
page 3). 
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Accessing Symantec Encryption Desktop Features 

The Symantec Encryption Desktop Main Screen 
The main screen of Symantec Encryption Desktop is your primary interface to the 
product. 

 

The Symantec Encryption Desktop main screen includes: 

1 The Menu bar. Gives you access to Symantec Encryption Desktop commands. 
The menus on the Menu bar change depending on which Control box is selected. 

2 The PGP Keys Control Box. Gives you control of PGP Keys. 

3 The PGP Messaging Control Box. Gives you control over PGP Messaging. 

4 The PGP Zip Control Box. Gives you control of PGP Zip, as well as the PGP Zip 
Assistant, which helps you create new PGP Zip archives. 

5 The PGP Disk Control Box. Gives you control of PGP Disk. 

6 The PGP Viewer Control Box. Gives you the ability to decrypt, verify, and 
display messages outside the mail stream. 

7 The Symantec File Share Encryption Control Box. Gives you control of 
Symantec File Share Encryption. 

8 PGP Keys Find box. Use to search for keys on your keyring. As you type text in 
this box, Symantec Encryption Desktop displays search results based on either 
name or email address. 

9 The Symantec Encryption Desktop Work area. Displays information and 
actions you can take for the selected Control box. 

Each Control box expands to show available options, and collapses to save space (only 
the Control Box’s banner displays). Expand a Control Box by clicking its banner. 
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Accessing Symantec Encryption Desktop Features  

When expanded, the contents of Control Boxes change depending on what is 
appropriate for what you are working on, or what is selected. For example, when the 
PGP Keys Control Box is selected, if a public key is selected, the options Email this 
Recipient and Email this Key appear at the bottom of the PGP Keys Control Box. If a 
private key is selected, only Email this Key is displayed. If no key is selected, neither 
option is displayed. 

To navigate around the Symantec Encryption Desktop main screen, use the Tab key. 
Then use the Space key or Enter to select an option. 

Note: Click Email this Recipient to open your system’s default email client and 
create a new email using the address of the selected key. This makes it easy to send a 
message to someone on your keyring. Click Email this Key to open your system’s 
default email client and create a new email with the selected public key attached (the 
message is not addressed). This is useful for sending your public key, or a public key 
on your keyring, to someone who does not already have it. 

 

Using the PGP Tray Icon 
One way to access many Symantec Encryption Desktop features is from the PGP Tray 
icon. 

 

Tip: You can open Symantec Encryption Desktop by double-clicking the PGP Tray 
icon. 

The PGP Tray displays one of four icons: 

 Normal operation ( ): Symantec Encryption Desktop is operating normally; no 
passphrases are cached, message proxying is enabled, no other Symantec 
Encryption Desktop operations are in progress. 

 Cached passphrase ( ): Symantec Encryption Desktop is operating normally; 
additionally, one or more private key passphrases has been cached. Caching 
passphrases is an optional time-saving feature, in that you don’t have to type your 
passphrase if it’s cached to sign a key, for example, but it’s also a security risk in 
that if you leave your system with the passphrase cached, whoever walks up to 
your system could use Symantec Encryption Desktop without having to type the 
appropriate passphrase. 

 Message proxying disabled ( ): Proxying of email messages has been disabled; 
incoming encrypted messages will not be decrypted or verified and outgoing 
messages will not be encrypted or signed. You can turn message proxying back on 
using the PGP Tray menu or the PGP Options. 

 Busy ( ): Symantec Encryption Desktop is in the middle of an operation, such as 
encrypting a disk. When the operation is complete, the PGP Tray icon changes 
back to the appropriate icon. 

When you right- or left-click on the PGP Tray icon, a menu is displayed giving you 
access to various options. Note that not all options may be available, depending on if 
you are a standalone or managed installation. 
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 Exit PGP Services. Stops Symantec Encryption Desktop services on this computer. 
Be very careful with this command; it will stop automatic encryption and 
decryption of email. 

If you stop the PGP Services, you can start them again by restarting your 
computer or by selecting Symantec Encryption Desktop from the Start menu 
(Start > Programs > Symantec Encryption > Symantec Encryption Desktop). 

 About Symantec Encryption Desktop. Displays information about the version of 
Symantec Encryption Desktop you are using, including licensing information. 

 Help. Opens Symantec Encryption Desktop’s integrated online help. 

 Options. Opens the Symantec Encryption Desktop Options dialog. 

 View Notifier. Displays the last incoming and outgoing message notifiers. 

 View Log. Displays the PGP Log. Use the PGP Log to see what actions Symantec 
Encryption Desktop is taking to secure your data. 

 Open PGP Viewer. Opens PGP Viewer so you can decrypt email out of the mail 
stream. 

 Open Symantec Encryption Desktop. Opens the Symantec Encryption Desktop 
main screen. You can also open Symantec Encryption Desktop by double-clicking 
the Symantec Encryption Desktop Tray icon. 

 Update Policy. Manually downloads policy from the Symantec Encryption Server. 
This option is available only for managed installations. 

 Clear Caches. Clears from memory any cached information, such as passphrases 
and cached public keys.  

Note: A cached passphrase is not cleared if you used a smart card or token to 
access a Symantec File Share Encryption protected folder, and removed the 
smart card or token. To clear a cached passphrase, create a hot key. For more 
information, see Advanced Options (on page 250). 

 Unmount PGP Virtual Disks. Unmounts all mounted PGP Virtual Disk volumes. 

 Current Window. Lets you use Symantec Encryption Desktop functionality 
(Decrypt & Verify, Encrypt & Sign, Sign, Encrypt) on the contents of the current 
window. 

 Clipboard. Lets you use Symantec Encryption Desktop functionality (Decrypt & 
Verify, Encrypt & Sign, Sign, Encrypt) on the contents of the Clipboard. Also lets 
you clear or edit the contents of the Clipboard. 

 

 

Using Shortcut Menus in Windows Explorer 
Windows Explorer gives you access to Symantec Encryption Desktop functions 
depending on the item that you right-clicked: 

 Drive. If you right-click a drive on your system in Windows Explorer and select 
Symantec Encryption Desktop from the menu displayed, you can do the following 
to the drive: 

 PGP Shredder Free Space on it 
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 PGP Virtual Disk. If you right-click a mounted PGP Virtual Disk drive on your 
system in Windows Explorer and select Symantec Encryption Desktop from the 
menu displayed, you can do the following to the drive: 

 Unmount the PGP Virtual Disk 

 Locate the PGP Virtual Disk file (.pgd) in Windows Explorer 

 Edit the PGP Virtual Disk properties 

If you right-click the PGP Virtual Disk file (.pgd) in Windows Explorer for an 
unmounted disk, and select Symantec Encryption Desktop from the menu 
displayed, you can also do the following: 

 Compact unused space 

 Use PGP Shredder to securely delete the PGP Virtual Disk (note that this also 
deletes all data on the disk) 

 Re-encrypt the PGP Virtual Disk 

 Folder. If you right-click a folder in Windows Explorer and select Symantec 
Encryption Desktop from the menu displayed, you can do the following to the 
folder: 

 Add to new PGP Zip 

 Create Self-Decrypting Archive of the contents in the folder 

 Secure with a key or passphrase 

 Decrypt & Verify it 

 Add it to Symantec File Share Encryption 

 Shred it 

 File. If you right-click a file in Windows Explorer and select Symantec Encryption 
Desktop from the menu displayed, you can do the following to the file, depending 
on what kind of file it is: 

 If you select an unencrypted file, you can Secure it with a key or passphrase, 
Sign, Shred, or Create a Self-Decrypting Archive 

 If you select an encrypted file, you can decrypt/verify or Shred it 

 If you select an unmounted PGP Virtual Disk volume (.pgd), you can mount 
or edit it; if you select a mounted volume, you can unmount it 

 If you select a PGP Zip (.PGP) file, you can Decrypt & Verify it, View it, or 
Shred it 

 If you select a PGP key file (.asc), you can decrypt/verify or Shred it. If you 
select decrypt/verify, you are given the option of importing the file 

 If you select a PGP public or private keyring file (PKR or SKR files, 
respectively), you can add the keys in it to your keyring or Shred it 

Note: When Symantec Endpoint Encryption Removable Storage software is installed, 
shortcut menus are not available. 
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Using the Start Menu 
You can access Symantec Encryption Desktop through the Windows Start menu. To do 
this, select Start > Programs > Symantec Encryption. 

The Start menu provides you with access to: 

 Symantec Encryption Desktop documentation in English and other supported 
languages 

 The Symantec Encryption Desktop application 

 Uninstalling Symantec Encryption Desktop 

 

 

Notifier alerts 
The Notifier feature displays a small information box that tells you the status of 
incoming and outgoing email messages. 

Note: The Notifier feature also displays the status of the Symantec Drive Encryption 
and Symantec File Share Encryption features on your computer. For more 
information, see Notifier for Disk features (on page 28). 

In a Symantec Encryption Server-managed environment, your administrator may have 
specified certain notifications settings (for example, whether notifications are to be 
displayed or the location of the notifier). In this case, you may not see any notifier 
messages at all. 

 

Notifications on Windows 8/8.1/10 systems 
Symantec Encryption Desktop notifier alerts appear on the Start screen on the 
Windows 8/8.1/10 style interface.  

Notifiers do not appear if you disable notifications for Windows 8/8.1/10 or Symantec 
Encryption Desktop.  

To receive notifications on Windows 8/8.1/10 systems 

1 Verify that Show app notifications and the Symantec Encryption Desktop 
notifications are turned on in the PC settings window of Windows 8/8.1/10. 

2 Verify that the Use PGP Notifier option is enabled in the PGP Options dialog box. 
For more information, see Enabling or Disabling Notifiers (on page 29). 

 

 

Notifier for Messaging 
Use the Notifier for Messaging feature to: 

 See if an incoming email is properly decrypted and/or signed. 
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 See if an outgoing email is properly encrypted and/or signed. 

 Stop an email message from being sent if the encryption options are not what you 
want. 

 View a quick summary of the sender, subject, and encryption key of an email. 

 Review, at any time, the status of previous incoming or outgoing messages for that 
Windows session. 

 See that a chat session with another Symantec Encryption Desktop user is being 
secured. 

Use the Notifier feature to monitor all or some of your incoming email, as well as 
maintain precise control over all or some of your outgoing messages. The choice is 
yours. You can set various Notifier options, or turn the Notifier feature completely off if 
you prefer. 

Some additional points about the Notifier feature: 

 For message notifications, use the left and right arrow buttons in the upper-right 
corner of the Notifier box to scroll Notifier messages forward or backward. This 
way, you can review messages that came before or after the message you are 
viewing currently. 

 When they first display, Notifier message boxes have a partially transparent 
appearance to prevent obscuring anything on your screen. Notifier message boxes 
become opaque if you move your cursor over them, and become translucent again 
when you move your cursor away from them. 

 Unless the cursor is over them, Notifier messages display for four seconds (this 
default setting can be changed in the Notifier options). If you want more time to 
read a Notifier, move your cursor over the Notifier and it remains on your display. 

 If you completely miss reading a Notifier, or you would like to review previous 
ones, choose View Notifier from the PGP Tray icon. 

 Close a Notifier message by clicking the X (in the upper right corner of the 
message. 

For more information about setting Notifier options, see Notifier Options (on page 249). 

 
 

Incoming Notifier Messages 

Notifications for incoming email provide information on whether the email was 
decrypted and verified, or decrypted and signed by an unverified or unknown key.  

 

Outgoing Notifier Messages 

For simple notification, choose to have a Notifier appear momentarily when email is 
sent (all email, or email meeting certain criteria).  

You can also set Symantec Encryption Desktop to include Block and Send buttons in 
the Notifier box. 

To manage the outgoing email with this Notifier 

1 In the PGP Outgoing Message Notifier box, do the following: 
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 To stop this email message from being sent, click Block. Note this blocks 
only this outgoing email message; future email messages to this sender can 
be sent. 

 To send this message, even though the recipient’s key cannot be found, click 
Send. 

 To continue to delay a message from being processed, hover your cursor over 
the Notifier box. When you move your cursor away from the Notifier box, the 
message is then processed using the default rule. 

 In Notifier options, the Delay outbound mail for setting specifies how long 
(in seconds) the Notifier gives you before it sends the mail without your 
intervention. The Notifier displays a countdown before it sends your mail. 

2 To view additional information, including the Action, Recipient, Policy, and 
Signing Key, click More. 

It is not necessary for you to view this additional information unless you want to 
see it. To hide it again, click Less. 

 

Outgoing Notifier Messages for Offline Policy 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your administrator may have specified what actions to 
take on outgoing messages if the Symantec Encryption Server is not available. The 
outgoing notifier message indicates one of the following: 

 Your Symantec Encryption Server is not available and policy has been set to block 
all messages. Email messages remain in your outbox and are sent when the 
Symantec Encryption Server can be contacted.  

 Your Symantec Encryption Server is not available and policy has been set to send 
all messages in the clear. 

 Your Symantec Encryption Server is not available and policy has been set to allow 
your local policy to take precedence. 

In the latter two cases, you can choose to send or block the outgoing message as you 
would any other outgoing message. 

 

Notifier for Disk features 
The Notifier for Disk features keep you informed when you are working with the 
Symantec File Share Encryption and the Symantec Drive Encryption features. 

Note: The Notifier feature also displays the status of incoming and outgoing email 
messages on your computer. For more information, see Notifier for Messaging. 

 

Symantec File Share Encryption 

When used with Symantec File Share Encryption, the Notifier feature alerts you to 
these things: 

 Actions taken to a shared folder. 

 Location of the affected folder. 
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 Name of the affected folder. 

 Who performed the action. 

 

 

Symantec Drive Encryption 

When used with the Symantec Drive Encryption feature, the Notifier feature alerts you 
to these things: 

 The disk being encrypted. 

 The size and type of disk. 

 Status of the encryption process. 

 

 

Enabling or Disabling Notifiers 
In a Symantec Encryption Server-managed environment, your administrator may have 
specified certain notifications settings (for example, whether notifications are to be 
displayed or the location of the notifier). In this case, the Notifier tab is not available 
and not displayed. 

To enable or disable Notifiers 

1 Open Symantec Encryption Desktop and select Tools > Options. 

2 Click the Notifier tab. 

3 Under Usage, specify if you want to Use PGP Notifer and, if so, the location. 
Symantec Encryption Desktop Notifications can appear at any of the four corners 
of your screen (Lower Right, Lower Left, Upper Right, or Upper Left). Select the 
corner that you want Symantec Encryption Desktop Notifications to appear. The 
default position is Lower Right. 

4 If you are using Symantec Encryption Desktop Messaging and you want Notifiers 
to appear, informing you of encryption and/or signing status when you send 
email, select the checkbox to Notify when processing outbound email. Deselect 
this checkbox to stop Notifiers from appearing when you send mail. 

5 Symantec Encryption Desktop looks for a public key for every recipient of the 
email messages that you send. By default, if it cannot find a public key for a 
recipient, it sends that email in the clear (without encryption). Select Ask me 
before sending email when the recipient’s key is not found if you want to be 
notified when a key is not found and be given a chance to block the email so that it 
is not sent. Then specify the following options: 

 Always ask me before sending email: Select this checkbox if you would 
prefer approving every email that you send. You can review the encryption 
status in the Notifier, and either send or block the email. 

 Delay outbound email for n second(s) to confirm (where n is a number from 
1-30; the default is 4 seconds). To change the amount of time that outbound 
messages are delayed, and a Notifier is displayed, click the up or down 
arrows. Use the delay period to review the Notifier message. 

(For more information on the Symantec Encryption Desktop default policy 
settings, see Services and Policies (on page 76).) 
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6 For incoming email, specify how you are notified of its status upon arrival. Select 
one of the following for Display notifications for incoming mail:  

 When receiving secured email—A Notifier appears whenever you receive 
secured email. The box displays who the email is from, its subject, its 
encryption and verification status, and the email address of the person 
sending it. 

 Only when message verification fails—For incoming email, you see a 
Notifier only when Symantec Encryption Desktop is unable to verify the 
signature of the incoming email. 

 Never—If you do not need or want to see a Notifier as you receive email, 
select this option. This option does not affect Notifiers for outgoing mail. 

 

 

Viewing the PGP Log 
Use the PGP Log to see what actions Symantec Encryption Desktop is taking to secure 
your data. 

To view the PGP Log 

1 To view logs, you must turn on logging. To do this, in Symantec Encryption 
Desktop select Tools > Enable Logging. 

2 Do one of the following: 

 Click the Symantec Encryption Desktop system tray icon and select View 
PGP Log from the shortcut menu. The PGP Log opens in a new window. 

 In Symantec Encryption Desktop, select Tools > View Log. The PGP Log 
opens in a new window. 

 In Symantec Encryption Desktop, click the PGP Messaging control box and 
then click View Log. The PGP Log is displayed in the application window. 

3 To change the view options or filter on specific logging information, do the 
following: 

 Click the arrow for View log for to select the days of the logs you want to 
view. 

 Click the arrow for View topic to select the types of logs you want to view. 
Choose from All, PGP, Email, Drive Encryption, File Share Encryption, 
Zip/SDA, or Virtual Disk. 

 Click the arrow for View level to select the minimum severity of log entries 
you want to view. Choose from Error, Warn, Info, or Verbose.  

To view Verbose logs, the PGP Log view window must remain open. When you 
close the window, the level of logging reverts back to the default level, Info. 
Note that Verbose can result in some large log files. 

4 When you are finished viewing the log: 

 To save a copy of the PGP Log, click Save. 

 To clear the entries in the PGP Log, click Shred. 

 To exit the PGP Log window, click Close. 
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By default, Symantec Encryption Desktop now saves log files in Unicode format. If you 
cannot open the PGP Log file after you have saved it, save the log as another file type.  

 

 

 





 

5 Working with PGP Keys 

PGP Keys is the feature of Symantec Encryption Desktop you use to create and 
maintain your keypair and the public keys of other Symantec Encryption Desktop 
users. 

This section describes viewing keys, creating a keypair, distributing your public key, 
getting the public keys of others, and working with keyservers. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

In This Chapter 

Viewing Keys..................................................................................................................33

Creating a Keypair.........................................................................................................34

Protecting Your Private Key ........................................................................................36

Distributing Your Public Key.......................................................................................38

Getting the Public Keys of Others...............................................................................41

Working with Keyservers.............................................................................................42

Using Master Keys.........................................................................................................43

 
 

Viewing Keys 
To view the keys on the local keyring, open Symantec Encryption Desktop and click on 
the PGP Keys Control box. Then click: 

 All Keys. Shows all PGP keys on your keyrings. 

 My Private Keys. Shows only the private keys on your keyrings. 

 Search for Keys. Lets you search for keys on your keyrings based on criteria you 
specify. 

 Smart Card Keys. If you have a smart card on your system, you also have this 
option. 

Some of the more common tasks you may want to perform are available from the PGP 
Keys Control box or work area. These are: 

 If a public key is selected in any view of the PGP Keys on your keyrings, the option 
to Email this Recipient is available in the PGP Keys Control box. 
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 If you perform a search, and you select a public key found in the search that is not 
on your local keyrings, the option Add to my Keyring is available in the PGP Keys 
Control box. 

 To see the properties of any key displayed in the work area, just double-click any 
part of the key listing to display the Key Properties dialog box for that key. 

When you perform a search, the option Save this Key Search is available in the PGP 
Keys Control box, so you can save the results for later access. 

 

Creating a Keypair 
You probably already created a PGP keypair for yourself using the Symantec 
Encryption Desktop Setup Assistant or with a previous version of the software — but if 
you have not, you need to now. Most of the things you do with Symantec Encryption 
Desktop require a keypair. 

Caution: It is bad practice to keep creating new keys for yourself. A PGP keypair is 
like a digital driver’s license or passport; if you create lots of them, you’re going to 
end up confusing yourself and those people who want to send you encrypted 
messages. It is best to have only one key that contains all the email addresses that 
you use. The PGP Global Directory will publish only one key per email address. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, keypair creation may be disabled. 

 

To create a PGP keypair 

1 Make sure the PGP Keys Control box is selected. 

2 Select File > New PGP Key or press Ctrl+N. The first screen of the PGP Key 
Generation Assistant is displayed. 

3 Read the information on this screen. 

4 If you want to generate your new PGP keypair on a token or smart card, make sure 
the token or smart card is connected to the system and then select the box labeled 
Generate Key on Token: [name of smart card or token on system]. For more 
information about smart cards and tokens, see Storing Keys on Smart Cards and 
Tokens (on page 231). 

5 Click Next. The Name and Email Assignment screen is displayed. 

6 Type your real name in the Full Name field and your correct email address in the 
Primary Email field. It is not absolutely necessary to type your real name or even 
your email address. However, using your real name makes it easier for others to 
identify you as the owner of your public key. Also, when you upload your public 
key to the PGP Global Directory (which makes it easily available to other Symantec 
Encryption Desktop users), your real email address is required. 

7 If you would like to add more email addresses to the key you are creating, click 
More and type them in the fields that appear. 

8 To specify advanced settings for the key you are creating, click Advanced. The 
Advanced Key Settings dialog box is displayed. Use this dialog box to specify the 
key type and size, expiration, and other settings. 

9 Select settings for the following: 
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 Key type. Choose between Diffie-Hellman/DSS and RSA. 

 Generate separate signing subkey. Select this box if you need a separate 
subkey for signing. A separate Signing Subkey is created along with the new 
keypair. You can also create additional signing or encryption subkeys any 
time after the new key has been created. For more information about 
separate Signing and Encryption Subkeys, see Working with Subkeys (on 
page 56). 

 Key size. Type from 1024 bits to 4096 bits. The larger the key, the more 
secure it is, but the longer it will take to generate. Some smart cards and 
tokens limit key size to 1024 bits. 

 Expiration. Select Never or specify a date on which the keypair you are 
creating will expire. 

 Allowed Ciphers. Deselect any cipher you do not want the keypair you are 
creating to support. 

 Preferred Cipher. Select the cipher you want to be used in those cases where 
no algorithm is specified. Only a cipher that is allowed can be selected as 
preferred. 

 Allowed Hashes. Deselect any hash you do not want the keypair you are 
creating to support. 

 Preferred Hash. Select the hash you want to be used in those cases where no 
hash is specified. Only a hash that is allowed can be selected as preferred. 

10 Click OK to close the Advanced Key Settings dialog box. 

11 Click Next. 

12 If you are part of a Symantec Encryption Server managed environment, you may 
see the Organization Settings screen, which displays keys your Symantec 
Encryption Server administrator has configured to add to your copy of Symantec 
Encryption Desktop (such as your organization’s Additional Decryption Key (ADK) 
or Organization Key). 

The Passphrase Assignment screen is displayed. 

13 Type the passphrase you want to use to maintain exclusive access to the private 
key of the keypair being created. 

14 To confirm your entry, press Tab to advance to the Confirmation field, then type 
the same passphrase again. For information on the Passphrase Quality Bar, see 
The Passphrase Quality Bar (on page 254). 

Note: Normally, as an added level of security, the characters you type for the 
passphrase do not appear on the screen. However, if you are sure that no one is 
watching, and you want to see the characters of your passphrase as you type, 
select the Show Keystrokes checkbox. 

Warning: Unless your Symantec Encryption Server administrator has 
implemented a PGP key reconstruction policy for your company, no one, 
including Symantec, can salvage a key with a forgotten passphrase. 

15 Click Next to begin the key generation process. Symantec Encryption Desktop 
generates your new keypair. 

This process can take several minutes.

16 When the key generation process indicates that it is done, click Next. You are 
prompted to add the public key portion of the key you just created to the PGP 
Global Directory. 
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17 Read the text on the screen and click Next to add your new key to the PGP Global 
Directory (recommended). Click Skip if you want to prevent the public key from 
being posted to the PGP Global Directory. 

18 Click Finish. Your new PGP keypair has been generated. It should be visible in the 
PGP Keys Work area. If you don’t see it listed, make sure All Keys or My Private 
Keys is selected in the PGP Keys Control box. 

Caution: Consider backing up your private key to a safe location at this point. 
Your private key is very important, and losing it could have catastrophic 
consequences once you have data that is encrypted to it. See Protecting Your 
Private Key (on page 36). 

 

Passwords and Passphrases 
Encrypting a file and then finding yourself unable to decrypt it is a painful lesson in 
learning how to choose a passphrase you will remember. 

Most applications require a password between three and eight letters. Using a 
single-word passphrase is generally a bad practice, and is discouraged. A single word 
password is vulnerable to a dictionary attack, which consists of having a computer try 
all the words in the dictionary until it finds your password. You can imagine simple 
enhancements to dictionary attacks which manage to find broad arrays of passwords 
even when slightly modified from dictionary terms. 

To protect against this manner of attack, it is widely recommended that you create a 
word that includes a combination of upper and lowercase alphabetic letters, numbers, 
punctuation marks, and spaces. This results in a stronger password, but an obscure one 
that you are unlikely to remember easily. 

Trying to thwart a dictionary attack by arbitrarily inserting a lot of non-alphabetic 
characters into a passphrase makes your passphrase too easy to forget and could lead to 
a disastrous loss of information because you can’t decrypt your own files. A multiple 
word passphrase is less vulnerable to a dictionary attack. However, unless the 
passphrase you choose is something that is easily committed to long-term memory, you 
are unlikely to remember it verbatim. 

Picking a phrase on the spur of the moment is likely to result in forgetting it entirely. 
Choose something that is already residing in your long-term memory. It should not be 
something that you have repeated to others recently, nor a famous quotation, because 
you want it to be hard for a sophisticated attacker to guess. If it’s already deeply 
embedded in your long-term memory, you probably won’t forget it. Of course, if you are 
reckless enough to write your passphrase down and tape it to your monitor or put it in 
your desk drawer, it won’t matter what you choose. 

For more information, see Working with Passwords and Passphrases (on page 253). 
 

Protecting Your Private Key 
Symantec Corporation recommends that you take these actions immediately after you 
create your keypair: 

Caution: Failure to take these actions could result in a devastating loss of data some 
time in the future. 
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 Back up a copy of your private key file to another, safe location, in case your 
primary copy is ever damaged or lost. See Backing up Your Private Key (on page 
38). 

 Reflect on your chosen passphrase to ensure that you chose something that you 
will not forget. If you are concerned that you chose a passphrase during the key 
creation process that you will not remember, change it RIGHT NOW to something 
you will not forget. For information on changing your passphrase, see Changing 
Your Passphrase (on page 50). 

Your private key file is very important because once you have encrypted data to your 
public key; only the corresponding private key can be used to decrypt the data. This 
holds true for your passphrase as well; losing your private key or the passphrase means 
that you will not be able to decrypt data encrypted to the corresponding public key. 
When you encrypt information, it is encrypted to both your passphrase and your 
private key. You need both to decrypt the encrypted data. Once the data is encrypted, 
no one—not even Symantec Corporation—can decrypt the data without your private key 
file and your passphrase. 

Consider a situation where you have important encrypted data, and then either forget 
your passphrase or lose your private key. The encrypted data would be inaccessible, 
unusable, and unrecoverable. 

 

Protecting Keys and Keyrings 
Besides making backup copies of your keys, you should be especially careful about 
where you store your private key. Even though your private key is protected by a 
passphrase that only you should know, it is possible that someone could discover your 
passphrase and then use your private key to decipher your email or forge your digital 
signature. For instance, somebody could look over your shoulder and watch the 
keystrokes you enter or intercept them on the network or over the Internet. 

To prevent anyone who might happen to intercept your passphrase from using your 
private key, store your private key only on your own computer. If your computer is 
attached to a network, make sure that your files are not automatically included in a 
system-wide backup where others might gain access to your private key. Given the ease 
with which computers are accessible over networks, if you are working with extremely 
sensitive information, you may want to keep your private key on a diskette, which you 
can insert like an old-fashioned key whenever you want to read or sign private 
information. 

As another security precaution, consider assigning a different name to your private 
keyring file and then storing it somewhere other than in the default location. Use the 
Keys tab of the Options dialog box to specify a name and location for your private and 
public keyring files. 

Your private and public keys are stored in separate keyring files. You can copy them to 
another location on your hard drive or to a diskette. By default, the private keyring 
(secring.skr) and the public keyring (pubring.pkr) are stored along with the other 
program files in your “PGP” folder; you can save your backups in any location you like. 

Keys generated on a smart card cannot be backed up because the private portion of your 
keypair is non-exportable. 

You can configure Symantec Encryption Desktop to back up your keyrings 
automatically after you close Symantec Encryption Desktop. Your keyring backup 
options can be set in the Keys tab of the Options dialog box. 
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Backing up Your Private Key 

To back up your private key 

1 In the PGP Keys control box, click My Private Keys. 

2 Select the icon representing your keypair. 

3 Select File > Export. 

4 Type a name for the file. 

5 Select the Include Private Key(s) check box. This is important, because if you do 
not do this, only your public key will be exported. 

6 Click Save. 

7 Copy the file (which has an .asc extension) to a secure location. This may be a 
compact disc which you carefully archive, another personal computer, or a USB 
flash drive that you keep in a safe location. Please remember not to distribute this 
file to others, as it contains both your private key and your public key. 

Note: If you are in a Symantec Encryption Server-managed environment and your 
key mode is SKM, you cannot export your key using this method. To export your 
keypair, ask your Symantec Encryption Server administrator to export it from the 
management console.  To determine what your key mode is, see Key Modes (on page 
100). 

 

What if You Lose Your Key? 
If you lose your key and do not have a backup copy from which to restore your key, you 
will never again be able to decrypt any information encrypted to your key. You can, 
however, reconstruct your key if your Symantec Encryption Server administrator has 
implemented a key restoration policy for your company. For more information, see PGP 
Key Reconstruction (see "Reconstructing Keys with Symantec Encryption Server" on page 
65, "If You Lost Your Key or Passphrase" on page 65) and contact your Symantec 
Encryption Server administrator. 

 

Distributing Your Public Key 
After you create your Symantec Encryption Desktop keypair, you need to get your 
public key to those with whom you intend to exchange encrypted messages. 

You make your public key available to others so they can send you encrypted 
information and verify your digital signature; and you need their public key to send 
encrypted messages to them. 

You can distribute your public key in various ways: 

 Publish your key on the PGP Global Directory (see "Placing Your Public Key on a 
Keyserver" on page 39).  

Generally none of the other methods are necessary once your key is published to 
this directory. 
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Distributing Your Public Key  

 Include your public key in an email message (see "Including Your Public Key in an 
Email Message" on page 40). 

 Export your public key or copy it to a text file (see "Exporting Your Public Key to a 
File" on page 40). 

On Windows systems, you can also: 

 Copy from a Smart Card directly to someone's keyring (see "Copying from a Smart 
Card Directly to Someone’s Keyring" on page 41). 

 

 

Placing Your Public Key on a Keyserver 
The best method for making your public key available is to place it on a public 
keyserver, which is a large database of keys, where anyone can access it. That way, 
people can send you encrypted email without having to explicitly request a copy of your 
key. It also relieves you and others from having to maintain a large number of public 
keys that you rarely use. 

There are a number of keyservers worldwide, including the PGP Global Directory, 
where you can make your key available for anyone to access. If you are using Symantec 
Encryption Desktop in a domain protected by a Symantec Encryption Server, your 
Symantec Encryption Server administrator will have preconfigured Symantec 
Encryption Desktop with appropriate settings. 

When you’re working with a public keyserver, keep these things in mind before you 
send your key: 

 Is this the key you intend to use? Others attempting to communicate with you 
might encrypt important information to that key. For this reason, we strongly 
recommend you only put keys on a keyserver that you intend for others to use. 

 Will you remember your passphrase for this key so you can retrieve data 
encrypted to it or, if you don’t want to use the key, so you can revoke it? 

 Other than the PGP Global Directory, once a key is up there, it’s up there. Some 
public keyservers have a policy against deleting keys. Others have replication 
features that replicate keys between keyservers, so even if you are able to delete 
your key on one server, it could reappear later. 

Most people post their public key to the PGP Global Directory right after they create 
their keypair. If you have already posted your key to the PGP Global Directory, you do 
not need to do it again. Under most circumstances, there is no need to publish your key 
to any other keyserver. Note also that other keyservers may not verify keys, and thus 
keys found on other keyservers may require significantly more work on your part to 
contact the key owner for fingerprint verification. 

 

To manually send your public key to a keyserver 

1 Open Symantec Encryption Desktop. 

2 Make sure the PGP Keys Control box is selected. 

3 Right-click the keypair whose public key you want to send to the keyserver. 

4 Select Send To and then select the keyserver you want to send the public key to 
from the list. If the keyserver you want to send your public key to is not on the list, 
see Working with Keyservers (on page 42). Symantec Encryption Desktop lets you 
know when the public key is successfully copied to the keyserver. 

 



 
40 Working with PGP Keys 

 
 
 

 

Distributing Your Public Key 

Once you place a copy of your public key on a keyserver, it’s available to people who 
want to send you encrypted data or to verify your digital signature. Even if you don’t 
explicitly point people to your public key, they can get a copy by searching the 
keyserver for your name or email address. 

Many people include the Web address for their public key at the end of their email 
messages. In most cases, the recipient can just double-click the address to access a copy 
of your key on the server. Some people even put their PGP fingerprint on their business 
cards for easier verification. 

 

Including Your Public Key in an Email Message 
Another convenient method of delivering your public key to someone is to include it 
with an email message. 

When you send someone your public key, be sure to sign the email. That way, the 
recipient can verify your signature and be sure no one has tampered with the 
information along the way. Of course, if your key has not yet been signed by any trusted 
introducers, recipients of your signature can only truly be sure the signature is from 
you by verifying the fingerprint on your key. 

 

To include your public key in an email message 

1 In Symantec Encryption Desktop, make sure the PGP Keys Control box is selected. 

2 Right-click the keypair whose public key you want to include in an email message. 

3 Select Send To and then select Mail Recipient. Your email application opens with 
your key information already in place. 

4 Address the message and send it. 

If this method does not work for you, you can open Symantec Encryption Desktop, 
select your keypair, select Edit > Copy, open an email message, then paste the public 
key into the body of the message. With some email applications you can simply drag 
your key from Symantec Encryption Desktop into the text of your email message to 
transfer the public key information. 

 

Exporting Your Public Key to a File 
Another method of distributing your public key is to export it to a file and then make 
this file available to the person with whom you want to communicate securely. 

There are three ways to export or save your public key to a file: 

 Select your keypair, then select File > Export. Enter a name and a location for the 
file, then click Save. Be sure not to include your private key along with your public 
key if you plan on giving this file to others. 

 Ctrl+click the key you want to save to a file, select Export from the list, enter a 
name and a location for the file, then click Save. Be sure not to include your 
private key along with your public key if you plan on giving this file to others. 

 Select your keypair, then select Edit > Copy. Open a text editor and select Paste to 
insert the key information into the text file, and save the file. You can then email 
or give the file to anyone you like. The recipient needs to use Symantec Encryption 
Desktop on his or her system to retrieve the public key portion. 
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Getting the Public Keys of Others  

 
 

Copying from a Smart Card Directly to Someone’s Keyring 
Another method of distributing your public key—if you have it on a smart card—is to 
copy it from the smart card directly to someone’s keyring. 

For more information about how to do this, see Copying your Public Key from a Smart 
Card to a Keyring (on page 235). 

 

Getting the Public Keys of Others 
Just as you need to distribute your public key to those who want to send you encrypted 
mail or verify your digital signature, you need to obtain the public keys of others to 
send them encrypted mail or verify their digital signatures. 

There are multiple ways to obtain someone’s public key: 

 Automatically retrieve the verified key from the PGP Global Directory 

 Find the key manually on a public keyserver 

 Automatically add the public key to your keyring directly from an email message 

 Import the public key from an exported file 

 Get the key from your organization’s Symantec Encryption Server 

Public keys are just blocks of text, so they are easy to add to your keyring by importing 
them from a file or by copying them from an email message and then pasting them into 
your public keyring in Symantec Encryption Desktop. 

 

Getting Public Keys from a Keyserver 
If the person to whom you want to send encrypted mail is an experienced Symantec 
Encryption Desktop user, it is likely that a copy of his or her public key is on the PGP 
Global Directory or another public keyserver. This makes it very convenient for you to 
get a copy of the most up-to-date key whenever you want to send him or her mail and 
also relieves you from having to store a lot of keys on your public keyring. 

There are a number of public keyservers, such as the PGP Global Directory maintained 
by Symantec Corporation, where you can locate the keys of most PGP users. If the 
recipient has not pointed you to the Web address where his or her public key is stored, 
you can access any keyserver and do a search for the user’s name or email address. This 
may or may not work, as not all public keyservers are regularly updated to include the 
keys stored on all the other servers. 

If you are in a domain protected by a Symantec Encryption Server, then your Symantec 
Encryption Server administrator may direct you to use the keyserver built into the 
Symantec Encryption Server. In this case, your Symantec Encryption Desktop software 
is probably already configured to access the appropriate Symantec Encryption Server. 

Similarly, the Symantec Encryption Server is configured by default to communicate 
with the PGP Global Directory. Thus, the PGP ecosystem distributes the load of key 
lookup and verification. 
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Working with Keyservers 

To get someone’s public key from a keyserver 

1 Open Symantec Encryption Desktop and highlight the PGP Keys Control box. 

2 Choose Search for Keys from the PGP Keys Control box. The Search for Keys 
screen is displayed in the Work area. 

3 Specify your search criteria, then click Search. If you want to search only a 
specific keyserver, click in the Search field and select the keyserver. If the 
keyserver you want to search is not currently on the list, select Edit Keyserver 
List and add it. 

You can search for keys on a keyserver by specifying values for multiple key 
characteristics. The inverse of most operations is also available. For example, you 
may search using “User ID is not Charles” as your criteria. 

The results of the search appear. 

4 If the search found a public key you want to add to your keyring, click Add to My 
Keying in the PGP Keys Control box. The selected key is added to your keyring. 

Tip: If you set the search criteria to look for a very common name (for example, 
'Name', 'contains', "John"), only the first match found is returned. This is by design, 
to prevent phishing (or harvesting keys from a keyserver). For common names or 
domains, you may have to enter the entire name or email address in order to find the 
correct key. 

 

Getting Public Keys from Email Messages 
A convenient way to get a copy of someone’s public key is to have that person attach it 
to an email message. 

To add a public key attached to an email message 

1 Open the email message. 

2 Double-click the .asc file that includes the public key. Symantec Encryption 
Desktop recognizes the file format and opens the Select key(s) dialog box. 

3 If asked, specify to open the file. 

4 Select the public key(s) you want to add to your keyring and click Import. 

 

 

Working with Keyservers 
Symantec Encryption Desktop understands the following kinds of keyservers: 
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Using Master Keys  

 PGP Keyservers. If you are using Symantec Encryption Desktop in a domain 
protected by a Symantec Encryption Server, Symantec Encryption Desktop is 
preconfigured to only communicate with the keyserver built into the Symantec 
Encryption Server with which it has a relationship. To Symantec Encryption 
Desktop, this is a trusted keyserver, and Symantec Encryption Desktop will 
automatically trust any key it finds on this keyserver unless the Symantec 
Encryption Server tells Symantec Encryption Desktop that the key is not 
trusted—this can happen, for instance, when verifying signatures from remote 
keys. 

The address for your PGP Keyserver may look like https://keyserver.example.com. 

 The PGP Global Directory. If you are using Symantec Encryption Desktop outside 
of a domain protected by a Symantec Encryption Server, Symantec Encryption 
Desktop is preconfigured to communicate with the PGP Global Directory 
(https://keyserver.pgp.com). 

The PGP Global Directory is a free, public keyserver hosted by Symantec 
Corporation and provides quick and easy access to the universe of PGP keys. It 
uses next-generation keyserver technology that verifies the key associated with 
each email address (so the keyserver does not fill up with unused keys, multiple 
keys per email address, forged keys, and other problems that plagued older 
keyservers) and lets you manage your own keys, including replacing your key, 
deleting your key, and adding email addresses to your key. Using the PGP Global 
Directory significantly enhances your chances of finding the public key of 
someone with whom you want to send secured messages. 

To Symantec Encryption Desktop, the PGP Global Directory is a trusted keyserver, 
and Symantec Encryption Desktop automatically trusts any key it finds there. 
During the initial connection to the PGP Global Directory, the PGP Global 
Directory Verification Key is downloaded, signed, and trusted by the key you 
publish to the directory. The PGP Global Directory key is also added to your 
keyring. All of the keys verified by the PGP Global Directory are thus considered 
valid by Symantec Encryption Desktop. 

PGP Universal Services Protocol. The PGP Universal Services Protocol (USP) is a 
SOAP protocol operating over standard HTTP/HTTPS ports. This is the default key 
lookup mechanism. If you are in a Symantec Encryption Server-managed 
environment, all key search requests as well as all other communications between 
the Symantec Encryption Server and Symantec Encryption Desktop use PGP USP. 

 Other keyservers. In most cases, other keyservers are other public keyservers. 
However, you may have access, through your company or some other means, to a 
private keyserver. 

For more information about working with keyservers, see Keys Options (on page 241). 
 

Using Master Keys 
The Master Key List is a set of keys that you want added by default any time you are 
selecting keys for messaging, disk encryption, Symantec File Share Encryption, and 
PGP Zip. This saves you the step of dragging the keys that you regularly use into the 
Recipients field. 

Note: If you generated your key using the Setup Assistant, your key is automatically 
added to the Master Key list. If you skipped key generation and imported your key 
into Symantec Encryption Desktop, your key is not automatically added to the list. 

 

https://keyserver.pgp.com/
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Using Master Keys 

 

Adding Keys to the Master Key List 

To add keys to the Master Key List 

1 In Symantec Encryption Desktop, select Tools > Options. 

2 Select the Master Keys tab. 

3 To use the Master Key List, select the Use Master Key List checkbox. You cannot 
add or remove keys from the Master Key List unless this box is selected. 

4 Click Add. The Select Master Keys dialog box is displayed. 

5 From the Key Source list on the left, select the key(s) that you want to use. Use 
Shift+click or Ctrl+click to select multiple keys. 

6 After selecting the keys you want, click Add. 

Tip: If there are any keys in the Keys to Add list on the right that you do not want 
to include, select them and click Remove.

7 When you have finished selecting keys, click OK. The keys you have selected 
appear in the Master Key List. 

 

 

Deleting Keys from the Master Key List 

To remove keys from the Master Key List 

1 In Symantec Encryption Desktop, select Tools > Options. 

2 Select the Master Keys tab. 

3 To use the Master Key List, select the Use Master Key List checkbox. You cannot 
add or remove keys from the Master Key List unless this box is selected. 

4 Select the key(s) that you want to remove. You can Shift+click or Ctrl+click to 
select multiple keys. 

5 Click Remove. The key(s) are removed. 

 

 

 



 

6 Managing PGP Keys 

This section describes how to manage keys with the Symantec Encryption Desktop 
application. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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Examining and Setting Key Properties 
The PGP Keys Work Area can display these important details about your keys: 

 Name 

 Email address 

 Validity 

 Size 

 KeyID 

 Trust 
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Working With Photographic IDs 

 Creation date 

 Expiration date 

 ADK 

 Status 

 Key description 

 Key usage 

You can choose how many or how few details are displayed by clicking the Keys item, 
then choosing columns to display by selecting View > Columns. 

You can, however, see more information about a key and you can modify certain 
information about a key, by examining its key properties. 

Note: If you are in a Symantec Encryption Server-managed environment and your 
key mode is SKM, you cannot make changes to your key.  In addition, SKM keys are 
set to never expire. To determine what your key mode is, see Key Modes (on page 
100). 

To view a key’s properties 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 

2 Double-click the key whose properties you want to view. The Key Properties dialog 
box for the key you selected is displayed. 

 

 

Working With Photographic IDs 
You can include a photographic ID on your Diffie-Hellman/DSS and RSA keys. 

To add your photograph to your key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and select 
My Private Keys. 

2 In the PGP Keys Work area, double-click the private key to which you are adding 
the photo ID. The Key Properties dialog box for the selected key is displayed. 

3 Right-click the placeholder key and silhouette icon and select Add Photo ID. The 
Add Photo dialog box is displayed. 

4 Drag or paste your photograph onto the Add Photo dialog box or browse to it by 
clicking Select File. 

5 Click OK. The Passphrase dialog box opens. 

6 Type your passphrase for the key you are modifying, then click OK. Your photo ID 
is added to your public key. 
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Managing User Names and Email Addresses on a Key  

To delete a photo ID 

 Right-click the existing photo on the Key Properties dialog box and select Remove 
Photo ID. The photo is removed from the key. 

 

To copy a photo ID 

 Right-click the existing photo on the Key Properties dialog box and select Copy 
Photo ID. You can then paste the photo into another key or into a graphics 
program. 

 

 

Managing User Names and Email Addresses on a Key 
Symantec Encryption Desktop supports multiple user names and email addresses on 
your keypair. These names and email addresses help others find your key so that they 
can send you encrypted messages. 

 

To add a new user name or address to your key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and select 
My Private Keys. 

2 In the PGP Keys Work area, double-click the private key to which you are adding a 
user name or email address. The Key Properties dialog box for the key you 
double-clicked is displayed. 

3 Click Add Email Address. The PGP New User Name dialog box is displayed. 

4 Type the new name and email address in the appropriate fields, then click OK. The 
PGP Enter Passphrase for Key dialog box is displayed. 

5 Enter the private key passphrase of the key you are modifying, then click OK.  

6 To set the new user name and address as the primary identifier for your key, click 
the name of the current primary keyholder in the Key Properties dialog box and 
select the user you just added. 

7 Exit the Key Properties dialog box. In the list of keys in Symantec Encryption 
Desktop, the new name is added to the end of the user name list associated with 
the key.  

 

 

To change the primary name associated with your key 

1 Do one of the following: 

 In the Key Properties dialog box, click the name of the current primary 
keyholder and select the name of the user from the list that is displayed. 

 In Symantec Encryption Desktop, expand your key in the keys list, 
right-click the user name you want to set as the primary identifier, and 
choose Set as Primary Name from the shortcut menu. 
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Importing Keys and X.509 Certificates 

 

To delete a name/email adress from  your key 

To delete a name/email address from your key 

1 From the list of keys, click the plus sign to the left of the key name to expand the 
key. 

2 Select the user ID you want to delete. 

3 Press the Delete key on your keyboard. A confirmation dialog box is displayed. 

Tip: You can also select Edit > Delete.  

4 Click Delete. The user ID is deleted. 

 

 
 

Importing Keys and X.509 Certificates 
You can import the public portion of PGP keys and PKCS-12 X.509 certificates (a digital 
certificate format used by most Web browsers) to your Symantec Encryption Desktop 
keyring, as well as PKCS-7 public X.509 certificates. You can also import Privacy 
Enhanced Mail (PEM) format X.509 certificates from your browser by copying and 
pasting into your public keyring. 

There are many ways to import the public portion of PGP keys and add it to your 
keyring. These methods include: 

 Double-clicking the file on your system. If Symantec Encryption Desktop 
recognizes the file format, it will open and ask if you want to import the key(s) in 
the file. 

 Choosing to import the key file in Symantec Encryption Desktop. 

 Dragging the file containing the public key onto the PGP Keys window. 

Symantec Encryption Desktop provides an Import Certificate Assistant to help you with 
this task. For more information, see Using the Import Certificate Assistant (on page 49). 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment and you imported an X.509 certificate on a token 
during enrollment (choosing to import the certificate as a PGP key), you must 
manually enable the Synchronize keyring with tokens and smart cards option. To 
do this, in Symantec Encryption Desktop choose Tools > Options and click the Keys 
tab. This step is required in order for the key to work properly with Symantec Drive 
Encryption. 
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Importing Keys and X.509 Certificates  

Using the Import Certificate Assistant 
X.509 certificates can be imported into Symantec Encryption Desktop from files, the 
Windows Personal Certificate store, or smart cards. Even smart card-based certificates 
which appear in your Windows Certificate store may be imported. The Import 
Certificate Assistant guides you through the importation process. 

When importing certificates from files, the certificate can only be imported from a file 
with a PEM, PFX, P7b, or P12 extension. 

Notes: When using certificates from the Windows Personal Certificate store, you 
may get prompted for your certificate's password or PIN by Windows itself (or the 
third-party smart card software, if using smart card-based Windows Personal 
Certificates). 
 
Some operations, such as changing the certificate's password, are not permitted 
from within Symantec Encryption Desktop when using certificates from the 
Windows Personal Certificate store. Use the Windows (or smart card) software for 
performing such operations. 

To import a certificate using the Import Certificate Assistant 

Before You Begin: Make sure that you know the passphrase for the certificate that 
you are importing. 

1 Start the Assistant by: 

 Selecting File > Open. 

 Selecting File > Import Personal Certificates. 

 Dragging the file containing the public key into the PGP Keys window 

2 If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, and your administrator has defined that you can 
choose the method to import the certificate, select: 

 Onto an existing key—the certificate is added to a key that is already in your 
keyring. 

 As new PGP key(s)—a new PGP key is created using the imported certificate. 

 As PGP X.509 wrapper key(s)—a new PGP key is created using the imported 
certificate. Symantec Encryption Desktop treats the new key as an X.509 
certificate. 

3 After you make your selection, click Next. Either the Certificate Passphrase Entry 
screen or the PGP Enter Passphrase dialog box displays. 

4 Provide the password for the certificate, then click Next. 

 If you are importing the certificate using the Onto an existing key option, 
the Select Key screen displays. Go to the next step. 

 If you are importing the certificate using the As new PGP key(s) option, the 
key is generated. Click Finish. The process is complete. 
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Changing Your Passphrase 

 If you are importing the certificate using the As PGP X.509 wrapper key(s) 
option, the Select key(s) dialog box displays. Click to select the key, click 
Import, and the PGP X.509 wrapper key is generated. The process is 
complete. 

5 To complete importing the certificate using the Onto an existing key option, from 
the Select Key dialog box, select the key onto which you would like to import the 
certificate, then type the password for the key. Click Next. 

6 The Key Generation Progress dialog box is displayed as the certificate is imported 
onto the key. 

7 Click Finish. The process is complete. 

 

 

Importing X.509 Certificates Included in S/MIME Email Messages 
If an X.509 certificate is included in an S/MIME email message sent to you, you can 
have Symantec Encryption Desktop import the certificates to your key ring. The same 
settings you have specified when public keys are found apply to these certificates. If 
specified, Symantec Encryption Desktop extracts and then imports the X.509 certificate 
to your keyring. If you want to encrypt email using imported certificates, be sure to 
manually sign the certificate.  

To import X.509 certificates, choose Tools > Options and select the Keys tab. Then 
select Ask to save to my keyring or Save keys to my keyring. 

Changing Your Passphrase 
It’s a good practice to change your passphrase at regular intervals, perhaps every three 
months. More importantly, you should change your passphrase the moment you think 
it has been compromised, for example, by someone looking over your shoulder at the 
keyboard as you typed it in. 

To change the passphrase for a split key, you must rejoin it first. 

Tip: Changing your passphrase on your key does not change the passphrase on any 
copies of the key (such as backups you may have made). If you think your key has 
been compromised, Symantec Corporation recommends that you shred any previous 
backup copies and then make new backups of your key. 

If you are in a Symantec Encryption Server-managed environment and your key mode 
is SKM, you cannot change the passphrase for your key. SKM keys are protected by a 
randomly generated passphrase (that is itself protected) and you are never prompted to 
enter a passphrase for an SKM key. To determine what your key mode is, see Key Modes 
(on page 100). 

 

Deleting Keys, User IDs, and Signatures 
Symantec Encryption Desktop gives you control over the keys on your keyrings, as well 
as the user IDs and signatures on those keys. 
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Deleting Keys, User IDs, and Signatures  

With public keys on your keyrings, you can delete entire keys, any user IDs on a key, 
and any or all signatures on a key. 

With your keypairs, you can delete entire keypairs or any or all signatures, as well as 
delete user IDs from a keypair as long as that is not the only user ID on the keypair. 

Note, however, that you cannot delete a user ID on a key if it is the only user ID, and you 
cannot delete self-signatures from keys. 

 

To delete a key, user ID, or signature from your PGP keyring 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 

2 Do one of the following: 

 To delete a key, right-click on the key, select Delete from the list of 
commands displayed, then click OK on the Confirmation dialog box. The key 
is deleted from your keyring. 

 To delete a user ID (from a public key) or signature, click the plus sign on the 
left side of the key to display the user IDs and signatures. When you see the 
user ID or signature you wish to delete, right-click it, select Delete from the 
list of commands displayed, then click OK on the Confirmation dialog. The 
user ID or signature is deleted. 

 

 
 

To change your private key passphrase 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and select 
My Private Keys. 

2 In the PGP Keys work area, double-click the private key for which you are 
changing the passphrase. The Key Properties dialog box is displayed. 

3 Click Change Passphrase. The PGP Passphrase Assistant is displayed. 

4 Enter your current passphrase for the private key, then click Next. The Create 
Passphrase dialog box is displayed. 

5 Enter your new passphrase in the first text field, and then enter it again in the 
Re-Enter Passphrase field to confirm the new passphrase. 

To display your keystrokes as you type your passphrase, select the Show 
Keystrokes box. 

The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating by comparing the amount of entropy in the 
passphrase you type against a true 128-bit random string (the same amount of 
entropy in an AES128 key). For more information, see The Passphrase Quality Bar 
(on page 254). 

6 Click Finish. Your passphrase is changed. 
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Disabling and Enabling Public Keys 
Sometimes you may want to temporarily disable a public key on your keyring, which 
can be useful when you want to retain a public key for future use, but you don’t want it 
cluttering up your recipient list every time you send mail. 

You cannot disable a keypair that is "implicitly trusted." In order to disable a key that 
has been set to implicitly trust, you must first change the trust status to None. 

To disable or enable a public key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 

2 Double-click the public key you want to disable. The Key Properties dialog box for 
the key you selected is displayed. 

3 Locate the Enabled field in the Key Properties. 

 If the current Enabled setting is Yes, the key is enabled. To disable the key, 
click Yes once. The Enabled field changes to No; the key is disabled. 

 If the current Enabled setting is No, the key is disabled. To enable the key, 
click No once. The Enabled field changes to Yes and the key is enabled. 

A disabled key cannot be used to encrypt or sign. You can use a disabled key, however to 
decrypt or verify. 

Tip: You can also synchronize keys on your keyring with the Symantec Encryption 
Server. This option is used primarily to enable/disable public keys on your keyring. 
To do this, right-click a key and choose Synchronize.  

 

Verifying a Public Key 
It is difficult to know for certain whether a public key belongs to a particular individual 
unless that person physically hands the key to you on a removable media or you get the 
key from the PGP Global Directory. Exchanging keys on removable media is not usually 
practical, especially for users who are located many miles apart. 

So the question remains: how can I make sure the public key I got from a public 
keyserver (not the PGP Global Directory) is really the public key of the person listed on 
the key? The answer is: you have to check the key’s fingerprint. 

There are several ways to check a key’s fingerprint, but the safest is to call the person 
and have them read the fingerprint to you over the phone. Unless the person is the 
target of an attack, it is highly unlikely that someone would be able to intercept this 
random call and imitate the person you expect to hear on the other end. You can also 
compare the fingerprint on your copy of someone’s public key to the fingerprint on 
their original key on a public server. 

The fingerprint can be viewed in two ways: in a unique list of words or in its 
hexadecimal format. 
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To check the digital fingerprint of a public key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. 

All keys on your keyring appear. 

2 Double-click the public key whose fingerprint you want to check. The Key 
Properties dialog box for the key you selected is displayed.  

The fingerprint of the key is shown under the name and email address, in either 
hexadecimal format (10 sets of four characters per set) or word list format (four 
columns with five unique words per column). 

3 Compare the fingerprint on the key with the original fingerprint. If the two are the 
same, then you have the real key. If not, then you do not have the real key. 

The word list is made up of special authentication words that Symantec 
Encryption Desktop uses and are carefully selected to be phonetically distinct and 
easy to understand without phonetic ambiguity. 

The word list serves a similar purpose as the military alphabet, which allows pilots 
to convey information distinctly over a noisy radio channel. 

4 If you have a forged key, delete it. 

5 Open your Web browser, navigate to the PGP Global Directory 
(https://keyserver.pgp.com), and search for the real public key. 

 

 

Signing a Public Key 
When you create a keypair, the keys are automatically signed. Similarly, once you are 
sure a key belongs to the correct person, you can sign that person’s public key, 
indicating that you have verified the key. When you sign someone’s public key, a 
signature icon along with your user name is shown attached to that key. 

If you import a keypair from a backup or from a different computer, that keypair may 
also need to be signed. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, key signing may be disabled. 

To sign someone’s key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 

2 Do one of the following: 

 From the Keys menu, select Sign. 

 Right-click on the key you want to sign and select Sign from the list of 
commands that is displayed. 

The PGP Sign Key dialog box is displayed with the user name/email address and 
hexadecimal fingerprint displayed in the text box. 

 

https://keyserver.pgp.com/
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3 Select the Allow signature to be exported checkbox, to allow your signature to be 
exported with this key. 

An exportable signature is one that is allowed to be sent to servers and travels 
with the key whenever it is exported, such as by dragging it to an email message. 
The checkbox provides a shorthand means of indicating that you want to export 
your signature so that others can rely on your signature and trust your keys as a 
result. 

4 Click More Choices to configure options such as signature type and signature 
expiration. 

5 Choose a signature type to sign the public key with. Your choices are: 

 Non-exportable. Use this signature when you believe the key is valid, but 
you don’t want others to rely on your certification. This signature type 
cannot be sent with the associated key to a keyserver or exported in any way. 

 Exportable. Use exportable signatures in situations where your signature is 
sent with the key to the keyserver, so that others can rely on your signature 
and trust your keys as a result. This is equivalent to selecting the Allow 
signature to be exported checkbox on the Sign Keys menu. 

 Meta-Introducer Non-Exportable. Certifies that this key and any keys 
signed by this key with a Trusted Introducer Validity Assertion are fully 
trusted introducers to you. This signature type is non-exportable. 

 Trusted Introducer Exportable. Use this signature in situations where you 
certify that this key is valid, and that the owner of the key should be 
completely trusted to vouch for other keys. This signature type is exportable. 
You can restrict the validation capabilities of the trusted introducer to a 
particular email domain. 

6 The Maximum Trust Depth option enables you to identify how many levels deep 
you can nest trusted-introducers. For example, if you set this to 1, there can only 
be one layer of introducers below the meta-introducer key. 

7 If you want to limit the trusted introducer’s key validation capabilities to a single 
domain, type the domain name in the Domain Restriction text box. 

8 In the Expiration field, select Never if you don’t want this signature to expire or 
select a date on which it does expire. 

9 Click OK. The PGP Enter Passphrase for Key dialog box is displayed. 

10 Select the key you want to sign with from the list, then type the passphrase of the 
signing key, if required. (If the passphrase is already cached, you don’t need to 
type it again.) 

11 Click OK. The key is signed. 

 

 

Revoking Your Signature from a Public Key 
You may, on occasion, want or need to revoke your signature from a key on your 
keyring. 

To revoke your signature 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 
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2 Expand the key from which you want to revoke your signature until you see your 
signing key. 

3 Right-click your signing key and then select Revoke from the list of commands 
displayed. The Revoke Signature dialog box is displayed. 

4 Verify that the Key ID and Name are the correct key (from which you want to 
revoke your signature) and click OK. The PGP Enter Passphrase for Key dialog box 
is displayed. 

5 Enter your passphrase and click OK. Your signature is revoked from the key.  

Note: If your signature was exportable and you distributed the key with the 
exportable signature, you must distribute the key with the revoked signature before 
others can see the revocation. 

 

Granting Trust for Key Validations 
Besides certifying that a key belongs to someone, you can assign a level of trust to the 
owner of the keys indicating how well you trust them to act as an introducer for others, 
whose keys you may get in the future. 

This means that if you ever get a key from someone that has been signed by an 
individual whom you have designated as trustworthy, the key is considered valid even 
though you have not done the check yourself. 

You must sign a key before you can set a trust level for it. 

Public keys can be None, Marginal, or Trusted. Your keypairs can be None or Implicit 
(meaning it is your own key and thus you trust it completely). You should not have 
anyone else’s keypairs. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the ability to grant trust to keys may be disabled. 

To grant trust to a key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click All Keys in the Control box. All keys on your keyring appear. 

2 Double-click the key for which you are granting trust. The Key Properties dialog 
box for the key you selected is displayed. 

3 Locate the Trust field. 

4 Click the current setting and select the desired setting from the list. 

 If you are granting trust for a public key, you can select None, Marginal, or 
Trusted. None means you don’t trust the owner to act as an introducer, 
Marginal means you partially trust them, Trusted means you fully trust 
them. 

 If you are granting trust for a keypair, you can select None or Implicit. Only 
keypairs that you are importing from backup or from another computer of 
yours need to have their trust set to Implicit; when you create a keypair, its 
trust is automatically set to Implicit. 
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Working with Subkeys 
A Symantec Encryption Desktop keypair consists of these elements: 

 the Master Key, for signing only; 

 one mandatory Subkey for encryption; 

 one or more optional Separate Subkey(s) for signing, encryption, or 
signing/encryption. 

The Master Key is used by default for signing, while a subkey is always used for 
encryption. This can improve the security of a Symantec Encryption Desktop keypair, 
as a separate encryption subkey can be revoked, removed, or added to the Symantec 
Encryption Desktop keypair without affecting the Master Key or the signatures on it. 

In addition to the Master Key and the mandatory encryption subkey, you have the 
option of creating one or more additional subkeys for your Symantec Encryption 
Desktop keypair. You can create any combination of subkeys that can be used for 
encryption only, for signing only, or for both encryption and signing. 

You can view the subkeys of a keypair from the Key Properties dialog box. The Usage 
column indicates the function that a subkey performs: 

Key Description 

 
Encryption subkeys display a blue padlock symbol. 

 
Signing subkeys display a blue pen symbol. 

 
Subkeys used for both encryption and signing display both 
symbols. 

 
The default encryption subkey displays a small green 
checkmark in the upper left corner. 

 
The default signing subkey displays a small green check mark in 
the upper left corner. 

 

 
 

Using Separate Subkeys 
Here are some examples of how additional separate subkeys can be useful: 

 Multiple encryption subkeys that are valid during different portions of the 
keypair’s lifetime can increase security. You can create encryption subkeys that 
have the Start and Expiration dates set so that only one encryption subkey at a 
time is valid. For example, you could create several encryption subkeys that are 
valid only during one future year (make sure you specify correct dates). The 
Encryption Subkey in use then changes with the new year. This can be a useful 
security measure, as it provides an automatic way to switch to a new encryption 
key periodically without having to recreate and distribute a new public key. 
Expired subkeys display a key icon with a red clock. 

 



 
Managing PGP Keys 57 

 
 
 

 

Working with Subkeys  

 Separate signing subkeys are needed in regions where separate subkeys for 
signing are required for legally-binding digital signatures. 

The separate subkeys that you can create depend on the type of keypair that you are 
working with: 

 For RSA keypairs, you can create subkeys for encryption, signing, and 
encryption/signing. 

 For Diffie-Hellman/DSS keypairs, you can create subkeys for encryption or 
signing, but you cannot create subkeys that both encrypt and sign. 

 For older PGP Legacy keypairs, subkeys are not supported. 

 

 

Viewing Subkeys 
You can view and change the subkey information on your own keypairs. The subkey 
information on your keyring’s public keypairs can be viewed, but not changed. 

To view subkeys and subkey properties 

1 Open Symantec Encryption Desktop, click the PGP Keys control box, then click All 
Keys. 

All keys on your Keyring appear. 

2 View the properties of a key by doing one of the following: 

 Double-clicking the key you want to view. 

 Right-clicking on the key, then selecting Key Properties from the shortcut 
menu. 

 Clicking to select the key in the Keyring, then selecting Keys > Key 
Properties. 

The Key Properties dialog box for the key you selected is displayed. 

3 Click the Subkeys heading in the Key Properties dialog box. The Subkeys for this 
key are displayed. 

4 To view the properties of a subkey, right-click the subkey you want to view and 
select Subkey Properties from the shortcut menu. 

 

 

Creating New Subkeys 
Most likely you will create new subkeys in the manner described in this section. 
However, you can also create subkeys when you first install Symantec Encryption 
Desktop and are using the New Key wizard. For more information, see Using Symantec 
Encryption Desktop for the First Time. 

To create new subkeys 

1 In the Subkeys section of the Key Properties dialog, click the Add button. The New 
Subkey dialog box is displayed. 
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2 In the Use this subkey for area, select Encryption, Signing, or Encryption and 
Signing, depending on how you want to use the new subkey. 

3 In the Key Size field, choose a key size from 1024 to 4096 bits, or type a custom 
key size from 1024 to 4096 bits. 

4 In the Start Date field, type a date on which the subkey you are creating becomes 
effective or choose a date from the calendar. 

5 In the Expiration area, select Never, or select Date and specify a date or select a 
date from the calendar. This information controls when the subkey expires. 

6 Click OK. The Passphrase dialog box is displayed. 

7 Type your passphrase and then click OK. The subkey is created. 

To specify how the key can be used (such as only for PGP Messaging), see Specifying Key 
Usage for Subkeys (on page 58). 

 

Specifying Key Usage for Subkeys 
Each subkey can have its own key usage properties. For example, one subkey could be 
used for Symantec Drive Encryption only, and another could be used for all other 
Symantec Encryption Desktop functions. 

An example of why you would want to set the key usage of a key is when you want to 
use a key for disk encryption only but you do not want to receive encrypted email. If 
you distribute your public key that does not allow for PGP Messaging, then email sent 
by another user would not be encrypted to your public key. 

Note: If you are in a Symantec Encryption Server-managed environment and your 
key mode is SKM, you cannot make changes to the key usage flags. To determine 
what your key mode is, see Key Modes (on page 100). 

To specify key usage 

1 Open Symantec Encryption Desktop, click the PGP Keys control box, then click All 
Keys. 

All keys on your Keyring appear. 

2 View the properties of a key by doing one of the following: 

 Double-clicking the key you want to view. 

 Right-clicking on the key, then selecting Key Properties from the shortcut 
menu. 

 Clicking to select the key in the Keyring, then selecting Keys > Key 
Properties. 

The Key Properties dialog box for the key you selected is displayed. 

3 Click the Subkeys heading in the Key Properties dialog box. The Subkeys for this 
key are displayed. 

4 To view the properties of a subkey, right-click the subkey you want to view and 
select Subkey Properties from the shortcut menu. 

5 Under the Key Usage section, select the Symantec Encryption Desktop functions 
for which this key can be used. A check next to the item indicates the key can be 
used for that function. 
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6 Click Close to save the subkey properties. 

 

 

Revoking Subkeys 

To revoke a subkey 

1 In the Subkeys section of the Key Properties dialog box, select the subkey you 
want to revoke, then click Revoke (above the subkey list). A PGP Warning dialog 
box is displayed, informing you that once you revoke the subkey, other users will 
not be able to encrypt data to it. 

2 Click Yes to revoke the subkey or click No to cancel. The Passphrase dialog box is 
displayed. 

3 Type your passphrase, then click OK. The subkey is revoked and the icon changes. 

 

 

Removing Subkeys 

To remove a subkey 

1 In the Subkeys section of the Key Properties dialog box, select the subkey you 
want to remove, then click Remove (above the subkey list). A PGP Warning dialog 
is displayed, informing you that once you remove the subkey, you will not be able 
to decrypt information encrypted to it. 

2 Click Yes to remove the subkey or click No to cancel. The subkey is removed. 

 

 

Working with ADKs 
An additional decryption key (ADK) is a key generally used by security officers of an 
organization to decrypt messages that have been sent to or from employees within the 
organization. 

Messages encrypted by a key with an ADK are encrypted to the public key of the 
recipient and to the ADK, which means the holder of the ADK can also decrypt the 
message. 

ADKs are rarely used or needed outside of a Symantec Encryption Server-managed 
environment. Although your Symantec Encryption Server administrator should not 
ordinarily need to use the additional decryption keys, there may be circumstances when 
it is necessary to recover someone’s email. For example, if someone is injured and out of 
work for some time, or if email records are subpoenaed by a law enforcement agency 
and the corporation must decrypt mail as evidence for a court case. 

You can only modify ADKs on your keypairs. 
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Adding an ADK to a Keypair 
When adding an Additional Decryption Key (ADK) to a keypair, do not then create 
another ADK and add the second ADK to the first keypair. 

To add an ADK 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click My Private Keys in the Control box. The private keys on your keyring 
appear. 

2 Double-click the key to which you are adding an ADK. The Key Properties dialog 
box for the key you selected is displayed. 

3 Click the up-arrow to the left of ADK, if applicable (only those keys that already 
have at least one ADK already assigned will have the up-arrow). The ADK 
information for this key is displayed, if configured. 

4 Click the plus sign icon on the right side of the ADK section. The Select Key(s) 
dialog box is displayed. 

5 Select the key you want to use as the ADK, then click OK. A PGP Warning dialog 
box is displayed, asking if you are sure you would like to add the selected key as an 
ADK.  

6 Click Yes. The PGP Enter Passphrase for Key dialog box is displayed. 

7 Type the passphrase for the key to which you are adding the ADK, then click OK. A 
PGP Information dialog box is displayed, telling you the ADK was added to the key. 

8 Click OK. 

Note: If you add an ADK to your key, then those who send you encrypted email must 
be able to access the public key portion of the ADK. 

 

Updating an ADK 

To update an ADK 

1 Select the ADK you want to update from the list of ADKs. The selected ADK 
highlights. 

2 Click the down arrow icon. The ADK is updated. 

 

 

Removing an ADK 

To remove an ADK 

1 Select the ADK you want to remove from the list of ADKs. The selected ADK 
highlights. 

2 Click the minus sign icon. A PGP Warning dialog box is displayed, asking if you are 
sure you want to remove the ADK. 
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3 Click OK to remove the ADK. The ADK is removed. 

 

 

Working with Revokers 
It is possible that one day you might forget your passphrase or lose your keypair (your 
laptop is stolen or your hard drive crashes, for example). 

Unless you are also using Key Reconstruction and can reconstruct your private key, you 
would be unable to use your key again, and you would have no way of revoking it to 
show others not to encrypt to it. To safeguard against this possibility, you can appoint a 
third-party key revoker. The third-party you designate is then able to revoke your key 
just as if you had revoked it yourself. 

This feature is available for both Diffie-Hellman/DSS and RSA keys. 

You can only change revoker information on your keypairs. If a public key on your 
keyring has a revoker, you can see that information but you cannot change it. 

 

Appointing a Designated Revoker 

To add a designated revoker to your key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click My Private Keys in the Control box. The private keys on your keyring 
appear. 

2 Double-click the key to which you are adding a revoker. The Key Properties dialog 
box for the key you selected is displayed. 

3 Click the plus sign to the left of Revokers, if applicable (only those keys that 
already have at least one revoker configured will have the plus sign). The Revokers 
information for this key is displayed, if configured. 

4 Click the plus sign icon on the right side of the Revokers section. The Select key(s) 
dialog box is displayed. 

5 Select the key you want to use as the Revoker key, then click OK. 

A PGP Warning dialog box is displayed, asking if you are certain that you want to 
grant revoker privileges to the selected key(s). 

6 Click Yes to continue or No to cancel. The PGP Enter Passphrase for Key dialog box 
is displayed. 

7 Type the passphrase for the keypair to which you are adding the revoker, then 
click OK. A PGP Information dialog box is displayed. 

8 Click OK. The selected key(s) is now authorized to revoke your key. For effective 
key management, distribute a current copy of your key to the revoker(s) or upload 
your key to the keyserver. 
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Revoking a Key 
If the situation ever arises that you no longer trust your personal keypair, you can 
revoke your key, which tells everyone to stop using your public key. 

The best way to circulate a revoked key is to place it on a public keyserver. 

To revoke a key 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click My Private Keys in the Control box. The private keys on your keyring 
appear. 

2 Right-click the key you want to revoke, then select Revoke from the list of 
commands displayed. A PGP Warning dialog box is displayed, asking if you are 
sure you want to revoke this key. 

3 Click Yes to confirm your intent to revoke the selected key or No to cancel. The 
PGP Enter Passphrase for Key dialog box is displayed. 

4 Type the passphrase for the keypair you are revoking, then click OK. When you 
revoke a key, it is marked out with a red X to indicate that it is no longer valid. 

5 Synchronize the revoked key so everyone will know not to use the now revoked 
public key. 

 

 

Splitting and Rejoining Keys 
Any private key can be split into shares among multiple “shareholders” using a 
cryptographic process known as Blakely-Shamir key splitting. This technique is 
recommended for extremely high security keys. 

For example, Symantec Corporation keeps a corporate key split between multiple 
individuals. Whenever we need to sign with that key, the shares of the key are rejoined 
temporarily. 

 

Creating a Split Key 
When you split a key, the shares are saved as files either encrypted to the public key of 
a shareholder or encrypted conventionally if the shareholder has no public key. After 
the key has been split, any attempts to sign or decrypt with it will automatically 
attempt to rejoin the key. 

To create a split key with multiple shares 

1 Open Symantec Encryption Desktop, click the PGP Keys Control box, and then 
click My Private Keys in the Control box. The private keys on your keyring 
appear. 

2 Click on the keypair you want to split. The selected keypair highlights. 
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3 Select Keys > Share Key > Make Shared. The Shared PGP Key dialog box is 
displayed. 

4 Add shareholders for the split key by dragging and dropping their keys in the 
Shareholder list. 

To add a shareholder that does not have a public key, click Add, type the person’s 
name, then allow the person to type in their passphrase. (The shareholder needs to 
be physically present in order to type their own passphrase.) 

5 When all of the shareholders are listed, you can specify the number of key shares 
that are necessary to decrypt or sign with this key. 

By default, each shareholder is responsible for one share. To increase the number 
of shares a shareholder controls, click the name in the shareholder’s list and then 
use the arrows to adjust the number of shares. 

6 Click Split Key. You are prompted to select a directory in which to store the 
shares. 

7 Select a location to store the key shares, then click OK. The Passphrase screen is 
displayed. 

8 Enter the passphrase for the key you want to split, then click OK. A confirmation 
dialog box is displayed. 

9 Click Yes to split the key. The key is split and the shares are saved in the location 
you specified. Each key share is saved with the shareholder’s name as the file 
name and an SHF extension. 

10 Distribute the key shares to the owners, then delete the local copies of the shares. 

Once a key is split among multiple shareholders, attempting to sign or decrypt 
with it will cause Symantec Encryption Desktop to automatically attempt to rejoin 
the key. 

Be sure you keep the original key that was split. You will need to have this key before 
you can rejoin the split key for any decryption functions. 

 

Rejoining Split Keys 
Once a key is split among multiple shareholders, attempting to sign or decrypt with it 
causes Symantec Encryption Desktop to attempt to rejoin the key automatically. There 
are two ways to rejoin the key: locally and remotely. 

Rejoining key shares locally requires the shareholder’s presence at the rejoining 
computer. Each shareholder is required to enter the passphrase for their key share. 

Rejoining key shares remotely requires the remote shareholders to authenticate and 
decrypt their keys before sending them over the network. The Symantec Encryption 
Desktop Transport Layer Security (TLS) feature provides a secure link to transmit key 
shares, allowing multiple individuals in distant locations to securely sign or decrypt 
with their key share. 

Caution: Before receiving key shares over the network, you should verify each 
shareholder’s fingerprint and sign their public key to ensure that their 
authenticating key is legitimate. 

 

Before you begin, be sure you have the original key that was split on the rejoining 
computer. 
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To rejoin a split key 

1 Contact each shareholder of the split key. To rejoin key shares locally, the 
shareholders of the key must be present. 

To collect key shares over the network, make sure the remote shareholders have 
Symantec Encryption Desktop installed and are prepared to send their key share 
file. Remote shareholders must have: 

 their key share files and passwords 

 a keypair (for authentication to the computer that is collecting the key 
shares) 

 a network connection 

 the IP address or Fully Qualified Domain Name of the computer that is 
collecting the key shares 

2 Do one of the following: 

 To temporarily rejoin the key, at the rejoining computer, use Windows 
Explorer to select the file(s) that you want to sign or decrypt with the split 
key. 

Right-click on the file(s) and select Sign or Decrypt from the Symantec 
Encryption Desktop shortcut menu. The PGP Enter Passphrase for Selected 
Key screen is displayed with the split key selected. 

Click OK to reconstitute the selected key. The Key Share Collection screen is 
displayed. 

 To permanently rejoin the key, right-click the split key and select Key 
Properties from the menu displayed. 

In the Key Properties dialog box, click Join Key (this button is labeled Change 
Passphrase for keys that are not split). 

The Passphrase dialog box is displayed.  

3 Do one of the following: 

 If you are collecting the key shares locally, click Select Share File and then 
locate the share files associated with the split key. The share files can be 
collected from the hard drive, a diskette, or a mounted drive. Continue with 
the next step. 

 If you are collecting key shares over the network, click Start Network. The 
remote user must start Symantec Encryption Desktop and select Keys > 
Share Key > Send Key Share. This starts the process of selecting the share 
file, decrypting the share file, selecting an authorization key, unlocking the 
authorization key, and entering the hostname/IP address of the joining 
computer. 

In the Signing Key field, select the keypair that you want to use for 
authentication to the remote system and enter the passphrase.  

Click OK to prepare the computer to receive the key shares. 

The status of the transaction is displayed in the Network Shares box. When the 
status changes to “Listening,” the PGP application is ready to receive the key 
shares. 

At this time, the shareholders must send their key shares. 
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When a share is received, the Remote Authentication dialog box is displayed. If 
you have not signed the key that is being used to authenticate the remote 
system, the key is considered invalid. Although you can rejoin the split key 
with an invalid authenticating key, it is not recommended. You should verify 
each shareholder’s fingerprint and sign each shareholder’s public key to 
ensure that the authenticating key is legitimate. 

4 Click Confirm to accept the share file. 

5 Continue collecting key shares until the value for Total Shares Collected matches 
the value for Total Shares Needed on the Key Shares Collection screen. 

6 Click OK.  

 If you elected to temporarily rejoin the key in order to decrypt or sign, the 
file is signed or decrypted with the split key and the rejoined key is 
discarded. 

 If you elected to permanently rejoin the key, the key is saved as a fully 
rejoined key (and is no longer split). 

 

 

If You Lost Your Key or Passphrase 
If you lost your key, you can reconstruct your key so you can continue to encrypt and 
decrypt data. How you do this depends on if you are using Symantec Encryption 
Desktop in a standalone environment or in a Symantec Encryption Server-managed 
environment. 

If you forgot your passphrase, you can reset your passphrase. To do this, you answer 
correctly three of the five security questions you answered when you set up your key or 
created your security questions. 

Reconstructing Keys with Symantec Encryption Server 
This section applies only to Symantec Encryption Desktop users in a Symantec 
Encryption Server-managed environment whose Symantec Encryption Server 
administrator has configured key reconstruction support for their copy of Symantec 
Encryption Desktop.

If you lose your key or forget your passphrase and do not have a backed up copy from 
which to restore your key, you will never again be able to decrypt any information 
encrypted to your key. You can, however, reconstruct your key if your Symantec 
Encryption Server administrator has implemented a PGP key reconstruction policy for 
you, in which your key is encrypted and stored on a Symantec Encryption Server in 
such a way that only you can retrieve it. 

The Symantec Encryption Server holding the key reconstruction data stores your key in 
such a way that only you can access it. Not even the Symantec Encryption Server 
administrator has the ability to decrypt your key. 
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Reconstructing Keys with PGP UN (No Heading) 

If your Symantec Encryption Server administrator has configured support for key 
reconstruction, you will be prompted to enter additional “secret” information when you 
install Symantec Encryption Desktop or when you create your security questions. 

Once your key is on the server, you can restore it at anytime by selecting Keys > I Lost 
My Key or Keys > I Forgot My Passphrase in Symantec Encryption Desktop. 

Tip: If you were not prompted to create your PGP questions during installation of 
Symantec Encryption Desktop, and your Symantec Encryption Server administrator 
allows local key reconstruction, you can manually create your questions. For more 
information, see Creating Your Security Questions (on page 66). 

 

Creating Key Reconstruction Data 
When you answer the PGP security questions, you are creating the key reconstruction 
data. In a standalone environment, this information is stored on your local disk in a .krb 
file. In a managed environment, you send the key reconstruction data to your 
company's Symantec Encryption Server whenever you install Symantec Encryption 
Desktop or when you create and answer your security questions.  

Choose obscure personal questions with answers that you are not likely to forget. Your 
questions can be up to 95 characters in length. An example of a good question might be, 
“Who took me to the beach?” or “Why did Fred leave?” An example of a bad question 
would be, “What is my mother’s maiden name?” or “Where did I go to high school?” 

When you have created and answered all five PGP questions, your private key is split 
into five pieces, using Blakely-Shamir key splitting. Three of the five pieces are needed 
to reconstruct the key. Each piece is then encrypted with the hash, the uniquely 
identifying number, of one answer. If you know any three answers, you can successfully 
reconstruct the whole key. 

 

Creating Your Security Questions 

Before you can reconstruct your key or create a new passphrase when you've forgotten 
it, you must create your security questions. You can customize the five security 
questions so that the answers are something that only you would know. 

To create your security questions 

1 In Symantec Encryption Desktop, click the PGP Keys Control box and then select 
your key. 

2 Select Keys > Create My PGP Questions. The PGP Security Question Assistant is 
displayed. 

3 Enter the passphrase for your key and click Next. The Create Security Question 1 
of 5 dialog box is displayed. 

4 In the first Create Security Question screen, click the arrow for the first field to 
select the question you want to use. Note that you can customize parts of the 
question in the next step. 

If you want to completely customize the question to create your own question, 
select Enter my own question. 
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5 For Personalize Your Question, click the arrows next to any of the text that you 
can customize. For example, if you selected the first question, you can customize 
that question by changing "friend" to "boy" and "had a crush on" to "held hands 
with." 

If you chose to create your own question, enter the question in this field. Be sure to 
enter a question that only you can know the answer to. 

6 For Answer Your Question, enter the answer to this security question. You can 
enter the answer using mixed upper- and lowercase letters, or use all one case 
(when you answer the question, the case will not matter). 

A hint is displayed in this field that disappears once you start entering the answer. 
For example, to answer the question "Who was the first boy that I ever held hands 
with?", the hint is "Enter first and last name". 

7 When you have defined your question and entered the answer, click Next to 
continue. The Create Security Question 2 of 5 dialog box is displayed. 

8 You are prompted to create and answer a total of five security questions. Continue 
to follow the steps above to select the question, customize the question, and 
answer the question. 

When you have entered all five questions and answers, the Completing the PGP 
Security Question Assistant screen is displayed. Click Finish to exit the assistant. 

You have now defined the five security questions. If you lost your key or forget your 
passphrase, you can reconstruct your key or reset your passphrase by answering three 
of these five questions. 

 

Reconstructing Your Key if You Lost Your Key or Passphrase 
If you have lost your key or have forgotten your passphrase, you can recover by 
reconstructing your key. You must first have created a set of security questions that 
only you can answer. For more information, see Creating Your Security Questions (on 
page 66). 

To reconstruct your key 

1 In Symantec Encryption Desktop, click the PGP Keys Control box and then select 
your key. 

2 Select Keys > I Lost My Key.  

3 In the The PGP Passphrase Assistant: Answer Security Questions dialog box, 
answer three of the five security questions correctly and click Next. The PGP 
Passphrase Assistant: Success dialog box is displayed. 

Tip: If the questions displayed are not your questions, click the link for These are 
not my questions. The PGP Passphrase Assistant: Select Key to Reconstruct 
dialog box is displayed. Select the Key ID of the key you want to reconstruct and 
click Next. 

4 Click Next. to continue with creating a new passphrase. The PGP Passphrase 
Assistant: Create Passphrase dialog box is displayed. 

5 Enter and re-enter your passphrase. 

Select Show Keystrokes if you want to see the characters you type for your 
passphrase. Be sure no one can see what you type. 
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The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating by comparing the amount of entropy in the 
passphrase you type against a true 128-bit random string (the same amount of 
entropy in an AES128 key). For more information, see The Passphrase Quality Bar 
(on page 254). 

6 Click Finish. Your key has been reconstructed. 

 

 

Protecting your Keys 
Besides making backup copies of your keys, you should be especially careful about 
where you store your private key. Even though your private key is protected by a 
passphrase that only you should know, it is possible that someone could discover your 
passphrase and then use your private key to decipher your email or forge your digital 
signature. For instance, somebody could look over your shoulder and watch the 
keystrokes you enter or intercept them on the network or even over the Internet. 

To prevent anyone who might happen to intercept your passphrase from using your 
private key, store your private key only on your own computer. If your computer is 
attached to a network, make sure that your files are not automatically included in a 
system-wide backup where others might gain access to your private key. Given the ease 
with which computers are accessible over networks, if you are working with extremely 
sensitive information, you may want to keep your private key on a flash drive, which 
you can insert like an old-fashioned key whenever you want to read or sign private 
information. 

As another security precaution, consider assigning a different name to your private 
keyring file and then storing it somewhere other than in the default location. 

Your private and public keys are stored in separate keyring files. You can copy them to 
another location on your hard drive or to a diskette. By default, the private keyring 
(secring.skr) and the public keyring (pubring.pkr) are stored along with the other 
program files in your “PGP” folder; you can save your backups in any location you like. 

You can configure Symantec Encryption Desktop to back up your keyrings 
automatically after you close Symantec Encryption Desktop. Your keyring backup 
options can be set in the Keys tab of the Options dialog box. 

Tip: If you have changed your passphrase on your key, remember that it does not 
change the passphrase on any copies of the key (such as backups you may have 
made). If you think your key has been compromised, Symantec recommends that you 
shred any previous backup copies and then make new backups of your key. 

 

 

 



 

7 Securing Email Messages 

This section describes how to use Symantec Encryption Desktop Email to automatically 
and transparently secure your email messages. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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How Symantec Encryption Desktop Secures Email 
Messages 

When secure email messaging is enabled, Symantec Encryption Desktop monitors the 
email traffic between your email client and your mail server. Depending on the 
circumstances, Symantec Encryption Desktop will intercede on your behalf to encrypt, 
sign, decrypt, or verify messages. 

Once configured correctly—and it’s very likely Symantec Encryption Desktop can do 
that for you automatically—you don’t have to do anything to encrypt and/or sign 
outgoing messages or to decrypt and/or verify incoming messages; the Symantec 
Encryption Desktop messaging proxy does it for you. 

How this happens is different for incoming and outgoing messages. 

For incoming messages, Symantec Encryption Desktop automatically evaluates all 
incoming email messages and takes the appropriate actions (described in the following 
section). 
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For outgoing messages, there are a range of actions that Symantec Encryption Desktop 
can take on your behalf based on configured policies. A policy is a set of instructions 
(such as "In this circumstance, do this") that tells Symantec Encryption Desktop what to 
do in specific situations. By combining these instructions, policies can be tailored to 
meet all of your email security requirements. Symantec Encryption Desktop comes 
pre-configured with a set of policies that suit the needs of the vast majority of users. 
However, you are also provided with fine-grained control over these policies if you want 
to change them.  

By default, when you are using Symantec Encryption Desktop standalone and are 
sending an outgoing message, Symantec Encryption Desktop looks for a key it can trust 
to encrypt the message. It looks first on the default keyring (called "All Keys") for the 
public key of the recipient. If it does not find such a key, it will, again by default, check 
the PGP Global Directory for a trusted key for the recipient. If it does not find a trusted 
key there, the message is sent in the clear, which is unencrypted. This default behavior, 
called Opportunistic Encryption, strikes a balance between protecting outgoing 
messages and making sure they get sent. 

Creating new policies is covered in detail in Creating a New Security Policy (on page 85). 

If you are in a Symantec Encryption Server-protected domain, your local Symantec 
Encryption Desktop policies determine how your messages are encrypted and when. For 
more information, consult with your organization’s Symantec Encryption Server 
administrator. 

 
 

Note: Symantec Encryption Desktop checks only the default keyring. To send 
encrypted email to a recipient whose key is on your local keyring, be sure to import 
the key to your default keyring. 
 
If you have multiple keyrings, the default keyring is the first keyring listed in the 
PGP Keys control box. To specify a different default keyring, right-click the keyring 
in the PGP Keys control box, choose Properties, and select the Default Keyring 
checkbox. 

 

Incoming Messages 
Symantec Encryption Desktop manages incoming mail messages based on the content 
of the message. These scenarios assume standalone Symantec Encryption Desktop, 
not in a domain protected by a Symantec Encryption Server (in which case mail action 
policies set by your Symantec Encryption Server administrator can apply): 

 Message not encrypted nor signed. Symantec Encryption Desktop does nothing to 
the content of these messages; it simply passes the message along to your email 
client. 

 Message encrypted, but not signed. When Symantec Encryption Desktop sees a 
message coming to you that is encrypted, it will attempt to decrypt it for you. To 
do this, Symantec Encryption Desktop will check the local keyring for the private 
key that can decrypt the message. If the private key is not on the local keyring, 
Symantec Encryption Desktop will not be able to decrypt it; the message will be 
passed to your email client still encrypted. If the private key is on the local 
keyring, Symantec Encryption Desktop will decrypt it immediately if the 
passphrase for the private key is in memory (cached). If the passphrase is not 
cached, Symantec Encryption Desktop will prompt you for the passphrase and 
decrypt the message when you supply the correct passphrase. Once a message is 
decrypted, Symantec Encryption Desktop passes it to your email client. 

 



 
Securing Email Messages 71 

 
 
 

 

How Symantec Encryption Desktop Secures Email Messages  

If the Symantec Encryption Desktop messaging proxy is turned off, Symantec 
Encryption Desktop will not be able to decrypt incoming encrypted messages; it 
will pass them along to your email client still encrypted. It is recommended that 
you leave your messaging proxy on all the time if you expect to be sending and 
receiving encrypted messages. On is the default setting. 

 Message signed, but not encrypted. Symantec Encryption Desktop will search the 
local keyring for a public key that can be used to verify the signature. If Symantec 
Encryption Desktop cannot find the appropriate public key on the local keyring, it 
will try to search for a keyserver at keys.domain (where domain is the domain of 
the sender of the message), then the PGP Global Directory 
(https://keyserver.pgp.com), and finally any other configured keyservers. If 
Symantec Encryption Desktop finds the right public key at any of these locations, 
it verifies the signature (or not, if the signature is bad) and passes the message to 
your email client annotated with information about the signature—information is 
also put into the PGP Log. If Symantec Encryption Desktop cannot find the 
appropriate public key, it passes the message to your email client unverified. 

 Message encrypted and signed. Symantec Encryption Desktop goes through both 
of the processes described above: first finding the private key to decrypt the 
message and then finding the public key to verify the signature. However, if a 
message cannot be decrypted, then it cannot be verified. 

If Symantec Encryption Desktop is unable to either decrypt or verify a message, you 
might want to consider contacting the sender of the message. If the message could not 
be decrypted, make sure the sender was using your real public key. If the message could 
not be verified, ask the sender to publish their key on the PGP Global Directory — older 
PGP versions or other OpenPGP products can access the web version of this directory at 
PGP Global Directory (https://keyserver.pgp.com) , or ask them to send their public key 
to you directly by email. 

Note: Symantec Encryption Desktop only encrypts by default to keys that are known 
to be valid. If you did not get a key from the PGP Global Directory, you may need to 
verify its fingerprint with the owner and sign it for it to be used. 

 

Verifying Signatures on Incoming Messages 
Starting with version 10.1, in a managed environment your Symantec Encryption 
Server administrator can set policy to enable you to decide if you want to perform 
signature verification on email messages. If enabled, a new button and/or menu option 
appears in your Microsoft Outlook or Lotus Notes email client. The button or option will 
be in the default state set by your administrator. For example, you administrator may 
allow you to choose to use signature verification and set the default state to always 
verify. However, you can override this setting by manually selecting the button or menu 
option to disable signature verification. When signature verification is turned off, it is 
turned off for all messages.  

Tip: If you have turned off signature verification and then you want to view the 
signature status on incoming email messages, select the PGP Verify Signatures 
button (so it is highlighted) or menu option. If you are viewing an email message, 
close the message or move away from the message's Preview pane, to view the 
signature verification of that message. 

 The PGP Verify Signatures is added to the tool bar in Microsoft Office. 

 

https://keyserver.pgp.com/
https://keyserver.pgp.com/
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When the button is selected, and signature verification is enabled, the button is 
highlighted (a color border appears around the button). There is no border around 
the button when signature verification is turned off. 

There is also a menu option in Microsoft Office to enable or disable signature 
verification (Actions > PGP Verify Signatures). 

 When enabled in Microsoft Office 2007, 2010, 2013, or 2016 the PGP Verify 
Signatures button is added to the tool bar. 

 When signature verification is enabled in Lotus Notes, a check appears next to the 
menu option (Actions > PGP Verify Signatures). 

Annotations 
When you view an email message and signature verification is turned off, the 
annotation for the message includes the beginning statement PGP Signature not 
checked and the ending statement Signature checking is off by policy. Any 
other actions, such as the decryption of the message, remain in the annotation. 

Notifications 
When you receive an email message and signature verification is turned off, the notifier 
includes the statement Signature checking is off by policy. 

Understanding Annotations on Incoming Messages 
When incoming email messages are received, Symantec Encryption Desktop decrypts 
any encrypted portions and verifies any signatures. Then a snippet of text, called an 
annotation, is inserted into the processed email message to indicate what encryption 
and signatures were present. Any email message with at least partial protection 
(encrypted, signed, or both) receives an annotation. If an email message is completely 
unprotected (for example, the email is not encrypted or signed by the sender) then the 
message is not annotated. 

You can choose three annotation levels: 

 Maximum: Verbose Annotation. Adds annotations to your incoming email 
detailing every action that Symantec Encryption Desktop has taken during 
message processing. 

 Medium: Failures and Successes. This option is the default. Provides annotations 
when there has been a processing failure, such as unknown key, or unknown 
signer. The Medium setting provides annotations for all decrypted and/or signed 
email, but does not list individual attached files. 

 Minimum: Failures Only. Only provides annotations when there has been a 
processing failure, such as detecting an unknown key or unknown signer. 

To specify the level of annotation you want to use, see Messaging Options (on page 243). 

In a Symantec Encryption Server-managed environment, your administrator may have 
specified the location of the annotation. The annotation can be "wrapped around" the 
message text (the default setting), or placed below the message text. 
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Outgoing Messages 
Email messages that you send can be encrypted, signed, both, or neither. Because you 
probably have different combinations for different recipients or email domains, you 
need to create policies for all of your outgoing email message possibilities. Once correct 
policies are in place, your email messages are protected automatically and 
transparently. 

If you are in a Symantec Encryption Server-managed environment, your Symantec 
Encryption Desktop policies are controlled by the policies specified by your Symantec 
Encryption Server administrator. Your administrator may also have specified how to 
handle outgoing email messages if the Symantec Encryption Server is not available. 
These policies are called offline (or local) policies. 

 

Securing Sent Items on IMAP Email Servers 
If you are using an IMAP email server, messages in your Sent Items folder are typically 
stored on the mail server. IMAP email clients send the sent message copy over the 
network to the folder using the IMAP protocol. If the sent message is not encrypted, the 
message could be intercepted. Symantec Encryption Desktop provides the ability for 
sent messages to be encrypted and/or signed as they are sent to the IMAP server. 

In a Symantec Encryption Server-managed environment, your administrator may have 
specified that all messages in the Sent Items folder be secured. 

In a standalone environment, you can specify if you want to secure the sent messages. 
To do this, choose Tools > Options and click the Messaging tab or item. Then specify if 
you want to encrypt, encrypt and sign, or just sign the messages. 

Email messages are encrypted using your public PGP key. 

When you access your Sent Items folder, and your key's passphrase is not cached, you 
are prompted to enter the passphrase. 

If the name of the folder is not a name that Symantec Encryption Desktop recognizes 
(for example, instead of "Sent Items" the folder is named "Outgoing Messages"), a 
message is displayed asking you confirm if the name of the folder is where your sent 
messages are typically stored. Note that the first message copied to this folder is not 
encrypted and/or signed, but that subsequent messages copied to this folder are. 

 
 

Sending MAPI Email with Microsoft Outlook 
Symantec Encryption Desktop spools outgoing messages so that you can continue to 
work in email without having to wait for the Notifier message to disappear.  

When a key is not found, instead of displaying the message in a Notifier and then 
displaying the outgoing message (so that you can modify it to remove the recipient, for 
example), a "key not found" non-delivery report is generated and sent. This is in the 
format of an incoming email message and is sent from the "System Administrator" and 
provides information on why the email did not reach some or all of the intended 
recipients. 

The most common messages contained in a non-delivery report include: 

 PGP: Message is blocked by policy - server not reachable. 
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 PGP: Message is blocked - additional decryption key not found. 

 PGP: Message is blocked - failed to unlock signing key. 

 PGP: Message is blocked - failed to find key by KeyID. 

 PGP: Message is blocked - blocked from notifier. 

 PGP: Message is blocked by policy - recipient key not found. 

 PGP: Message is blocked by policy. 

Contact your Symantec Encryption Server administrator for assistance with policy 
issues. 

 

Using the Sign and Encrypt Buttons in Microsoft Outlook 
This feature is available for Microsoft Outlook 2007 SP2, 2010, 2013, and 2016 when 
used with Microsoft Exchange (MAPI) and SMTP email accounts. This feature provides 
buttons to explicitly sign, encrypt, or sign and encrypt an email message. This feature 
satisfies compliance with signature regulations, such as for the European Union, that 
require users to consciously sign email messages. 

The Sign and Encrypt buttons are available for both managed and standalone 
installations of Symantec Encryption Desktop. 

 In standalone environments, enable or disable the Sign and Encrypt buttons in the 
Options dialog box. To do this, select Tools > Options, select the Messaging tab, 
and select (or deselect) the option to Enable PGP encrypt and sign buttons in 
Outlook. The buttons are disabled by default. 

 If you are using Symantec Encryption Desktop in a managed environment, your 
Symantec Encryption Server administrator will have specified if this feature is 
available and may have disabled this feature by policy. In addition, your 
administrator may have specified the default states for the Sign and Encrypt 
buttons, if they are enabled. Override the default state specified by your 
administrator by selecting the button to toggle the default state. For example, if 
your administrator has specified the buttons are enabled by default, so that all 
messages are sent out encrypted and signed, but you want to send an email 
message that is not signed, click Sign to toggle the button off. The email will be 
sent out encrypted but not signed. 

When enabled in Microsoft Outlook 2007/2010/2013/2016, both buttons appear on the 
Message ribbon. 

Outgoing email policy determines how the email message is sent. There are three new 
default policies included in new installations of Symantec Encryption Desktop to 
support these buttons. For existing installations, these three default policies must be 
created. For more information on the policy settings, see Security Policy Information 
and Examples (on page 90). 

The Sign and Encrypt buttons are an additional feature where you have control over 
which email needs to be encrypted and/or signed. The buttons are not a replacement for 
the email proxying used in Symantec Encryption Desktop.   

Note: If you reply to or forward an email message that you want to encrypt and/or 
sign, be sure to select the appropriate buttons. Forwards or replies are treated as new 
messages and require you explicitly select the options to secure the message. 

 

Use the following procedure whether you are creating a new email message, or 
forwarding or replying to an email message. 
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If you are using Symantec Encryption Desktop in a managed environment, your 
Symantec Encryption Server administrator may have specified the default states for 
the Sign and Encrypt buttons. Override the default state specified by your 
administrator by selecting the button to toggle the default state. 

The following instructions describe how to encrypt and/or sign a message when the 
default button actions are toggled off. 

To sign, encrypt, or sign and encrypt a email message 

1 Begin composing your email message. 

2 Do one of the following: 

 To sign only, click Sign ( ). Note that when you choose to sign only, the 
email will be sent in cleartext. 

 To encrypt only, click Encrypt ( ). 

 To sign and encrypt, click both Sign and Encrypt (  ). 

Tip: If you have selected one or both buttons and then save the email message as 
a draft, the buttons remain selected when you continue composing the message. 

3 Continue composing your email message and send it. The Notifier displays the 
result of sign and/or encrypt process (for more information on notifiers, see 
Outgoing Notifier Messages (on page 27)). 

 

 

Using Offline Policy 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the offline mail policy is defined by your Symantec 
Encryption Server administrator. This policy defines what happens to email messages 
when the Symantec Encryption Server is offline or cannot be reached by Symantec 
Encryption Desktop. 

 Block outbound messages. Your outbound messages are not sent. If the messages 
can be queued by your mail client, they stay in the queue until the Symantec 
Encryption Server is available. If the messages cannot be queued, the email 
messages are blocked.  

 Send outbound messages in the clear. You are prompted to choose if you want to 
allow the email message to be sent unsecured. If you choose to send, the message 
is sent in the clear. If you choose not to send, the message is blocked.  

 Follow standalone policy. Symantec Encryption Desktop follows the standalone 
policy to process your outbound messages. For more information, see Viewing 
Services and Policies (on page 77). 

For information on the notifiers you receive when any of the above occurs, see Outgoing 
Notifier Messages for Offline Policy (on page 28). 
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Your Symantec Encryption Server administrator can specify how often your mail 
policies get downloaded to Symantec Encryption Desktop. When you are in offline 
mode, the last downloaded offline mail policy remains in effect for processing your 
outbound email messages. If you have been in offline mode for a period of time that is 
longer than the grace period allowed for the offline standalone mail policy to be in 
effect, your administrator could have also specified how outgoing email should be 
processed. In this case, Symantec Encryption Desktop can start blocking your outbound 
messages or the same offline standalone mail policy can be used for processing your 
outbound messages, depending on how policy is defined by your administrator. 

When you have been offline for some time, you can manually request a download of 
policy from the Symantec Encryption Server once you are back online. To do this when 
you are back online, select the Symantec Encryption Desktop icon in the tray and then 
select Update Policy. The latest policies are downloaded from the Symantec Encryption 
Server and any client logs are uploaded to the server. The option to manually update a 
policy is available for managed users only. 

If your Symantec Encryption Server administrator allows you to use standalone 
policies, see Creating a New Security Policy (on page 85). 

 

Services and Policies 
To understand how to use Symantec Encryption Desktop to automatically and 
transparently protect your outgoing messages, you need to understand two terms: 
service and policy. 

 Service. Information about one email account on your system and the policies that 
apply to that account. In most cases, Symantec Encryption Desktop will 
automatically create and configure a service for each email account on your 
system. In some circumstances, you may want to create and configure a service 
manually. 

 Policy. A set of one or more instructions that tell Symantec Encryption Desktop 
what to do in specific situations. Policies are associated with services—often more 
than one (a policy can be reused by different services). Conversely, a service can 
(and usually does) have more than one policy. 

When deciding how to handle a specific outgoing email message, Symantec Encryption 
Desktop checks the policies configured for the service one at a time (from the top of the 
list going down). When it finds a policy that applies, it stops checking policies and 
implements the one that applies. 

All new services are created with the following default policies: 

 Encrypt and Sign Buttons. Specifies that email is both signed and encrypted when 
both the Encrypt and Sign buttons are enabled in Microsoft Outlook 2007, 2010, 
2013, or 2016. This policy is available only on Symantec Encryption Desktop for 
Windows. 

 Sign Button. Specifies that email is signed when the Sign button is enabled in 
Microsoft Outlook 2007, 2010, 2013, or 2016. This policy is available only on 
Symantec Encryption Desktop for Windows. 

 Encrypt Button. Specifies that email is encrypted when the Encrypt button is 
enabled in Microsoft Outlook 2003, 2007, 2010, or 2013. This policy is available 
only on Symantec Encryption Desktop for Windows. 

 Mailing List Admin Requests. Specifies that administrative requests to mailing 
lists are sent in the clear; that is, not encrypted or signed. 
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 Mail List Submissions. Specifies that submissions to mailing lists are sent signed 
(so they can be authenticated) but not encrypted. 

 Require Encryption: [PGP] Confidential. Specifies that any message flagged as 
confidential in your email client or containing the text “[PGP]” in the subject line 
must be encrypted to a valid recipient public key or it cannot be sent. 

 Opportunistic Encryption. Specifies that any message for which a key to encrypt 
cannot be found should be sent without encryption (in the clear). Having this 
policy as the last policy in the list ensures that your messages will always be sent, 
albeit in the clear, even if a key to encrypt it to the recipient cannot be found. 

Do not put Opportunistic Encryption first in the list of policies (or anywhere but 
last, for that matter) because when Symantec Encryption Desktop finds a policy 
that matches, and Opportunistic Encryption matches everything, it stops 
searching and implements the matching policy. So if a policy is lower on the list 
than Opportunistic Encryption, it will never be implemented. 

Note: The default policies can be modified, but not deleted. Alternatively, they can be 
disabled, then moved up or down in the list of policies. 

 

Viewing Services and Policies 

To view services and policies 

1 Open Symantec Encryption Desktop. 

2 Click the PGP Messaging Control box. The PGP Messaging Control box highlights. 
All currently configured services are listed at the top of the PGP Messaging 
Control box. 

3 Click on a service to see the account properties and the security policies that are 
part of the service. This section provides information on what security policy is 
being enforced. If you are managed by a Symantec Encryption Server, the security 
policies are set by your administrator. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, different messages and/or options may be displayed 
above the list of policies depending on how policy is set. 

 
If Symantec Encryption Server 
Policy is: 

Message displayed in Symantec 
Encryption Desktop above the list of 
policies is: 

Offline policy is set to block "Messages will be blocked when the server is 
unreachable." 

Offline policy is set to send in clear "Messages will be sent in the clear when the server 
is unreachable."  

Offline policy is set to standalone "Standalone policies will be enforced when the 
server is unreachable." A checkbox is available to 
Display standalone policies.  

Policy is set to standalone "The following standalone policies will be 
enforced."  

In all cases, if your administrator has specified you can override policy, a checkbox is 
available to Override server policies with local policies.  
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Creating a New Messaging Service 
A service is information about an email account, as well as the security policies that are 
to be applied to outgoing messages for that email account. 

Important: In most cases, Symantec Encryption Desktop creates services for you as 
you use your email accounts to send or receive messages. If you need to create a 
service yourself, make sure to read and understand these instructions. Incorrect 
configuration of a service could result in problems sending or receiving email 
messages. 

To create a new service 

1 Open Symantec Encryption Desktop and click the PGP Messaging Control box. The 
PGP Messaging Control box highlights. 

2 Click New Messaging Service in the PGP Messaging Control box. You can also 
select Messaging > Create New Service. 

In the PGP Messaging Work area, “New Service” is displayed at the top of the 
screen, the account properties appear with no values, and the default security 
policies appear in the Security Policies section. 

3 In the Description field of the Account Properties section, specify a name for this 
service. 

4 Type your email address in the Email Address field. 

5 Type the name of your incoming and outgoing email servers, or click Server 
Settings if you want to set advanced options. If you chose to set advanced options, 
the Server Settings dialog box is displayed. 

6 Select the type of server that the new service will be using under Server Type: 

 Internet Mail—for standalone Symantec Encryption Desktop users who have 
a POP or IMAP mail connections. 

 Symantec Encryption Server—for Symantec Encryption Desktop users who 
are in a Symantec Encryption Server-managed environment. Contact your 
Symantec Encryption Server administrator for more details on correct 
settings. 

 MAPI/Exchange—for Symantec Encryption Desktop users who are using 
Microsoft Outlook as a client on a Microsoft Exchange/MAPI server. Contact 
your mail administrator for more information on correct settings. 

 Lotus Notes—for Symantec Encryption Desktop users who are using Lotus 
Notes as their email client with a Lotus Domino server. For more information 
on the correct settings, contact your email administrator. 

Some of the fields in the Server Settings dialog box change depending on what 
type of server you select. 

Note: If you are manually connecting to a Symantec Encryption Server, see 
Manually binding to a Symantec Encryption Server (on page 259). 

7 Enter the following for Incoming Mail Server: 

 Name: Type the name of the mail server that handles incoming messages. 

 



 
Securing Email Messages 79 

 
 
 

 

Services and Policies  

 Protocol: Select the protocol used to pick up messages on the incoming mail 
server. 

The Automatic setting (available with the Internet Mail or Symantec 
Encryption Server settings) can automatically detect either POP or IMAP 
connections. 

 Port: Keep Automatic (the default) or specify a port to connect to on the 
incoming mail server to pick up messages (if you have selected either the 
Internet Mail or Symantec Encryption Server settings and either POP or 
IMAP—not Automatic). 

 SSL/TLS: Specify how Symantec Encryption Desktop interacts with your 
mail server. Choose one: 

 Automatic: PGP will do its best to provide SSL/TLS protection. It first 
tries the alternate port, then it attempts STARTTLS (if supported by 
the server), finally, if the above fails, it connects to the server 
unprotected. 

 Require STARTTLS: Symantec Encryption Desktop requires that the 
server honor the STARTTLS command. 

 Require SSL: Symantec Encryption Desktop requires that the server 
honor SSL/TLS-protected connections on the specified alternate port. 

 Do Not Attempt: Symantec Encryption Desktop does not attempt any 
SSL/TLS protection of the connection with the mail server. 

 Warn if email client attempts SSL/TLS: When selected, Symantec 
Encryption Desktop displays a warning dialog box if the email client 
attempts SSL/TLS, as this is a condition that is incompatible with Symantec 
Encryption Desktop proxying your email. (This option is selected by default.) 

Caution: This option should only be enabled if you are certain your mail server 
supports SSL/TLS. It ensures that Symantec Encryption Desktop will not fall 
back to sending or receiving messages with the mail server over an unprotected 
connection if, for example, a problem occurs while negotiating SSL/TLS 
protection for the connection. If you enable this option and your mail server 
does not support SSL/TLS, Symantec Encryption Desktop will not send or 
receive any of your messages.

Outgoing Mail Server (SMTP)

 Name: Type the name of the mail server that handles outgoing messages. 

 Port: Keep Automatic (465, 25) or specify another port to connect to on the 
outgoing mail server to send messages. 

This option is only available for the outgoing mail server if your settings 
permitted choosing it for the incoming mail server. 

 SSL/TLS: Specify how Symantec Encryption Desktop interacts with your 
mail server. Choose one: 

 Automatic: Symantec Encryption Desktop will do its best to provide 
SSL/TLS protection. It first tries the alternate port, then it attempts 
STARTTLS (if supported by the server), finally, if the above fails, it 
connects to the server unprotected. 

 Require STARTTLS: Symantec Encryption Desktop requires that the 
server honor the STARTTLS command. 
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 Require SSL: Symantec Encryption Desktop requires that the server 
honor SSL/TLS-protected connections on the specified alternate port. 

 Do Not Attempt: Symantec Encryption Desktop does not attempt any 
SSL/TLS protection of the connection with the mail server. 

 Warn if email client attempts SSL/TLS: When selected, Symantec 
Encryption Desktop displays a warning dialog box if the email client 
attempts SSL/TLS, as this is a condition that is incompatible with Symantec 
Encryption Desktop proxying your email. (This option is selected by default.) 

Caution: This option should only be enabled if you are certain your mail server 
supports SSL/TLS. It ensures that Symantec Encryption Desktop will not fall 
back to sending or receiving messages with the mail server over an unprotected 
connection if, for example, a problem occurs while negotiating SSL/TLS 
protection for the connection. If you enable this option and your mail server 
does not support SSL/TLS, Symantec Encryption Desktop will not send or 
receive any of your messages.

8 Click OK when you are finished. 

9 In the Symantec Encryption Server field, select the name of the Symantec 
Encryption Server protecting the email domain you are in. <None> is displayed if 
you are not in an email domain protected by a Symantec Encryption Server. If 
your domain is protected by a Symantec Encryption Server, but it is not listed, 
select <create new> to enter the name of your Symantec Encryption Server. For 
more information, check with your Symantec Encryption Server administrator. 

10 Click Key Mode. The Key Management Mode dialog box is displayed, displaying 
your current key mode. If necessary, click Reset Key, which starts the Key Setup 
Assistant. 

11 Click OK. 

12 In the Username field, type the user name on the email account. 

13 In the Default Key field, the current key displays. 

 If you are using Symantec Encryption Desktop as a standalone product, you 
can either keep the default key, or select another one from the menu (if 
another key is available). 

 If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the default key is displayed and you cannot 
change it. If you need to change your key, you must click Key Mode and go 
through the procedure to reset your key on the Symantec Encryption Server. 

14 Enable Cache this key’s passphrase when I log in (by selecting the checkbox) if 
you want to cache the passphrase for the keypair you just selected when you log 
in. 

If you don’t cache the key’s passphrase, you will be prompted for it when you are 
sending signed messages or receiving encrypted messages. 

15 In the Security Policies provided by [server name] section, the current policies 
that apply to you are displayed. You can keep the default security polices, disable 
the default security policies, or add new policies if you are using Symantec 
Encryption Desktop as a standalone product. If you are using Symantec 
Encryption Desktop in a Symantec Encryption Server-managed environment, your 
options are likely to be different, depending on what your Symantec Encryption 
Server administrator has specified. 
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16 If you have edited any policies, you must click Done when you are finished. 
Otherwise, when you are done with the security policies, the account is ready. It is 
not necessary to click a button to save your information. It was saved as soon as 
you typed it. 

 

 

Editing Messaging Service Properties 

Caution: Before making any changes to an existing messaging service, be sure to exit 
your email client. 

To make changes to the account properties of an existing service 

1 Open Symantec Encryption Desktop and click the PGP Messaging Control box. The 
PGP Messaging Control box highlights. 

2 Click on the name of the service whose account properties you want to edit. The 
settings for the selected service appear in the PGP Messaging Work area. 

3 Make the desired changes to the account properties of the service. For more 
information, see Creating a New Messaging Service (on page 78). 

 

 

Disabling or Enabling a Service 
If you want to stop a service from working, but you don’t want to delete the service 
because you might need it again, you can disable the service. This is useful if you only 
want Symantec Encryption Desktop to process mail on particular accounts, but not 
others. If you are certain that you won’t need the service again, you can delete the 
service. 

To disable or enable an existing service 

1 In the PGP Messaging Control box, click the name of the service you want to 
disable. The settings for the service appear in the PGP Messaging Work area. 

2 Do one of the following: 

 To disable the service, select Messaging > Disable Service. The service is 
disabled. 

 To enable the service select Messaging > Enable Service. The service is 
enabled. 

Symantec Encryption Desktop alerts you that the change may not take place until 
you restart your email client. 

Tip: You can disable, enable, and delete services by right-clicking the name in the 
PGP Messaging Control Box and selecting the desired command. 
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Deleting a Service 
If you are certain that you will not need a messaging service any longer, you can delete 
the service from Symantec Encryption Desktop. 

To delete a service 

1 Click the name of the service you want to delete. The settings for the service 
appear in the PGP Messaging Work area. 

2 Select Messaging > Delete Service. The service is deleted. 

Tip: You can delete a service by right-clicking the name in the PGP Messaging 
Control Box and selecting the desired command. 

 

Multiple Services 
Some email services and Internet Service Providers use multiple mail servers for a 
single DNS name in a round-robin fashion such that Symantec Encryption Desktop may 
create multiple messaging services for a single email account, seeing each mail server 
as separate and thus requiring its own messaging service. 

Symantec Encryption Desktop ships with wildcard support for common email services, 
such as *.yahoo.com and *.me.com (or *.mac.com). However, if you are using a 
less-common email service or if the services change their mail server configurations, 
you could run into this problem. 

If you see Symantec Encryption Desktop create multiple services for a single email 
account, and you check the settings and see they are the same except the mail server 
for the first service is mail1.example.com, the mail server for the second service is 
mail2.example.com, and the mail server for the third is mail3.example.com, and 
so on, you may need to manually edit one of the services. 

The best solution is to manually edit one of the services such that the mail server entry 
for that service can support multiple mail servers being used round-robin. For the 
example cited above, you could manually change the server name on the Server 
Settings dialog box for one of the services to mail*.example.com, and then delete the 
other services. 

Some round-robin setups may be more complicated, requiring a slightly different 
solution. For example, if Symantec Encryption Desktop were to create services with 
mail servers of pop.frodo.example.com, smtp.bilbo.example.com, and 
mail.example.com, then the best wildcard solution would be *.example.com. 

 

Troubleshooting PGP Messaging Services 
By default, Symantec Encryption Desktop automatically determines your email account 
settings and creates a PGP Messaging service that proxies messaging for that email 
account. 

Because of the large number of possible email account settings and mail server 
configurations, on some occasions a messaging service that Symantec Encryption 
Desktop automatically creates may not work quite right. 
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If Symantec Encryption Desktop has created a messaging service that is not working 
right for you, one or more of the following items may help correct the problem: 

 Verify that you can both connect to the Internet and send and receive email with 
PGP Services stopped. To do this, right-click the Symantec Encryption Desktop 
tray icon and select Exit PGP Services from the list of commands. 

Note: You should always restart your email client after starting or stopping PGP 
Services. 

 Read the Symantec Encryption Desktop Release Notes for the version of Symantec 
Encryption Desktop you are using to see if your problem is a known issue. 

 Make sure SMTP authentication is enabled for the email account (in your email 
client). This is recommended for Symantec Encryption Desktop to proxy your 
messaging. If you only have one email account and you are not using Symantec 
Encryption Desktop in a Symantec Encryption Server-managed environment, then 
SMTP authentication is not needed. It is required when using a Symantec 
Encryption Server as your SMTP server, or when you have multiple email accounts 
on the same SMTP server. 

 Open the PGP Log to see if the entries offer any clues as to what the problem 
might be. 

 If SSL/TLS is enabled in your email client, you must disable it there if you want 
Symantec Encryption Desktop to proxy your messaging. (This does not leave the 
connection to and from your mail server unprotected; by default Symantec 
Encryption Desktop automatically attempts to upgrade any unprotected 
connection to SSL/TLS protection. The mail server must support SSL/TLS for the 
connection to be protected.) 

 If either Require STARTTLS or Require SSL is selected (in the SSL/TLS settings of 
the Server Settings dialog box) your mail server must support SSL/TLS or 
Symantec Encryption Desktop will not send or receive any messages. 

 If your email account uses non-standard port numbers, make sure these are 
included in the settings of your messaging service. 

 If Symantec Encryption Desktop is creating multiple messaging services for one 
email account, use a wild card for your mail server name. For more information, 
see Multiple Services (on page 82). 

 Delete the PGP Messaging service that is not working correctly and send/receive 
email. Symantec Encryption Desktop regenerates the messaging service. 

If none of these items help correct the problem, try the following: 

1 Delete the PGP Messaging service that is not working correctly. 

2 Stop all Symantec Encryption Desktop services and then exit Symantec 
Encryption Desktop if it was open. To stop the services, right-click the Symantec 
Encryption Desktop tray icon and select Exit PGP Services from the list of 
commands. 

3 Verify that you have Internet connectivity and can send and receive email with 
PGP Messaging services stopped. 

4 Open your email client and write down your email account settings (including user 
name, email address, incoming and outgoing mail server, incoming mail server 
protocol, and any non-standard mail server ports). 

5 Close your email client and restart Symantec Encryption Desktop, which restarts 
PGP Services. Either restart your computer or open Symantec Encryption Desktop 
from the Windows Start menu. 
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6 Manually create a PGP Messaging service using the account settings you wrote 
down. 

7 Open your email client and begin sending and receiving messages. 

8 If you continue to have problems with a PGP Messaging service, access any of the 
following for assistance: 

 Symantec website (https://support.symantec.com/en_US/dpl.62369.html) 

 Symantec Knowledgebase (http://www.symantec.com/docs/TECH164863) 

By default, Symantec Encryption Desktop automatically determines your email account 
settings and creates a PGP Messaging service that proxies messaging for that email 
account. 

Because of the large number of possible email account settings and mail server 
configurations, on some occasions a messaging service that Symantec Encryption 
Desktop automatically creates may not work quite right. 

If Symantec Encryption Desktop has created a messaging service that is not working 
right for you, one or more of the following items may help correct the problem: 

 Verify that you can both connect to the Internet and send and receive email with 
PGP Services stopped. To do this, right-click the Symantec Encryption Desktop 
tray icon and select Exit PGP Services from the list of commands. 

Note: You should always restart your email client after starting or stopping PGP 
Services. 

 Read the Symantec Encryption Desktop Release Notes for the version of Symantec 
Encryption Desktop you are using to see if your problem is a known issue. 

 Make sure SMTP authentication is enabled for the email account (in your email 
client). This is recommended for Symantec Encryption Desktop to proxy your 
messaging. If you only have one email account and you are not using Symantec 
Encryption Desktop in a Symantec Encryption Server-managed environment, then 
SMTP authentication is not needed. It is required when using a Symantec 
Encryption Server as your SMTP server, or when you have multiple email accounts 
on the same SMTP server. 

 Open the PGP Log to see if the entries offer any clues as to what the problem 
might be. 

 If SSL/TLS is enabled in your email client, you must disable it there if you want 
Symantec Encryption Desktop to proxy your messaging. (This does not leave the 
connection to and from your mail server unprotected; by default Symantec 
Encryption Desktop automatically attempts to upgrade any unprotected 
connection to SSL/TLS protection. The mail server must support SSL/TLS for the 
connection to be protected.) 

 If either Require STARTTLS or Require SSL is selected (in the SSL/TLS settings of 
the Server Settings dialog box) your mail server must support SSL/TLS or 
Symantec Encryption Desktop will not send or receive any messages. 

 If your email account uses non-standard port numbers, make sure these are 
included in the settings of your messaging service. 

 If Symantec Encryption Desktop is creating multiple messaging services for one 
email account, use a wild card for your mail server name. For more information, 
see Multiple Services (on page 82). 

 Delete the PGP Messaging service that is not working correctly and send/receive 
email. Symantec Encryption Desktop regenerates the messaging service. 

 

https://support.symantec.com/en_US/dpl.62369.html
http://www.symantec.com/docs/TECH164863
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If none of these items help correct the problem, try the following: 

1 Delete the PGP Messaging service that is not working correctly. 

2 Stop all Symantec Encryption Desktop services and then exit Symantec 
Encryption Desktop if it was open. To stop the services, right-click the Symantec 
Encryption Desktop tray icon and select Exit PGP Services from the list of 
commands. 

3 Verify that you have Internet connectivity and can send and receive email with 
PGP Messaging services stopped. 

4 Open your email client and write down your email account settings (including user 
name, email address, incoming and outgoing mail server, incoming mail server 
protocol, and any non-standard mail server ports). 

5 Close your email client and restart Symantec Encryption Desktop, which restarts 
PGP Services. Either restart your computer or open Symantec Encryption Desktop 
from the Windows Start menu. 

6 Manually create a PGP Messaging service using the account settings you wrote 
down. 

7 Open your email client and begin sending and receiving messages. 

8 If you continue to have problems with a PGP Messaging service, access any of the 
following for assistance: 

 Symantec website (https://support.symantec.com/en_US/dpl.62369.html) 

 Symantec Knowledgebase (http://www.symantec.com/docs/TECH164863) 

 
 

Creating a New Security Policy 
Security policies control how Symantec Encryption Desktop handles outgoing email 
messages. 

Note: When you create a new security policy, you are creating a messaging security 
policy, not a mailing list policy. You cannot create a new mailing list policy, but you 
can edit the default mailing list policies. 

To create a new security policy 

1 In the PGP Messaging Control box, click the name of the service for which you 
want to create a new security policy. The settings for the service appear in the PGP 
Messaging Work area, including the list of existing security policies. 

2 Do one of the following: 

 Click New Policy in the PGP Messaging Control box. 

 Select Messaging > New Messaging Policy. The Message Policy dialog box is 
displayed. 

If your email domain is protected by a Symantec Encryption Server, and you look 
at the Message Policy settings for a policy from a Symantec Encryption Server, the 
fields may be different from the fields shown above. 

3 In the Description field, type a descriptive name for the policy you are creating. 

 

https://support.symantec.com/en_US/dpl.62369.html
http://www.symantec.com/docs/TECH164863
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4 In the First Section (stating the policy conditions), in the If field, select: 

 If any. The policy applies when any condition is met. 

 If all. The policy only applies when all conditions are met. 

 If none. The policy only applies if none of the conditions are met. 

5 In the first condition field, select: 

 Recipient. The policy applies only to messages to the specified recipient. 

 Recipient Domain. The policy applies only to email messages in the 
specified recipient domain. 

 Sender. The policy applies only to messages with the specified sender 
address. 

 Message. The policy applies only to messages which have the specified 
signed and/or encrypted state. 

 Message Subject. The policy applies only to messages with the specified 
message subject. 

 Message Header. The policy applies only to messages for which the specified 
header meets the specified criterion. Note that the conditions described in 
the next section (is, is not, contains, and so on) apply to the text typed in the 
text box that is displayed when you select Message Header. 

 Message Body. The policy applies only to messages with the specified 
message body. 

 Message Size. The policy applies only to messages of the specified size (in 
bytes). 

 Message Priority. The policy applies only to messages with the specified 
message priority. 

 Message Sensitivity. The policy applies only to messages with the specified 
message sensitivity. 

6 In the second condition field, select: 

 is. The condition is met when text in the first condition field matches the text 
typed in the text box. 

 is not. The condition is met when text in the first condition field does not 
match the text typed in the text box. 

 contains. The condition is met when text in the first condition field contains 
the text typed in the text box. 

 does not contain. The condition is met when text in the first condition field 
does not contain the text typed in the text box. 

 begins with. The condition is met when text in the first condition field begins 
with the text typed in the text box. 

 ends with. The condition is met when text in the first condition field ends 
with the text typed in the text box. 

 matches pattern. The condition is met when text in the first condition field 
matches the pattern typed in the text box. 

 greater than. The condition is met when message size is greater than the text 
typed in the text box. 

 



 
Securing Email Messages 87 

 
 
 

 

Creating a New Security Policy  

 less than. The condition is met when message size is less than the text typed 
in the text box. 

7 In the third condition field, select: 

 text entry box. Type text for the matching criteria. For example, if you 
selected Message Size is greater than, then type a number representing the 
size of the message. 

 normal. Matching criteria for Message Sensitivity is normal. 

 none or normal. Matching criteria for Message Sensitivity is none (for Mac 
OS X systems) or normal (for Windows systems). 

 personal. Matching criteria for Message Sensitivity is personal. 

 private. Matching criteria for Message Sensitivity is private. 

 confidential. Matching criteria for Message Sensitivity is confidential. 

 signed. Matching criteria for Message is signed. 

 encrypted. Matching criteria for Message is encrypted. 

 encrypted to key ID. Matching criteria for encrypted to key ID (you must 
then type a key ID in the resulting text box). 

 low. Matching criteria for Message Priority is low. 

 normal. Matching criteria for Message Priority is normal. 

 high. Matching criteria for Message Priority is high. 

Create more condition lines by clicking the plus sign icon. 

8 In the Perform the following actions on the message section, in the first action 
field, select: 

 Send In Clear. Specifies that the message should be sent in the clear; that is, 
not signed nor encrypted. 

 Sign. Specifies that the message should be signed. 

 Encrypt to. Specifies that the message should be encrypted. 

9 In the second action field, select: 

 recipient’s verified key. Ensures the message can be encrypted only to a 
verified key of the intended recipient. 

 recipient’s unverified key. Allows the message to be encrypted to an 
unverified key of the intended recipient. Will also encrypt to a verified key, if 
available. 

 recipient’s verified end-to-end key. Ensures the message can be encrypted 
only to a verified end-to-end key of the intended recipient. An end-to-end 
key is a key in sole possession of the individual recipient. In a Symantec 
Encryption Server-managed environment, this is a Client Key Mode key 
which is different from a Server Key Mode key, where the Symantec 
Encryption Server is in possession of the key.  

Whether the key is end-to-end or not is shown in the Group field on the Key 
Properties dialog box. No means that the key is end-to-end (is not part of a 
group), and Yes means that it is not end-to-end.) 

 recipient’s unverified end-to-end key. Allows the message to be encrypted 
to an unverified end-to-end key of the intended recipient. Will also encrypt 
to a verified key, if available. 
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 a list of keys. Specifies that the message can only be encrypted to keys on the 
list. 

Create more action lines by clicking the plus sign icon. 

10 In the Prefer encoding field, select: 

 automatic. Lets Symantec Encryption Desktop choose the message encoding 
format. This is almost always the best option unless you know exactly why 
you need to use one of the other message encoding formats explicitly. 

 PGP Partitioned. Sets PGP Partitioned as the preferred message encoding 
format. This format is the most backwards compatible with older PGP and 
OpenPGP products. 

 PGP/MIME. Sets PGP/MIME as the preferred message encoding format. 
PGP/MIME is able to encrypt and sign the entire message including 
attachments in one pass and is usually therefore faster and better able to 
reproduce the full message fidelity. 

 S/MIME. Sets S/MIME as the preferred message encoding format. Choose 
S/MIME if, for some reason, you need to force messages to be S/MIME even if 
the user has a PGP key. 

11 In the Recipient’s key is not available section, in the first Key Not Found field, 
select: 

 Search keys.domain and. Specifies a search that includes both keys.domain 
as well as another server you specify. 

 Search. Allows for searching for an appropriate key if one is not found on 
the local keyring. 

 Clear-sign message. Specifies that the message should be sent in the clear, 
but signed. 

 Send message unsecured. Specifies that the message be sent in the clear. 

 Block message. Specifies that the message must not be sent if an appropriate 
key is not found. 

12 In the second Key Not Found field, select: 

 All keyservers. Allows all keyservers, including the PGP Global Directory, to 
be searched for an appropriate key. 

 PGP Global Directory or keyserver.pgp.com. Specifies that only the PGP 
Global Directory is searched.  

 [configured keyservers]. Specifies that only the keyserver you choose from 
the list of currently configured keyservers is searched. Note that keyservers 
other than the PGP Global Directory may provide unverified keys that 
cannot be used if you require verified keys in the policy. Unless you know 
exactly why you need to search another keyserver and are prepared to find 
those keys manually to verify them when necessary, search only on the PGP 
Global Directory. 

 Edit Keyserver List. Lets you add keyservers to the list of currently 
configured keyservers. 

13 In the last Key Not Found field, specify: 

 temporarily cache found keys. Specifies that a found key should be 
temporarily saved in memory. Keys in this cache will automatically be used 
when verifying signed messages, and will be used for encryption if they have 
been verified. 
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 ask to save found keys. Specifies that Symantec Encryption Desktop should 
ask if you want to save to your local keyring a particular found key. 

 save found keys. Specifies that found keys should automatically be saved to 
your local keyring. 

14 In the If no result field, select: 

 Clear-sign message. Allows messages for which an encryption key has not 
been found to be signed and sent in the clear. 

 Send message unsecured. Do not encrypt message. 

 Block message. Prevents message for which an encryption key has not been 
found from being sent. 

15 Click OK when the policy settings are configured. The new policy is displayed in 
the list of security policies. 

 

 

Regular Expressions in Policies 
Symantec Encryption Desktop supports the use of regular expressions in security 
policies in text entry boxes. Use regular expressions to match multiple text strings 
using a single text string. 

Note: In addition to the following examples, Symantec Encryption Desktop also 
supports broader regular expressions that adhere to standard formats. The “Matches 
Pattern” criteria actually means “matches regular expression.” 

Some mail policy rule conditions require that some part of an email must match a 
pattern. The patterns in the condition take the form of a regular expression. A regular 
expression is a string of characters that represents the format for a term to match. Any 
term that fits the format of the regular expression is a match.  

Some common elements of regular expressions:  

? indicates that there should be one or none of the previous expression  

+ indicates that there is at least one of the previous expression  

. matches any single character  

* indicates that there should be none, one, or any number of the previous expression 

[ ] matches any single character contained within the brackets  

[a-z] matches any lowercase letter within the set from a to z 

[1-9] matches any digit within the set from 1 to 9  

{n}
a sequence of exactly n matches of the 
expression 

The following are examples of regular expressions to match common items that may 
appear in a sensitive email message.  

Data Example Regular Expression  

Phone number (555)555-4567 
\(?[2-9][0-9]{2}[\]-.)[2-9][0-9]{
2}[-.][0-9]{4}  
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Data Example Regular Expression  

Email address joe@example.com
[a-zA-Z0-9._%-]+@[a-zA-Z0-
9.-]+\.[a-zA-Z]{2,6}  

Credit card number 1234 1234 1234 1234 
[1-9][0-9]{3} ?[0-9]{4} 
?[0-9]{4} ?[0-9]{4}  

Social Security Number 123-45-6789 [0-9]{3}-[0-9]{2}-[0-9]{4} 

City, state abbreviation Palo Alto, CA .*, [A-Z][A-Z] 

2-character state 
abbreviation 

CA [A-Z][A-Z] 

Zip code 12345 [0-9]{5}(-[0-9]{4})? 

Dollar amounts, with leading 
$ symbol  

$3.95 \$[0-9]+.[0-9][0-9] 

Date, numeric 2003-08-06 [0-9]{4}-[0-9]{2}-[0-9]{2} 

Date, alpha-numeric Jan 3, 2003 

(Jan|Feb|Mar|Apr|May|Jun|Jul
|Aug|Sep|Oct|Nov|Dec)\.? 
(3[0-1]|[1-2][0-9]|0?[0-9]), 
[0-9]{4}  

HTTP URL http://www.example.com
https?://(([012][0-9]{0,2}\.){3}
[012][0-9]{0,2}|([a-zA-Z0-9]+\
.)+[a-zA-Z0-9]{2,6})(/.*)?  

IP address 123.123.123.123 
([012][0-9]{0,2}\.){3}[012][0-9
]{0,2}  

A blank line  ^$ 

 

 

Security Policy Information and Examples 
When you create a service, several default security policies are automatically created: 

 Require Encryption: [PGP] Confidential 

 Sign + Encrypt Button 

 Sign Button 

 Encrypt Button 

 Mailing List Admin Requests 

 Mailing List Submissions 

 Opportunistic Encryption. 

The order of the default policy rules is important. Be sure the order appears exactly as 
described above. 

This section describes how the default security policies work. It also describes two 
example situations for which you might want to create a security policy and explains 
how to configure them. 

Note: If you make any changes to the default policies and want to restore the default 
settings, click Revert to Default n the Message Policy dialog box. 

 

 

mailto:joe@example.com
http://www.example.com/
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Encrypt Button Default Policy 

Encrypt Button is one of the default security policies that Symantec Encryption 
Desktop automatically creates for a service. The settings for this default policy are: 

 If: If all 

 Conditions: Message Header "X-PGP-Encrypt-Button" contains "selected" 

 Actions: Encrypt to recipient's verified key 

 Prefer encoding: Automatic 

 If a recipient's key is not available: Search keys.domain and keyserver.pgp.com 
and temporarily cache found keys 

 If no result: Block message 

This rule should appear fourth in the list of default policies. 

Note: If you have upgraded from version 9.x, this policy is not automatically included 
and you will need to create the policy manually with the settings described above. 
For information on how to create a new policy, see Creating a New Security Policy (on 
page 85). If you do not plan to use the Encrypt button with Microsoft Outlook, you do 
not need to create this policy. 

 

Mailing List Admin Requests Default Policy 

Mailing List Admin Requests is one of the default security policies that Symantec 
Encryption Desktop automatically creates for a service.   

The settings for this default policy are: 

 If: If any 

 Conditions: Recipient / matches pattern/ .*-subscribe@.*, .*-unsubscribe@.*, 
.*-report@.*, .*-request@.*, .*-bounce@.*, 

 Actions: Send in clear 

This rule should appear fifth in the list of default policies. 
 

Mailing List Submission Default Policy 

Mailing List Submission is one of the default security policies that Symantec 
Encryption Desktop automatically creates for a service.  

The settings for this default policy are: 

 If: If any 

 Conditions: Recipient / matches pattern/ .*-users@.*, .*-bugs@.*, .*-docs@.*, 
.*-help@.*, .*-news@.*, .*-digest@.*, .*-list@.*, .*-devel@.*, .*-announce@.*, 

 Actions: Sign 

Prefer Encoding: PGP Partitioned This rule should appear sixth in the list of default 
policies. 
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Opportunistic Encryption Default Policy 

Opportunistic Encryption is one of the default security policies that Symantec 
Encryption Desktop automatically creates for a service. The settings for this default 
policy are: 

 If: any 

 Conditions: Recipient Domain / is / * 

 Actions: Sign / Encrypt to / recipient’s verified key 

 Prefer message encoding: automatic 

 Key Not Found: Search keys.domain and / keyserver.pgp.com/ temporarily cache 
found keys 

If no result: Send message unsecured This rule should appear seventh (last) in the list of 
default policies.  Opportunistic Encryption causes those messages for which a verified 
key can be found to be sent signed and encrypted. Those messages for which a verified 
key cannot be found are delivered with no encryption (in the clear). This ensures your 
messages get sent, although some may be sent in the clear. 

This policy was designed to go last in your list of security policies, as it will match any 
message sent. If placed above a policy in the list, Symantec Encryption Desktop will 
never reach that policy, thus rendering it useless. 

 

Require Encryption: [PGP] Confidential Default Policy 

Require Encryption: [PGP] Confidential is one of the default security policies that 
Symantec Encryption Desktop automatically creates for a service. The settings for this 
default policy are: 

 If: any 

 Conditions: Message Subject / contains / [PGP] 
Message Sensitivity / is / confidential 

 Actions: Sign / Encrypt to / recipient’s verified key 

 Prefer message encoding: automatic 

 Key Not Found: Search keys.domain and / All Keyservers / temporarily cache 
found keys 

 If no result: Block message 

This rule should appear first in the list of policies.  

Require Encryption: [PGP] Confidential causes those messages with subjects that 
contain [PGP] or are marked confidential in your email client to require encryption to a 
verified key in order to be sent. If a verified key cannot be found, the message is not 
sent. 

 

Sign + Encrypt Buttons Default Policy 

Encrypt and Sign Buttons is one of the default security policies that Symantec 
Encryption Desktop automatically creates for a service. The settings for this default 
policy are: 
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 If: If all 

 Conditions: Message Header "X-PGP-Sign-Button" contains "selected"; Message 
Header "X-PGP-Encrypt-Button" contains "selected" 

 Actions: Sign; Encrypt to recipient's verified key 

 Prefer encoding: automatic 

 If a recipient's key is not available: Search keys.domain and keyserver.pgp.com 
and temporarily cache found keys 

 If no result: Block message 

This rule should appear second in the list of default policies. 

Note: If you have upgraded from version 9.x, this policy is not automatically included 
and you will need to create the policy manually with the settings described above. 
For information on how to create a new policy, see Creating a New Security Policy (on 
page 85). If you do not plan to use the Encrypt button with Microsoft Outlook, you do 
not need to create this policy. 

 

Sign Button Default Policy 

Sign Button is one of the default security policies that Symantec Encryption Desktop 
automatically creates for a service. The settings for this default policy are: 

 If: If all 

 Conditions: Message Header "X-PGP-Sign-Button" contains "selected" 

 Actions: Sign 

 Prefer encoding: automatic 

This rule should appear third in the list of default policies. 

Note: If you have upgraded from version 9.x, this policy is not automatically included 
and you will need to create the policy manually with the settings described above. 
For information on how to create a new policy, see Creating a New Security Policy (on 
page 85). If you do not plan to use the Encrypt button with Microsoft Outlook, you do 
not need to create this policy. 

 

Example of a Policy to Require Encryption to <Domain> 

If you use Opportunistic Encryption with its default settings and you put it at the 
bottom of the list of policies, it will cause those messages for which a verified key 
cannot be found to be delivered in the clear. This ensures that your messages get sent, 
but it also means that some may be sent in the clear. 

If there are specific domains to which sending in the clear is not an option, you can 
create a security policy that calls for encrypting and/or signing or the message is not 
sent. When you create this policy, make sure it is higher in the list than Opportunistic 
Encryption. 

 If: any 

 Conditions: Recipient Domain / is / example.com 

 Actions: Encrypt to / recipient’s verified key 
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 Prefer message encoding: automatic 

 Key Not Found: Search keys.domain and / All Keyservers / temporarily cache 
found keys 

 If no result: Block message 

This security policy is similar to Require Encryption: [PGP] Confidential in that it 
requires a message be encrypted or the message is not sent, but the criteria is not 
whether the message is marked confidential but rather that the email domain of the 
recipient is example.com. Using this policy ensures all messages to example.com are 
encrypted with a verified key or they are not sent. 

 

Example of a Policy to Sign and Send in the Clear to a Specific Domain 

If you regularly send email to a domain for which you want to sign all messages but not 
encrypt them, you should set up a policy for that domain. 

 If: any 

 Conditions: Recipient Domain / is / example.com 

 Actions: Sign 

 Prefer message encoding: automatic 

 

 

Working with the Security Policy List 
There are several important things you can do to the security policies in the list of 
security policies, such as edit a policy, add a new policy (described in Creating a New 
Security Policy (on page 85)), delete a policy, and change the order of policies in the list. 

 
 

Editing a Security Policy 

To edit an existing security policy 

1 Open Symantec Encryption Desktop and click the PGP Messaging Control box. The 
PGP Messaging Control box highlights. 

2 In the PGP Messaging Control box, click the name of the service that has the 
security policy you want to edit. The properties for the service you selected appear 
in the PGP Messaging Work area. 

3 Click Edit Policies. 

4 Select the security policy you want to edit, then do one of the following: 

 To edit the policy, click Edit Policy. The Message Policy dialog box is 
displayed, displaying the current settings for the specified policy. Make the 
desired changes to the policy. For information about the fields on the 
Message Policy dialog box, see Creating a New Security Policy (on page 85). 
When you have made the desired changes, click OK to close the Message 
Policy dialog box. The specified security policy is changed. 
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 To delete the policy, click Remove Policy. 

 To create a copy of the policy (to use as a basis for a new policy), click 
Duplicate Policy. 

 To move the policy up or down in the list (changing the order in which 
policies are applied), click Move Up or Move Down. 

Default policies can be viewed, modified, and disabled, but not deleted. 

5 Click Done. 

 

 

Editing a Mailing List Policy 

To edit a default Mailing List policy 

1 Open Symantec Encryption Desktop and click the PGP Messaging Control box. The 
PGP Messaging Control box highlights. 

2 In the PGP Messaging Control box, click the name of the service that has the 
security policy you want to edit. The properties for the service you selected appear 
in the PGP Messaging Work area. 

3 Click the Edit Policies button. 

4 In the list of security policies, click on the Mailing List policy you want to edit. The 
selected policy highlights. 

5 Click Edit Policy. The Message Policy dialog box is displayed, displaying the 
current settings for the specified policy. 

The default policies can be viewed, modified, and disabled, but not deleted. 

6 Make the desired changes to the policy. In the first field, select: 

 If any. The policy applies when any condition is met. 

 If all. The policy only applies when all conditions are met. 

 If none. The policy only applies if none of the conditions are met. 

7 In the first condition field, select: 

 Recipient. The policy applies only to messages to the specified recipient. 

 Recipient Domain. The policy applies only to email messages in the 
specified recipient domain. 

 Sender. The policy applies only to messages with the specified sender 
address. 

 Message. The policy applies only to messages which have the specified 
signed and/or encrypted state. 

 Message Subject. The policy applies only to messages with the specified 
message subject. 

 Message Header. The policy applies only to messages for which the specified 
header meets the specified criterion. Note that the conditions described in 
the next section (is, is not, contains, and so on) apply to the text typed in the 
text box that is displayed when you select Message Header. 
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 Message Body. The policy applies only to messages with the specified 
message body. 

 Message Size. The policy applies only to messages of the specified size (in 
bytes). 

 Message Priority. The policy applies only to messages with the specified 
message priority. 

 Message Sensitivity. The policy applies only to messages with the specified 
message sensitivity. 

8 In the second condition field, select: 

 is. The condition is met when text in the first condition field matches the text 
typed in the text box. 

 is not. The condition is met when text in the first condition field does not 
match the text typed in the text box. 

 contains. The condition is met when text in the first condition field contains 
the text typed in the text box. 

 does not contain. The condition is met when text in the first condition field 
does not contain the text typed in the text box. 

 begins with. The condition is met when text in the first condition field begins 
with the text typed in the text box. 

 ends with. The condition is met when text in the first condition field ends 
with the text typed in the text box. 

 matches pattern. The condition is met when text in the first condition field 
matches the pattern typed in the text box. 

9 In the third condition field, in the text entry box, type the text for the matching 
criteria. 

10 In the Perform the following actions on the message section, in the first action 
field, select: 

 Send In Clear. Specifies that the message should be sent in the clear; that is, 
not signed nor encrypted. 

 Sign. Specifies that the message should be signed. 

 Encrypt to. Specifies that the message should be encrypted. 

11 In the second action field, select: 

 recipient’s verified key. Ensures the message can be encrypted only to a 
verified key of the intended recipient. 

 recipient’s unverified key. Allows the message to be encrypted to an 
unverified key of the intended recipient. 

recipient’s verified end-to-end key. Ensures the message can be encrypted 
only to a verified end-to-end key of the intended recipient. An end-to-end key 
is a key in sole possession of the individual recipient. In a Symantec 
Encryption Server-managed environment, this is a Client Key Mode key which 
is different from a Server Key Mode key, where the Symantec Encryption 
Server is in possession of the key.  

Whether the key is end-to-end or not is shown in the Group field on the Key 
Properties dialog box. No means that the key is end-to-end (is not part of a 
group), and Yes means that it is not end-to-end.) 
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 recipient’s unverified end-to-end key. Allows the message to be encrypted 
to an unverified end-to-end key of the intended recipient. 

 a list of keys. Specifies that the message can only be encrypted to keys on the 
list. 

12 In the prefer message encoding field, select: 

 automatic. Lets Symantec Encryption Desktop choose the message encoding 
format. This is almost always the best option unless you know exactly why 
you need to use one of the other message encoding formats explicitly. 

 PGP Partitioned. Sets PGP Partitioned as the preferred message encoding 
format. This format is the most backwards compatible with older PGP and 
OpenPGP products. 

 PGP/MIME. Sets PGP/MIME as the preferred message encoding format. 
PGP/MIME is able to encrypt and sign the entire message including 
attachments in one pass and is usually therefore faster and better able to 
reproduce the full message fidelity. 

 S/MIME. Sets S/MIME as the preferred message encoding format. Choose 
S/MIME if, for some reason, you need to force messages to be S/MIME even if 
the user has a PGP key. 

13 In the Recipient’s key is not available section, in the first Key Not Found field, 
select: 

 Search keys.domain and. Specifies a search that includes both keys.domain 
as well as another server you specify. 

 Search. Allows for searching for an appropriate key if one is not found on 
the local keyring. 

 Clear-sign message. Specifies that the message should be sent in the clear, 
but signed. 

 Send message unsecured. Specifies that the message be sent in the clear. 

 Block message. Specifies that the message must not be sent if an appropriate 
key is not found. 

14 In the second Key Not Found field, select: 

 All keyservers. Allows all keyservers, including the PGP Global Directory, to 
be searched for an appropriate key. 

 PGP Global Directory or keyserver.pgp.com. Specifies that only the PGP 
Global Directory is searched.  

 [configured keyservers]. Specifies that only the keyserver you choose from 
the list of currently configured keyservers is searched. Note that keyservers 
other than the PGP Global Directory may provide unverified keys that 
cannot be used if you require verified keys in the policy. Unless you know 
exactly why you need to search another keyserver and are prepared to find 
those keys manually to verify them when necessary, search only on the PGP 
Global Directory.  

 Edit Keyserver List. Lets you add keyservers to the list of currently 
configured keyservers.  

15 In the last Key Not Found field, specify: 
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 temporarily cache found keys. Specifies that a found key should be 
temporarily saved in memory. Keys in this cache will automatically be used 
when verifying signed messages, and will be used for encryption if they have 
been verified. 

 ask to save found keys. Specifies that Symantec Encryption Desktop should 
ask if you want to save to your local keyring a particular found key. 

 save found keys. Specifies that found keys should automatically be saved to 
your local keyring. 

16 In the If no result field, select: 

 Clear-sign message. Allows messages for which an encryption key has not 
been found to be signed and sent in the clear. 

 Send message unsecured. Do not encrypt message. 

 Block message. Prevents message for which an encryption key has not been 
found from being sent. 

17 When you have made the desired changes, click OK to close the Message Policy 
dialog box. The specified security policy is changed. 

 

 

Deleting a Security Policy 

To delete an existing security policy 

1 In the PGP Messaging Control box, click the name of the service that has the 
security policy you want to delete. The properties for the service you selected 
appear in the PGP Messaging Work area. 

2 Click Edit Policies. 

3 In the list of security policies, click on the policy you want to delete. The specified 
policy highlights. 

4 Click Remove Policy. A Symantec Encryption Desktop Confirmation dialog box is 
displayed. 

5 Click Delete Policy to delete the policy or OK to disable it. The specified security 
policy is deleted or disabled. 

6 Click Done. 

Note: Default policies can be disabled, but not deleted. 

 

Changing the Order of Policies in the List 

To change the order of policies in the Security Policy list 

1 In the PGP Messaging Control box, click on the name of the service that has the 
security policy whose order you want to change. The properties for the service you 
selected appear in the PGP Messaging Work area. 

2 Click Edit Policies. 
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3 In the list of security policies, click on the policy whose order in the list you want 
to change. The specified policy highlights. 

4 Click Move Up or Move Down until the policy is in the desired location in the list. 
Make sure Opportunistic Encryption is at the bottom of the list. Any policy below 
it will not be implemented. 

5 Click Done. 

 

 

Symantec Encryption Desktop and SSL/TLS 
When you use Symantec Encryption Desktop, Symantec Corporation’s goal is for your 
data to be automatically protected whenever possible. This includes protecting your 
data in transit between your email client and your mail server. 

Tip: SSL stands for Secure Sockets Layer, which is a cryptographic protocol that 
secures communications between two devices; in this case, between your email client 
or Symantec Encryption Desktop and your mail server. TLS stands for Transport 
Layer Security and is the successor to SSL. 

Symantec Encryption Desktop protects your data to and from your mail server in 
different ways depending on the circumstances. The following information applies only 
if you selected Automatic (the default) for the SSL/TLS setting in the server settings 
dialog: 

 When the connection is not SSL/TLS protected. If the connection between your 
email client and your mail server is not SSL/TLS protected, Symantec Encryption 
Desktop will automatically attempt to upgrade that connection to SSL/TLS (it will 
negotiate with your mail server and upgrade the connection if the mail server 
supports it). 

If the mail server does not support SSL/TLS, the message(s) Symantec Encryption 
Desktop sends and receives during the session will be over an unprotected 
connection. Whether or not those messages will be encrypted or decrypted by 
Symantec Encryption Desktop does not affect the attempt by Symantec 
Encryption Desktop to upgrade the connection. Messages encrypted by Symantec 
Encryption Desktop can be sent or received over a connection protected by 
SSL/TLS or not protected by SSL/TLS. 

Note: Symantec Encryption Desktop always attempts to upgrade an unprotected 
connection to the mail server to SSL/TLS protection because an 
SSL/TLS-protected connection not only protects any non-PGP-encrypted 
messages on their way to the mail server or coming from it, but it also protects 
your mail server authentication passphrase when it is sent to the mail server. 

 When the connection is protected by SSL/TLS. If you have SSL/TLS protection 
turned on in your email client for the connection to your mail server, you must 
turn it off if you want Symantec Encryption Desktop to encrypt or decrypt your 
messages; Symantec Encryption Desktop cannot process your messages if they are 
already SSL/TLS-encrypted. 
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Turning off SSL/TLS protection in your email client does not mean that your 
non-PGP-encrypted messages are now unprotected going to or coming from your 
mail server. As with any connection that is not SSL/TLS protected, Symantec 
Encryption Desktop will automatically attempt to upgrade the connection to 
SSL/TLS protection if the mail server supports it (if you selected Automatic for 
the SSL/TLS setting in the server settings dialog). If the mail server does not 
support SSL/TLS connections, the messages Symantec Encryption Desktop sends 
during the session will be over an unprotected connection. 

The only time your messages will be sent in the clear to your mail server is if the 
messages are not PGP encrypted and the connection to the mail server cannot be 
upgraded to SSL/TLS protected, or you have selected the Do Not Attempt option 
in the SSL/TLS setting. 

 When you cannot have messages sent in the clear. Some security policies require 
that only protected messages can be sent; in other words, unprotected messages 
must never be sent. If necessary, you can configure Symantec Encryption Desktop 
to support this kind of security policy. 

Select the applicable PGP Messaging service, access the Server Settings dialog box 
(click the name of the server currently in the Server field of the Account 
Properties for the service), and choose an option from the SSL/TLS list other than 
Automatic. 

When this option is enabled, Symantec Encryption Desktop will only send 
messages to or receive messages from your mail server if the connection between 
them is SSL/TLS protected. If an SSL/TLS-protected connection cannot be 
established, Symantec Encryption Desktop will not interact with the server. 

Note: This option should be enabled only if you are certain your mail server 
supports SSL/TLS. It ensures that Symantec Encryption Desktop will not fall 
back to sending or receiving messages with the mail server over an unprotected 
connection if, for example, a problem occurs while negotiating SSL/TLS 
protection for the connection. If you enable this option and your mail server does 
not support SSL/TLS, Symantec Encryption Desktop will not send or receive any 
of your messages. 

 When you want SSL/TLS enabled in your email client. To use Symantec 
Encryption Desktop with SSL/TLS enabled in your email client, you must deselect 
the option to Warn if email client attempts SSL/TLS for your incoming or 
outgoing mail server, or both. When you disable this option for a connection to a 
mail server, Symantec Encryption Desktop ignores incoming and outgoing traffic 
over that connection when the connection is protected by SSL/TLS. 

Symantec Encryption Desktop monitors the connections to and from this server, 
ignoring traffic sent or received on SSL/TLS-protected connections. If, however, 
Symantec Encryption Desktop detects a non-SSL/TLS-protected connection, it 
handles the traffic like any other unprotected connection and attempts to upgrade 
the connection to SSL/TLS (if in Automatic mode) and apply applicable policies to 
messages. 

 

Key Modes 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, Symantec Encryption Desktop will have a key mode. 
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Note: The information in this section applies only to users of Symantec Encryption 
Desktop in an email domain protected by a Symantec Encryption Server. 

Available key modes are: 

 Server Key Mode (SKM): Keys are generated on and managed by the Symantec 
Encryption Server; they are only shared with the computer on which you are 
running Symantec Encryption Desktop as needed. Your private key is stored only 
on the Symantec Encryption Server, which also handles all private key 
management. The Symantec Encryption Server administrator has complete access 
to your private key and can thus access all messages you encrypt. This key mode is 
not compatible with smart cards (smart cards can be used on Windows systems 
only). 

Starting with version 10.0, SKM keys that previously could be used only for 
messaging can be used for all other Symantec Encryption Desktop encryption 
actions. This includes encrypting disks and files, and decrypting IMAP/POP email 
messages when disconnected from Symantec Encryption Server.   

If you are using an SKM key, you will never need to enter a passphrase for 
authentication. SKM key passphrases are randomly generated by Symantec 
Encryption Desktop and are stored encrypted. When Symantec Encryption 
Desktop requires a passphrase, Symantec Encryption Desktop retrieves the 
encrypted passphrase from your system without requiring interaction from you. 

 Client Key Mode (CKM): Keys are generated on and managed by the computer on 
which you are running Symantec Encryption Desktop; private keys are not shared 
with the Symantec Encryption Server. All cryptographic operations (encrypt, 
decrypt, sign, verify) are also handled by the computer on which you are running 
Symantec Encryption Desktop. On Windows systems, this key mode is compatible 
with smart cards. 

 Guarded Key Mode (GKM): Very similar to CKM, except that an encrypted copy of 
the private key is stored on the Symantec Encryption Server, which you can access 
if you change computers. As the key is encrypted, the Symantec Encryption Server 
administrator cannot access this private key, only you can. This key mode is 
compatible with smart cards (on Windows systems only) as long as the key is not 
generated directly on the smart card; that is, as long as the key is copied to the 
smart card.  

 Server Client Key Mode (SCKM): Also very similar to CKM, except that a copy of 
the private encryption key is stored on the Symantec Encryption Server; private 
signing keys never leave the computer on which you are running Symantec 
Encryption Desktop. This key mode ensures compliance with laws and corporate 
policies that require that the private signing key not leave the control of the user, 
while making sure that the private encryption key is stored in case of emergency. 
This key mode is compatible with smart cards (on Windows systems only) as long 
as the key is not generated directly on the smart card. SCKM requires a key with a 
separate signing subkey, which can be created for a new key with version 9.5 or 
later or added to an older PGP key using version 9.5 or later.  

Depending on how your Symantec Encryption Server administrator configured your 
copy of Symantec Encryption Desktop, you may or may not be able to choose your key 
mode. Also, you may or may not be able to change your key mode. 

Contact your Symantec Encryption Server administrator if you have additional 
questions about your key mode. 
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Key Modes 

Determining Key Mode 
Remember that only Symantec Encryption Desktop users in a Symantec Encryption 
Server-protected environment will have a key mode; standalone Symantec Encryption 
Desktop users do not have a key mode. 

To determine your key mode 

 Open Symantec Encryption Desktop and select the PGP Messaging service whose 
key mode you want to determine. The account properties and security policies for 
the selected service appear. 

In the Symantec Encryption Server field, the key mode for the selected service is 
shown in parentheses after the name of the Symantec Encryption Server (for 
example, keys.example.com (GKM)). This indicates that the key mode for the 
selected service, in this example, is Guarded Key Mode and that the associated 
Symantec Encryption Server is keys.example.com. 

 

Changing Key Mode 
Depending on how your Symantec Encryption Server administrator configured your 
copy of Symantec Encryption Desktop, you may not be able to change your key mode. 

To change your key mode 

1 Open Symantec Encryption Desktop and select the PGP Messaging service for the 
key mode you want to change. The account properties and security policies for the 
selected service appear. 

2 Click Key Mode. The PGP Universal Key Mode screen is displayed, describing your 
current key management mode. 

3 Click Reset Key and then click Yes in the confirmation message displayed. The 
PGP Key Setup Assistant is displayed. 

4 Read the text, then click Next. The Key Management Selection screen is displayed. 

5 Select the desired key mode. Depending on how your Symantec Encryption Server 
administrator configured your copy of Symantec Encryption Desktop, some key 
modes may not be available. 

6 Click Next. The Key Source Selection screen is displayed. 

7 Choose one of the following: 

 New Key. You will be prompted to create a new PGP key, which will be used 
to protect your messaging. 

 Symantec Encryption Desktop Key. You will be prompted to specify an 
existing PGP key to use to protect your messaging. 

 Import Key. You will be prompted to import a PGP key, which will be used to 
protect your messaging. 

8 Make the desired selection, then click Next. 

9 If you selected New Key, do the following: 

 Enter a passphrase for the key, then click Next. 
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 When the key is generated, click Next. 

 Click Finish. 

10 If you selected Symantec Encryption Desktop Key, do the following: 

 Select the key from the local keyring that you want to use, then click Next. 

 Click Finish. 

11 If you selected Import Key, do the following: 

 Browse to file that holds the PGP key you want to import (it must contain a 
private key), then click Next. 

 Click Finish. 

 

 

Tip: You can also change your key mode from the PGP Options dialog box. Choose 
Tools > Options and select the Advanced tab. Click Reset Key, and follow the steps 
above when the PGP Key Setup Assistant is displayed. This option is available if you 
are using Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment. 

Encoding Formats 
Symantec Encryption Desktop for Windows supports the following message formats: 

 PGP-EML. A newer, standards based format for PGP-encrypted messages. 

 PGP/MIME. A newer, standards based format for PGP-encrypted messages. 

 Partitioned. An older format for PGP-encrypted messages that comes in three 
formats: text/plain, text/HTML, and text/RTF.  

The encoding format is specified by your key properties. Your administrator may have 
defined a default encoding format.  

Viewing the PGP Log 
Use the PGP Log to see what actions Symantec Encryption Desktop is taking to secure 
your messages. 

To view the PGP Log 

1 To view logs, you must turn on logging. To do this, in Symantec Encryption 
Desktop select Tools > Enable Logging. 

2 In Symantec Encryption Desktop, click the PGP Messaging control box and then 
click PGP Log. The PGP Log is displayed in the application window.  

3 To change the view options or filter on specific logging information, do the 
following: 

 Click the arrow for View log for to select the days of the logs you want to 
view. 
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 Click the arrow for View topic to select the types of logs you want to view. 
Choose from All, PGP, Email, Whole Disk, NetShare, Zip/SDA, or Virtual 
Disk. 

 Click the arrow for View level to select the minimum severity of log entries 
you want to view. Choose from Error, Warn, Info, or Verbose. Note that 
Verbose can result in some large log files. 

4 When you are finished viewing the log: 

 To save a copy of the PGP Log, click Save. 

 To clear the entries in the PGP Log, click Shred. 

 

 

 



 

8 Viewing Email with PGP Viewer 

This section provides information on how to use PGP Viewer to decrypt, verify, and 
display encrypted messages. 

Note: PGP Viewer only runs on systems with Symantec Encryption Desktop 
installed. You cannot use PGP Viewer standalone. 

In This Chapter 

Overview of PGP Viewer.............................................................................................105

Opening an Encrypted Email Message or File.........................................................106

Copying Email Messages to Your Inbox...................................................................107

Exporting Email Messages .........................................................................................107

Specifying Additional Options ..................................................................................108

Specifying Options in PGP Viewer............................................................................108

Security Features in PGP Viewer ..............................................................................109

 
 

Overview of PGP Viewer 
In normal usage, Symantec Encryption Desktop sits between your email client (Mozilla 
Thunderbird, for example) and your email server so that Symantec Encryption Desktop 
can encrypt and sign outgoing messages and decrypt and verify incoming messages. 
When Symantec Encryption Desktop is doing this, it is called “in the mail stream.” 

Use PGP Viewer to decrypt, verify, and display messages outside the mail stream. 

There are multiple ways you could have ended up with encrypted messages outside the 
mail stream: 

 Encrypted messages saved securely. Many organizations store messages 
encrypted for security purposes. Storing them puts them outside the mail stream, 
but PGP Viewer can decrypt, verify, and display them while maintaining the 
original encrypted message. 

 Encrypted text in a webmail message. Encrypted messages sent to a webmail 
account cannot be decrypted by Symantec Encryption Desktop. However, PGP 
Viewer can decrypt those messages. Simply open the message.pgp file attachment 
using PGP Viewer. 

 Encrypted text not decrypted by Symantec Encryption Desktop. If a message was 
automatically downloaded by your email client when Symantec Encryption 
Desktop was not running or when your passphrase was not cached, you could end 
up with encrypted message text that is now outside the mail stream. 

PGP Viewer decrypts, verifies, and displays multiple types of messaging content: 

 Modern PGP-encrypted content (PGP/MIME and PGP Partitioned) 
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Opening an Encrypted Email Message or File 

 Legacy PGP-encrypted content (PGP/MIME and PGP Partitioned) 

 RFC-2822 compliant encrypted content 

PGP Viewer uses Symantec Encryption Desktop keyrings for operations that require 
keys. 

PGP Viewer honors applicable Symantec Encryption Desktop preferences; passphrase 
caching options, for example. 

In a Symantec Encryption Server-managed environment, PGP Viewer searches for 
verification keys per the applicable policy. 

PGP Viewer displays signature information for messages it decrypts in the message 
window, not in the message itself. This provides access to full signature information 
and prevents spoofing of inline signature annotations. 

Compatible Email Clients 
Note: For a list of supported email clients, refer to the Symantec Encryption Desktop 
System Requiremens in the Symantec Encryption Desktop for Mac OS X Release Notes 

Due to the Lotus Notes architecture, an encrypted message cannot be dragged from 
Lotus Notes email client and dropped into PGP Viewer to be decrypted. 

 

Opening an Encrypted Email Message or File 
Use PGP Viewer to open (decrypt, verify, and display) encrypted message files of the 
following types: 

 *.pgp: Created by a PGP application. 

 *.eml: Created by Outlook Express or Thunderbird. 

 *.msg: Created by Microsoft Outlook. 

When PGP Viewer opens an encrypted message, it does not overwrite the encrypted 
text. The original message remains intact. 

To decrypt, verify, and display an encrypted message from a file 

1 Open PGP Viewer. To do this, select the PGP icon in the system tray and then 
select PGP Viewer or from within Symantec Encryption Desktop select the PGP 
Viewer control box. 

2 Click Open File in PGP Viewer or pull down the Viewer menu and select Open File 
in PGP Viewer. 

The Open Message File dialog appears. 

3 In the Open Message File dialog box, navigate to the file you want to open, select it, 
then click Open. PGP Viewer decrypts, verifies, and displays the message in a 
separate window. 

Tip: You can drag and drop the file you want to open onto the portion of the PGP 
Viewer windows that displays: Drag Email or Files Here. PGP Viewer opens the 
file, decrypts and verifies it, and displays the message. 
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4 To open another message, click Open Message in the toolbar, navigate to the 
desired file, select it, then click Open. PGP Viewer decrypts, verifies, and displays 
the message. A pane on the left side of the PGP Viewer screen is displayed so that 
you can see all open messages. 

5 To open a pane on the left side of the PGP Viewer window or to close the pane if it 
is open, click the Pane button on the toolbar. 

 

 
 

Copying Email Messages to Your Inbox 
Use PGP Viewer to copy plaintext versions of decrypted messages to the inbox of your 
email client. 

To copy a message to the inbox of your email client 

1 With the message in the PGP Viewer window, click Copy to Inbox. The Copy to 
Inbox confirmation dialog box displays the name of the email client to which the 
message will be copied. To change this setting, see Specifying Options in PGP 
Viewer (on page 108). 

2 Click OK to continue. 

If you are copying a message to the Mozilla Thunderbird email client for the first 
time, a dialog box displays, advising that you must install an add-on. 

Click Yes to install the add-on and follow the on-screen instructions or click No. 
You must be using Thunderbird 2.0 or greater to install the add-on. 

3 PGP Viewer opens your email client and copies a plaintext version of the message 
to the inbox. 

 

 

Exporting Email Messages 
Use PGP Viewer to export a decrypted message to a file. 

To export a message from PGP Viewer to a file 

1 With the message displayed in the PGP Viewer window, click Export. The Export 
Message File dialog is displayed. 

2 In the Export Message File dialog box, specify the desired location, filename, and 
format for the file, then click Save. PGP Viewer saves the file to the specified 
location. 
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Specifying Additional Options 

Specifying Additional Options 
Use the Tools button on the PGP Viewer Toolbar (on the far right) to specify several 
PGP Viewer features: 

 Text Encoding: Specify the text encoding format for the message currently being 
displayed by PGP Viewer. 

 Show Remote Images: Display external resources (images, CSS style sheets, 
iframe content, and so on) for the message currently being displayed by PGP 
Viewer. You can specify that PGP Viewer automatically displays external 
resources in Preferences. 

 View Message Source: Display the source of the message currently being 
displayed by PGP Viewer. Viewing the message source can tell you more 
information about the message. 

 Preferences: Display the PGP Viewer Preferences dialog box. 

 

 

Specifying Options in PGP Viewer 
PGP Viewer includes options (preferences) that provide control of certain functionality. 

To access PGP Viewer preferences 

1 Open PGP Viewer from the PGP Tray or use PGP Viewer to decrypt, verify, and 
display a message. 

The PGP Viewer screen appears. 

2 Click the Tools icon (on the far right of the PGP Viewer Toolbar) and select 
Preferences. The Preferences dialog box is displayed. 

3 Select the General tab and specify the following options: 

 Ask user to confirm Copy to Inbox command: Controls whether or not a 
confirmation prompt is displayed when you copy text from PGP Viewer to 
the inbox of your email client. The default is enabled. 

 Automatically load remote images: Controls whether external resources 
like images, CSS style sheets, or iframe content, for example, are 
automatically loaded by PGP Viewer. The default is disabled, as this may be a 
security risk. 

 Use email client: Lets you specify the email client to which PGP Viewer will 
copy content. The default is Windows Default (Email); PGP Viewer 
determines your default Windows email and uses that as its default. You can 
also select Outlook, Outlook Express, and Thunderbird. 

4 Select the Text tab, and specify the following options: 

 Font: Controls the font PGP Viewer uses to display text. 

 Text Color: Controls the color of text that PGP Viewer displays. 
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Security Features in PGP Viewer  

 Background Color: Controls the background color of text that PGP Viewer 
displays. 

 

 

Security Features in PGP Viewer 
PGP Viewer proactively protects your security: 

 The Web browser embedded in PGP Viewer, which displays messaging content, 
has JavaScript, Java Applets, and plugins disabled. This prevents an attacker from 
delivering a malicious payload that PGP Viewer might otherwise load. 

 External resources — images, CSS style sheets, iframe content (an inline frame 
that contains another document), and so on — are loaded automatically based on 
the Automatically load remote images preference. For security purposes, this 
preference is disabled by default. When this preference is disabled, PGP Viewer 
does not generate any network traffic to external sites. 

 

 

 





 

9 Protecting Disks with Symantec Drive 
Encryption 

Symantec Drive Encryption locks down the entire contents of a laptop, desktop, 
external drive, or USB flash drive, including boot sectors, system files, and swap files. 
You can also use Symantec Drive Encryption to encrypt just the boot partition or 
Windows partitions. Encryption runs as a background process that is transparent to 
you, automatically protecting valuable data without requiring you to take additional 
steps. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have specified, by policy, that all boot drives must be encrypted. If this is the case, 
Symantec Encryption Desktop periodically verifies that drives are encrypted and will 
enforce policy by automatically encrypting unencrypted boot drives. 
 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have customized the Symantec Drive Encryption BootGuard screen to include 
additional text or a custom image such as your organization's logo. Your actual login 
screen may look different if your administrator has customized the screen. 
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About Symantec Drive Encryption 
When you encrypt an entire disk using the Symantec Drive Encryption feature, every 
sector is encrypted using a symmetric key. This includes all files including operating 
system files, application files, data files, swap files, free space, and temp files. 

On subsequent reboots, Symantec Drive Encryption prompts you for the correct 
passphrase. Then the encrypted data is decrypted as you access it. Before any data is 
written to the disk, Symantec Drive Encryption encrypts it. As long as you are 
authenticated to your Symantec Drive Encryption-encrypted disk (after you have 
entered the correct passphrase at the PGP BootGuard screen), the files are available. 
When you shut down your system, the disk is protected against use by others. 

If your system supports the Intel® Advanced Encryption Standard (AES) Instructions 
(AES-NI), your system is encrypted and decrypted using the hardware associated with 
this encryption algorithm. AES-NI provides improved performance during encryption 
and decryption processes as well as disk I/O enhancements while your disk is 
encrypted. 

Before encrypting your disk with Symantec Drive Encryption, it is important to 
understand the process of creating and using a Symantec Drive Encryption-encrypted 
disk: 

1 Make sure that your Symantec Encryption Desktop license supports its use, as 
described in Licensing Symantec Drive Encryption (on page 113). 

2 Perform the tasks to Prepare Your Disk for Encryption (on page 114). 
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Licensing Symantec Drive Encryption  

3 Choose how you want to authenticate yourself to encrypt the disk in Determining 
the Authentication Method for the Disk (on page 121). 

4 Choose the encryption options to use in Setting Encryption Options (on page 123). 

5 Start the encryption process in Encrypting a Disk or Partition (on page 126). 

6 Learn how to use an encrypted disk in Using a Symantec Drive 
Encryption-Encrypted Disk (on page 129). 

7 Learn how to maintain your encrypted disk in Maintaining the Security of Your 
Disk (on page 141). 

8 Learn how to decrypt the disk, if needed, in Decrypting a Symantec Drive 
Encryption-Encrypted Disk (on page 156). 

9 Understand the features that help avoid security problems in Special Security 
Precautions Taken by Symantec Encryption Desktop. 

If you are a Symantec Encryption Server administrator, or are using Symantec Drive 
Encryption in a Symantec Encryption Server-managed environment, see Using 
Symantec Drive Encryption in a Symantec Encryption Server-Managed Environment (on 
page 151) for additional information. 

Warning: Once you unlock a disk, its files are available to you—as well as anyone else 
who can physically use your system. Your files are unlocked until you lock them 
again by shutting down your computer. Use a PGP Virtual Disk volume for files that 
need to be secured even while your computer is in use. For more information, see 
Using PGP Virtual Disk (on page 161). 

How does Symantec Drive Encryption Differ from PGP Virtual Disk? 
The PGP Virtual Disk feature differs from Symantec Drive Encryption in that PGP 
Virtual Disk perform like additional volumes on your system that can be locked, even 
while you are using your computer. These volumes are like a vault where you can store 
files needing protection. There is no actual physical disk, only the virtual one that the 
PGP Virtual Disk feature creates and manages. 

Symantec Drive Encryption protects your entire physical hard disk. 

Both products work independently of each other, so you can use them at the same time. 
For more information, see Using PGP Virtual Disk (on page 161). 

 

Licensing Symantec Drive Encryption 
To use the Symantec Drive Encryption feature, your copy of Symantec Encryption 
Desktop must have a license that supports it. 

To verify your license supports Symantec Drive Encryption 

1 Open Symantec Encryption Desktop. 

2 Select Help > License. The Symantec Encryption Desktop License dialog box is 
displayed. 
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3 In the Product Information section, find the Symantec Drive Encryption icon. 
Move your cursor over the product name to see information about the product and 
to find out if you are currently licensed to use it.  

If your license does not support Symantec Drive Encryption, you can find more 
information about licensing Symantec Encryption Desktop using one of the following 
methods: 

 If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, contact your Symantec Encryption Server 
administrator for more information about support for the Symantec Drive 
Encryption feature in your license. For more information, see Using Symantec 
Encryption Desktop with Symantec Encryption Server (on page 257). 

 If you are using Symantec Encryption Desktop outside of a Symantec Encryption 
Server-managed environment, go to the Symantec website 
(https://support.symantec.com/en_US/dpl.62369.html) for more information 
about adding the Symantec Drive Encryption feature to your license. 

 

 

Prepare Your Disk for Encryption 
Before you encrypt your disk, there are a few tasks you must perform to ensure 
successful initial encryption of the disk. 

 Determine the BIOS mode of the system. Symantec recommends that you 
determine the type of the system before you encrypt your disk because Symantec 
Encryption Desktop encrypts boot disks differently depending upon the BIOS 
mode of the system. See How to Determine if Your Windows System is Running in 
UEFI Mode (on page 119). 

 Make sure you are not running a disk compression utility on your boot disk. 
After your disk has been encrypted, there are files that must not be compressed in 
order for Symantec Encryption Desktop to work correctly. Symantec Corporation 
recommends that you do not compress your boot disk before or after you have 
encrypted it. 

 Determine whether your target disk is supported. See Supported Disk Types (on 
page 115). 

 Make sure your keyboard type is supported. See Supported Keyboards (on page 
117). 

 Ensure the health of the disk before you encrypt it. If Symantec Drive Encryption 
encounters disk errors during encryption, it will pause encryption so you can 
repair the disk errors. However, it is more efficient to repair errors before you 
initiate encryption. See Ensure Disk Health Before Encryption (on page 119). 

 Back up the disk before you encrypt it. Before you encrypt your disk, be sure to 
back it up so that you won’t lose any data if your laptop or computer is lost, stolen, 
or you are unable to decrypt the disk. Also be sure to make regular backups of your 
disk. 

 

https://support.symantec.com/en_US/dpl.62369.html
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Prepare Your Disk for Encryption  

 Create a recovery disc or drive. While the chances are extremely low that a 
master boot record could become corrupt on a boot disk or partition protected by 
Symantec Drive Encryption, it is possible. Before you encrypt a boot disk or 
partition using Symantec Drive Encryption, create a recovery disc or drive. See 
Creating and Using a Recovery Disc (on page 154) or Creating and Using a Recovery 
USB Drive for Microsoft Windows 7 and Windows 8 UEFI-Based Systems (on page 
155). 

 Consider the time it will take to encrypt the disk and prepare accordingly. See 
Calculate the Encryption Duration (on page 120). 

 Be certain that you will have AC power for the duration of the encryption process. 
See Maintain Power Throughout Encryption (on page 120). 

 Run a pilot test to ensure software compatibility. As a good security practice, 
Symantec Corporation recommends testing Symantec Drive Encryption on a small 
group of computers to ensure that Symantec Drive Encryption is not in conflict 
with any software on the computer before rolling it out to a large number of 
computers. This is particularly useful in environments that use a standardized 
Corporate Operating Environment (COE) image. Certain other disk protection 
software is incompatible with Symantec Drive Encryption and can cause serious 
disk problems, up to and including loss of data. See Run a Pilot Test to Ensure 
Software Compatibility (on page 121) for known interoperability issues, and review 
the Symantec Encryption Desktop Release Notes for the latest updates to this list. 

 Ensure you have the correct token and drivers. If you are using a USB token for 
authentication to a fixed disk protected using Symantec Drive Encryption, make 
sure you have the correct token and you have installed the proper driver software. 
See Preparing a Smart Card or Token to Use For Authentication (on page 124). 
Smart cards and tokens can be used on Windows systems booting in BIOS mode 
only. 

 Perform Disk Recovery on Decrypted Disks. Where possible, as a best practice, if 
you need to perform any disk recovery activities on a disk protected with 
Symantec Drive Encryption, Symantec Corporation recommends that you first 
decrypt the disk. Do this by Disk > Decrypt in Symantec Encryption Desktop, 
using your prepared Symantec Drive Encryption recovery disc or drive, or by 
connecting the hard disk via a USB cable to a second system and decrypting from 
that system's Symantec Encryption Desktop software. Once the disk is decrypted, 
proceed with your recovery activities. 

 Installing on a Windows Server system. If you are installing Symantec Drive 
Encryption on a Windows Server system, go to the Symantec Knowledgebase 
(http://www.symantec.com/docs/TECH164863) and search for additional best 
practices information. 

 

 

Supported Disk Types 
The Symantec Drive Encryption feature protects the contents of the following types of 
disks: 

 Desktop or laptop disks, including solid-state drives (either partitions, or the 
entire disk)  

 External devices, excluding music devices and digital cameras 

 USB flash disks 

 Formatted disk or partition types: 

 

http://www.symantec.com/docs/TECH164863
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 04 (FAT16), 06 (FAT16B), 07 (NTFS), 0B (FAT32)  

If you use Symantec Drive Encryption with a FAT disk or partition, you can 
later convert it to NTFS. 

 GPT boot disks on UEFI systems 

Note that the boot drive must be partitioned in GPT with only one EFI system 
partition. 

 Controller mode: AHCI 

Symantec Corporation does not recommend that you change the default controller 
mode. 

There is no minimum or maximum size for a Symantec Drive Encryption-encrypted 
disk. If the disk or partition is supported by the operating system (or your hardware 
BIOS for the boot disk or partition), it should work with Symantec Encryption Desktop. 
Note that if your disk is partitioned, all partitions must be supported in order for 
encryption to proceed. 

If you want to re-partition a drive that has been encrypted with Symantec Drive 
Encryption, you must first take back up of all the partitions. After you have backed up 
the partitions, decrypt the drive and restart the system. You can now partition the drive 
as required and ensure to restart the system. You can then encrypt the partitions(s). 

All Windows power management modes (Hibernation, Standby/Sleep, Suspend) are 
supported. 

Dual-boot Mode Support 
You can use the Symantec Drive Encryption feature on a dual-boot system, as long as 
you boot to an operating system supported by Symantec Drive Encryption and 
Symantec Drive Encryption is installed. Partition mode supports dual-booting with 
another operating system (such as Linux) as long as you encrypt only your Windows 
partition. The other operating system must be on another, non-encrypted partition. 

Note: For Windows systems booting in UEFI mode, dual-booting is not supported.  

Unsupported Disk/Partition Types 
The following disk types are not supported: 

 Music devices and digital cameras 

 Diskettes and CD-RW/DVD-RWs 

 Any configuration where the system partition is not on the same disk as the boot 
partition 

 Advanced Format drives (4K sector size) 

 Self-encrypting drives (Opal supported) 

 Dynamic disks 

 SCSI drives/controllers  

 Software RAID disks 

 exFAT formatted disks 
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Warning: Some Windows operating systems allows basic disks to be converted to 
dynamic disks, which support some features that basic disks do not. Never perform 
this conversion on the boot drive of a system that has already been protected using 
Symantec Drive Encryption. This conversion, from a basic-type disk to a dynamic 
one, renders the drive unusable. 

 

Encryption Algorithm Used by Symantec Drive Encryption 

The encryption algorithm used by Symantec Drive Encryption is AES-256. You cannot 
change these options. 

 

Supported Keyboards 
Be sure that you are using a keyboard with one of the supported languages. 

On Windows systems, the Symantec Drive Encryption log-in screen supports the 
following keyboard layouts: 

 Belgian (Belgium; Comma) 

 Belgian (Belgium; Period) 

 Bosnian (Bosnia) 

 Bosnian (Bosnia; Cyrillic) 

 Bulgarian (Bulgaria) 

 Bulgarian (Bulgaria; Latin) 

 Bulgarian (Bulgaria; Typewriter) 

 Canadian Multilingual Standard (Canada) 

 Chinese Simplified (China, Singapore) 

 Chinese Traditional (Hong Kong, Taiwan) 

 Croatian (Croatia) 

 Czech (Czech Republic; QWERTY) 

 Danish (Denmark) 

 Dutch (The Netherlands) 

 English (United States) 

 English (United Kingdom) 

 English (US-International) 

 Estonian (Estonia) 

 Finnish (Finland) 

 French (Belgium) 

 French (Canada) 

 French (France) 

 French (Switzerland) 

 German (Germany/Austria) 
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 German (IBM) 

 German (Switzerland) 

 Hebrew (Israel) 

 Hungarian (Hungary) 

 Hungarian (Hungary; 101 keys) 

 Icelandic (Iceland) 

 Irish (Ireland) 

 Italian (Italy) 

 Italian (Italy; 142 keys) 

 Japanese (Japan) 

 Korean (Korea) 

 Norwegian (Norway) 

 Polish (Poland; Programmers) 

 Polish (Poland; 214 keyboard) 

 Portuguese (Brazil; ABNT keyboards) 

 Portuguese (Brazil; ABNT2 keyboards) 

 Portuguese (Portugal) 

 Romanian (Romania) 

 Russian (Russia; Cyrillic) 

 Serbian (Serbia and Montenegro; Cyrillic) 

 Serbian (Serbia and Montenegro; Latin) 

 Slovak (Slovakia) 

 Slovenian (Slovenia) 

 Spanish (Spain) 

 Spanish (Latin America) 

 Spanish Variation 

 Swedish (Sweden) 

 Turkish (Turkey; F) 

 Turkish (Turkey; Q) 

 Ukrainian (Ukraine) 

Different keyboard layouts can have different mappings between characters, 
potentially causing problems when you enter your passphrase to authenticate. Select 
the keyboard layout that most closely maps to the keyboard you are using, then make 
sure to use that same layout each time you authenticate. 

While typing your password or passphrase, you can press F8 at any time to switch 
between the selected keyboard layout and the secondary English (US) keyboard layout. 

For information on supported characters for passphrases, see Supported Characters for 
Symantec Drive Encryption Passphrases (on page 126). 
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Supported Input Method Editors (IME) 
Symantec Encryption Desktop supports the use of Japanese IME when creating and 
entering passphrases or self recovery questions. No other IME is supported. 

To enable/disable Japanese IME, press Alt+` on US English keyboard. The "`" (accent) 
key is the key above the Tab. Use the Space key is to select Kanji when Japanese IME is 
enabled.  

Japanese IME applies to Windows systems running in BIOS mode. For Windows systems 
running in UEFI mode, IME is not supported. 

 

Ensure Disk Health Before Encryption 
Symantec Corporation deliberately takes a conservative stance when encrypting drives, 
to prevent loss of data. It is not uncommon to encounter Cyclic Redundancy Check 
(CRC) errors while encrypting a hard disk. If Symantec Drive Encryption encounters a 
hard drive or partition with bad sectors, Symantec Drive Encryption will, by default, 
pause the encryption process. This pause allows you to remedy the problem before 
continuing with the encryption process, thus avoiding potential disk corruption and 
lost data. 

To avoid disruption during encryption, Symantec Corporation recommends that you 
start with a healthy disk by correcting any disk errors prior to encrypting. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the bad sectors encountered during encryption are 
logged to the Symantec Encryption Server and the encryption process continues. 

 

Best Practices Recommendation 

As a best practice, before you attempt to use Symantec Drive Encryption, use a 
third-party scan disk utility that has the ability to perform a low-level integrity check 
and repair any inconsistencies with the drive that could lead to CRC errors. Microsoft 
Windows' Check Disk (chkdsk.exe) utility is not sufficient for detecting these issues 
on the target hard drive. Instead, use software such as SpinRite or Norton Disk Doctor™. 
These software applications can correct errors that would otherwise disrupt 
encryption. 

Caution: As a best practice, highly fragmented disks should be defragmented before 
you attempt to encrypt them. 

If you are installing Symantec Drive Encryption on a Windows Server system, go to the 
Symantec Knowledgebase (http://www.symantec.com/docs/TECH164863) and search 
for additional best practices information.. 

 

How to Determine if Your Windows System is Running in UEFI Mode 
Symantec Encryption Desktop encrypts boot disks differently depending upon whether 
your Windows system boots in BIOS mode or UEFI mode. 

 

http://www.symantec.com/docs/TECH164863
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To determine whether your system boots in UEFI mode 

1 On the Windows Start screen, start typing msinfo32 and press Enter. 

2 In the System Information window, look for the following line: 

BIOS Mode is UEFI

If this line is missing, your system is booting in BIOS mode.  

For more information on how to authenticate at PGP BootGuard with either type of 
system, see Authenticating at the PGP BootGuard Screen (on page 130). 

Calculate the Encryption Duration 
Encryption is a time-consuming and CPU-intensive process. The larger the disk or 
partition being encrypted, the longer the encryption process takes. You should consider 
this as you schedule initial encryption of the disk. 

Factors that may affect encryption speed include: 

 the size of the disk or partition 

 the processor speed and number of processors 

 the number of system processes running on the computer 

 the number of other applications running on the system 

 the amount of processor time those other applications require 

With an average system, an 80 GB boot disk or partition takes approximately three 
hours to encrypt using Symantec Drive Encryption (when no other applications are 
running). A very fast system, on the other hand, can easily encrypt such a disk or 
partition in less than an hour. 

You can still use your system during encryption. Your system is somewhat slower than 
usual during the encryption process, although it is fully usable. 

Symantec Encryption Desktop automatically slows the encryption process if you are 
using the system. The encryption process is faster if you avoid using your computer 
during the initial encryption. The system returns to normal operation when the 
encryption process is complete. 

If you decide to run other applications during the encryption process, those 
applications will probably run slightly slower than normal until the encryption process 
is over. 

 

Maintain Power Throughout Encryption 
Because encryption is a CPU-intensive process, encryption cannot begin on a laptop 
computer that is running on battery power. The computer must be on AC power. If a 
laptop computer goes on battery power during the initial encryption process (or a later 
decryption or re-encryption process) Symantec Drive Encryption pauses its activity. 
When you restore AC power, the encryption, decryption, or re-encryption process 
resumes automatically. 
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Regardless of the type of computer you are working with, your system must not lose 
power, or otherwise shut down unexpectedly, during the encryption process, unless you 
have selected the Power Failure Safety option. Do not remove the power cord from the 
system before the encryption process is over. If loss of power during encryption is a 
possibility—or if you do not have an uninterruptible power supply for your 
computer—consider choosing the Power Failure Safety option described in Setting 
Encryption Options (on page 123). 

Caution: This holds true for removable disks, such as USB devices. Unless you have 
selected the Power Failure Safety option, you run the risk of corrupting the device if 
you remove it during encryption. 

 

Run a Pilot Test to Ensure Software Compatibility 
As a good security practice, Symantec Corporation recommends testing Symantec Drive 
Encryption on a small group of computers to ensure that Symantec Drive Encryption is 
not in conflict with any software on the computer before rolling it out to a large number 
of computers. This is particularly useful in environments that use a standardized 
Corporate Operating Environment (COE) image. 

Certain other disk protection software is incompatible with Symantec Drive Encryption 
and can cause serious disk problems, up to and including loss of data. Please note the 
following known interoperability issues, and please review the Symantec Encryption 
Desktop Release Notes for the latest updates to this list. 

Software that is not compatible: 

 Symantec Endpoint Encryption Full Disk 

 Faronics Deep Freeze (any edition) 

 Utimaco Safeguard Easy 3.x 

 Absolute Software's CompuTrace laptop security and tracking product. Symantec 
Drive Encryption is compatible only with the BIOS configuration of CompuTrace. 
Using CompuTrace in MBR mode is not compatible. 

 Hard disk encryption products from GuardianEdge Technologies: Encryption 
Anywhere Hard Disk and Encryption Plus Hard Disk products, formerly known as 
PC Guardian products. 

The following programs co-exist with Symantec Encryption Desktop on the same 
system, but will block the Symantec Drive Encryption feature: 

 Safeboot Solo 

 SecureStar SCPP 

 

 

Determining the Authentication Method for the Disk 
When you encrypt a disk or partition using Symantec Drive Encryption, you choose a 
method that determines how you will authenticate yourself to decrypt the disk. 

You have the following options: 

 Passphrase and Single Sign-On Authentication (on page 122) 
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 Public Key Authentication (on page 122) 

 Token-Based Authentication (on page 122) 

Note: For Windows systems booting in UEFI mode, Passphrase and Single Sign-On 
Authentication are the only available authentication methods. 

 

Note: To authenticate users using Windows PE, you must use passphrase users. 
Token users are not supported. 

Note: Trusted Platform Module (TPM) Authentication is not supported in this 
release. 

 

 

Passphrase and Single Sign-On Authentication 
With passphrase authentication, you specify a passphrase to use when you reboot a 
computer with an encrypted boot disk or partition, or if you attempt to access any other 
encrypted disk or partition. This method requires no additional files or hardware, and 
can be used with fixed as well as removable disks. 

You have two options with passphrase authentication: 

 You can choose a passphrase that you use only with Symantec Drive Encryption. 

 You can synchronize your Symantec Drive Encryption passphrase with your 
Windows Account logon, so you only need to type your passphrase once to unlock 
your encrypted disk or partition and to log in to Windows. If synchronized with 
your Windows login, this option is known as Single Sign-On (SSO). 

For instructions on setting up Single Sign-On, see Using Symantec Drive Encryption 
Single Sign-On (on page 138). 

 

Public Key Authentication 

Note: For Windows systems booting in UEFI mode, public key authentication method 
is not supported. 

With public-key authentication, you specify a public key when encrypting a disk or 
partition using Symantec Drive Encryption. Only the holder of the corresponding 
private key can access the contents of the disk or partition. To do that, they must 
provide the passphrase of their private key. 

Public key authentication is available only for removable disks you use with your 
system. Fixed disks, including boot disks, partitions, or disks in USB enclosures, can use 
either passphrase or token authentication—not public key authentication. 

 

Token-Based Authentication 

Note: For Windows systems booting in UEFI mode, token-based authentication 
method is not supported. 
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If you are using the Symantec Drive Encryption feature to encrypt a fixed disk 
(including your boot disk or partition) and for authentication you want to use a PGP key 
on a token, you must use a PGP keypair on a token or smart card that is compatible with 
Symantec Drive Encryption. For a list of compatible devices, see Using Smart Cards or 
Tokens to Authenticate at the PGP BootGuard Screen (on page 125). 

Using a keypair on a token adds an extra level of security, as you can take the token 
away with you. 

Note that you must install the appropriate drivers for your device before you can 
proceed with disk encryption. For more information, see Preparing a Smart Card or 
Token to Use For Authentication (on page 124). 

 

Trusted Platform Module (TPM) Authentication 

Note: Trusted Platform Module (TPM) Authentication is not supported in this 
release. 

Setting Encryption Options 
Once you have completed the tasks for getting your disk ready for encryption, you 
should review the process for starting initial encryption: 

1 Choose whether to encrypt the entire disk or specific partitions. See 
Partition-Level Encryption (on page 123). 

2 Choose options to use during encryption, such as power failure safety or greater 
encryption speed. See Using Symantec Drive Encryption Options (on page 125). 

3 Select your choice of authentication. See Determining the Authentication Method 
for the Disk (on page 121). 

Note: If you are using token-based authentication, make sure your token is ready 
for use. See Preparing a Smart Card or Token to Use For Authentication (on page 
124). The token-based authentication method applies to Windows systems 
booting in BIOS mode only. 

4 Encrypt the disk as described in Encrypting a Disk or Partition (on page 126). 

Note: If you are a Symantec Encryption Server-managed user, Symantec Drive 
Encryption creates a Recovery Token to use to recover disks for which the 
passphrase has been forgotten. See Creating a Recovery Token in a Managed 
Environment (on page 152). 

 

Partition-Level Encryption 
If your disk is divided into partitions, you can choose to encrypt by partition, rather 
than encrypting the entire disk. You can use this flexibility to encrypt: 

 One disk partition. 

 All disk partitions except one. 
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 Any number of partitions in-between. 

Only the files on the partition(s) that you have selected are encrypted. 

Partition mode supports dual-booting with another operating system (such as Linux) as 
long as you encrypt only your Windows partition. The other operating system must be 
on another, non-encrypted partition. 

Note: For Windows systems booting in UEFI mode, dual-booting is not supported.  

Note: Once a disk or any of its partitions have been encrypted, you cannot change the 
disk’s partitioning (for example, adding or removing a partition, or resizing an 
existing partition). Make sure the disk is partitioned the way you want it before 
protecting it with Symantec Drive Encryption. 

 

Preparing a Smart Card or Token to Use For Authentication 

Note: For Windows systems booting in UEFI mode, authentication with a smart card 
or token is not supported. 

If you choose to authenticate with a smart card or token, please note that you must use 
a compatible device (for a list of compatible devices, see Using Smart Cards or Tokens to 
Authenticate at the PGP BootGuard Screen (on page 125)). 

 Use the proper token model. 

 Consider adding other users (a passphrase user, for example) to the encrypted disk 
in case the token is ever lost. 

 Install the token’s drivers on the system on which you will use the token before 
you use the token. 

 

 

Requirements for Using Smart Cards or Tokens for Authentication 

Please review these requirements and ensure you meet them prior to encryption. 

Warning: Using a keypair on a token to authenticate to a disk or partition encrypted 
using Symantec Drive Encryption increases your security, but if you lose the token 
you can no longer authenticate to the PGP BootGuard login screen, and all the data 
on the disk or partition is lost. For this reason, consider adding other users 
(passphrase, token, or both) to a disk or partition encrypted using Symantec Drive 
Encryption. If your token is lost or stolen, those additional users can authenticate 
and unlock the disk or partition for you. 

 You can use only keypairs stored on the token. You must either create a keypair on 
the SafeNet eToken, or send an existing keypair to the token by choosing Add To 
from the right-click shortcut menu. 

 When you create a keypair on a token, or when you send an existing keypair to the 
token, the passphrase to the private key of that keypair changes to the PIN of the 
token. For an SafeNet eToken, the default PIN is 1234567890. Because this is a 
well-known default PIN, you should immediately change the PIN using SafeNet's 
configuration tools so that the security of the keypair is not severely reduced. 

 Note that keys with spaces in the user name cannot be used for authentication at 
PGP BootGuard. 
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Using Smart Cards or Tokens to Authenticate at the PGP BootGuard Screen 

This section provides instructions for using smart cards to authenticate at the PGP 
BootGuard screen. For information on compatible smart cards/tokens and readers, see 
the System Requirements section available in the Symantec Encryption Desktop 10.4  
for Windows Release Notes. 

 

Before using Smart Cards or Tokens 
Before you use any smart card or token, install the latest software drivers on the system 
on which you will be using the token. Microsoft Windows may recognize the token 
generically if you do not install the software drivers, but Symantec Encryption Desktop 
requires the appropriate software drivers to be installed.  

For example , if you want to use eToken PKI Client (RTE), download the latest version 
of the eToken PKI Client (RTE) driver software, and then install it on your system. 
When the installation of the eToken PKI client driver software on your system is 
complete, open Symantec Encryption Desktop and click the PGP Keys control box. If the 
driver software was installed correctly, you see Smart Card Keys listed in the PGP Keys 
control box. 

If you see No suitable key available in the Select Key field when you specify Token Key 
User as your method of authentication for the disk or partition you are encrypting 
using Symantec Drive Encryption, it means one of several things: 

 Your eToken is not inserted. 

 The driver software is not the right version, or was not installed correctly. 

 The keypair on the token cannot be used, or there is no key on the eToken (that is, 
the eToken is empty). 

 

 

Using Symantec Drive Encryption Options 
The Symantec Drive Encryption feature offers the Power Failure Safety option that you 
can select prior to protecting your disk or partition: 

 Power Failure Safety. While you can pause the initial encryption process at any 
time by properly shutting down or restarting your computer, it is exceptionally 
important to avoid unexpected shutdowns (power failures, power cord gets pulled 
out, and so on). If this is a possibility for you—or if you do not have an 
uninterruptible power supply for your computer—consider choosing the Power 
Failure Safety option. When Power Failure Safety is selected, encrypting is 
journaled; if the power fails, the encryption process can safely and accurately 
resume where it was interrupted. However, this option can cause initial encryption 
to take several times longer to complete. 

This is also useful when encrypting USB devices. Interrupting encryption by 
removing a USB device during encryption can corrupt the device and require that 
it be reformatted. Encrypting with Power Failure Safety mode permits you to 
remove the USB device during encryption and resume encryption once it is 
reinserted. 
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Encrypting a Disk or Partition 
Once you have prepared the disk and specified encryption options, you can encrypt the 
disk or partition. Note the following before you begin: 

 If you are using a USB token for authentication to a fixed disk protected using 
Symantec Drive Encryption, make sure you have the correct token and you have 
installed the proper driver software. For more information, see Token-Based 
Authentication (on page 122). 

Note: Token-based authentication is not available for Single Sign-On on 
Windows systems booting in UEFI mode. 

 Your system is somewhat slower than usual during the encryption process, 
although it is fully usable. It returns to normal operation when the encryption 
process is complete. 

Symantec Encryption Desktop automatically slows the encryption process if you 
are using the system. The encryption process is faster if you avoid using your 
computer during the initial encryption. 

 You can minimize or close Symantec Encryption Desktop during encryption. This 
does not affect the process, but it does improve the speed of the encryption 
process. 

 To stop the encryption process for a short time, click Stop, then click Pause on the 
dialog box. Click Resume to restart. You may need to authenticate after you click 
Resume. 

 To shut down the system before the encryption process is over, perform a normal 
shutdown. You do not need to pause the process. When you restart, the encryption 
process automatically resumes where it left off. 

 You can only encrypt, decrypt, or re-encrypt one disk or partition at a time. Once 
you begin an operation on a disk or partition, you cannot start encrypting another 
one until the process is complete on the first. You cannot circumvent this by 
pausing the first operation. 

 

 

Supported Characters for Symantec Drive Encryption Passphrases 
The Symantec Drive Encryption feature supports alphanumeric characters, 
punctuation characters, standard meta-characters, and extended ASCII characters 
when creating passphrases. Tab and control characters are not supported. As you 
choose a passphrase, note the following: 

 The following characters are supported: 

abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ

0123456789

`~!@#$%^&*()_+={}\|:;[]'"<>,.?/-

 Cyrillic characters are supported. 
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Encrypting the Disk 
Before you encrypt your disk, be sure to back it up so that you won’t lose any data if 
your laptop or computer is lost, stolen, or you are unable to decrypt the disk. 

You can only encrypt, decrypt, or re-encrypt one disk or partition at a time. Once you 
begin an operation on a disk or partition, you cannot start encrypting another one until 
the process is complete on the first. You cannot circumvent this by pausing the first 
operation. 

Caution: While your disk is encrypting, do not accept any operating system updates if 
they are offered. If the update occurs automatically, do not restart your computer 
until the encryption process has completed. 

To protect a disk or partition using Symantec Drive Encryption 

1 Open Symantec Encryption Desktop and click on the PGP Disk Control box. The 
PGP Disk Control box highlights. 

2 Click Encrypt Disk or Partition. The Encrypt Disk or Partition work area displays, 
and you see a listing of the disks on your system that can be protected by 
Symantec Drive Encryption: disks, disk partitions, removable media, and so on. 

3 In the Encrypt Disk or Partition work area, in the Select disk or partition to 
encrypt section at the top, click to select the disk or partition on your computer 
that you want to protect using Symantec Drive Encryption. 

Note: For Windows systems booting in UEFI mode, if the disk selected for 
encryption is the boot disk, then ensure that the boot disk has a System Partition 
with more than 10 MB of free space. 

4 Choose the Encryption Options that you want to use, if any. For more information 
about your choices, see Using Symantec Drive Encryption Options (on page 125). 

5 In the User Access section, specify how you want to access your protected disk or 
partition: 

Note: For Windows systems booting in UEFI mode, token-based method is not 
supported. To determine whether your system is booting in UEFI mode, see How 
to Determine if Your Windows System is Running in UEFI Mode (on page 119). 

 Token-based Public Key User. If you are protecting a fixed (non-removable) 
disk on your system. Use this option on Windows systems booting in BIOS 
mode. Token-based authentication is not available on Windows systems 
booting UEFI mode. 

 Type the user name or email address associated with the key, then 
press Enter to find the key. You can also select Add User Key. A list of 
the keypairs on your keyring is displayed. From the key source box, 
select the public key or keys that you want to use. Click Add to move 
the keys to the Keys to add field and then click OK. Click Encrypt. 

 Passphrase User. If you want to protect your disk or partition with a 
passphrase, select New Passphrase User. The PGP Disk Assistant: Whole 
Disk Encryption - New User dialog box is displayed. 
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 To unlock your encrypted disk using your Windows Account Logon, 
select Use Windows Password then click Next. In the PGP Disk 
Assistant: Two Factor Authentication dialog box, select Proceed with 
Passphrase Authentication only and click Next. In the PGP Disk 
Assistant: Windows Account Logon dialog box, type your Windows user 
name, domain, and password, and click Next. Click Finish. 

If you choose the Use Windows Password option, after initial encryption, 
use your Windows password when the PGP BootGuard screen is displayed 
at the start of booting. The PGP Single Sign-On (SSO) feature logs into 
Windows for you—you only need to type your passphrase once. (This is the 
Single Sign-On feature. For more information, see Using Symantec Drive 
Encryption Single Sign-On (on page 138).) 

 To unlock your encrypted disk or partition using a new passphrase, 
select Create New Passphrase, then click Next. In the PGP Disk 
Assistant: Two Factor Authentication dialog box, select Proceed with 
Passphrase Authentication only and click Next. In the PGP Disk 
Assistant: Create Username and Passphrase dialog box, type the name 
of the new user and the passphrase you want associated with the user. 
Type the passphrase again in the Confirm field and click Next. Click 
Finish. 

Note: As a security precaution, the passphrase that you create for the passphrase 
user expires periodically.  As a best practice for your data security, you must 
change your passphrase immediately when your passphrase expires.  

Normally, as an added level of security, the characters you type for the passphrase 
are not visible on the screen. However, if you are sure that no one is watching 
(either physically over your shoulder or scanning for the radio waves emitted by 
your monitor) and you would like to see the characters of your passphrase as you 
type, select the Show Keystrokes checkbox. See The Passphrase Quality Bar (on 
page 254). 

For better data protection, your passphrase expires after a certain number of days. 

Caution: It is strongly recommended that you use a supported keyboard layout 
when you are creating a passphrase for your disk or partition protected with 
Symantec Drive Encryption (for more information, see Supported Keyboards (on 
page 117). The Whole Disk Encryption log-in screen assumes you are using one 
of these keyboard layouts when you type your passphrase to authenticate. Using 
a different keyboard layout could result in problems authenticating. For more 
information, see Authenticating at the PGP BootGuard Screen (on page 130). 

6 Confirm that you have the user access arrangement that you want, then click 
Encrypt. 

7 Read the information in the dialog box, and then click OK. 

8 To see how much of the disk has been encrypted, refer to the Encryption Progress 
bar. 

Note: Symantec Encryption Desktop maps a drive before encrypting it. The time 
it takes to map the drive adds up to the overall time taken to start the encryption 
process. The larger the size of the drive is, the longer it takes to map the drive 
and, therefore, to start encryption. 

9 To stop the encryption process temporarily, click Stop, then click Pause in the 
dialog box is displayed. To resume, click Resume. You may be prompted for the 
appropriate passphrase. 

 



 
Protecting Disks with Symantec Drive Encryption 129 

 
 
 

 

Using a Symantec Drive Encryption-Encrypted Disk  

Note: If the encryption process stops and Symantec Encryption Desktop 
indicates a disk read/write error, it means that Symantec Encryption Desktop 
has encountered bad sectors on your disk or partition during the encryption 
process. You can continue encryption or abort the process and fix the errors. See 
Encountering Disk Errors During Encryption (on page 129). If you are using 
Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment, the bad sectors encountered during encryption are logged to the 
Symantec Encryption Server and the encryption process continues. 

When the encryption process completes, the User Access section displays the user 
you used to encrypt the disk with, and additional user access options become 
available so you can add a new user, change the passphrase, or delete a user. 

10 Once your disk has been encrypted, Symantec Corporation recommends that you 
then create a recovery disc or drive. For more information, see Creating and Using 
a Recovery Disc (on page 154) or Creating and Using a Recovery USB Drive for 
Microsoft Windows 7 and Windows 8 UEFI-Based Systems (on page 155). 

 

 

Encountering Disk Errors During Encryption 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the bad sectors encountered during encryption are 
logged to the Symantec Encryption Server and the encryption process continues. 

Many hard disks have bad sectors. If Symantec Drive Encryption encounters bad disk 
sectors during encryption, encryption pauses. You are warned that Symantec Drive 
Encryption has encountered disk errors. (Note that these errors are unrelated to 
encryption; they are an indication that your hard disk needs maintenance.) 

You can do one of the following: 

 Force encryption to continue by clicking Yes. Disk errors are frequently 
encountered and often harmless. Clicking Yes will continue the encryption 
process and Symantec Drive Encryption will ignore further errors. 

 Stop encryption by clicking No, completely decrypt the disk, and then repair the 
disk errors using a tool such as SpinRite or Norton Disk Doctor before making 
another attempt to encrypt the disk. If you know that your disk is seriously 
fragmented or has many bad sectors, you should immediately perform the 
maintenance that your hard disk needs before encrypting the disk. 

 

 

Using a Symantec Drive Encryption-Encrypted Disk 
Your computer boots up in a different way once you use Symantec Drive Encryption to 
protect the boot disk—or a secondary fixed disk—on your system. On power-up, the first 
thing you see is the PGP BootGuard log-in screen asking for your passphrase. 

Symantec Drive Encryption then decrypts the disk. If you enabled the Single Sign-On 
feature (that is, you synchronized your Symantec Drive Encryption passphrase with 
your Windows Account logon), you are also logged on to Windows. 
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When you use a Symantec Drive Encryption-encrypted disk, it is decrypted and opened 
automatically as needed. With most modern computers, after the disk is completely 
encrypted, there is no noticeable slowdown of your activities. 

Once you decrypt a disk or partition, its files are available to you—as well as anyone else 
who can physically use your system. Your files are unlocked until you lock them again 
by shutting down your computer. 

Warning: Because your files remain unlocked until you lock them again, you may 
want to use a PGP Virtual Disk volume for files that need to be secured even while 
your computer is in use. See Using PGP Virtual Disk (on page 161). 

When you shut down a system with an encrypted boot disk or partition, or if you 
remove an encrypted removable disk from the system, all files on the disk or partition 
remain encrypted and fully protected—data is never written to the disk or partition in 
an unencrypted form. Proper authentication (passphrase, token, or private key) is 
required to make the files accessible again. 

 

Authenticating at the PGP BootGuard Screen 
The PGP BootGuard log-in screen prompts you for the proper passphrase for a 
protected disk or partition for one of two reasons: 

 If your boot disk or partition is protected using Symantec Drive Encryption, you 
must authenticate correctly for your system to start up. This is required because 
the operating system files that control system startup are encrypted, and must be 
decrypted before they can be used to start up the system. The PGP Single Sign-On 
feature also logs into Windows for you, if you chose the SSO option when you first 
encrypted the boot disk or partition. 

 If a secondary fixed disk or partition is protected using Symantec Drive 
Encryption, you can authenticate at startup so that you don’t have to authenticate 
later when you need to use files on the secondary disk or partition. Because the 
files on the secondary (non-boot) disk or partition are not required for startup, you 
are not required to authenticate at startup. If you do not authenticate at startup, 
you are asked to authenticate later, when you try to use the files on the secondary 
disk or partition.  

Note: The PGP BootGuard log-in screen accepts the authentication information from 
any user configured for an encrypted disk or partition. For example, if you have two 
users configured for a boot disk or partition and two different users configured for a 
secondary fixed disk or partition on the same system, any of the four configured 
users can use their passphrase to authenticate on the PGP BootGuard log-in screen 
at startup, even the two users configured on the secondary disk or partition. 

On the PGP BootGuard log-in screen you can: 

 Authenticate an encrypted boot or secondary disk or partition on the system. 

 View information about the disks or partitions on your system. This option is 
available on Windows BIOS systems. 

 Choose your keyboard layout. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have customized the Symantec Drive Encryption BootGuard screen to include 
additional text or a custom image such as your organization's logo. Your actual login 
screen may look different if your administrator has customized the screen. 
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To authenticate using the PGP BootGuard log-in screen 

1 Start or restart the system that has a disk or partition protected by Symantec 
Drive Encryption. On startup, the PGP BootGuard log-in screen is displayed. 

2 To change the keyboard layout, press F2 and select a keyboard from the list 
displayed. Press F8 at any time to switch between the selected layout and 
secondary layout. 

Note: The secondary keyboard layout is always English (US). 

3 Type a valid passphrase or Windows password and press Enter. 

Caution: The PGP BootGuard log-in screen assumes you are using one of the 
supported keyboard layouts when you type your passphrase. If you used a 
different keyboard layout to create the passphrase for a disk or partition 
protected by Symantec Drive Encryption, you could have problems 
authenticating because the mappings between the keyboard layouts may be 
different. See Selecting Keyboard Layouts (on page 135). 

To see the characters you type, press Tab before you begin typing. 

If you make a typing error, or think you might have made a typing error, press Esc 
to clear all characters and start again. 

If local self recovery has been configured and you have forgotten your passphrase, 
select Forgot Passphrase. For more information, see If You Forgot Your 
Passphrase (on page 146).   

Note: Token authentication in PGP BootGuard requires pressing Ctrl+Enter 
instead of just Enter. You may also experience some delay during the 
authentication of tokens in PGP BootGuard. For Windows systems booting in 
UEFI mode, token-based authentication is not available.  

4 If you typed a valid passphrase, the PGP BootGuard log-in screen goes away and 
the system boots normally. 

When you first encrypted the boot disk, if you chose to use your Windows Account 
Logon to authenticate, the Symantec Drive Encryption feature logs into Windows 
for you. You only need to type your passphrase once. 

If you typed an invalid passphrase, an error message is displayed. Try typing the 
passphrase again. 

 

Authenticating with a Microsoft Surface Pro System 

In order to authenticate with the keyboard on a Microsoft Surface Pro 2 system, 
whether you have a Touch cover or a Type cover, you need to "activate" the keyboard 
first. To do this, from a powered off state, press the Power button and the volume down 
button at the same time. Once the Symantec Encryption Desktop authentication screen 
appears, authenticate as usual. 

To enable compatibility with Secure Boot on Microsoft Surface Pro 2 and Surface Pro 3 
laptops, search and download the Microsoft Surface Pro UEFI CA OEM PK Tool from 
Microsoft's download center and run the tool. Note that this tool can only be run when 
your system is decrypted and Secure Boot is enabled. 
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Authenticating Using an External Keyboard on a Windows 8/8.1/10 UEFI System 

If you are authenticating using an external keyboard on a Windows 8/8.1/10 system 
running in UEFI mode, be sure that you plug in the keyboard before you power on your 
system. 

If you are using a USB keyboard, certain BIOS settings (such as Fast/Quick Boot mode) 
might delay USB initialization and prevent USB and detachable keyboards from 
working during pre-boot authentication. In addition, some systems require that XHCI 
Pre-boot Mode be enabled in the USB Configuration for the external keyboard to work 
at pre-boot authentication. 

If you are using a tablet, Windows 8/8.1/10 32-bit systems running in UEFI mode are 
not supported. 

If you encounter issues with your external keyboard, refer to your system user guide to 
determine how to activate the USB connections. 

See also How to Determine if Your Windows System is Running in UEFI Mode (on page 
119). 

Authenticating with a User Name and Domain 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your administrator may require authenticating at PGP 
BootGuard with your user name and domain. The PGP BootGuard screen displays fields 
for you to enter your user name, domain, and passphrase. Depending on the settings 
specified by your administrator, the information in the user name and domain fields 
may be filled in automatically based on the last information entered. The passphrase 
you enter depends on the type of user you are: 

 If you are an SSO passphrase user, the passphrase you enter is the one associated 
with your Windows domain login. When you have entered the correct information, 
the system continues to boot into the operating system and automatically logs you 
in to Windows.  

 If you are a normal passphrase user, the passphrase you enter is the one you 
created when you added a user and encrypted your disk. This type of user is not 
associated with a Windows domain. When you have entered the correct 
information, the system continues to boot and then you are prompted to enter 
your Windows credentials. 

 

 

Using multiple keyboard layouts in PGP BootGuard 

Maintenance Pack 8 adds a secondary keyboard layout that can be used during pre-boot 
authentication. This feature enables users to select and enter text with two keyboard 
layouts active. 

Note: The secondary keyboard layout is always English (US). You cannot change the 
language of the secondary keyboard layout. 
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Authenticating Using a Virtual Keyboard on a Tablet PC 

This section describes how to use a virtual keyboard on your Tablet PC to enter your 
passphrase and authenticate at the PGP BootGuard screen.  

The following instructions describe how to use the virtual keyboard displayed at the 
PGP BootGuard screen. If you have docked your system or have an external keyboard 
connected directly to your system, you can also use that keyboard to authenticate. 

To use the virtual keyboard 

1 When you reboot your computer, the PGP BootGuard screen appears. On this 
screen is a virtual keyboard. 

2 Enter your passphrase using the virtual keyboard (using a pen or your fingertip). 

3 When you are finished, on the virtual keyboard press the Enter key. 

Note: The Continue and Advanced menu items displayed in the PGP BootGuard 
screen are not buttons and cannot be selected using the touch screen on your Tablet 
PC.  

 

Audible Sounds During Authentication 

This option is available on Windows systems booting in BIOS mode. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, and your Symantec Encryption Server administrator has 
enabled this option, your system makes audible sounds during PGP BootGuard 
authentication. There are three different tone pairs to indicate when to enter a 
passphrase, and the success or failure of authentication. 

Each indicator starts with a middle sound and the second sound is higher, the same, or 
lower. 

 When the system is first ready for passphrase/pin entry, the middle-middle 
(ready) sound is played. When you hear this sound, enter your passphrase and 
press Enter. 

 After you have entered a passphrase, the tones played depend on the success or 
failure of the passphrase: 

 If passphrase authentication succeeded, the middle-high sound is played. 
The system then continues booting. 

 If passphrase authentication failed, the middle-low sound is played. The PGP 
BootGuard authentication screen is displayed and the passphrase field is 
cleared so you can re-enter your passphrase. 

Note that these sounds cannot be customized by your Symantec Encryption Server 
administrator. The administrator can specify only if audible sounds are enabled during 
PGP BootGuard authentication. 
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Becoming Locked Out at the PGP BootGuard Screen 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have specified a PGP BootGuard lockout. You are "locked out" if you exceed the 
maximum allowed number of passphrase attempts at the PGP BootGuard screen. This 
applies only to passphrase users (token users are not affected). 

To remove the lockout, please contact your Symantec Encryption Server administrator. 
 

Using Keyboard Shortcuts in the PGP BootGuard Screen 

When you are authenticating at the PGP BootGuard screen, the following keyboard 
shortcuts are available to you. To access the list of keyboard shortcuts while in the PGP 
BootGuard screen, press F1. 

Key Description 

F1 On Windows systems running in BIOS mode: 

Display the help. 

On Windows systems running in UEFI mode: 

Disabled. 

F2 Display the keyboard screen (to change keyboards). 

F3 Hide/show passphrase or PIN characters. 

F4 Display the options to bypass PGP BootGuard if you forgot your 
passphrase. If local self-recovery is not configured, the WDRT 
screen appears. 

F5 Display the Administrator login screen. 

F6 On Windows systems running in BIOS mode: 

Display the user bypass screen. 

On Windows systems running in UEFI mode: 

Disabled. 

F7 On Windows systems running in BIOS mode: 

Display the token login screen. 

On Windows systems running in UEFI mode: 

Disabled. 

F8 Switch between keyboard layouts. 

Up On Windows systems running in BIOS mode: 

Change selection to the previous option or, when viewing the help, 
scroll the text up. 

On Windows systems running in UEFI mode: 

Disabled. 

Down On Windows systems running in BIOS mode: 

Change selection to the next option or, when viewing the help, 
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scroll the text down. 

On Windows systems running in UEFI mode: 

Disabled. 

Enter Depending on the screen, this key can authenticate the passphrase, 
select the option, return to the Login screen, or display the Forgot 
Passphrase screen. 

Tab Move to next field. 

Shift+Tab Move to previous field. 

Esc When entering a user name or passphrase, clears the field. 
Otherwise, cancels and returns to the Login screen. 

Backspace Deletes the previous character. 

Delete On Windows systems running in BIOS mode: 

The same as backspace. To correct errors in the passphrase field, 
use Esc to clear the field. 

On Windows systems running in UEFI mode: 

Disabled. 

The following navigation keys are recommended for visible entries only. To verify the 
characters at the cursor location when using these keys in the passphrase field, press 
F3 to show the hidden characters.  

Left On Windows systems running in BIOS mode: 

Moves the cursor to the left. 

On Windows systems running in UEFI mode: 

Disabled. 

Right On Windows systems running in BIOS mode: 

Moves the cursor to the right. 

On Windows systems running in UEFI mode: 

Disabled. 

Home On Windows systems running in BIOS mode: 

Moves the cursor to the beginning of the field. 

On Windows systems running in UEFI mode: 

Disabled. 

End On Windows systems running in BIOS mode: 

Moves the cursor to the end of the field. 

On Windows systems running in UEFI mode: 

Disabled. 

 

 

Selecting Keyboard Layouts 
On Windows systems, the Symantec Drive Encryption log-in screen supports the 
following keyboard layouts: 

 Belgian (Belgium; Comma) 

 



 
136 Protecting Disks with Symantec Drive Encryption 

 
 
 

 

Using a Symantec Drive Encryption-Encrypted Disk 

 Belgian (Belgium; Period) 

 Bosnian (Bosnia) 

 Bosnian (Bosnia; Cyrillic) 

 Bulgarian (Bulgaria) 

 Bulgarian (Bulgaria; Latin) 

 Bulgarian (Bulgaria; Typewriter) 

 Canadian Multilingual Standard (Canada) 

 Chinese Simplified (China, Singapore) 

 Chinese Traditional (Hong Kong, Taiwan) 

 Croatian (Croatia) 

 Czech (Czech Republic; QWERTY) 

 Danish (Denmark) 

 Dutch (The Netherlands) 

 English (United States) 

 English (United Kingdom) 

 English (US-International) 

 Estonian (Estonia) 

 Finnish (Finland) 

 French (Belgium) 

 French (Canada) 

 French (France) 

 French (Switzerland) 

 German (Germany/Austria) 

 German (IBM) 

 German (Switzerland) 

 Hebrew (Israel) 

 Hungarian (Hungary) 

 Hungarian (Hungary; 101 keys) 

 Icelandic (Iceland) 

 Irish (Ireland) 

 Italian (Italy) 

 Italian (Italy; 142 keys) 

 Japanese (Japan) 

 Korean (Korea) 

 Norwegian (Norway) 

 Polish (Poland; Programmers) 

 Polish (Poland; 214 keyboard) 
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 Portuguese (Brazil; ABNT keyboards) 

 Portuguese (Brazil; ABNT2 keyboards) 

 Portuguese (Portugal) 

 Romanian (Romania) 

 Russian (Russia; Cyrillic) 

 Serbian (Serbia and Montenegro; Cyrillic) 

 Serbian (Serbia and Montenegro; Latin) 

 Slovak (Slovakia) 

 Slovenian (Slovenia) 

 Spanish (Spain) 

 Spanish (Latin America) 

 Spanish Variation 

 Swedish (Sweden) 

 Turkish (Turkey; F) 

 Turkish (Turkey; Q) 

 Ukrainian (Ukraine) 

Different keyboard layouts can have different mappings between characters, 
potentially causing problems when you enter your passphrase to authenticate. Select 
the keyboard layout that most closely maps to the keyboard you are using, then make 
sure to use that same layout each time you authenticate. 

While typing your password or passphrase, you can press F8 at any time to switch 
between the selected keyboard layout and the secondary English (US) keyboard layout. 

To select a keyboard layout for Windows systems booting in BIOS mode 

1 Start or restart the system with the disk or partition protected by Symantec Drive 
Encryption. On startup, the PGP BootGuard log-in screen is displayed. 

2 Press the down arrow on your keyboard until Keyboard is highlighted. 

3 Press Enter. The Keyboard layouts screen is displayed. 

4 Press Tab to move focus to the list of keyboard layouts, then use the up and down 
arrows on your keyboard to select the desired keyboard layout. 

5 Press Tab again. The Go Back option highlights. 

6 Press Enter. The PGP BootGuard log-in screen is displayed again. 

7 (Optional) While typing your password or passphrase, press F8 at any time to 
switch between the selected layout and the secondary layout. 

Note: The secondary keyboard layout is always English (US). 

To select a keyboard layout for Windows systems booting in UEFI mode 

1 Start or restart the system with the disk or partition protected by Symantec 
Encryption Desktop. On startup, the PGP BootGuard log-in screen is displayed. 

2 Press F2. The Keyboard layouts screen is displayed. 
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3 Use the Up and Down arrows on your keyboard to select the desired keyboard 
layout.  

4 Press Enter. The PGP BootGuard log-in screen is displayed again. 

5 (Optional) While typing your password or passphrase, press F8 at any time to 
switch between the selected layout and the secondary layout. 

Note: The secondary keyboard layout is always English (US). 

 

Using Symantec Drive Encryption Single Sign-On 
Single Sign-On allows you to use your existing Windows passphrase to both 
authenticate to your Symantec Drive Encryption-encrypted drive and automatically log 
you into Windows. 

How does Single Sign-On Work? 
Single Sign-On utilizes one of the methods Microsoft Windows provides for 
customizing the Windows login experience. Symantec Drive Encryption uses your 
configured authentication information to dynamically create specific registry entries 
when you attempt to log in. 

Note: Your Windows password is never stored in the registry, nor in any form on the 
disk—neither encrypted, nor as cleartext. 

Your Symantec Encryption Server administrator can add you as a Windows user for 
Drive Encryption single sign-on without knowing or providing your correct Windows 
password.  

Because that Windows password is not correct, single sign-on fails, and you will have to 
log in to Windows manually. However, once you have logged in to Windows 
successfully, your correct password is then synchronized with the Drive Encryption 
SSO record. Once synchronized, SSO occurs automatically -- the next time you log on at 
PGP BootGuard, you are automatically logged in to Windows using SSO. 

Prerequisites for Using Single Sign-On 
 You must have Symantec Drive Encryption installed. 

 

Local users and Single Sign-On 

If a computer is not a member of a domain, Symantec Drive Encryption automatically 
disables certain User Access features when a Single Sign-On user is added to a disk, 
including 'Use Welcome Screen' and 'Fast User Switching' (which relies on the welcome 
screen), such that it then makes the Windows Security panel available when using the 
Ctrl+Alt+Delete key combination. 

These features are already automatically disabled if computers are members of a 
domain. 
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Encrypting the Disk to Use Single Sign-On 

To encrypt the disk to use Single Sign-On 

1 Click the PGP Disk control box, then select Encrypt Disk or Partition. 

2 Select the disk or partition that you want to encrypt, and choose the Symantec 
Drive Encryption options, if any. For information on these options, see Setting 
Encryption Options (on page 123). 

3 In the User Access section, select New Passphrase User. 

4 Select Use Windows Password, and then click Next. 

5 Type your Windows login password, and then click Finish. 

Symantec Drive Encryption verifies that your name is correct across the domain, 
and that the Windows password is correct. Symantec Drive Encryption also checks 
your password to make sure that it contains only allowable characters. If your 
password does contain any such characters, you are not allowed to continue. See 
Supported Characters for Symantec Drive Encryption Passphrases (on page 126) for 
information on allowable characters. 

6 Click Encrypt, and then click OK. 

 

 

Using the 'Fast Startup' Option with Single Sign-On on Windows 8/8.1/10 
If your system is running Windows 8/8.1/10, you can take advantage of the 'fast 
startup' option while using Single Sign-On in Symantec Drive Encryption. 

Note: SSO is not supported on Windows 8/8.1/10 systems running in BIOS mode, 
with the 'fast startup' option enabled. 

To use the 'fast startup' option: 

 In Windows 8/8.1/10, make sure the 'fast startup' option is selected from Power 
Options / Shutdown settings ("Turn on fast startup"). This option is enabled by 
default. 

 In Symantec Drive Encryption, make sure your disk or boot partition is completely 
encrypted for Single Sign-On (see Encrypting the Disk to Use Single Sign-On (on 
page 139)). 

 

Multiple Users and Single Sign-On 
You can configure up to 28 users for Single Sign-On. Symantec Corporation, however, 
recommends limiting the number of Single Sign-On users to the fewest possible 
persons who must share the system. While technically feasible to do so, a large number 
of users sharing a single, encrypted computer is not a secure solution, and Symantec 
Corporation discourages this practice. 

Note: The Single Sign-On feature is passphrase-only; you cannot utilize Single 
Sign-On with users' keys, nor is the feature compatible with smart cards or tokens. 
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Logging in with Single Sign-On 
Once you have configured Single Sign-On, when you start up the system, the PGP 
BootGuard screen is displayed. If you provide the correct user name and password 
Symantec Drive Encryption logs you in to the Windows session and provides access to 
those disk partitions encrypted with Symantec Drive Encryption. 

 

Changing Your Passphrase With Single Sign-On 
To synchronize your Windows password changes with Symantec Drive Encryption, you 
must change your password for Single-Sign On using the Change Password feature in 
the Windows Security dialog box, which you access by pressing Ctrl+Alt+Del. 

To change your passphrase 

1 Press Ctrl+Alt+Delete. 

2 Type your old password. 

3 Type and confirm your new password. 

4 Click OK. 

Single Sign-On automatically and transparently synchronizes with this new 
password. You can use the new password immediately, in your next login attempt. 

Caution: If you change your password in any other manner—by using the Domain 
Controller, the Windows Control Panel, the system administrator, or from another 
system—your next login attempt on the PGP BootGuard screen will fail. You must 
then supply your old Windows password. Successful login on the PGP BootGuard 
screen using your old Windows password then brings up the Windows Login 
username/password screen. You must then log in successfully using your new 
Windows password, at which time Symantec Drive Encryption will synchronize with 
the new password. 

 

Displaying the Windows Login dialog box 
When using Symantec Drive Encryption with SSO, once you have successfully entered 
your passphrase at the PGP BootGuard, you are automatically logged in to your 
computer. As soon as Windows has started up, your Windows desktop is displayed. 

However, there may be times when you need to log in to your system using the 
Windows Login dialog box, rather than automatically logging in. For example, you may 
need to access certain network dialog boxes, such as your corporate VPN, that might be 
bypassed using SSO. 

To skip Symantec Drive Encryption SSO login and display the Windows Login 

1 Log in to your computer at the PGP BootGuard screen as usual by entering your 
passphrase and pressing Enter. 
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2 When the Microsoft Windows splash screen is displayed, press and hold the Shift 
key until the Windows Login dialog box is displayed. Note that you can press the 
Shift key when the splash screen is about halfway through the Windows boot 
process. 

3 When the Windows Login dialog box is displayed, enter the information to log in 
to your system. 

 

 

Maintaining the Security of Your Disk 
The following sections describe how to work with your disk once you have encrypted it 
with Symantec Encryption Desktop. 

 

Getting Disk or Partition Information 
This section applies to Windows systems running in BIOS mode. 

To see read-only disk or partition information on the Advanced PGP BootGuard log-in 
screen 

1 Start or restart the system that has a disk or partition protected using Symantec 
Drive Encryption. On startup, the PGP BootGuard log-in screen is displayed. 

2 Press the down-facing arrow on your keyboard. In the lower right corner, 
Advanced highlights. 

3 Press Enter. The Advanced PGP BootGuard log-in screen is displayed. 

This screen displays the following information: 

 All disks or partitions on the system, including the encryption status of disks 
or partitions protected using Symantec Drive Encryption. 

 The computer name (if allowed by Symantec Encryption Server policy). Note 
that if you just changed your computer name, it is not updated in this screen 
until you log out or restart your system. 

 The computer ID. 

 The disk or partition that is currently selected. 

4 To return to the PGP BootGuard log-in screen, highlight Go Back in the lower right 
corner of the screen, then press Enter. 

 

 

Modifying the System Partition 

Do not make any changes to the system partition on a boot disk that has been encrypted 
by Symantec Encryption Desktop; it will fail to boot properly on the next startup. If you 
must make changes to the partitioning of an encrypted disk, decrypt the disk first and 
then make the partition changes. 
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Adding Other Users to an Encrypted Disk or Partition 
The user who creates an encrypted disk or partition can make it available to others. 
These additional users can access the encrypted disk or partition using their own 
unique passphrase, private key, or token (including PIV cards). You can have up to 124 
users per encrypted disk. 

To determine what type of user is associated with the encrypted disk, move your cursor 
over the user's name in the User Access list. A "hint" is displayed showing the type of 
user. A token key icon is used to indicate a token user and the Windows Domain/User 
Name is displayed for an SSO user. 

Caution: Having multiple users who can access a disk or partition protected by 
Symantec Drive Encryption serves as a backup in case one person forgets their 
passphrase or loses their authentication token. Users configured for an encrypted 
disk or partition can authenticate to the Symantec Drive Encryption log-in screen to 
unlock any protected disk or partition on that system. 

To add additional users to a disk or partition protected by Symantec Drive Encryption 

1 Click the PGP Disk Control box on the left pane of the Symantec Encryption 
Desktop main screen. 

2 Select the encrypted disk or partition to which you want to add another user in the 
list of disks at the top of the PGP Disk Work area. 

3 Click New Passphrase User. The Select User Type dialog box is displayed. 

4 Follow the instructions provided in the User Access step in Encrypting the Disk (on 
page 127). 

Note: Public key encryption is the most secure protection method when adding other 
users to disks or partitions encrypted with Symantec Drive Encryption because: (1) 
There is no need to reveal passphrases to new users, so the risk of passphrases being 
intercepted or overheard is minimal. (2) Other users do not need to memorize 
another passphrase. (3) It is easier to manage lists of users if each uses their own 
private key to access the disk. If you are protecting a boot disk or partition with 
Symantec Drive Encryption, the public key must be on a token. Use this option on 
Windows systems booting in BIOS mode. This option is not available on Windows 
systems booting in UEFI mode. 

 

Deleting Users From an Encrypted Disk or Partition 
At some point you may want to remove the ability of a user to access an encrypted disk 
or partition. 

To remove a user from an encrypted disk or partition 

1 On the Encrypt Whole Disk (Partition) screen, select the appropriate disk or 
partition protected by Symantec Drive Encryption. 

2 From the User Access list, select the name of the user you want to remove. 

3 Click Delete User. The Passphrase dialog box is displayed, prompting you to 
authenticate. 
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4 Type a valid passphrase, then click OK. The alternate user is removed. 

 

 

Changing User Passphrases 
If you are using Single Sign-On, change your password as described in Changing Your 
Passphrase when the Single Sign-On Feature is Used (on page 144). 

To change user passphrases on an encrypted disk or partition 

1 On the Encrypt Whole Disk (Partition) screen, select the appropriate disk or 
partition protected by Symantec Drive Encryption. 

2 In the User Access list, select the name of the user whose passphrase you want to 
change. 

3 Click Change Passphrase. You are prompted to type the current passphrase. 

4 Type the appropriate passphrase, then click OK. The Change User Passphrase 
dialog box is displayed. 

5 Type a new passphrase. 

6 In the Confirm Passphrase field, type the new passphrase again, then click OK. 
The passphrase is changed. 

The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating. For more information, see The Passphrase Quality 
Bar (on page 254). 

Normally, as an added level of security, the characters you type for a passphrase 
are not visible on the screen. If you would like to see the characters of your 
passphrase as you type, select the Show Keystrokes check box. 

 

Changing the passphrase of a Passphrase user on an encrypted disk 

If you are a normal passphrase user, the passphrase you enter is the one you created 
when you added a user and encrypted your disk. This type of user is not associated with 
a Windows domain.  

To change user passphrases on an encrypted disk or partition 

1 On the Encrypt Whole Disk (Partition) screen, select the appropriate disk or 
partition protected by Symantec Drive Encryption. 

2 In the User Access list, select the name of the user whose passphrase you want to 
change. 

3 Click Change Passphrase. You are prompted to type the current passphrase. 

4 Type the appropriate passphrase, then click OK. The Change User Passphrase 
dialog box is displayed. 

5 Type a new passphrase. 

6 In the Confirm Passphrase field, type the new passphrase again, then click OK. 
The passphrase is changed. 
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The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating. For more information, see The Passphrase Quality 
Bar (on page 254). 

Normally, as an added level of security, the characters you type for a passphrase 
are not visible on the screen. If you would like to see the characters of your 
passphrase as you type, select the Show Keystrokes check box. 

 
 

 

Changing the expired passphrase of a Passphrase user on an encrypted disk 

The Symantec Encryption Server administrator can set a passphrase expiry policy and 
apply it on an encrypted computer. If you are a passphrase user on that computer, the 
passphrase expiry policy is applied to your user account. After a passphrase expiry 
policy is set, you must change your passphrase when it expires. 

When a passphrase expires, your user account automatically enters into a grace period. 
Later, when you authenticate at the PGP BootGuard screen and log on, Symantec 
Encryption Desktop displays the PGP Disk - Change User Passphrase dialog box and 
prompts you to change your passphrase. Also, a warning note indicates the grace 
period.  

As a best practice for data security, you should change your passphrase immediately. 

To change the passphrase after it expires 

1 In the PGP Disk - Change User Passphrase dialog box, type your current 
passphrase in the Enter Old Passphrase field. 

2 Type your new passphrase in the Enter New Passphrase and Re-enter Passphrase 
fields respectively.  

Note: To postpone changing the passphrase after it expires, click Cancel in the PGP 
Disk - Change User Passphrase dialog box. 

You may continue using the passphrase during the grace period. The grace period starts 
when you log on for the first time after the passphrase expires. However, when the 
grace period also expires, you must change your passphrase. The Cancel button does 
not appear when the grace period expires. 

To view the date on which the passphrase of a passphrase user was last updated, or to 
view the date on which the passphrase grace period started, run the following 
command:  

C:\Program Files\Symantec Corporation\Symantec Encryption Desktop> 
pgpwde --list-user --verbose 

Changing Your Passphrase when the Single Sign-On Feature is Used 

If you opt for the Symantec Drive Encryption Single Sign-On feature, it is recommended 
that you change your passphrase using the Change Password feature in the Windows 
Security dialog box. 

Note: You can access the Windows Security dialog box by pressing Ctrl+Alt+Delete.. 
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To change your passphrase while using the Single Sign-On feature 

1 Press Ctrl+Alt+Delete. The Windows Security dialog box is displayed. 

2 Type your old passphrase. 

3 Type and confirm your new passphrase. 

4 Click OK. Your Windows password and Symantec Drive Encryption passphrase are 
changed together. Use the new passphrase during your next login attempt. 

Caution: If you change your passphrase in any manner other than the one described 
here, your next login attempt on the PGP BootGuard screen will fail. You must then 
supply your old passphrase. Successful login on the PGP BootGuard screen using 
your old passphrase then brings up the Windows Login username/password screen. 
You must then log in successfully using the Windows Login screen, at which time the 
Symantec Drive Encryption feature will synchronize with the new passphrase. 

 

Local users and the Symantec Drive Encryption Single Sign-On Feature 

If a computer is not a member of a domain, Symantec Drive Encryption automatically 
ensures that users must sign in using Ctrl+Alt+Delete. It does that by disabling certain 
Windows user access features, including the Use Welcome Screen and Ctrl+Alt+Delete 
options after a Single Sign-On user has been added. 

These features are automatically disabled when a computer is member of a domain. 
 

Re-Encrypting an Encrypted Disk or Partition 
Consider re-encrypting a protected disk or partition that you suspect of having a 
passphrase or authentication token that has been compromised, or if users have been 
removed who previously had access. 

To re-encrypt a disk or partition, the Symantec Drive Encryption feature uses the same 
encryption algorithm (AES256)—but a different underlying encryption key—to encrypt 
the disk or partition again. The result is as if you decrypted the disk or partition and 
encrypted it again, but much faster. 

Note: Re-encryption applies to all partitions that are already encrypted. Selecting 
one partition to encrypt implies all partitions on the same disk that are already 
encrypted would be re-encrypted one by one. 

To re-encrypt an encrypted disk or partition 

1 Select the appropriate encrypted disk or partition. 

2 Select Disk > Re-Encrypt. You are prompted to authenticate. 

3 Type the appropriate passphrase, then click OK. The re-encryption process begins. 
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If You Forgot Your Passphrase 
If you forgot your passphrase, and if your system is configured for it, you can bypass 
PGP BootGuard by answering three out of five security questions correctly. You create 
and answer the five security questions. This is similar to recovering your key if you lost 
the key or forgot the passphrase for the key. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled the option for local self recovery (LSR). Your administrator may also 
have specified that LSR be configured during enrollment. In this case, you are 
prompted to enter the security questions as you set up Symantec Encryption 
Desktop. If Symantec Encryption Desktop does not prompt you to configure LSR, you 
can manually do so after encrypting an internal drive. 

To create your security questions 

1 Using Symantec Encryption Desktop, encrypt your internal drive. You can use 
either a Passphrase user or a Windows SSO user. 

2 Right-click the user's name in Symantec Encryption Desktop and select Add 
Security Questions. 

Note: You cannot create security questions for the Drive Encryption-Admin user 
or the ADK. 

3 Create and answer the five security questions. The user's name is displayed with 
LSR to the right (and a tool tip), to indicate that "local self recovery" has been 
configured for the user. 

 

To recover your passphrase at PGP BootGuard 

1 At the PGP BootGuard screen, press F4 or use the arrow keys to select Forgot 
Passphrase and press Enter. 

2 On the screen that prompts you to select a recovery option, select Answer my 
questions to log into the system and press Enter. 

3 Do one of the following: 

 If the screen prompts you to select username, select your username and 
press Enter. 

 If the screen prompts you to enter Drive Encryption username, enter your 
Drive Encryption username and press Enter. 

These screens appear based on the LSR policy applied to the computer, the 
number of LSR-configured Drive Encryption users on the computer, and the type 
of PGP BootGuard screen enabled for the computer. 

4 Answer the first security question displayed. Type the answer and press Enter. 

5 Continue to answer the questions. You must answer three of the five questions 
correctly. 
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6 When you have answered the questions correctly, the Windows operating system 
begins to start up. When the Log On to Windows dialog box is displayed, enter 
your Windows login name and password. 

When Windows has finished launching, the PGP Disk - Change User Passphrase 
dialog box is displayed. 

7 Enter and confirm a new passphrase for the user, and click OK. The new 
passphrase is created for the user.  

The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating. For more information, see The Passphrase Quality 
Bar (on page 254). 

Normally, as an added level of security, the characters you type for a passphrase 
are not visible on the screen. If you would like to see the characters of your 
passphrase as you type, select the Show Keystrokes check box. 

The same security questions are displayed if you forget your passphrase again. If you 
want to change your security questions, right-click the user name and select Add 
Security Questions. 

 

Backing Up and Restoring 
While most modern backup programs have no problem backing up the data on a 
Symantec Encryption Desktop-encrypted disk, some other backup programs do have 
problems with it. These other backup programs fail when they encounter the file 
PGPWDE01, a file used by Symantec Encryption Desktop. The solution is to have these 
programs exclude PGPWDE01 from the backup (most backup programs let you exclude 
individual files). Once you get your backups working again with these programs, it is a 
good idea to test the backup to make sure it works. 

If you are restoring your disk but the software does not run successfully, decrypt your 
disk and try again. If your backup image restores successfully but your system does not 
boot, visit the Symantec Knowledgebase and search for knowledge article TECH213093. 

.. 

 

Using Automatic Backup Software on a Symantec Drive Encryption-Encrypted Disk 

You can automatically back up the disk or partition once protected with Symantec 
Drive Encryption. Be sure to back up your system first before you encrypt it with 
Symantec Drive Encryption.  

It is important to note that any files the software backs up are decrypted before being 
backed up. To back up encrypted data, use a PGP Virtual Disk or Symantec File Share 
Encryption protected folders. 

If you used backup-and-restore software and you are restoring your disk, but the 
software does not run successfully, decrypt your disk and try again. If your backup 
image restores successfully but your system does not boot, refer to Symantec 
Knowledgebase article TECH213093 (http://www.symantec.com/docs/TECH213093). 

 

 

http://www.symantec.com/docs/TECH213093
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Uninstalling Symantec Encryption Desktop from Encrypted Disks or Partitions 
If you have any disks or partitions on your system that are protected by Symantec Drive 
Encryption, these disks or partitions become inaccessible once Symantec Encryption 
Desktop is uninstalled. For that reason, a safety feature prevents you from uninstalling 
Symantec Encryption Desktop if your system has any disks or partitions protected by 
Symantec Drive Encryption. In this instance you see an error message explaining that 
the uninstall process is being terminated to protect the encrypted disk or partition. 

If you want to uninstall Symantec Encryption Desktop, first decrypt any disks or 
partitions on your system that are protected using Symantec Drive Encryption. 

 

Working with Removable Disks 
This section describes how to work with removable disks. If you are using Symantec 
Drive Encryption in a Symantec Encryption Server-managed environment, your 
security policy may require that removable disks be encrypted. Your security policy 
may also require that removable disks be mounted as read-only disks, but an option is 
provided for you to encrypt the disk. 

Caution: Always use the Microsoft Windows Safely Remove Hardware option to stop 
attached USB devices before removing them. 

Note: When Symantec Endpoint Encryption Removable Storage software is installed 
on the client, Symantec Drive Encryption removable disk policies are not applied. 
Symantec Drive Encryption, however, will continue to decrypt already encrypted 
removable storage drives. 

 

Encrypting Removable Disks 
If you are using Symantec Drive Encryption in a Symantec Encryption Server-managed 
environment, your security policy may require that removable disks be encrypted. 
When you insert the removable disk, the Symantec Encryption Desktop Storage Device 
Connected dialog box is displayed. 

Do one of the following: 

 If the removable disk is an external drive, such as a USB flash disk or external 
hard drive, click Encrypt. The device is automatically encrypted to your key. Note 
that if your boot disk is encrypted with other users' keys, they are added as users 
to your removable disk. If your key cannot be found, or if other users' keys cannot 
be found, then you are prompted to create a passphrase user. 

Note: If your Symantec Encryption Server administrator has specified all 
removable disks be encrypted automatically, and your boot disk is not encrypted, 
the first keypair on user's keyring is used for encrypting the device. 

Depending on the size of the disk, it may take some time for the encryption 
process to complete. While the disk is being encrypted you can continue to use the 
removable disk. 
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Warning: Be sure the encryption process has completed before you remove the 
disk.  

 If you do not want to encrypt the device, click Lock. The device will be locked and 
will be read-only. If you attempt to modify or delete any files from the device, a 
Windows error message will appear. 

If the removable disk is a music device or digital camera, click Lock. These types of 
devices will not work if the contents of the device are encrypted. If you 
accidentally encrypt a music device or digital camera, you will need to decrypt it. 
Depending on your corporate security policy you may need to contact your IT 
department or Symantec Encryption Server administrator for help with 
decrypting this device. 

Note: If you do not click Lock within 60 seconds, the device mounts normally 
with write access. 

If your security policy requires that all removable disks be encrypted and the Symantec 
Encryption Server is not available (for example, if you are on an airplane and not 
connected to your corporate network), the removable device cannot be encrypted. 
Therefore, the device will be “locked” and will be read-only. The next time you connect 
to the Symantec Encryption Server, you will be able to encrypt the contents of the disk 
(if it has not already been encrypted).  

Note: When your Symantec Encryption Server administrator has specified that all 
removable disks be encrypted, the option to Exit PGP Services is no longer available 
from the PGP Tray menu. 

 

Using Locked (Read-Only) Disks as Read-Only 
If you are using Symantec Drive Encryption in a Symantec Encryption Server-managed 
environment, your security policy may require that removable disks be mounted as 
read-only devices. When you insert the removable disk, the Symantec Encryption 
Desktop Storage Device Connected dialog box is displayed. The removable disk is 
locked, and you cannot write data to the disk until you encrypt it. If you choose to 
encrypt the device, you can continue to use the disk as normal. 

Do one of the following: 

 If the removable disk is an external drive, such as a USB flash disk or external 
hard drive, and you want to be able to write to the disk, click Encrypt. The device 
is automatically encrypted to your key. Note that if your boot disk is encrypted 
with other users' keys, they are added as users to your removable disk. If your key 
cannot be found, or if other users' keys cannot be found, then you are prompted to 
create a passphrase user. 

Depending on the size of the disk, it may take some time for the encryption 
process to complete. While the disk is being encrypted you can continue to use the 
removable disk. 

Warning: Be sure the encryption process has completed before you remove the 
disk.  

 If you do not want to encrypt the device, click Lock. The device will be locked and 
will be read-only. If you attempt to modify or delete any files from the device, a 
Windows error message will appear. 
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If the removable disk is a music device or digital camera, click Lock. These types of 
devices will not work if the contents of the device are encrypted. If you 
accidentally encrypt a music device or digital camera, you will need to decrypt it. 
Depending on your corporate security policy you may need to contact your IT 
department or Symantec Encryption Server administrator for help with 
decrypting this device. 

Moving Removable Disks to Other Systems 
If you use Symantec Drive Encryption to protect a removable disk—a USB flash disk, for 
example—you can move that disk to another Windows or Mac OS X system and access 
the encrypted files on that flash disk on the other system. Removable disks created 
using Symantec Drive Encryption on Linux can be accessed using version 10.0 or later. 

You will need to be able to authenticate to access the contents of the disk. 

Note: Consider Symantec Encryption Desktop licensing when moving an encrypted, 
removable disk. To protect a disk using the Symantec Drive Encryption feature, you 
must have the appropriate Symantec Encryption Desktop license. However, if you 
have protected a removable disk with Symantec Drive Encryption, you can use that 
removable disk on another computer with version 9.5.2 or later installed—even if the 
other system does not have a Symantec Encryption Desktop license that supports 
Symantec Drive Encryption. 

 

Reformatting an Encrypted Removable Disk 
If you have encrypted a removable disk and then used the Windows Disk Management 
utility to reformat it, the next time you insert the disk you are prompted to enter the 
passphrase. 

In order to remove this requirement, do the following: 

1 Start a command prompt (Start > Run, and enter cmd) and navigate to 
C:\Program Files\Symantec Corporation\Symantec Encryption 
Desktop. 

2 Enter the following command: 

pgpwde --fixmbr --disk 1

If you have more than one encrypted disk on your system, you may need to run the 
pgpwde --enum command first. This command lists your encrypted disks. If the 
command returns information that your USB drive is not disk "1", use that 
number instead (for example, if your USB disk is disk "2", enter the command to 
remove encryption as pgpwde --fixmbr --disk 2 . 

You will no longer be prompted for the passphrase when you insert the disk. 
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Using Symantec Drive Encryption in a Symantec 
Encryption Server-Managed Environment 

The Symantec Drive Encryption feature can be administered for Symantec Encryption 
Desktop users in a Symantec Encryption Server-managed environment. Administrators 
can deploy Symantec Encryption Desktop installers to users throughout their 
enterprise. 

 

Symantec Drive Encryption Administration 
The Symantec Encryption Server administrator can control: 

 Whether or not the Symantec Drive Encryption feature is available to users. If 
you are in a Symantec Encryption Server-managed environment and the 
Symantec Drive Encryption feature is not available, check with your Symantec 
Encryption Server administrator to see if the feature has been disabled by policy. 

The Symantec Drive Encryption feature also requires an appropriate license from 
Symantec Corporation. If the feature is disabled for you, even though it is enabled 
by policy, check with your Symantec Encryption Server administrator to make 
sure you have an appropriate license. 

 Whether or not you can recover disks or partitions that are protected with 
Symantec Drive Encryption. If you forget the passphrase to a disk or partition 
encrypted with Symantec Drive Encryption, or if you lose the authentication 
token, the disk or partition is not accessible. However, if you are using the 
Symantec Drive Encryption feature in a Symantec Encryption Server-managed 
environment, check with your Symantec Encryption Server administrator to see if 
disk or partition recovery is an available option. 

 Whether or not your boot disk must be encrypted with Symantec Drive 
Encryption when you install Symantec Encryption Desktop. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, contact your Symantec Encryption Server 
administrator for more information. 

 Whether or not your computer uses the Symantec Drive Encryption Single 
Sign-on (SSO) feature. 

For more information on this feature, see Using Symantec Drive Encryption Single 
Sign-On (on page 138). 

 What modes you can use with the Symantec Drive Encryption feature. 

 Whether or not your Symantec Encryption Server administrator can use an 
administrator key (with a smart card) to access your encrypted disk or partition. 
This feature applies to Windows systems booting in BIOS mode. This feature is not 
supported for Windows systems booting in UEFI mode. 

For more information on encryption modes, see Determining the Authentication Method 
for the Disk (on page 121). 
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If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, after installing Symantec Encryption Desktop, you may 
be required to encrypt your boot disk or partition using the Symantec Drive Encryption 
feature. Conversely, the Symantec Drive Encryption feature may be disabled by your 
Symantec Encryption Server administrator. 

If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, you may be prompted to encrypt a removable disk when 
it is inserted. For more information, see Encrypting Removable Disks (on page 148). 

If your policy should change from one to the other, specifically from having the ability 
to encrypt a disk to having that feature disabled, note that you are still able to use any 
drives that are already whole disk encrypted. You will not, however, be able to encrypt 
any more drives, re-encrypt existing encrypted drives, or add new users. 

For more information, see Using Symantec Encryption Desktop with Symantec 
Encryption Server (on page 257). 

 

Accessing an Encrypted Device Using a Whole Disk 
Recovery Token 

A whole disk recovery token (WDRT) is used to access the disk or partition (on Windows 
systems) in case the passphrase or authentication token is lost. 

WDRTs are associated with encrypted devices, not single computers or single users. A 
single computer can be associated with multiple encrypted devices. If multiple users 
have accounts on the same device, they share the same recovery token. Whatever you 
do with the token affects all users sharing that device. Each encrypted device has only 
one recovery token, which unlocks all the encrypted disks on that device. 

Note that the recovery token is used only to gain access to an encrypted disk or 
partition (on Windows systems). You cannot use the recovery token to encrypt or 
decrypt data. 

Caution: Consider re-encrypting disks or partitions (on Windows systems) protected 
by Symantec Drive Encryption if security is compromised, by passphrase exposure 
for example, or loss of the authentication token (on Windows systems). This process 
re-encrypts the disk or partition with the same encryption algorithm, but with a 
different underlying encryption key. The result is as if you decrypted the disk or 
partition and encrypted it again, but is much faster. 

Creating a Recovery Token in a Managed Environment 
If you are working within a Symantec Encryption Server-managed environment, and 
the policy that applies to you allows for the creation of WDRTs, then Symantec 
Encryption Desktop creates a recovery token whenever you encrypt a disk, partition (on 
Windows systems), or removable disk with Symantec Drive Encryption. This recovery 
token can be used to access the disk or partition (on Windows systems) in case the 
passphrase or authentication token (on Windows systems) is lost. 

If the policy that applies to you does not support it, you will not be able to use WDRTs. 

This recovery token is automatically sent to the Symantec Encryption Server that is 
managing security for the disk or partition (on Windows systems) protected by 
Symantec Drive Encryption. 
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If you are in a Symantec Encryption Server-managed environment, and you lose the 
passphrase or authentication token used to protect a disk or partition (on Windows 
systems) with Symantec Drive Encryption, contact your Symantec Encryption Server 
administrator for assistance using the recovery token. 

The recovery token can be used only once to gain access to a disk or partition (on 
Windows systems) that has been protected using Symantec Drive Encryption. After a 
recovery token is used, a new one is generated automatically and sent to the Symantec 
Encryption Server. You are given the option of creating a new user, or keeping the 
existing one(s) on the disk or partition. 

Creating a Recovery Token in a Standalone Environment 
In a standalone environment, Symantec Drive Encryption displays a WDRT when you 
attempt to encrypt a boot disk, fixed internal disk, or removable device for the first 
time. Be sure that you save the WDRT outside your encrypted device, either by writing 
it down or by taking a picture. In case you forget your passphrase or lose your smart 
card or token, you can use the WDRT that you saved to unlock your encrypted device. 

Using a Recovery Token 
Follow the steps below to unlock your encrypted device. 

Whole disk recovery token strings contain both letters and numerals. Because it can be 
difficult to tell the difference between certain letters and numbers, WDRTs use letter 
and number equivalencies. You can type either the letter or number when you use a 
WDRT, and the string is accepted. The following letters and numbers are 
interchangeable: 

 Capital letter B and numeral eight (8) 

 Capital letter O and numeral zero (0) 

 Capital letter I and numeral one (1) 

 Capital letter S and numeral five (5) 

When you enter a recovery token, you do not need to match the case (all uppercase) or 
dashes. You can enter all lowercase characters without the dashes if you want. 

To use a recovery token on a boot disk when PGP BootGuard with simple authentication 
is configured for your computer 

 At the PGP BootGuard screen, enter the recovery token in the passphrase field and 
press Enter. 

To use a recovery token on a boot disk when PGP BootGuard with detailed authentication 
is configured for your computer 

1 At the PGP BootGuard screen, press F4 or use the arrow keys to select Forgot 
Passphrase. 

2 If the screen to select a recovery option appears, select Use WDRT to log into the 
system and press Enter. 

This screen appears when local self recovery is also enabled for your computer 
and configured for a user. 

 



 
154 Protecting Disks with Symantec Drive Encryption 

 
 
 

 

Recovering Data From an Encrypted Drive 

3 Enter the recovery token and press Enter. 

To use a recovery token on a removable drive 

 Insert the disk and enter the recovery token when prompted to enter the 
passphrase. 

 

 

 

Recovering Data From an Encrypted Drive 
Although rare, you may find it necessary to recover data from an encrypted drive that 
has been damaged or corrupted. Or, you may find that you do not have the login 
information in order to access a drive (such as a former employee's encrypted drive). In 
these cases, there are several things you can do: 

1 Use a recovery disc or drive. If a recovery disc or drive was created before the disk 
or partition was encrypted, you can use it to decrypt the disk. For more 
information, see Creating and Using a Recovery Disc (on page 154) or Creating and 
Using a Recovery USB Drive for Microsoft Windows 7 and Windows 8 UEFI-Based 
Systems (on page 155). 

2 Use another system to decrypt the drive. For more information, see Decrypting a 
Symantec Drive Encryption-Encrypted Disk (on page 156). 

3 Use the Whole Disk Recovery Token. If you are using Symantec Encryption 
Desktop in a Symantec Encryption Server-managed environment, the recovery 
token is created automatically when the disk is encrypted. For more information, 
see Using a Recovery Token (on page 153). Note that the recovery token is used 
only to gain access to an encrypted disk or partition (on Windows systems). You 
cannot use the recovery token to encrypt or decrypt data. 

 

 

Creating and Using a Recovery Disc 
While the chances are extremely low that a master boot record could become corrupted 
on a boot disk or partition protected by Symantec Drive Encryption, it is possible. If it 
happens, it could prevent your system from booting. 

Be safe: prepare for this highly unlikely event by creating a recovery CD before you 
encrypt a boot disk or partition using Symantec Drive Encryption. 

Caution: Note that recovery discs work only with the version of the software that 
created the recovery disc. For example, if you attempt to use a 10.2.1 recovery disc to 
decrypt a hard disk protected with Symantec Encryption Desktop 10.4 software, it 
will render the Symantec Encryption Desktop 10.4 disk inoperable. 

This section includes procedures for creating and using a recovery compact disc. 
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To create a recovery CD 

1 Make sure Symantec Encryption Desktop for Windows and Roxio Easy Media 
Creator or Roxio Easy CD Creator (or other software that can create a CD from an 
ISO image) are installed on your system. 

2 Open Roxio Easy Media Creator or Roxio Easy CD Creator and choose to create a 
Data CD Project. 

3 Select File > Record CD from CD Image. The Record CD from Hard Disk Image 
screen is displayed. 

4 Select Files of Type > ISO Image Files (ISO). 

5 Navigate to the PGP directory. The default directory is C:\Program Files\PGP 
Corporation\PGP Desktop\. 

6 Select bootg.iso and click Open. The Record CD Setup screen is displayed. 

7 Insert a blank, recordable CD into a CD drive on your system. 

8 On the Record CD Setup screen, click Start Recording. The Record CD from CD 
Image Progress screen is displayed as the ISO file is burned to the CD. 

9 When the file is burned to the CD, click OK. The Symantec Drive Encryption 
recovery CD is ready. 

10 Remove the recovery CD from the drive and label it appropriately. 

 

To use a recovery CD 

Caution: Once you have started to decrypt a disk or partition using a recovery disc, do 
not stop the decryption process. Depending on the size of the disk being decrypted, 
this process can take a long time. A faster way to decrypt the drive is to use another 
system that has the same version of Symantec Encryption Desktop installed on it. 
For more information, see Decrypting a Symantec Drive Encryption-Encrypted Disk 
(on page 156). 

1 If the Symantec Drive Encryption Recovery log-in screen does not appear when 
you restart your system, or on restart you are prompted for a Symantec Drive 
Encryption recovery disc, insert the recovery CD into a CD drive on the system. 

2 Restart the system. The Symantec Drive Encryption log-in screen from the 
recovery disc is displayed. 

3 Type an appropriate passphrase for the boot drive or partition that is protected by 
Symantec Drive Encryption. You can: 

 Press Enter to attempt to boot the system. 

 Type D to decrypt the disk. 

 

 

Creating and Using a Recovery USB Drive for Microsoft Windows 7 and Windows 8 
UEFI-Based Systems 

This section includes procedures for creating and using a recovery USB drive for 
Microsoft Windows 7 and Windows 8 UEFI-based systems. 
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To create a recovery USB drive 

1 Format a USB drive in the FAT32 format. (Ensure that the drive is a USB 2.0 drive, 
with a minimum of 1 GB of space.) 

2 In the root directory on the drive, create a folder named EFI. 

3 In the EFI directory, create a subfolder named Boot. 

4 Copy the following files from the C:\Program Files\PGP Corporation\PGP 
Desktop directory, to the newly created \EFI\Boot folder on the USB drive: 

 bootx64.efi 

 pgpcontents.tar 

The USB drive is now a bootable UEFI drive. 

To use a recovery USB drive 

1 Insert the drive into your system. 

2 Access your system's boot option menu (usually by pressing F9, F10, or F12 
immediately after powering up Windows, but consult the user guide of your PC for 
more detail). 

3 Select the USB drive (or, on some systems, go to select the .efi file on the USB 
drive) from the boot option menu to boot the recovery USB drive. 

The PGP BootGuard authentication screen displays as usual. If the encryption record is 
still intact, you have the option either to boot directly into Windows or to decrypt 
without booting, after a successful authentication. If the drive encryption record has 
been damaged, the recovery drive scans the hard drive and attempts to recover the 
record. If the recovery is successful, you have the option to decrypt the hard drive after 
authentication. 

Decrypting a Symantec Drive Encryption-Encrypted Disk 
As a best practice, if you need to perform any disk recovery activities on a disk 
protected with Symantec Drive Encryption, Symantec Corporation recommends that 
you first decrypt the disk. Decrypt a disk by doing one of the following: 

 Use the Symantec Encryption Desktop Disk > Decrypt option (see the following 
procedure for information on how to use this option to decrypt a disk). 

 Use your prepared Symantec Drive Encryption Recovery Disc (see Creating and 
Using a Recovery Disc (on page 154) or Creating and Using a Recovery USB Drive for 
Microsoft Windows 7 and Windows 8 UEFI-Based Systems (on page 155) for 
information on how to create a recovery disc). 

 Connect the hard disk via a USB cable to a second system and decrypt from that 
system's Symantec Encryption Desktop software. 

Once the disk is decrypted, proceed with your recovery activities. 
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Special Security Precautions Taken by Symantec Encryption Desktop  

To use Symantec Encryption Desktop to decrypt a disk 

1 Open Symantec Encryption Desktop and click on the PGP Disk Control box. The 
PGP Disk Control box highlights. 

2 Click Encrypt Whole Disk or Partition. The Encrypt Whole Disk or Partition work 
area displays, and you see a listing of the disks on your system that can be 
protected by Symantec Drive Encryption: disks, disk partitions, removable media, 
and so on. 

3 In the Encrypt Whole Disk or Partition work area, in the Select disk or partition to 
encrypt section at the top, click to select the disk or partition on your computer 
that you want to decrypt. 

4 Select Disk > Decrypt or click Decrypt. The Unlock Disk dialog box is displayed. 

5 Enter the passphrase to unlock the disk. The Decryption Progress displays in the 
Symantec Encryption Desktop window.  

The time it will take to decrypt the disk is also displayed in the Symantec 
Encryption Desktop window. To pause or cancel the decryption process, click Stop. 
If necessary, you can shut down the computer by choosing Start > Shut Down. Do 
not power down the system by depressing the power on/off button. 

To use another system to decrypt a Symantec Drive Encryption-encrypted drive 

1 Remove the hard drive you want to decrypt from the computer and place it in a 
drive enclosure. 

2 Connect a USB cable from the drive enclosure to a computer that has Symantec 
Encryption Desktop installed on it. 

3 On the computer that has Symantec Encryption Desktop installed, at the prompt 
enter the passphrase to decrypt the drive that is located in the drive enclosure. 

 

 

Special Security Precautions Taken by Symantec 
Encryption Desktop 

Symantec Encryption Desktop has features that help avoid security problems with the 
Symantec Drive Encryption feature. These precautions also apply to PGP Virtual Disk 
volumes. 

 

Passphrase Erasure 
When you enter a passphrase, Symantec Encryption Desktop uses it only for a brief 
time, then erases it from memory. Symantec Encryption Desktop also avoids making 
copies of the passphrase. The result is that your passphrase typically remains in 
memory for only a fraction of a second. Without this critically important feature, 
someone could search for your passphrase in your computer memory while you were 
away from the system. You would not know it, but they would then have full access to 
data protected by this passphrase. 
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Special Security Precautions Taken by Symantec Encryption Desktop 

Virtual Memory Protection 
Your passphrase or other keys could be written to disk as part of the virtual memory 
system swapping memory to disk. Symantec Encryption Desktop takes care that the 
passphrases and keys are never written to disk. This feature prevents a potential 
intruder from scanning the virtual memory file looking for passphrases. 

Hibernation vs Standby (Sleep) 
In Windows, Hibernate mode writes an image of your computer’s entire main memory 
storage to a file on your hard drive, but not your passphrase. Symantec Corporation 
recommends that you always use Hibernate, rather than Standby (Sleep), as Hibernate 
turns your computer off and then requires that you authenticate at the PGP BootGuard 
screen to log in again. 

Memory Static Ion Migration Protection 
When you protect a disk or partition (on Windows systems) with Symantec Drive 
Encryption, your passphrase is turned into a key. This key is used to encrypt and 
decrypt the data on the encrypted disk or partition. While the passphrase is erased 
from memory immediately, the key (from which your passphrase cannot be derived) 
remains in memory. 

This key is protected from virtual memory; however, if a certain section of memory 
stores the exact same data for extremely long periods of time without being turned off 
or reset, that memory tends to retain a static charge, which could be read by attackers. 
If your encrypted disk or partition (on Windows systems) is decrypted for long periods, 
over time, detectable traces of your key could be retained in memory. Devices exist that 
could recover the key. You won’t find such devices at your neighborhood electronics 
shop, but major governments are likely to have a few. 

Symantec Encryption Desktop protects against this by keeping two copies of the key in 
RAM, one normal copy and one bit-inverted copy, and inverting both copies every few 
seconds. 

Other Security Considerations 
In general, the ability to protect your data depends on the precautions you take, and no 
encryption program can protect you from sloppy security practices. For instance, if you 
leave your computer on with sensitive files open when you leave your desk, anyone can 
access that information—even if the disk or partition (on Windows systems) is protected 
using Symantec Drive Encryption. 

Here are some tips for maintaining optimal security: 

 When you are away from your desk, use a screen saver with a password to deter 
others from accessing your computer or viewing your screen. 
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Using the Windows Preinstallation Environment  

 Make sure that your encrypted disks or partitions (on Windows systems) are not 
available to other computers on a network. You may need to arrange this with the 
network management staff within your organization. Once you have decrypted 
your disk or partition, Symantec Drive Encryption can no longer protect the files. 
They can be seen by anyone with network access to them. Consider the PGP 
Virtual Disk feature for storing files that need to be locked even while you are 
using your computer. 

 Never write down your passphrase. Pick something you can remember. If you have 
trouble remembering your passphrase, use something to jog your memory, such as 
a poster, a song, a poem, or a joke—just do not write it down. 

 If you use Symantec Encryption Desktop at home and share your computer with 
other people, they will probably be able to see your open files on a disk or partition 
(on Windows systems) that is protected using Symantec Drive Encryption. As long 
as you shut down a system with a whole disk encrypted disk or partition, or if you 
remove an encrypted removable disk from the system, all files on the disk or 
partition remain encrypted and fully protected. 

 

Using the Windows Preinstallation Environment 
Creating a customized Windows Preinstallation (PE) CD/UFD (USB Flash Drive) 
provides a bootable recovery tool that can be used for rescue purposes. For example, 
you can use the DOS commands to copy, edit, backup and delete files. Symantec has 
added support for customizing Windows Preinstallation Environment (WinPE) bootable 
media on Windows 10 systems that have Symantec Encryption Desktop 10.4 for 
Windows installed. 

For more information about creating Windows Preinstallation Environment (WinPE) 
bootable media on Windows systems and to obtain the Symantec Drive Encryption 
drivers and tools, go to the Symantec Knowledgebase https://support.symantec.com and 
search for “Windows PE Recovery Tools for Symantec Encryption Desktop 10.4”.  

Also included in this knowledgebase article is a technical note you can download that 
contains all of the instructions in this section. 

 

 

https://support.symantec.com/




 

10 Using PGP Virtual Disk 

Use PGP Virtual Disk to organize your work, keep similarly named files separate, or 
keep multiple versions of the same documents or programs separate. 

This section describes the PGP Virtual Disk feature of Symantec Encryption Desktop. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

In This Chapter 

About PGP Virtual Disk ..............................................................................................161

Creating a New PGP Virtual Disk..............................................................................162

Viewing the Properties of a PGP Virtual Disk.........................................................164
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The PGP Virtual Disk Encryption Algorithms ........................................................173

Special Security Precautions Taken by PGP Virtual Disk.....................................174

 

 

Note: PGP Virtual Disk was called PGP Disk in previous versions of Symantec 
Encryption Desktop. The phrase PGP Disk now includes both the PGP Virtual Disk 
and the Symantec Drive Encryption features. 

 

About PGP Virtual Disk 
A PGP Virtual Disk is an area of space, on any disk connected to your computer, which 
is set aside and encrypted. PGP Virtual Disk is much like a bank vault, and is very useful 
for protecting sensitive files while the rest of your computer is unlocked for work. 
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Creating a New PGP Virtual Disk 

A PGP Virtual Disk looks and acts like an additional hard disk, although it is actually a 
single file that can reside on any of your computer disks. It provides storage space for 
your files—you can even install applications, or save files to a PGP Virtual Disk — but it 
can also be locked at any time without affecting other parts of your computer. When 
you need to use the applications or files that are stored on a PGP Virtual Disk, you can 
unlock the disk and make the files accessible again. 

PGP Virtual Disk is unlocked and locked by mounting and unmounting it from your 
computer. Symantec Encryption Desktop helps manage this operation for you. 

Although you specify a size for your PGP Virtual Disk, you can also create a 
dynamically-sizing disk, one that grows larger as needs require it. The size you specify 
when you are creating the disk is the maximum size the disk can become. 

When a PGP Virtual Disk is mounted, you can: 

 Move/copy files into or out of the mounted PGP Virtual Disk. 

 Save files to the mounted PGP Virtual Disk. 

 Install applications within the mounted PGP Virtual Disk. 

Files and applications on a PGP Virtual Disk are stored encrypted. If your computer 
crashes while a PGP Virtual Disk is unmounted, the contents remain safely encrypted. 

When a PGP Virtual Disk is unmounted, it does not appear within Windows Explorer 
and it is inaccessible to anyone without proper authentication. 

It is important to remember that all your data remains secure in the encrypted file and 
is only deciphered when you access one of the files. Having the data for a volume stored 
in this manner makes it easy to manipulate and exchange PGP Virtual Disk with others 
but it also makes it easier to lose data if the file is somehow deleted. It is wise to keep a 
back up copy of these encrypted files so that the data can be recovered if something 
happens to the original. 

For information about the PGP Options that affect PGP Virtual Disk volumes, see Disk 
Options (on page 247). 

Caution: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, you may be required to create a PGP Virtual Disk 
after installing Symantec Encryption Desktop. If so, the size, file system, and 
algorithm may have been specified. For more information, see Using Symantec 
Encryption Desktop with Symantec Encryption Server (on page 257). 

Creating a New PGP Virtual Disk 

To create a new PGP Virtual Disk 

1 Open Symantec Encryption Desktop. 

2 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then click New Virtual Disk. Alternatively, select File > New 
> PGP Virtual Disk. The New Virtual Disk screen is displayed in the right pane of 
the screen. 

3 In the Name field, type the name that you would like for the new PGP Virtual Disk. 

4 In the Disk File Location field, accept the default location for the PGP Virtual Disk 
volume you are creating, or click Browse to specify another location. 

 



 
Using PGP Virtual Disk 163 

 
 
 

 

Creating a New PGP Virtual Disk  

5 From the Mount as menu, select the drive letter that you would like for the new 
PGP Virtual Disk. 

You can: 

 Accept the drive letter that Symantec Encryption Desktop suggests for you. 

 From the Mount as menu, select an available drive from the list. 

 From the Mount as menu, select Folder, if you would like to mount the new 
PGP Virtual Disk to a folder instead of a drive letter. If you do this, a field is 
displayed next to the Mount as menu, so you can specify a location for the 
folder. 

6 Select Mount at Startup to have your new PGP Virtual Disk volume mount at 
startup automatically. When selected, you are prompted for your PGP Virtual Disk 
passphrase when you start your computer. 

7 Select Unmount when inactive for n mins [where n is a number of minutes] to 
have the PGP Virtual Disk unmount if you have not used your computer for a 
specific time interval that you specify (in minutes). This is helpful if you often 
leave your computer unattended—it is an additional safeguard that locks your PGP 
Virtual Disk if you forget to. 

8 From the Capacity menu, select the desired type of PGP Virtual Disk. Your choices 
are: 

 Dynamic (resizable). This type of disk grows in capacity as files are added to 
it, yet it stays small until the additional space is needed. Symantec 
Encryption Desktop manages this process, you only need to set the 
maximum size that you would like the disk to be. You can also compress this 
disk later, if you choose. This type of PGP Virtual Disk is available for FAT- 
or FAT32-formatted disks only. 

 Expandable. This type of disk grows in capacity as files are added to it, yet it 
stays small until the additional space is needed. Symantec Encryption 
Desktop manages this process, you only need to set the maximum size that 
you would like the disk to be. You can also compress this disk later, if you 
choose. This type of PGP Virtual Disk is available for NTFS-formatted disks 
only. 

 Fixed size. This type of disk remains the same size, regardless of how many 
files are added to it. This type of PGP Virtual Disk is available for any type of 
formatted disk. 

9 From the Capacity menu, set the size (in the case of Dynamic disks, the maximum 
size) for your new PGP Virtual Disk. Use whole numbers; no decimal places. 
Choose KB (kilobytes), MB (megabytes), or GB (gigabytes) from the menu. 

The maximum allowable size for a PGP Virtual Disk depends on the size and 
format of your hard disk. 

10 Specify a file system format for the volume: 

 FAT. Volume must be 100 KB or larger. 

 FAT32. Volume must be 260 MB or larger. 

 NTFS. Volume must be 5 MB or larger (12 MB for Windows Vista). 

11 Specify the encryption algorithm you want to use to protect your data: 

 AES (256 bits). AES (Advanced Encryption Standard) is a block cipher that 
can be used at 128, 192, or 256 bits. The more secure 256-bit version is used 
for creating PGP Virtual Disk volumes by default. 
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Viewing the Properties of a PGP Virtual Disk 

 EME2-AES (256 bits). EME2 (Encrypt-Mix-Encrypt v2) is a stronger 
algorithm that encrypts twice for each operation. EME2 is a wide block mode 
algorithm that is currently under review by the IEEE Standards Working 
Group. 

 CAST5 (128 bits). CAST is a 128-bit block cipher. CAST is a strong, 
military-grade encryption algorithm that has a solid reputation for its ability 
to withstand unauthorized access. 

 Twofish (256 bits). Twofish is a 256-bit block cipher, symmetric algorithm. It 
was one of five algorithms that the U.S. National Institute of Standards and 
Technology (NIST) considered for the AES (Rijndael was selected). 

12 You must have at least one user who can access your new PGP Virtual Disk. In the 
User Access section, specify who you want to give access to, and what method 
they use for access: 

 User Key. To add users who authenticate with public-key cryptography: 

 Click Add User Key. The Add Key Users box is displayed, displaying the 
keypairs currently on your keyring. 

 From the Add Key Users box, select the key users you want by 
double-clicking the listing. Alternatively, you can drag the listing from 
the left side to the right, or select a listing and click Add. Click OK 
when you are finished. 

 Passphrase. Click New Passphrase User. The Create New User dialog box is 
displayed. 

 For each new passphrase user, type a name for that user, type a 
passphrase for them, then type the passphrase again to confirm. Click 
OK to create the passphrase user. If you want to authorize more 
passphrase users, repeat the process. 

 To modify the passphrase for a passphrase user, select that user, then 
click Change Passphrase. 

For information on creating effective, high-quality passphrases, refer to Creating 
Strong Passphrases (on page 255). 

13 Click Create to start creating the new PGP Virtual Disk. A progress bar indicates 
how much of the PGP Virtual Disk has been initialized and formatted. When 
complete, your new PGP Virtual Disk is displayed in the PGP Disk control area. 

14 The first user you create is granted administrator status, and there can only be 
one administrator at a time. However, you can grant administrator status to any of 
your other users, regardless of whether they are public key or passphrase users. 
Click their name in the User Access list, then click Make Admin. 

15 Delete any user, other than the Administrator, by selecting their name and 
clicking Delete User. To delete the Administrator, first grant administrator status 
to another user, then delete the former administrator. 

 

 

Viewing the Properties of a PGP Virtual Disk 
Once a PGP Virtual Disk has been created, information about the disk and settings you 
can change are accessible from the Disk Properties screen. 
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Finding PGP Virtual Disks  

To view the properties of a PGP Disk volume 

 In the PGP Disk control box on the left pane of the Symantec Encryption Desktop 
main screen, click the name of the disk. The Disk Properties is displayed in the 
right side of the main screen. Information displayed includes the PGP Virtual Disk 
file location, disk capacity, mounted drive letter, disk format, encryption type, and 
status of the disk (mounted or unmounted). 

 

 

Finding PGP Virtual Disks 
If you created PGP Virtual Disks using previous installations of Symantec Encryption 
Desktop, you can easily find these volumes using the PGP Disk Search Assistant. 

To find PGP Virtual Disks on your system 

1 In Symantec Encryption Desktop, click the PGP Disk control box. The PGP Disk 
main screen is displayed. 

2 Select File > Scan for PGP Disks. The PGP Virtual Disk Search Assistant dialog box 
is displayed. 

3 Follow the instructions displayed in the assistant. 

Tip: To find the mounted volume of a specific PGP Virtual Disk, in Symantec 
Encryption Desktop, right-click the name of the volume and select Show disk 
location in Explorer. Windows Explorer opens a new window displaying the contents 
of that volume. 

 

Using a Mounted PGP Virtual Disk 
Create, copy, move, and delete files and folders on a PGP Virtual Disk just as you 
normally do with any other disk on your system. 

Anyone else who has access to the volume (either on the same computer or over the 
network) can also access the data stored there. It is not until you unmount the volume 
that the data is protected. 

Caution: Although each PGP Virtual Disk file is encrypted and cannot be accessed by 
anyone without proper authorization, it can still be deleted from your system. 
Anyone with access to your system could delete the encrypted file containing the 
PGP Virtual Disk. For this reason, keeping a backup copy of the encrypted file is an 
excellent safety measure, as is keeping your computer locked when you are not 
nearby. 

 

Mounting a PGP Virtual Disk 
When you create a new PGP Virtual Disk, it is automatically mounted so you can begin 
using it to store your files. 
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Using a Mounted PGP Virtual Disk 

To secure the contents of a volume, you must unmount it. Once a volume is unmounted, 
its contents remain secured in an encrypted file where they are inaccessible until the 
volume is mounted once again. 

There are several ways to mount a PGP Virtual Disk: 

 In Symantec Encryption Desktop, select the PGP Virtual Disk you want to mount 
and select Disk > Mount Disk.  

 In Symantec Encryption Desktop, select the PGP Virtual Disk you want to mount 
and then click Mount in the upper-right corner. 

 Change the properties of the PGP Virtual Disk so that it mounts when your 
computer starts. 

On Windows systems only: 

 During creation of the PGP Virtual Disk, select the Mount at Startup checkbox. 
The volume mounts automatically when you start Windows. If you do not select 
this during creation of the PGP Virtual Disk, you can set it as an option later. 

 In Windows Explorer, right-click the PGP Virtual Disk file, and select Symantec 
Encryption Desktop > Mount Disk from the shortcut menu. 

Mounted PGP Virtual Disk volumes appear as empty drives in Windows Explorer. 
 

Unmounting a PGP Virtual Disk 
You lock a PGP Virtual Disk by unmounting it. Once a PGP Virtual Disk is unmounted, 
its contents are locked in the encrypted file associated with the volume. Its contents are 
inaccessible until the volume is mounted once again. 

Caution: You may lose data if you unmount a PGP Virtual Disk when some files that it 
contains are open. Specify options for unmounting disks by selecting Tools > 
Options and clicking the Disk tab. One option is Allow PGP Disks to unmount even 
while files are still open. If that option is selected, the option for Don’t ask before 
unmounting also becomes available. Do not use these options unless you are 
familiar with them. While these options can be useful for advanced users who 
protect their data with regular data backups, they are not recommended for most 
users. 

There are several ways to unmount a PGP Virtual Disk volume: 

 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the volume you want to unmount. Click 
Unmount in the upper-right corner, or select Disk > Unmount. 

 In Windows Explorer, right-click on the PGP Virtual Disk file, then select 
Symantec Encryption Desktop > Unmount Disk from the shortcut menu. 

 Use the hot key to unmount all PGP Virtual Disks. The default hot key is 
Ctrl+Shift+U. The hot key must be enabled first. 

Once a PGP Virtual Disk is unmounted, its contents remain locked and inaccessible 
until the volume is mounted once again. 

 

Compacting a PGP Virtual Disk 
To free up additional space on your PGP Virtual Disk, compact the disk. If the PGP 
Virtual Disk is mounted, you must unmount the disk first, before you can compact it. 
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Using a Mounted PGP Virtual Disk  

Note: Only FAT- or FAT32 formatted PGP Virtual Disks that are dynamic (not fixed 
in size) can be compacted. NTFS-formatted disks or fixed size disks cannot be 
compacted.  

To compact a PGP Virtual Disk 

 Do one of the following: 

 In Windows Explorer navigate to the location of the .pgd file. Right-click the 
file and select Symantec Encryption Desktop > Compact unused space. 

 In Symantec Encryption Desktop, click the PGP Disk control box on the left 
pane of the Symantec Encryption Desktop main screen, select the PGP 
Virtual Disk you want to compact, and then select Disk > Compact. You can 
also right-click the PGP Virtual Disk in the PGP Disk control box and select 
Compact from the shortcut menu. 

 

 

Re-Encrypting PGP Virtual Disks 
You can re-encrypt all data stored on a PGP Virtual Disk. You might do this for either 
(or both) of two reasons: 

 You want to change the encryption algorithm currently being used to protect the 
volume. 

 You suspect there has been a security breach. 

With re-encryption, you encrypt your PGP Virtual Disk again, but use a different 
underlying encryption key. 

Caution: Adept users may be able to search the memory of a computer for the 
underlying encryption key of a PGP Virtual Disk. These users could use the key to 
access the volume even after being removed from the user list. Re-encrypting the 
disk changes this underlying key and prevents this kind of intrusion. 

To re-encrypt a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk you want to re-encrypt. 

2 If the PGP Virtual Disk that you want to re-encrypt is mounted, unmount it. 

3 Select the PGP Virtual Disk you want to re-encrypt. 

4 Select Disk > Re-Encrypt. 

5 Type your passphrase for the volume. The PGP Re-Encryption Assistant is 
displayed. 

6 Read the introductory information, and then click Next. A dialog box is displayed 
displaying: 

 The current encryption algorithm protecting your PGP Virtual Disk.  

 The available encryption algorithms other than the one you originally chose. 

For example, if your PGP Virtual Disk is currently encrypted with AES, then the 
CAST5 and Twofish options appear in the New Algorithm list. 
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Working with Alternate Users 

7 Do one of the following: 

 To re-encrypt the volume using the current algorithm, select the Re-encrypt 
to the same algorithm checkbox, then click Next. The PGP Virtual Disk 
volume is re-encrypted using the same encryption algorithm as before. 

 To re-encrypt the volume using a different algorithm, select the algorithm 
from the New Algorithm menu, then click Next. The PGP Virtual Disk 
volume is re-encrypted using the new encryption algorithm you selected. 

8 When the current status displays Done, click Next. 

9 Click Finish to complete the re-encryption process. 

 

 

Working with Alternate Users 
This section describes how to add, delete, and disable alternate user accounts for your 
PGP Virtual Disks. Also included is information on how to change the rights for users, 
including granting administrator rights to a user. 

 

Adding Alternate User Accounts to a PGP Virtual Disk 
The administrator of a PGP Virtual Disk can make it available to other users. Those 
users can access the volume using their passphrases or private keys. 

Make sure the PGP Virtual Disk is not currently mounted, otherwise, you cannot add 
alternate user accounts. 

To add alternate user accounts to a PGP Virtual Disk 

1 Click the PGP Disk Control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk to which you want to add an 
alternate user account. 

2 Do one of the following: 

 To add a new public key user, click Add User Key. The Add Key Users dialog 
box is displayed. 

 To add a new passphrase user, click New Passphrase User. The PGP Disk 
New User dialog box is displayed. 

3 Do one of the following: 

 If you selected Add User Key, in the Add Key Users dialog box, select a public 
key from the list and click OK. 

 If you selected New Passphrase User, in the PGP Disk New User dialog box, 
type the user name, the passphrase for the PGP Virtual Disk you are adding 
the user to, then type the passphrase again in the PGP Disk New User box 
and click OK. 

The alternate user account is added. 
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Working with Alternate Users  

Deleting Alternate User Accounts from a PGP Virtual Disk 
At some point you may want to remove the ability of an alternate user to access a PGP 
Virtual Disk. 

Make sure that the PGP Virtual Disk is not mounted. You cannot remove an alternate 
user account if the volume is mounted. 

To remove an alternate user account from a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk for the user account you 
want to delete. 

2 In the User Access list, select the name of the alternate user whose account you 
want to remove. You cannot remove the Administrator. 

3 Click Delete User. The Passphrase dialog box is displayed, prompting you for 
either the administrator passphrase or the passphrase for the user account being 
removed. 

4 Type the passphrase, then click OK. The alternate user account is removed. 

 

 

Disabling and Enabling Alternate User Accounts 
To prevent access to a PGP Virtual Disk for an alternate user without deleting their 
account entirely, you can instead temporarily disable their access. 

Make sure that the PGP Virtual Disk is not mounted. You cannot disable or enable an 
alternate user account if the volume is mounted. 

To disable or enable an alternate user account from a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk for the user account you 
want to change. 

2 In the User Access list, do one of the following: 

 To disable a user, right-click the name of the alternate user account you 
want to disable and select Disable. The Passphrase dialog box is displayed, 
prompting you for either the administrator passphrase or the passphrase for 
the user account being disabled. Type the passphrase, then click OK. The 
alternate user account is disabled. 

 To enable a user that you previously disabled, right-click the name of the 
alternate user account you want to enable and select Enable. The Passphrase 
dialog box is displayed, prompting you for either the administrator 
passphrase or the passphrase for the user account being disabled. Type the 
passphrase, then click OK. The alternate user account is enabled. 
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Working with Alternate Users 

Changing Read/Write and Read-Only Status 
Users of a PGP Virtual Disk can have either full read/write privileges, or read privileges 
only. You can change these privileges for a user at any time. 

Make sure the selected PGP Virtual Disk is not mounted. You cannot change rights if 
the volume is mounted. 

To change the rights for a user on a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk for the user account you 
want to change. 

2 In the User Access list, select the name of the user whose status you want to 
change. 

3 Do one of the following: 

 To change the user to read-only access, right-click the user's name and select 
Read-Only. 

 To change the user to read/write access, right-click the user's name and 
select Read/Write. 

The Enter Passphrase dialog box is displayed. 

4 Type the administrator passphrase for the PGP Virtual Disk, then click OK. The 
rights of the selected user are changed. 

 

 

Granting Administrator Status to an Alternate User 
You can change the status of a user account from alternate to administrator. 

Make sure the selected PGP Virtual Disk is not mounted. You cannot make a user into 
an administrator if the volume is mounted. 

To grant administrator status 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk for the user account you 
want to change.  

2 In the User Access list, select the user you want to make administrator of the PGP 
Virtual Disk. Select either a passphrase user or yourself (if you are not the current 
administrator). Note that you cannot make a public key user an administrator of 
the PGP Virtual Disk.  

3 In the option bar on the left, click Make Admin. The selected user account is 
changed to administrator. 

Note: You can grant Administrator status to only one user account at a time. By 
granting Administrator status to one account, you also remove it from another. 
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Changing User Passphrases  

Changing User Passphrases 
Make sure the selected PGP Virtual Disk is not mounted. You cannot change the 
passphrase if the volume is mounted. 

To change a user’s passphrase for a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk on which you are a user. 

2 Select the name of a passphrase user from the User Access list, and click Change 
Passphrase. The Enter Passphrase dialog box is displayed 

Tip: You can also right-click the user's name and select Change User Passphrase 
from the shortcut menu. 

3 Type the current passphrase for the user and click OK. The PGP Enter Confirmed 
Passphrase dialog box is displayed 

4 Type a new passphrase, type the passphrase again to confirm it, and click OK. The 
passphrase is changed. 

 

 

Deleting PGP Virtual Disks 
At some point you may decide you no longer need a particular PGP Virtual Disk and 
may choose to delete the disk entirely. 

Caution: When you delete a PGP Virtual Disk, all data on it is also deleted. There is no 
way to retrieve the data once you delete a PGP Virtual Disk. Make sure that you have 
copied any data that you want to save to another location before deleting a PGP 
Virtual Disk. 

Make sure the selected PGP Virtual Disk is not mounted. You cannot delete the PGP 
Virtual Disk if the volume is mounted. 

To delete a PGP Virtual Disk 

1 Click the PGP Disk control box on the left pane of the Symantec Encryption 
Desktop main screen, then select the PGP Virtual Disk you want to delete. 

2 Select Disk > Delete. A confirmation dialog box is displayed. 

3 Do one of the following: 

 Click OK to delete the PGP Virtual Disk from the Symantec Encryption 
Desktop listing. The PGP Virtual Disk remains on your system. 

 Click Delete PGP Disk to remove the PGP Virtual Disk from the Symantec 
Encryption Desktop listing, as well as deleting it from your hard drive. 
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Maintaining PGP Virtual Disks 
This section describes how to take proper care of the PGP Virtual Disk that you use with 
your computer. 

 

Mounting PGP Virtual Disk Volumes on a Remote Server 
You can place PGP Virtual Disk volumes on any kind of server (Windows or UNIX). The 
volumes can then be mounted by anyone with a Windows computer and Symantec 
Encryption Desktop. 

Note: The first person to mount the PGP Virtual Disk volume locally has read-write 
access to the volume. No one else is then able to access the volume. If you want 
others to be able to access files within the volume, you must mount the volume in 
read-only mode (applies to FAT and FAT32 file system formats only). All users of the 
volume then have read-only access. 

If the PGP Virtual Disk volume is stored on a Windows server, you can also mount the 
volume remotely on the server and allow people to share the mounted volume. 
However, this action provides no security for the files within the volume. 

 

Backing up PGP Virtual Disk Volumes 
Backing up the contents of your PGP Virtual Disk is the best way to safeguard your 
information from hardware failure or other loss. 

It is not advisable to back up the contents of a mounted (and therefore, decrypted) PGP 
Virtual Disk just as you would any other volume. The contents are not encrypted, and 
are accessible to anyone who can restore the backup. Instead, instead make a backup 
copy of the encrypted volume. 

To back up PGP Virtual Disks 

1 Unmount the PGP Virtual Disk. 

2 Copy the unmounted encrypted file to a diskette, tape, or removable cartridge just 
as you would any other file. Even if some unauthorized person has access to the 
backup, he or she will not be able to decipher its contents. 

When making backups of the encrypted files, keep these issues in mind: 

 Backing up encrypted files to a network drive gives others plenty of opportunity to 
guess at a weak passphrase. It is much safer to back up only to devices over which 
you have physical control. 

 A lengthy, complicated passphrase helps further improve the security of your 
data. 

 If you are on a network, make sure that any network backup system does not back 
up the files in your mounted PGP Virtual Disk. (You may need to discuss this with 
your System Administrator.) Once a PGP Virtual Disk is mounted, its files are 
decrypted and can be copied to a network backup system that way. 
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Exchanging PGP Virtual Disks 
You can exchange PGP Virtual Disk with other users who have Symantec Encryption 
Desktop installed on their computers. You do that by sending them a copy of the PGP 
Virtual Disk data file, which contains the volume data. Here are some of the ways you 
might exchange PGP Virtual Disk: 

 As mail attachments 

 On a removable disk or CD 

 Over a network 

Once the other user has the PGP Virtual Disk file, they can mount it on a system 
running Symantec Encryption Desktop and use the correct passphrase to access it. If 
the volume was encrypted to their public key, they would use their private key for 
access. 

Note: Public key is the most secure protection method when adding alternate users 
to a PGP Virtual Disk because: (1) You do not need to exchange a passphrase with the 
alternate user which, depending on your method, could be intercepted or overheard. 
(2) The alternate user does not need to memorize another passphrase which could be 
forgotten. (3) It is easier to manage a list of alternate users if each uses their own 
private key to unlock the volume. 

 

The PGP Virtual Disk Encryption Algorithms 
Encryption employs a mathematical formula to scramble your data so that no one else 
can use it. When you apply the correct mathematical key, you unscramble the data. The 
PGP Virtual Disk volume encryption formula uses random data for part of the 
encryption process. 

The Symantec Encryption Desktop application offers strong algorithm options for 
protecting your PGP Virtual Disk volumes: AES-256, CAST, and Twofish. 

 The Advanced Encryption Standard (AES) is the NIST-approved encryption 
standard. The underlying cipher is Rijndael, a block cipher designed by Joan 
Daemen and Vincent Rijmen. The AES replaces the previous standard, the Data 
Encryption Standard (DES). PGP Virtual Disk volumes can be protected with the 
strongest variation of AES, AES-256 (that is, AES with a key size of 256 bits). 

 CAST is considered an excellent block cipher because it is fast and very difficult to 
break. Its name is derived from the initials of its designers, Carlisle Adams and 
Stafford Tavares of Northern Telecom (Nortel). Nortel has applied for a patent for 
CAST, but they have made a commitment to make CAST available to anyone on a 
royalty-free basis. CAST appears to be exceptionally well-designed by people with 
good reputations in the field. 

The design is based on a very formal approach, with a number of formally 
provable assertions that give good reasons to believe that it probably requires key 
exhaustion to break its 128-bit key. CAST has no weak keys. There are strong 
arguments that CAST is immune to both linear and differential cryptanalysis, the 
two most powerful forms of cryptanalysis in the published literature, both of 
which have been effective in cracking the Data Encryption Standard (DES). 
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EME2-AES (256 bits) is a stronger algorithm that encrypts twice for each 
operation. EME2 (Encrypt-Mix-Encrypt v2) is a wide block mode algorithm that is 
currently under review by the IEEE Standards Working Group. 

 

Special Security Precautions Taken by PGP Virtual Disk 
Symantec Encryption Desktop takes special care to avoid security problems with PGP 
Virtual Disk volumes that other programs may not.  

These precautions also apply to whole disk encrypted drives. 
 

Passphrase Erasure 
When you enter a passphrase, Symantec Encryption Desktop uses it only for a brief 
time, then erases it from memory. Symantec Encryption Desktop also avoids making 
copies of the passphrase. The result is that your passphrase typically remains in 
memory for only a fraction of a second. Without this critically important feature, 
someone could search for your passphrase in your computer memory while you were 
away from the system. You would not know it, but they would then have full access to 
data protected by this passphrase. 

 

Virtual Memory Protection 
Your passphrase or other keys could be written to disk as part of the virtual memory 
system swapping memory to disk. Symantec Encryption Desktop takes care that the 
passphrases and keys are never written to disk. This feature prevents a potential 
intruder from scanning the virtual memory file looking for passphrases. 

 

Hibernation 
In Windows, Hibernate mode writes an image of your computer’s entire main memory 
storage, including PGP Virtual Disk information, to a file on your hard drive. If your 
PGP Virtual Disk is open when you invoke hibernation, sensitive data will be written to 
your hard drive, including the session key, but not your passphrase. 

Because hibernation is inherently insecure, Symantec Corporation recommends using 
the Symantec Drive Encryption feature if you use hibernation or make sure to enable 
the PGP Virtual Disk options Unmount when computer goes to sleep and Prevent sleep 
if disk(s) cannot be unmounted, located on the Disk tab of the PGP Options. 

 

Memory Static Ion Migration Protection 
When you mount a PGP Virtual Disk volume, your passphrase is turned into a key. This 
key is used to encrypt and decrypt the data on your PGP Virtual Disk volume. While the 
passphrase is erased from memory immediately, the key (from which your passphrase 
cannot be derived) remains in memory while the disk is mounted. 
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This key is protected from virtual memory; however, if a certain section of memory 
stores the exact same data for extremely long periods of time without being turned off 
or reset, that memory tends to retain a static charge, which could be read by attackers. 
If your PGP Virtual Disk volume is mounted for long periods, over time, detectable 
traces of your key could be retained in memory. Devices exist that could recover the 
key. You won’t find such devices at your neighborhood electronics shop, but major 
governments are likely to have a few. 

Symantec Encryption Desktop protects against this by keeping two copies of the key in 
RAM, one normal copy and one bit-inverted copy, and inverting both copies every few 
seconds. 

Other Security Considerations 
In general, the ability to protect your data depends on the precautions you take, and no 
encryption program can protect you from sloppy security practices. For instance, if you 
leave your computer running with sensitive files open when you leave your desk, 
anyone can access that information or even obtain the key used to access the data. 

Here are some tips for maintaining optimal security: 

 Unmount PGP Virtual Disk volumes when you leave your computer. This way, the 
contents will be safely stored in the encrypted file associated with the volume 
until you are ready to access it again. 

 Use a screen saver with a password so that it is more difficult for someone to 
access your computer or view your screen when you are away from your desk. 

 Make sure that your PGP Virtual Disk volumes cannot be seen by other computers 
on the network. You may need to talk to your network management people to 
guarantee this. The files in a mounted PGP Virtual Disk volume can be accessed by 
anyone who can see them on the network. 

 Never write down your passphrases. Pick something you can remember. If you 
have trouble remembering your passphrase, use something to jog your memory, 
such as a poster, a song, a poem, a joke, but do not write down your passphrases. 

 If you use Symantec Encryption Desktop at home and share your computer with 
other people, they will probably be able to see your PGP Virtual Disk volume files. 
As long as you unmount the PGP Virtual Disk volumes when you finish using 
them, no one else will be able to read their contents. 

 If another user has physical access to your computer, that person can delete your 
PGP Virtual Disk files as well as any other files or volumes. If physical access is an 
issue, try either backing up your PGP Virtual Disk files or keeping them on an 
external device over which only you have physical control. 

 Be aware that copies of your PGP Virtual Disk volume use the same underlying 
encryption key as the original. If you exchange a copy of your volume with another 
and both change your master passwords, both of you are still using the same key 
to encrypt the data. While it is not a trivial operation to recover the key, it is not 
impossible. 

You can change the underlying key by re-encrypting the volume. 

 

 





 

11 Using Symantec File Share Encryption 

Symantec File Share Encryption provides transparent, end-to-end encryption for 
shared file storage. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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About Symantec File Share Encryption 
Symantec File Share Encryption enables specific users to share protected files in a 
shared space, such as on a corporate file server, in a shared folder, or on removable 
media such as a USB drive. 
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Note: In circumstances where you do not have an easily accessible shared space, 
using a USB removable drive is one way to share your Symantec File Share 
Encryption files. 

The files are protected by encryption, but continue to appear as normal application 
files—Notepad, Microsoft Word, HTML, Microsoft Excel, and so on. Applications can 
directly read from and write to the files; the fact that the files are protected is 
transparent to the applications. Anyone else with access to the shared space can see the 
files, but they cannot read/use them. 

Symantec File Share Encryption is client-only software—there is nothing to install on 
the file server and it works with your existing storage infrastructure. The encryption 
and decryption of protected files and folders is done only on the client. Server backups 
will archive encrypted files (ciphertext) which is unreadable to anyone who is not 
authorized to view the files. 

Those who have access to the protected files are called Users, and folders containing 
the protected files are called Protected Folders.  

Users are assigned roles that specify the type of actions that user can make. For more 
information on roles, see Symantec File Share Encryption Roles (on page 179). 

The Protected Folder is any folder designated to hold protected files. Files that are in a 
folder converted to a Protected Folder are automatically encrypted; files moved into a 
Protected Folder after its creation are encrypted when they are added. You can also 
protect individual files by selecting Protect Individual Files in the File Share tab of 
Tools > Options. 

Caution: Symantec File Share Encryption does not provide access control for the files 
in a Protected Folder. Because it is file-level access control, anyone with access to the 
files in a Protected Folder can add new, unencrypted files and/or remove existing 
encrypted files. This makes it important that you establish your Protected Folder in a 
secure shared space; but it also means that your network administrator can back up 
the files in the Protected Folder without being able to read them. 

Symantec File Share Encryption can be used with both the PGP Virtual Disk and 
Symantec Drive Encryption features of Symantec Encryption Desktop. This means that 
you can create a Protected Folder in a PGP Virtual Disk or if your drive is encrypted by 
Symantec Drive Encryption. Symantec File Share Encryption protection is designed for 
files in a shared, collaborative environment, usually over a network. PGP Virtual Disk 
and Symantec Drive Encryption protect individual drives or portions of drives on a 
local system. All three are valuable security products that are designed for slightly 
different circumstances. In fact, you can use all three on the same system to provide 
strong security for your data. 

Symantec File Share Encryption is not compatible with the Work Folders or Storage 
Spaces features in Microsoft Windows 8.1/10 or Microsoft Windows Server 2012 R2. 

Here is an example to help you understand how you might use Symantec File Share 
Encryption: 

Suppose you are the VP of Finance for a small company with two major product 
lines. The company president calls you into her office and asks you to spearhead 
an initiative to see if adding another major product line would be successful. 

She wants you and representatives from Marketing, Sales, Engineering, 
Manufacturing, and Support to examine the issue from all sides and make a 
recommendation. The whole project needs to be low profile. 
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Fortunately, in your organization everyone uses Symantec Encryption Desktop in 
a Symantec Encryption Server-managed environment, so the solution for creating, 
sharing, updating, and securely storing the files you need is already in place: 
Symantec File Share Encryption. 

Because members of your project are physically dispersed, you need to set up the 
Protected Folder for the project in a location accessible to everyone. For example, 
creating the Protected Folder on the corporate network would allow all project 
members to access it. 

Once the Protected Folder is established, the project members can add new files, 
open and work on existing files, or removes files without worrying about the fact 
that they are protected by encryption—the encryption and decryption are totally 
transparent. 

Another advantage of Symantec File Share Encryption is that the files appear normally 
to anyone who is not an Authorized User, thus allowing your network administrator to 
back up the files in the Protected Folder the same way they back up all the other files on 
the corporate network. The backups are also protected by encryption. 

Note: The Symantec File Share Encryption tracking engine ignores EFS-protected 
objects. This is by design and ensures any complications are avoided due to the fact 
EFS is tightly coupled with NTFS. Any files or folders that are EFS-encrypted and are 
moved or copied into a Symantec File Share Encryption-protected folder retain their 
EFS-encryption, but do not become Symantec File Share Encryption-protected. To 
Symantec File Share Encryption protect these objects, remove the EFS encryption 
before moving/copying into a folder. 

Symantec File Share Encryption provides complete security for files in a Protected 
Folder. Data is always encrypted, even when a Protected Folder is being accessed or is in 
transit from or to project members. 

Caution: If you choose Save As for a protected file, and save it outside the Protected 
Folder, the new version will not be protected. 

 

Symantec File Share Encryption Roles 
 Admin: This is the "owner" of the protected folder. The Admin can add users and 

remove users, and can change the roles of Users and Group Admins. The Admin 
has full rights to read and write to the protected folder. There can be only one 
Admin for each protected folder and it is created automatically by the creator — 
you do not need to specify an Admin manually for the protected folder. There is 
only one Admin per folder. 

You become an Admin by creating a protected folder, adding yourself as a 
member, and applying the Admin role to yourself. You can be a member of 
multiple Admin sets at one time.  

The Admin role cannot be removed by a Group Admin, but an Admin can reassign 
his or her role to another member. 

Admins must have full write access to the protected folder. 

 Group Admin: This is an "administrator" of the protected folder. The Group 
Admin can add and remove users, and can promote users to Group Admins or 
demote Group Admins to Users. There can be as many Group Admins as needed. 
The Group Admin has full rights to read and write to the protected folder. There 
can be multiple Group Admins for each Symantec File Share Encryption protected 
folder. 
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Group Admins must have full write access to the protected folder. 

 Users: This is the set of users who are allowed to access the protected files in the 
shared space. The files in the protected folder are encrypted to the keys of the 
Users. You become a User when a protected folder is created, you are added to the 
Symantec File Share Encryption, and the Admin or Group Admin assigns the User 
role to you. All Users have equal privileges to read and write to the protected 
folder. Users do not have the ability to change the roles of other Users. You can be 
a member of multiple User sets at one time. Users do not have the right to decrypt 
files or folders. This is limited, so Users cannot decrypt files and re-encrypt the 
files with new role assignments. 

Note: If you have a folder that is protected with a previous version of Symantec 
Encryption Desktop, you must select new roles for existing users manually. For more 
information, see Changing a User's Role (on page 195). 

 

Integrating with Symantec Data Loss Prevention 
Symantec Data Loss Prevention discovers, monitors, and protects confidential data. 
When integrated with Symantec File Share Encryption, Symantec Data Loss Prevention 
performs these actions on endpoint local disks and on internal networks, using 
Symantec File Share Encryption to protect (encrypt) sensitive files, without user 
intervention.  

Symantec Data Loss Prevention uses two methods to identify sensitive files, as specified 
by the Data Loss Administrator: 

 Data in Motion (DIM). This method monitors data that is in transit, including data 
that is copied, moved from or to the local disk, or saved. 

 Data at Rest (DAR). This method discovers stationary data. 

When Symantec Data Loss Prevention identifies a sensitive file, it encrypts the file: 

 Whether or not the file is in a Protected Folder. 

 Using the keys specified by the Data Loss Administrator.  

When Symantec Data Loss Prevention encrypts a file: 

 The keys may or may not be the same keys as those defined by the Admin or Group 
Admin of the protected file. 

 The file may be decrypted then re-encrypted if the file is already encrypted by 
Symantec File Share Encryption. Decryption requires that the file owner be logged 
on. 

 Provides the same user interface as files encrypted by Symantec File Share 
Encryption: 

 Displays the same lock icon. 

 Allows you to view the encryption keys associated with a file in the 
Properties dialog box under the Symantec File Share Encryption tab. DIM 
files show ‘DLP Auto Encrypt’ as the Signing Key; DAR files show the KEY ID. 
For more information, see Accessing the Properties of a Protected File or 
Folder (on page 204). 

 Allows you to add or remove users from the access list if you are the Admin 
or Group Admin. 
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How Symantec Data Loss Prevention Integration Affects You 

Symantec Data Loss Prevention runs in the background, but you may occasionally 
notice evidence of it working. Below are examples of how the integration of Symantec 
Data Loss Prevention with Symantec File Share Encryption may impact you: 

 You are logged on and working on a task, with several files on your desktop 
unencrypted. Time passes and you notice that one of these files is now encrypted, 
as indicated by a lock icon. You bring up the file’s Properties dialog box and select 
the Symantec File Share Encryption tab. You are still on the access list, so your 
access to the file remains unchanged. 

 You log off and go home for the evening. Several files in a directory are 
unencrypted. When you return in the morning and log on, many of these files are 
now encrypted, as indicated by lock icons. You bring up a file’s Properties dialog 
box and select the Symantec File Share Encryption tab. If you are not on the access 
list, you no longer have access to the file. Remember that even if you are not listed 
explicitly, you may have access because you belong to a Group Key used to encrypt 
the file. 

 You copy a file from your local disk to another location. The original file was 
unencrypted, but the copied version is encrypted. 

 You are working on a project and have set up a Protected Folder for file sharing 
among project members. Because the files are in the Protected Folder, the files 
themselves are protected—encrypted so that only project members can update 
them. You work on a file, then close it. You return in the afternoon to do more 
work. But when you attempt to open the file, you receive an Access Denied 
message. You view the file’s Properties and under the Symantec File Share 
Encryption tab see that the list of users with access to this file is not the list of 
project members. Now the list includes only the Human Resources manager. 
Symantec Data Loss Prevention has discovered and identified the file as 
sensitive—it contains employee badge numbers—and has re-encrypted it to a 
smaller access list, defined by the Symantec Data Loss Prevention administrator. 

See also: 

Accessing the Properties of a Protected File or Folder (on page 204) 

Using a Group Key (on page 183) 

Integrating with Dropbox 
Dropbox is a file hosting service operated by Dropbox, Inc. The integration of Symantec 
File Share Encryption with Dropbox brings protection to files copied from a Dropbox 
Windows client to cloud-based storage. You can view these encrypted Dropbox files 
from your iOS device. This integration allows protected files to move among Dropbox 
locations, to be read, edited, and saved by you or a collaborative group. Files and folders 
are encrypted or decrypted transparently, as needed. 

The summary steps to use Dropbox with Symantec File Share Encryption are: 

1 Install Dropbox on your Windows system. 

2 Create, move, copy, update, and save files and folders into your Dropbox folder to 
encrypt them. 

3 View the encrypted files on your iOS device by accessing your Dropbox account in 
the cloud and running the "Symantec File Share Encryption for iOS" application. 
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About Dropbox Integration 

The integration of Symantec File Share Encryption and Dropbox combines file 
protection with cloud-based storage and access. This integration includes the following 
elements: 

 A specific Dropbox integration policy that specifies the encryption keys, defined 
by your Symantec Encryption Server administrator 

 The installation of Symantec Encryption Desktop and Dropbox on your Windows 
client 

 The encryption of files and folders inside the Dropbox folder, when triggered by 
your activities of file/folder creation, update, and copy/move 

 The connection of your Windows client (and iOS device) with the Symantec 
Encryption Server to resolve the keys 

 The deferral to Dropbox of its own icon display within the Dropbox folder, with 
the use of other indicators to identify the encrypted files 

 The (optional) addition of external files and folders to the Dropbox folder, via the 
cloud, with an added step to apply the encryption 

 The use of your iOS device to view the files, by authenticating to your Dropbox 
account and running the "Symantec File Share Encryption for iOS" app 

 

For information on these topics, see: 

System Requirements for Integrating with Dropbox (on page 206) 

Encrypting Files (on page 207) 

Activating a Dropbox Policy (on page 207) 

Resolving Users' Keys (on page 207) 

Adding Encrypted Files to a Dropbox Folder (on page 207) 

Identifying an Encrypted File (on page 208) 

Sharing Encrypted Dropbox Files (on page 208) 

Decrypting Files (on page 209) 

See also the Symantec File Share Encryption for iOS User's Guide

Licensing Symantec File Share Encryption 
In order to use Symantec File Share Encryption, you must be running the software 
version 9.5 or later and have a license that supports Symantec File Share Encryption. 

To see if your copy of Symantec Encryption Desktop supports Symantec File Share 
Encryption 

1 Open Symantec Encryption Desktop. 
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2 Select Help > License. The Symantec Encryption Desktop License dialog box is 
displayed. 

3 In the Product Information section, find the Symantec File Share Encryption 
icon. Move your cursor over the product name to see information about the 
product and to find out if you are currently licensed to use it. If Symantec File 
Share Encryption is not supported, contact your Symantec Encryption Server 
administrator about getting a license that supports Symantec File Share 
Encryption. 

If you created one or more Protected Folders with a Symantec File Share Encryption 
license that has now expired, you will not be able to create any new Protected Folders, 
use the files currently in any Protected Folders, add files to existing Protected Folders, 
or be added as an Authorized User for a new Protected Folder. 

In order to regain access to the decrypted versions of any files in an existing Protected 
Folder, you must either obtain a new Symantec File Share Encryption license or decrypt 
the files/folders in your Protected Folders using the Remove <file name> from 
Symantec File Share Encryption command (for more information, see Accessing 
Symantec File Share Encryption Features using the Shortcut Menu (on page 203)). 

 

Authorized User Keys 
Symantec File Share Encryption uses the PGP keys of the Users you designate to 
control access to the decrypted files in the Protected Folder, and it uses the private keys 
of Authorized Users to sign new files that are added to the Protected Folder. 

Note: Symantec File Share Encryption does not support the use of passphrases to 
protect files. PGP keys must be used to protect files. 

When a set of Users is created, the creator specifies the public keys of the users who 
will be able to use the files in the Protected Folder. To use those files, Users must have 
the corresponding private key on their system in order to gain decrypted access to the 
files. 

 

Using a Group Key 
Starting with PGP Universal Server 3.2 and PGP Desktop 10.2, your Symantec 
Encryption Server administrator can create Symantec File Share Encryption group 
keys. The group key is a single key that is shared by a group of users and is used to 
encrypt or decrypt Symantec File Share Encryption-protected files and folders. Using a 
single key, in this case the group key, reduces the overhead associated with encrypting 
a file/folder to a large number of keys. Any member of the group associated with the 
key can access protected folders/files encrypted to that group key. 

Group membership for the group key is controlled by your Symantec Encryption Server 
administrator and is used with Active Directory. Your Symantec Encryption Server 
administrator can map file server access/encryption policies to Active Directory 
security groups. The group key name should correspond with an Active Directory 
group, such as EngineeringManagers or FinanceAP.  

If you need to create a group key, contact your Symantec Encryption Server 
administrator. 
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Establishing a Symantec File Share Encryption Admin (Owner) 

If a member of the group associated with the key leaves your organization or is no 
longer authorized to access the protected data, contact your Symantec Encryption 
Server administrator to remove the user from the group key membership. Be sure to 
re-encrypt your folders to ensure access is denied to that member. 

Note: Group keys are different than using Active Directory groups. Using a group key 
adds only the single key to a protected folder. Using an Active Directory group adds 
every key found for members of that group. For more information on Active 
Directory groups, see Working with Active Directory Groups (on page 196). 

 

Adding a Group Key to a Protected Folder 

The group key is a single key that is shared by a group of users and is used to encrypt or 
decrypt Symantec File Share Encryption-protected files and folders. The icon displayed 
next to the group key name in the User Selection dialog box indicates the key is a group 
key.  

To add a group key 

1 In Symantec Encryption Desktop, select the folder you want protected with a 
group key. 

2 Click the directory icon and select the name of your Symantec Encryption Server 
(for example, keys.example.com). 

3 Type a search term in the Search field, then click the magnifying glass or press 
Enter to start the search. The results of the search appear in the Key source 
column. 

 The search is a wild card search. For example, entering "eng" as a search 
term will return Bob England, EngineeringGroup, SalesEngineeringGroup, 
and Tom Seng. 

4 Select the group key in the User Selection dialog box and click Add. When selected, 
information about the group key is displayed in the middle panel of the selection 
dialog box. When added, the group key is displayed in the Keys to add column. 

 
 

Establishing a Symantec File Share Encryption Admin 
(Owner) 

While a Symantec File Share Encryption Admin for a Protected Folder is not required, 
you may want to consider establishing one from among the authorized Users or Group 
Admins. It would be the responsibility of this person to monitor the files and folders in 
the Protected Folder, add and remove users and Group Admins, and to make sure that 
the activity in the Protected Folder is going as planned. 

Because all Authorized Users can add or remove files, folders, and (in some cases) users, 
it is possible that, over time, files are inappropriately added or removed from the 
Protected Folder, or Users are inappropriately added or removed. 

The Admin of a protected folder should monitor Users and the Protected Folder for 
these problems and fix them if they occur. 
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"Blacklisted" and "Whitelisted" Files, Folders, and Applications  

"Blacklisted" and "Whitelisted" Files, Folders, and 
Applications 

Certain files, folders, and applications can be "blacklisted" or "whitelisted." Black- or 
whitelisted items are either never protected or forced to be protected. 

“Blacklisted” and Other Files You Cannot Protect 
Symantec File Share Encryption does not allow you to protect certain files and folders. 
Before a file or folder is protected by Symantec File Share Encryption, it is checked 
against this list, known as the “blacklist.” If a file or folder is identified as being 
blacklisted, Symantec File Share Encryption continues with creating the Protected 
Folder, but the file and/or folder is skipped and a message is displayed in the Symantec 
File Share Encryption Assistant Progress screen that the item is blacklisted. 

Files that are blacklisted include: 

 All files with the file extension *.skr, *.pkr, and *.pgd, to prevent you from 
encrypting your keys or PGP Virtual Disks. 

 The Encryption Desktop installation folder and all files within it (by default, the 
folder is located at C:\Program Files\PGP Corporation\PGP Desktop). 

 The Encryption Desktop Preferences folder and all files within it (by default, the 
folder is located at C:\Documents and Settings\[your user name]\Application 
Data\PGP Corporation\PGP). 

 The PGP default keyring folder (by default, the keyring is located in the My 
Documents folder). 

Other files that Symantec File Share Encryption prevents from adding to Protected 
Folders are any files or folders that have the System attribute set, and all files and 
folders in the Windows installation directory (by default, C:\Windows and 
C:\Windows\System32), as well as the Thumbs.db file created when viewing 
thumbnail graphics in Windows Explorer. When system files or folders are added to 
Symantec File Share Encryption, the file and/or folder is skipped and a message is 
displayed in the Symantec File Share Encryption Assistant Progress screen that the 
item is a system file or folder. 

 

"Blacklisted" and "Whitelisted" Folders Specified by Symantec Encryption Server 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have specified certain folders as "blacklisted" or "whitelisted." 

Blacklisted folders 
Blacklisted folders are folders that are never added to Symantec File Share Encryption 
and encrypted. An example of a blacklisted folder may be your C:\Program Files 
folder or your C:\Windows\Temp folder. If your Symantec Encryption Server 
administrator has specified that a folder be blacklisted and that folder does not exist, it 
is not created on your system. 
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"Blacklisted" and "Whitelisted" Files, Folders, and Applications 

Note: Folders and/or files that have been Symantec File Share Encryption-protected 
are not decrypted automatically if they are blacklisted (by Symantec Encryption 
Server policy), even if the policy has been applied. To remove Symantec File Share 
Encryption protection, access or move the file or folder. Any new objects added to a 
protected blacklisted folder will not receive Symantec File Share Encryption 
encryption.  

Whitelisted folders 
Whitelisted folders are folders that are always added to Symantec File Share 
Encryption and the contents are encrypted. If your Symantec Encryption Server 
administrator has specified that a folder be whitelisted and that folder does not exist, it 
is created on your system. For example, if your Symantec Encryption Server 
administrator specified that C:\Documents and Settings\[user name]\My 
Documents\secured is a whitelisted folder, and the subfolder \secured does not 
exist, then it is created. You cannot remove whitelisted folders from Symantec File 
Share Encryption. 

Note: If you remove a folder that your Symantec Encryption Server administrator 
has specified as whitelisted, that folder is automatically recreated the next time you 
access Symantec File Share Encryption or restart Symantec Encryption Desktop. 

 

Application-based Encryption and Decryption Bypass Lists 
If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have specified certain applications as those where files created by these applications 
are either never decrypted or always encrypted. 

Application-based Encryption List 
Applications in this list are applications where any files written by the application are 
forced to be encrypted. Files created by applications in the application-based 
encryption list are automatically encrypted to your key and are always encrypted 
regardless of location, including temporary files and system caches. Examples of the 
types of applications that may be included in this list are Microsoft Office, Microsoft 
Excel, and Adobe Acrobat.  

Other types of encryption (for example, the whitelisted folders) take precedence over 
files created by applications in the application-based encryption list. 

An example use would be if your Symantec Encryption Server administrator specified 
that Microsoft Excel is in the application-based encryption lists so that all spreadsheets 
created by your Financial department are protected. 

Decryption Bypass List 
Applications in this list are applications where any files written by the application are 
prevented from being automatically decrypted. These applications are provided the 
on-disk file contents, including the Symantec File Share Encryption header and file 
ciphertext. Applications in the decryption bypass list effectively bypass the Symantec 
File Share Encryption filter when reading file, so the files remain encrypted on read, 
allowing these applications to pass the encrypted data to other applications. Examples 
of the types of applications that may be included in this list are backup and FTP 
programs. 
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Working with Protected Folders  

Other types of encryption (for example, the blacklisted folders) take precedence over 
files created by applications in the decryption bypass list. 

An example use would be if your Symantec Encryption Server administrator specified 
your corporate backup program in the decryption bypass list. All backup files created 
by this application are protected and the encryption is preserved when the backup file 
is transferred to another location. 

 

Working with Protected Folders 
The Protected Folder is any folder designated to hold protected files. Files that are in a 
folder converted to a Protected Folder are automatically encrypted; files moved into a 
Protected Folder after its creation are encrypted when they are added. You can also 
protect individual files by selecting Protect Individual Files in the File Share tab of 
Tools > Options. 

Tip: Be sure that you have an appropriate back up strategy in place and that all 
Symantec File Share Encryption protected folders are backed up on a regular basis. 

Choosing the Location for a Protected Folder 
Symantec Corporation recommends that you create your Symantec File Share 
Encryption Protected Folder in a space that is accessible to all Authorized Users, but 
that is protected from everyone else. 

While you can create the Protected Folder in a publicly accessible space, remember that 
Symantec File Share Encryption does not provide access control for the files in a 
Protected Folder. 

What you do with the files in a Protected Folder and who can access them impacts the 
protection Symantec File Share Encryption can provide. You should take the following 
circumstances into consideration when choosing the location for a Symantec File Share 
Encryption Protected Folder. 

 Normal Usage (on page 187) 

 File Access (on page 188) 

 Direct Access to Ciphertext (see "Direct Access to Encrypted Data (Ciphertext)" on 
page 188) 

 Protected Files Corrupted, Deleted, or Overwritten (on page 188) 

 “Blacklisted” and Other Files You Cannot Protect (on page 185) 

 

 

Normal Usage 

In normal usage by an Authorized User, Symantec File Share Encryption fully protects 
the files within a Protected Folder. Normal usage means opening a protected file, 
making changes, then saving it; creating a new file in a Protected Folder; or moving or 
copying a file into a Protected Folder. 
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Working with Protected Folders 

When a file is moved or copied out of a Symantec File Share Encryption Protected 
Folder, Symantec File Share Encryption attempts to keep the file protected. This allows 
you to copy files from a Protected Folder to a USB drive, for example, and retain the 
file’s protection. If you move or copy a file out of a Protected Folder, you should always 
verify that the destination file is still protected by looking for the visual lock indicator 
or examining the file properties. 

 

File Access 

Every application you use will have full access to the decrypted data of your Symantec 
File Share Encryption-protected files. This includes other Symantec Corporation 
applications, such as PGP Zip. So, if you create a PGP Zip archive and include a 
Symantec File Share Encryption-protected file, the PGP Zip archive will contain a 
decrypted version of the file. 

Be aware also that if you choose Save As for a protected file, and save it outside the 
Protected Folder, the new version will not be protected. 

 

Direct Access to Encrypted Data (Ciphertext) 

There are some circumstances where Symantec File Share Encryption can be bypassed, 
providing direct access to the encrypted data, or ciphertext, of the encrypted file. 

This allows the protected files on a file server, for example, to be backed up, moved, 
copied, or FTP'd by a user (such as the network administrator) who has physical access 
to the protected files but who does not have Symantec Encryption Desktop installed. In 
these cases, the ciphertext of the protected files would be backed up, moved, copied, or 
FTP'd. 

 

Protected Files Corrupted, Deleted, or Overwritten 

Symantec File Share Encryption does not provide file access control. Even though users 
without proper authorization are unable to open files within Protected Folders, it is still 
possible for these users to access them. This means that even protecting files with 
Symantec File Share Encryption is no assurance that they cannot be corrupted, deleted, 
or overwritten by users who have access to them. Symantec File Share Encryption 
protects the contents of a file—it cannot protect the file itself. 

It is highly recommended that you keep strong file access controls in place—in addition 
to the cryptographic access control and protection offered by Symantec File Share 
Encryption. 

 

Creating a New Symantec File Share Encryption Protected Folder 
The Protected Folder is the folder that holds the Symantec File Share 
Encryption-protected files. 

Tip: When you create a new Symantec File Share Encryption Protected folder, the 
files already in the folder will have their last modification dates changed to the date 
of the Symantec File Share Encryption operation. If you want to preserve the 
modification dates, first create an empty Symantec File Share Encryption folder and 
then add files to it.  
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Working with Protected Folders  

Note: You must have write-permissions to create a Symantec File Share Encryption 
Protected Folder. 

To create a new Symantec File Share Encryption Protected Folder 

1 Open Symantec Encryption Desktop and click on the Symantec File Share 
Encryption Control Box. The Symantec File Share Encryption work area is 
displayed. 

2 Do one of the following: 

 Drag the folder you want to be the Protected Folder to the field labeled “Drag 
and Drop Folder Here,” which opens the Symantec File Share Encryption 
Assistant and skips the step of specifying the Protected Folder. 

 Click Add Folder in the Symantec File Share Encryption Control Box or 
select Symantec File Share Encryption > Add Folder. The Select Folder 
screen of the Symantec File Share Encryption Assistant is displayed. 

 Click Browse. The Browse For Folder dialog box is displayed. 

 Navigate to the folder with the files you want to include in the 
Protected Folder you are creating. To create an empty folder into which 
you will put the files you want to be part of the Protected Folder, click 
Make New Folder. 

 Click OK to close the Browse For Folder dialog box. The Select Folder 
screen is displayed again. 

 (Optional) In the Description field, type a description for the Protected 
Folder you are creating. 

3 Click Next. The Add Users screen is displayed. 

4 To add users for the Protected Folder you are creating, click the down arrow icon. 
A list of the keys on your keyring is displayed. 

5 Select a user, and then click Add. 

Note: If you want access to the contents of the Protected Folder, do not forget to 
add your own key. If you do not, you will not be able to use the files in the 
Protected Folder. 

You can also add authorized users by clicking Add. The User Selection dialog box 
is displayed. 

6 Do one of the following: 

 Drag keys from the Key source column into the Keys to add column. 

 Click on a key in the Key source column and click Add. 

 Double-click on a key in the Key source column 

 Add keys from the PGP Global Directory, by clicking the PGP Global 
Directory icon, typing a search term in the Search field, then clicking the 
magnifying glass to start the search. The results of the search appear in the 
Key source column; from there, add them to the Keys to add column. 

 



 
190 Using Symantec File Share Encryption 

 
 
 

 

Working with Protected Folders 

Note: Symantec File Share Encryption does not automatically notify newly added 
members that they have been added to a Protected Folder as authorized users. 
Generally speaking, it is the responsibility of the creator of a new Protected 
Folder to notify members that the Protected Folder has been created and that 
they are authorized users. 

7 Click OK when you are finished with the User Selection screen. The Add Users 
screen is displayed again. 

8 To assign roles to each user, right-click the user's name and select the role: 

 Admin: Create only one Admin per Symantec File Share Encryption 
protected folder. This role has full read/write rights to the folder, can add 
and remove users, assign roles to other users, and can promote another user 
to be the Admin. 

 Group Admin: Create as many Group Admins as you need for each Symantec 
File Share Encryption protected folder. This role has full read/write rights to 
the folder, can add and remove users, and assign roles to other users. 

 User: Create as many Users as you need for each Symantec File Share 
Encryption protected folder. This role has full read/write rights to the folder. 

You can change a user's role at any time after the protected folder is created. Click 
on the protected folder in the Symantec Encryption Desktop, and right-click the 
user's name to change the role. You can also select the user's name and click 
Change Role. 

9 Click Next. The Select Signer screen is displayed. 

10 Select one private key from the private keys on the local keyring. This key will be 
used to sign the files that are protected by encryption in the Protected Folder. 

11 Type the Passphrase for the key. 

12 Click Next. The Progress screen is displayed. 

The files in the specified Protected Folder are encrypted and the specified users 
are added as Authorized Users. 

Note: If you cancel the encryption process, files that have already been encrypted 
remain encrypted. To return the files to their original, unencrypted state, see 
Decrypting Symantec File Share Encryption-Protected Folders (on page 198). 

13 When the process is done, click Finish. 

 

 

Using Files in a Symantec File Share Encryption Protected Folder 
Once you are a Symantec File Share Encryption Authorized User, there are three ways 
to use the files in the Protected Folder: 

 Double-click the Protected Folder to open it, then double-click the specific file you 
want to use. 

 Open the file you want to use from within the application that created it. 

 Open the Protected folder by clicking its path, which displays as a hypertext link; 
then double-click the specific file you want to use. 
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Working with Protected Folders  

If the passphrase of the private key used for your membership in the Symantec File 
Share Encryption Protected File is cached on your system, you do not need to do 
anything else to open the files; they will open automatically. 

If your passphrase is not cached, however, the Protected Folder is locked. You will need 
to authenticate before you can open the files in the Protected Folder. For more 
information, see Unlocking a Protected Folder (on page 191). 

Note: When opening a Symantec File Share Encryption-protected text document on 
Windows Vista using Notepad, you will receive two notifications that the file is being 
unlocked. This is a result of how Notepad accesses the file. 

 

Unlocking a Protected Folder 
Use the Unlock button to try to access a folder that you cannot seem to access but 
believe you should be able to unlock, or in situations where a folder requires manual 
unlocking. You must manually unlock a Protected Folder when the folder is locked due 
to one of the following reasons: 

 The timer in the Passphrase prompt dialog box expires. 

 If you click Cancel in the Passphrase dialog box without entering a valid 
passphrase. 

Any subsequent attempts to access the protected folder result in an “Access is denied” 
dialog box and you must unlock each Protected Folder before you can use the files in 
them. 

To unlock a Protected Folder 

1 Right-click the Protected Folder and select Properties. 

2 In the Properties dialog box, select the Symantec File Share Encryption tab. 

3 Click Unlock. The Unlocking dialog box is displayed. 

4 Type the appropriate passphrase, then click OK. The Unlocking dialog disappears. 
Your passphrase is cached and you have access to all files in the Protected Folder. 

Note: If your Symantec Encryption Server administrator has enabled the option, you 
can select Rescan Symantec File Share Encryption Locks from the PGP Tray menu. 
Use this option to unlock a Symantec File Share Encryption protected folder when 
your key is on a smart card or token that was not inserted when you attempted to 
access the folder. 

 

Determining the Files in a Protected Folder 
Once you become an Authorized User, you have full access to all files in the Protected 
Folder. If you created the Protected Folder, you probably know what files are in it. If you 
were added to the Protected Folder by another member, however, it may not be 
immediately clear to you what files are available to you in the Protected Folder. 

To determine what files are in a Protected Folder 

1 Open Symantec Encryption Desktop and click on the Symantec File Share 
Encryption Control Box. 
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Working with Protected Folders 

2 Click the path to the Protected Folder, which is displayed as a hypertext link. The 
Protected Folder contents appear in a new window, showing the files and folders 
that are in the Protected Folder. 

If access is denied, it means the Protected Folder is locked. You will need to either go to 
the Symantec File Share Encryption tab of the Properties screen for the locked folder 
and unlock it or restart your system to gain access. For more information about 
unlocking a Protected Folder, see Using Files in a Symantec File Share Encryption 
Protected Folder (on page 190). 

 

Adding Subfolders to a Protected Folder 
Symantec File Share Encryption supports adding both files and folders into a Protected 
Folder after it has been created. 

All of the files in a folder you add into a Protected Folder will automatically be 
protected; once added to the Protected Folder, both the folder and the files in it will only 
be available to authorized users. 

Be sure not to add a folder that is already a Protected Folder for a different set of 
authorized users. This would cause the new subdirectory to have a different set of 
authorized users from the parent folder. 

Note: The Symantec File Share Encryption tracking engine ignores EFS-protected 
objects. This is by design and ensures any complications are avoided due to the fact 
EFS is tightly coupled with NTFS. Any files or folders that are EFS-encrypted and are 
moved or copied into a Symantec File Share Encryption-protected folder retain their 
EFS-encryption, but do not become Symantec File Share Encryption-protected. To 
Symantec File Share Encryption protect these objects, remove the EFS encryption 
before moving/copying into a folder. 

 
 

Checking Folder Status 
The Check Folder Status command, available from the Symantec File Share Encryption 
Folder work area, the Symantec File Share Encryption Control Box, or from the 
Symantec File Share Encryption menu, provides up-to-date information about the 
status of the specified Symantec File Share Encryption folder. 

To check the status of a folder in a Protected Folder 

1 On the Symantec File Share Encryption work area, in the Folder Status section, 
click Check Folder Status. You must have a Symantec File Share Encryption folder 
selected. 

2 Read the text to the left of the Check Folder Status button for the status of the 
selected folder (for example: “All folders and files are encrypted”). 

Tip: The date, time, and Key ID of the person who last administered the protected 
folder are displayed below the user list. 
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Working with Symantec File Share Encryption Users  

Copying Protected Folders to Other Locations 
You will achieve greatest security if you always work within a protected folder; 
Symantec Corporation recommends that when you need to copy a folder, you must first 
create a Protected Folder as your destination. Whenever you move files from a 
Protected Folder to another Protected Folder, your environment will remain protected. 

Symantec File Share Encryption retains file encryption even when the Protected Folder 
is moved to another location. However, depending on how you copy the files, and 
where, you may discover that the process has caused the folder to lose its protection. 
The files in the folder retain their protected status, but the folder may lose its Symantec 
File Share Encryption information, and thus lose its PGP icon as well. 

Note: If Symantec Endpoint Encryption Removable Storage is installed, files and 
folders protected by Symantec File Share Encryption are decrypted before written to 
a removable device. Those files and folders will fall under Symantec Endpoint 
Encryption Removable Storage management, which may result in re-encryption 
based on a Symantec Endpoint Encryption policy. 

If you have copied a folder to an unprotected location, as a best practice, check the 
folder status as described in Checking Folder Status (on page 192) to ensure the folder 
and files are encrypted. 

If the folder is not encrypted, do the following: 

1 If your Symantec File Share Encryption permissions allow you to do so, create a 
new protected folder at the destination as described in Creating a New Symantec 
File Share Encryption Protected Folder (on page 188). 

2 Copy the contents of the folder that has lost its protection into the new protected 
folder. 

3 Import the access list of the old folder into the new folder as described in 
Importing Symantec File Share Encryption Access Lists (on page 196). 

 

 

Working with Symantec File Share Encryption Users 
Anyone with a version 9.5 or later who has an appropriate keypair in Symantec 
Encryption Desktop can be a user of a Symantec File Share Encryption Protected 
Folder. 

Keypairs can be: 

 Created in Symantec Encryption Desktop 

 Created by an OpenPGP application and imported into Symantec Encryption 
Desktop 

 An X.509 certificate that has been imported into Symantec Encryption Desktop 

In addition, a user can be a group. The group is represented by a group key name. 
Groups  are created by your Symantec Encryption Server administrator. For more 
information on groups, see Using a Group Key (on page 183). 

There are two ways to become a user: 
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Working with Symantec File Share Encryption Users 

 You can create a Protected Folder using Symantec Encryption Desktop and add 
yourself as a user. 

 You can be added as a user by an existing member. 

Once you become a user, you have the same rights as all other users.  
 

Adding a Symantec File Share Encryption User 
Most Symantec File Share Encryption Users are added when the Protected Folder is 
created, but you can add members at any time after creation—as long as you are an 
Admin or Group Admin of that Protected Folder. 

Caution: Be careful who you add as a User to a Symantec File Share Encryption. Once 
a person is added, that person has all the rights and privileges as any other user. The 
new member can add new files to, or remove existing files from, the Protected Folder. 

To add a new Symantec File Share Encryption User 

1 Select the Symantec File Share Encryption folder to which you want to add a new 
member. 

2 In the User Access section, click Add User. The User Selection dialog box is 
displayed. 

3 Do one of the following: 

 Drag keys from the Key source column into the Keys to add column. 

 Click on a key in the Key source column and click Add. 

 To add keys from the PGP Global Directory, click the PGP Global Directory 
icon, type a search term in the Search field, then click the magnifying glass 
or press Enter to start the search. The results of the search appear in the 
Key source column; from there, add them to the Keys to add column. 

Note: Symantec File Share Encryption does not notify new members that they 
have been added as an Authorized User. Generally speaking, it is the 
responsibility of the person who adds a new user to tell them that they are now 
authorized. 

4 Click OK. The user is added to the list of Users. 

5 Click Apply. The Select Signer screen is displayed. 

6 Select one private key from the private keys on the local keyring or accept the 
default key. This key will be used to sign the files when they are re-encrypted. 
Re-encryption of the files in a Protected Folder is done automatically as a security 
precaution when Users are added. 

7 Type the passphrase for the selected key, if it is not cached, then click Next. The 
Progress screen is displayed and the files in the specified Protected Folder are 
re-encrypted. 

8 Click Finish. 
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Working with Symantec File Share Encryption Users  

Changing a User's Role 
You can change a user's role at any time after the protected folder is created. For more 
information on roles, see Symantec File Share Encryption Roles (on page 179). 

To change a User to an Admin or Group Admin, be sure that user has full rights to the 
protected folder. A group key user cannot be changed to an Admin or Group Admin. 

To change a user's role 

1 In Symantec Encryption Desktop, select the Symantec File Share Encryption 
folder to which you want to add a new member. 

2 In the User Access section, select the user's name and click Change Role. 

Tip: You can also right-click the user's name and select the role. 

3 From the list displayed, select the role you want to apply to this user: 

 Admin: Create only one Admin per Symantec File Share Encryption 
protected folder. This role has full read/write rights to the folder, can add 
and remove users, assign roles to other users, and can promote another user 
to be the Admin. 

 Group Admin: Create as many Group Admins as you need for each Symantec 
File Share Encryption protected folder. This role has full read/write rights to 
the folder, can add and remove users, and assign roles to other users. 

 User: Create as many Users as you need for each Symantec File Share 
Encryption protected folder. This role has full read/write rights to the folder. 

4 Click Apply to save your changes. 

 

 

Deleting a User from a Protected Folder 
To remove a member of a Symantec File Share Encryption Protected Folder, you must 
delete that user. 

To delete a user from a Symantec File Share Encryption Protected Folder 

1 On the Symantec File Share Encryption screen, select the Protected Folder from 
which you want to delete the user. 

2 In the User Access list near the bottom of the screen, click on the name of the user 
you want to delete, then click Delete User. The user is deleted from the list. 

3 Click Apply. The Select Signer screen is displayed. 

4 Select one private key from the private keys on the local keyring or accept the 
default key. This key will be used to sign the files when they are re-encrypted. 
Symantec File Share Encryption automatically re-encrypts files in a Protected 
Folder as a security precaution when a member is removed from the Protected 
Folder. 

5 If you are prompted to do so, type the passphrase for the selected key, then click 
Next. The Progress screen is displayed and the files in the specified Protected 
Folder are re-encrypted. 
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6 Click Finish. The deleted user is no longer a member of the Protected Folder and 
will not be able to access the files in it. 

 

 

Importing Symantec File Share Encryption Access Lists 
Importing access lists lets you import the set of members and their keys from one set of 
Authorized Users of which you are a member to another set of Authorized Users of 
which you are a member. 

This option is available only when you have more than one Protected Folder. 

To import an access list 

1 On the Symantec File Share Encryption screen, select the Protected Folder into 
which you want to import the members of another Protected Folder. 

2 In the User Access list near the bottom of the screen, click Import Access List. 
The PGP Import User Access List dialog box is displayed. 

3 Click the name of the existing Protected Folder whose members you want to 
import, then click Import. 

4 Click Apply. The Select Signer dialog box is displayed. 

5 Select one private key from the private keys on the local keyring or accept the 
default key. This key will be used to sign the files when they are re-encrypted. 
Re-encryption of the files in a Protected Folder is done automatically as a security 
precaution when membership in that folder is modified. 

6 If you are prompted to do so, type the passphrase for the selected key, then click 
Next. The Progress screen is displayed and the files in the specified Protected 
Folder are re-encrypted. 

7 Click Finish. The new members are added to the Protected Folder. 

 

 

Working with Active Directory Groups 
Symantec File Share Encryption integrates with Active Directory so you can easily 
assign users to Protected Folders an Active Directory group. Symantec File Share 
Encryption uses LDAP (Lightweight Directory Access Protocol) to retrieve group 
information from your organization’s Active Directory. 

Note: Active Directory groups are different than using group keys. Using an Active 
Directory group adds every key found for members of that group. Using a group key 
adds only the single key to a protected folder. For more information on group keys, 
see Using a Group Key (on page 183). 
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Setting up Symantec File Share Encryption to Work with Groups 
In order to retrieve group information, you must bind to your Symantec Encryption 
Server and then enable the Use for Group Expansion option. The following procedures 
describe these steps if you have installed Symantec Encryption Desktop in a standalone 
environment. If Symantec Encryption Desktop is installed and integrated with a 
Symantec Encryption Server environment, you do not need to follow this procedure, as 
LDAP integration is automatic. 

Note: There is a limit as to the number of users you can add at one time to a 
Symantec File Share Encryption folder (50 users). Although it is possible to 
customize this hard coded limit, there are implications for doing so and this should 
not be attempted without obtaining support from Symantec Corporation.  

To set up Symantec File Share Encryption to work with groups 

1 Add the Symantec Encryption Server to your list of Preferred Keyservers. To do 
this, create a new messaging service and specify the name of your Symantec 
Encryption Server. For more information, see Creating a New Messaging Service 
(on page 78). 

2 Bind to the Symantec Encryption Server. To do this, follow the instructions to 
manually bind to a Symantec Encryption Server in Messaging with Lotus Notes and 
MAPI Using Symantec Encryption Desktop with IBM Lotus Notes" on page  (see "
261). 

3 In the PGP Key Generation assistant, select the key mode as GKM, CKM, or SCKM. 
Do not select SKM. 

4 Verify that the key is available on the Symantec Encryption Server. To do this, in 
Symantec Encryption Desktop, select the PGP Keys Control Box. Click Search for 
Keys, select the name of the Symantec Encryption Server, enter your name, and 
click . Search

5 Enable group expansion. To do this, in Symantec Encryption Desktop, select the 
PGP Messaging Control Box. 

6 Choose Messaging > Use for Group Expansion. A check is displayed next to the 
menu item to indicate it is enabled. 

 

 

Adding an Active Directory Group to a Protected Folder 
Once you are set up to add members of Active Directory groups to Symantec File Share 
Encryption protected folders, you search for the group name and add the group. Note 
that all members of the Active Directory group are added to the protected folder. 

Once the Active Directory group has been added, the group can be deleted just as if you 
were deleting a single user. 

To add an Active Directory group 

1 Do one of the following: 

 Create a new Symantec File Share Encryption folder. 
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Decrypting Symantec File Share Encryption-Protected Folders 

 Select the Symantec File Share Encryption folder in Symantec Encryption 
Desktop and select Add User. 

2 In the User Selection dialog box, select the keyserver associated with the Active 
Directory group. This may be the default keyserver displayed, such as 
keys.example.com. 

3 In the Find field on the right side, type the name of the Active Directory group and 
click the magnifying glass to search for the group. 

4 When the results are displayed in the left side of the dialog box under Key source, 
select the group name and click Add. When you select the group name, the middle 
pane of the dialog box displays the number of members of the Active Directory 
group and the number of associated keys found on the keyserver. 

5 Click OK.  

6 Continue with creating the protected folder or adding users. 

 

 

Refreshing Groups 
If you are using Symantec File Share Encryption in a Symantec Encryption 
Server-managed environment, and your Symantec Encryption Server administrator has 
established Active Directory groups, you can have Symantec File Share Encryption 
verify that group memberships are up to date. 

To refresh Active Directory groups 

1 On the Symantec File Share Encryption screen, select the Protected Folder whose 
Active Directory groups you want to refresh. 

2 In the User Access section, click Refresh Groups. Symantec File Share Encryption 
checks the Active Directory group memberships and refreshes them if necessary. 

 

 

Decrypting Symantec File Share Encryption-Protected 
Folders 

The Remove Folder command restores the files in a Protected Folder to their normal, 
decrypted state. 

All folders and files that are part of the Protected Folder are decrypted; the PGP icon 
overlay on the files will be removed. 

To remove protection from a Symantec File Share Encryption Protected Folder 

1 On the Symantec File Share Encryption screen, select the Protected Folder whose 
protection you want to remove. 

2 In the Symantec File Share Encryption Control Box, on the left side of the 
Symantec Encryption Desktop window, click Remove Folder. The Confirm 
Decryption dialog box is displayed. 
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Re-Encrypting a Folder  

3 Verify that you are removing protection from the desired folder, then click Next. 
The Unlocking Folder dialog is displayed, if your passphrase has not been cached. 

4 Type the passphrase of one of the keys to which the files were encrypted, then 
click OK. You must type an appropriate passphrase in the allotted time or the 
decryption process will be cancelled. The Progress screen is displayed and the files 
are decrypted. 

5 Click Finish. The files in the Protected Folder are no longer protected by 
encryption, it is removed from the Symantec File Share Encryption Protected 
Folder list, and its lock icon disappears. 

Tip: You can also decrypt a folder by right-clicking the folder in Windows Explorer 
and selecting Decrypt foldername> with Symantec File Share Encryption from the 
shortcut menu. 

 

Re-Encrypting a Folder 
Re-encrypting a folder re-encrypts the files in the specified Protected Folder. 
Re-encryption changes the underlying key, preventing access to anyone who might 
have been able to determine the current key. You must be a Group Admin or Admin of 
the folder in order re-encrypt that folder. 

The Re-encrypt Folder command lets you re-encrypt whenever you want; for example, 
if you believe an unauthorized person has gained access to the files in the Protected 
Folder. 

Examples of why you might want to re-encrypt: 

 You are concerned some Protected Folder contents are not encrypted; for example, 
if someone who is not an Authorized User places a file in a Protected Folder. 

 The key information of an Authorized User has been compromised. 

 A new Authorized User is added, and needs access to the Protected Folder (this 
does not happen automatically). 

To re-encrypt a Protected Folder 

1 On the Symantec File Share Encryption screen, select the Protected Folder you 
want to re-encrypt. 

2 In the Symantec File Share Encryption Control Box, on the left side of the 
Symantec Encryption Desktop window, click Re-encrypt Folder. The Add Users 
screen is displayed.  

You can add new members to or remove existing members from a Protected Folder 
that is being re-encrypted. 

3 Click Next to continue. The Select Signer screen is displayed. 

4 Select one private key from the private keys on the local keyring or accept the 
default key. This key will be used to sign the files when they are re-encrypted. 

5 If you are prompted to do so, type the passphrase and then click Next. The 
Progress screen is displayed and the files in the specified Protected Folder are 
re-encrypted. 

6 Click Finish. The re-encryption process is complete. 
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Clearing a Passphrase 
By default, Symantec File Share Encryption caches passphrases according to the 
settings on the General tab of the Symantec Encryption Desktop Options. This can 
make it easier to use Symantec File Share Encryption, as you do not need to type your 
passphrase to use the protected files in the Protected Folder. 

However, if you are going to be leaving your system, you may not want to leave it with 
your passphrase cached, as this might let an unauthorized person perform actions 
without needing the passphrase. 

To clear a passphrase 

1 In Windows, click the PGP icon in the System Tray. 

2 Select Clear Caches from the menu displayed. At least one passphrase must be 
cached for this command to be active. Your cached passphrases are cleared. 

 

 

Protecting Files Outside of a Protected Folder 
Symantec File Share Encryption has an advanced option that lets you protect individual 
files that are not in a Symantec File Share Encryption Protected Folder. This option is 
disabled by default. 

Note: You may be prevented from selecting this option by your Symantec Encryption 
Server administrator if you are using Symantec Encryption Desktop in a Symantec 
Encryption Server-managed environment. 

Note: If Symantec Endpoint Encryption Removable Storage is installed, files 
protected by Symantec File Share Encryption will be decrypted before written to a 
removable storage device. Those files will fall under Symantec Endpoint Encryption 
Removable Storage management, which may result in re-encryption based on a 
Symantec Endpoint Encryption policy. 

To protect individual files outside of a Symantec File Share Encryption Protected 
Folder, you must first select the Protect individual files option on the Symantec File 
Share Encryption tab of the PGP Options; for more information, see Symantec File 
Share Encryption Options (on page 247). You cannot protect files that are outside of a 
Symantec File Share Encryption Protected Folder until this option is enabled. 

Once you select the Protect individual files option, you can protect individual files that 
are outside of a Protected Folder using the Symantec Encryption Desktop shortcut 
menu in Windows Explorer. Individually protected files do not appear in the Symantec 
File Share Encryption Work area of the Symantec Encryption Desktop user interface.
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Protecting Files Outside of a Protected Folder  

Caution: Symantec File Share Encryption makes every effort to protect individually 
protected files, but some applications (Microsoft Word, for example) save modified 
files in such a way that it appears to Symantec File Share Encryption that the 
protected file has been deleted. Under such circumstances, Symantec File Share 
Encryption cannot continue to protect these files. Note that this applies only to 
individually protected files that are not in a Protected Folder, not files in a Symantec 
File Share Encryption Protected Folder. To avoid having protected files become 
unprotected, Symantec Corporation strongly recommends that you keep files you 
want protected in a Symantec File Share Encryption Protected Folder. 

To enable the Protect individual files option 

1 Select Tools > Options. 

2 Click the File Share tab. 

3 On the File Share tab, make sure the Protect individual files option is selected. 
The default setting is not selected. 

 

To protect individual files using Symantec File Share Encryption 

1 In Windows Explorer, right-click the file you would like to protect using Symantec 
File Share Encryption. 

2 In the shortcut menu, select Symantec Encryption Desktop > Encrypt [file name] 
to Symantec File Share Encryption Advanced. 

3 When the Symantec File Share Encryption Assistant is displayed, add Authorized 
Users and select a private key for signing. 

4 When the encryption process is complete, click Finish. The protected file displays 
a Symantec File Share Encryption icon in Windows Explorer. 

You can also use the shortcut menu to view the Symantec File Share Encryption 
properties of a protected file, re-encrypt individually protected files that are outside of 
a Protected Folder, and remove protection from them. 

To view the Symantec File Share Encryption properties of a protected file using the 
shortcut menu 

1 In Windows Explorer, right-click the protected file whose Symantec File Share 
Encryption properties you would like to view. 

2 Select Properties from the list. 

3 Select the Symantec File Share Encryption tab. The Properties window for the 
selected file is displayed. 

4 When done viewing properties, click OK. 

 

To re-encrypt protected files using the shortcut menu 

1 In Windows Explorer, right-click the protected file you would like to re-encrypt. 

2 In the shortcut menu, select Symantec Encryption Desktop > Re-encrypt. 

3 When the Symantec File Share Encryption Assistant is displayed, add and/or 
remove Authorized Users and select a private key for signing. 
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Backing Up Symantec File Share Encryption-Protected Files 

4 When the re-encryption process is complete, click Finish. 

 

To remove protection from individually protected files using the shortcut menu 

1 In Windows Explorer, right-click the protected file whose protection you would 
like to remove. 

2 In the shortcut menu, select Symantec Encryption Desktop > Decrypt [file name] 
from Symantec File Share Encryption. 

3 When the Symantec File Share Encryption Assistant is displayed, confirm that you 
want to remove protection from the file by clicking Next. 

4 When the file has been decrypted, click Finish. 

 

 

Backing Up Symantec File Share Encryption-Protected 
Files 

You can back up files and folders that have been protected by Symantec File Share 
Encryption. Whether you are using Symantec File Share Encryption in a Symantec 
Encryption Server managed environment or not determines how the files are handled 
during the backup process. 

Backing up files with an unmanaged client 
When an unmanaged (standalone) client backs up protected files and folders, the 
protected files are decrypted transparently during backup and are stored in the clear on 
the backup media. Restoring them to their original encryption will encrypt them again 
transparently. 

Backing up files with a Symantec Encryption Server-managed client 
When a managed client is used to back up of protected files and folders, how the 
encryption is handled depends on if the backup application is set as an application 
bypass by the Symantec Encryption Server administrator. 

 If the backup application is part of the decryption bypass list, the protected files 
stay encrypted on the backup media after backup. Restoring them to their original 
location keeps them encrypted. 

 If the backup application is not part of the decryption bypass list, then it is similar 
to backing up files with an unmanaged client. In this case, the protected files are 
decrypted transparently during backup and are stored in the clear on the backup 
media. Restoring them to their original encryption will encrypt them again 
transparently. 

Note: Symantec Corporation recommends that you do not mix the different scenarios 
between backing up data and restoring data. For example, if you are using an 
unmanaged client to back up the files, an unmanaged client should restore the files. 
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Accessing Symantec File Share Encryption Features using 
the Shortcut Menu 

Some Symantec File Share Encryption functionality is available from the right-click 
shortcut menu in Windows Explorer. 

Note: When Symantec Endpoint Encryption Removable Storage is installed, the 
shortcut menu is not available. 

You can protect folders (and files, if you have enabled the Protect individual files 
option) from Windows Explorer by right-clicking the item. Select Symantec Encryption 
Desktop > Add [name] to Symantec File Share Encryption from the shortcut menu 
displayed to begin the process of designating that item as protected by Symantec File 
Share Encryption. 

For more information about protecting individual files outside of a Protected Folder 
using Symantec File Share Encryption, see Protecting Files Outside of a Protected Folder 
(on page 200). 

Once a folder or file is protected by Symantec File Share Encryption, there are three 
commands you can perform in Windows Explorer using the shortcut menu: 

 Symantec File Share Encryption Properties. This command opens the Symantec 
File Share Encryption tab of the Properties screen for the file or folder. On this 
tab, you can view who can use protected files, unlock a file/folder if locked, and 
add users who can use the protected files. 

 Re-encrypt. This command re-encrypts the specified folder or file to a new 
underlying key. 

 Decrypt <file name> with Symantec File Share Encryption. This command 
removes the Symantec File Share Encryption protection from the specified folder 
or file. 

For the applicable procedures, see Protecting Files Outside of a Protected Folder (on page 
200). 

 

Symantec File Share Encryption in a Symantec Encryption 
Server-managed Environment 

If you are using Symantec File Share Encryption in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have configured settings that affect how Symantec File Share Encryption works on your 
system. 

These settings are: 

 Allow the user to create and manage Symantec File Share Encryption folders. 
When enabled, this setting allows you to create Symantec File Share Encryption 
Protected Folders. When disabled, you can use a Protected Folder that someone 
else has created, but you cannot create one yourself. This setting is enabled by 
default. 

 



 
204 Using Symantec File Share Encryption 

 
 
 

 

Accessing the Properties of a Protected File or Folder 

 Allow the user to enable Advanced User mode. When enabled, this setting allows 
you to enable Advanced User mode in your PGP Options, which means that you 
can protect individual files that are moved out of a Protected Folder. This setting 
is disabled by default. 

 Force the encryption of files in the following folders. These folders are called 
"whitelisted" folders. Whitelisted folders are folders that are always added to 
Symantec File Share Encryption and the contents are encrypted. For more 
information, see "Blacklisted" and "Whitelisted" Folders Specified by Symantec 
Encryption Server (on page 185). 

 Prevent the encryption of files in the following folders. These folders are called 
"blacklisted" folders. Blacklisted folders are folders that are never added to 
Symantec File Share Encryption and encrypted. For more information, see 
"Blacklisted" and "Whitelisted" Folders Specified by Symantec Encryption Server (on 
page 185). 

Contact your Symantec Encryption Server administrator if you have any questions 
about these settings. 

 

Accessing the Properties of a Protected File or Folder 
Any file that is protected by Symantec File Share Encryption has a Symantec File Share 
Encryption tab on its Properties dialog box, which shows information about the file. 

To access the Symantec File Share Encryption tab on the Properties dialog box of a file 

1 In Windows Explorer, right-click the file and select Properties from the list. 

2 Click the Symantec File Share Encryption tab.  

3 The Symantec File Share Encryption tab for a file shows you the names of those 
users who can use the encrypted file. From here you can do one of the following: 

 Unlock. Click to unlock a Protected Folder that has been locked. 

 Edit. Click to display the Add Users screen, which lets you add/remove users 
who can use the selected file/folder. The file/folder will be re-encrypted if a 
user is added or removed. 

 View the roles for each user by right-clicking the user's name. You cannot 
change the user's role in this tab (to change a user's role, see Changing a 
User's Role (on page 195)). 

4 To close the Properties dialog, click OK. 

 

 

Using the Symantec File Share Encryption Menus in 
Symantec Encryption Desktop 

There are three Symantec Encryption Desktop menus that have commands that affect 
Symantec File Share Encryption: File, Edit, and Symantec File Share Encryption. 
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Using the Symantec File Share Encryption Menus in Symantec Encryption Desktop  

Note: When Symantec Endpoint Encryption Removable Storage is installed, these 
menus are not available. 

 

The File Menu 
When the Symantec File Share Encryption Control Box is selected, selecting File > New 
Symantec File Share Encryption Folder lets you create a new Protected Folder. 

The process is the same as described in Creating a New Symantec File Share Encryption 
Protected Folder (on page 188). 

 

The Edit Menu 
When the Symantec File Share Encryption Control Box is selected, the Rename 
command under the Symantec Encryption Desktop Edit menu lets you rename a 
Protected Folder. 

To rename a Symantec File Share Encryption Protected Folder via the Edit menu 

1 Open Symantec Encryption Desktop and click on the Symantec File Share 
Encryption Control Box. 

2 If you have more than one Protected Folder, click on the name of the Protected 
Folder you want to rename. 

3 Select Edit > Rename. 

4 Type a new name for the Protected Folder. 

5 Press Enter or click outside the Protected Folder name. The Protected Folder is 
renamed. 

The Show File in Explorer... option in the Edit menu is equivalent to clicking a 
Protected Folder’s path. Choosing this option opens a selected folder in Windows 
Explorer. 

 

The Symantec File Share Encryption Menu 
You can select the following commands from the Symantec File Share Encryption menu 
when the Symantec File Share Encryption Control Box is selected: 

 Add Folder: Select this command to create a new Protected Folder. The process is 
the same as described in Creating a New Symantec File Share Encryption Protected 
Folder (on page 188). You must select the Symantec File Share Encryption Control 
Box for this command to be active. 

 Remove Folder: Select this command to begin the process of taking a Protected 
Folder and restoring it to its normal, decrypted state. All folders and files that are 
part of the Protected Folder will be decrypted; the PGP icon overlay on the files 
will be removed. You must select a Protected Folder for this command to be active. 
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 Re-encrypt Folder: Select this command to re-encrypt the files in a Protected 
Folder. Re-encryption changes the underlying key, preventing access to anyone 
who might have been able to determine the current key. Re-encryption is done 
automatically when a user is added to or removed from a Protected Folder. The 
Re-encrypt Folder command lets you re-encrypt whenever you want; for example, 
if you believe an unauthorized person has gained access to the files in the 
Protected Folder. You must select a Protected Folder for this command to be 
active. 

 Check Folder Status: Select this command to get up-to-date information about the 
status of the selected Protected Folder. You must select a Protected Folder for this 
command to be active. 

 Clear Recent Folder: Select this command to remove it from the list of Protected 
Folders. Unlike the Remove Folder command, however, this command does not 
decrypt the files in the Protected Folder. You must select a Protected Folder for 
this command to be active. 

 

 

Working with Dropbox 
The features and behaviors of Symantec File Share Encryption and Dropbox remain 
basically unchanged in their integrated relationship. Slight differences in your 
interaction with each product, however, and the timing and triggering of encryption 
inside the Dropbox world are discussed in the topics of this section. 

 
 

System Requirements for Integrating with Dropbox 
The integration of Symantec File Share Encryption and Dropbox requires the 
installation of the following software: 

 Symantec Encryption Desktop, v. 10.4, on a managed client, licensed for Symantec 
File Share Encryption 

 Dropbox, v. 3.16.1 

The software can be installed in any sequence. 

Note: If you have been using Dropbox, and then install Symantec Encryption 
Desktop, existing files in the Dropbox folder are unaffected. You must update them 
to trigger the encryption. 

Note: Once Symantec File Share Encryption and Dropbox are integrated, if you 
uninstall Dropbox, Symantec File Share Encryption continues to protect the files in 
the Dropbox folder. To remove this protection, manually decrypt the files and 
folders. 

See Encrypting Files (on page 207) 
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Encrypting Files 
Files are encrypted automatically whenever you create, copy, move, and/or save them 
to the Dropbox folder. Your Symantec Encryption Server administrator specifies the 
encryption credentials in the Dropbox policy. 

In the following cases, files are decrypted first, and then re-encrypted according to 
Dropbox policy: 

 You move or save files into a Dropbox folder that have already been encrypted by 
Symantec File Share Encryption or Data Loss Prevention (DLP). 

 Files in a Dropbox folder are already encrypted to a previous Dropbox policy, then 
the administrator changes that policy.  

Note: Only the latest version of a file is encrypted; previous unencrypted versions 
remain unencrypted. 

See also:  

  Activating a Dropbox Policy (on page 207) 

  Integrating with Symantec Data Loss Prevention (on page 180) 

Activating a Dropbox Policy 
Your Symantec Encryption Server administrator creates the Dropbox policy. 

To activate a Dropbox policy 

Do one of the following: 

 Reboot your computer. 

 Log off, then log on, to your Windows session. 

 From the PGP Tray icon menu, click Update Policy. 
 

Resolving Users' Keys 
Users' keys are resolved automatically when your computer connects with the 
Symantec Encryption Server. Once keys are resolved, they remain cached for that 
Windows session. Depending on how your administrator defined the Dropbox policy, 
encryption credentials for Dropbox can include your local user key, one or more group 
keys, or other keys, such as an Additional Decryption Key (ADK). 

To view the encryption keys associated with a file, see Accessing the Properties of a 
Protected File or Folder (on page 204). 

 

Adding Encrypted Files to a Dropbox Folder 

To add encrypted files to the Dropbox folder, you can: 

 Create new files in the folder 
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 Update and save existing files in the folder 

 Copy or move files into the folder, using drag-and-drop, keyboard shortcuts, or 
commands 

Note: If Dropbox synchronization downloads unencrypted files from the cloud into 
the Dropbox folder, those files are not encrypted. 

 

Adding Files When Offline 

If your system is not able to connect with the Symantec Encryption Server, your keys 
must already be cached to allow you to add files to the Dropbox folder; otherwise, you 
will receive an "Access denied" error. 

 

Adding and Encrypting External Files 

If you are away from the office and creating or updating a file, place the file in your 
local Dropbox folder that uses the same account as the Dropbox folder on your 
Windows system. Unless you have Symantec Encryption Desktop installed at home, the 
Dropbox application uploads the file in plain text to your Dropbox folder in the cloud.  

During Dropbox synchronization, the Dropbox application downloads that unencrypted 
file to your Windows Dropbox folder.  

To encrypt that file, update the file and then save it back to your Dropbox folder. 
During the next synchronization, your encrypted file is uploaded to the cloud. 

Identifying an Encrypted File 
A file that Symantec File Share Encryption encrypts displays a lock icon, including 
encrypted files in the Dropbox folder. The Dropbox icon is displayed on files in the 
Dropbox folder that are not encrypted. You can also verify the file is encrypted by 
looking at the properties of the file. 

To verify that a file in the Dropbox folder is encrypted 

 In Windows Explorer, do one of the following: 

 Right-click the file and select Properties from the list, or 

 Select File > Properties from the list.  

If there is a Symantec File Share tab, then this file is encrypted. 

Alternatively, if you try to open an encrypted file and your credentials are not cached, 
Symantec File Share Encryption will prompt you for your credentials. 

 
 

Sharing Encrypted Dropbox Files 
To share encrypted files, each user must have Symantec Encryption Desktop installed. 
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To share key access to encrypted files: 

 Exchange your public keys with each other 

Belong to the same group that the files are encrypted to To share Dropbox files and 
folders with other users: 

 See instructions on the Dropbox website (www.dropbox.com). Various degrees of 
sharing are available. 

 

Decrypting Files 
When you provide decryption credentials, any file you open is decrypted transparently.  

Note: If the right-click Decrypt menu option is available when you use Symantec 
Encryption Desktop for Windows, it does not work for cloud decryption. If you select 
it, an error appears. 

 

 

http://www.dropbox.com/
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Use PGP Zip to create, open, and edit encrypted and compressed packages, called PGP 
Zip archives. This section describes how to use the PGP Zip feature of Symantec 
Encryption Desktop. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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Overview 
A PGP Zip Archive package is a single file that is encrypted and compressed for 
convenient transport or backup. These archive files can hold any combination of files 
and/or folders, and are especially convenient for secure transport or backup. 

Use the PGP Zip Assistant to create new PGP Zip Archive packages. The Assistant 
guides you through the process of selecting the files and/or folders for your archive and 
the method of encryption or packaging: 

 Encrypting and packaging your files and/or folders using the PGP keys of one or 
more recipients (recipients must have Symantec Encryption Desktop on their 
computers). 

 Encrypting and packaging your files and/or folders using a passphrase (recipients 
must have Symantec Encryption Desktop on their computers). 

 Encrypting and packaging your files and/or folders into a self-decrypting archive 
(PGP Zip SDA) that is protected by a passphrase (recipients do not need Symantec 
Encryption Desktop, but the recipient's computer must be running Microsoft 
Windows); 

 No encryption and no packaging, but a file is created that you can send to your 
recipients to verify that you are the person who sent the file. 
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When you are using the PGP Zip Assistant to create a PGP Zip Archive file, you have the 
option of automatically sending the original files to the PGP Shredder, so they can be 
removed securely and permanently from your computer. 

When you receive a PGP Zip Archive file, you can: 

 Extract all of the files and/or folders in the archive. 

 Extract some of the files and/or folders in the archive. 

 Extract some files and/or folders in the archive while adding others. 

 Add new files and/or folders to the archive. 

 Edit the archive by: 

 Changing the type of encryption. 

 Changing the signing key. 

 Changing the recipients. 

PGP Zip archives are encrypted to the preferred cipher for Symantec Encryption 
Desktop (if configured by a Symantec Encryption Server administrator) or to AES256. 
PGP Zip Archives can be moved between the Windows and Mac OS X platforms. 
Symantec Encryption Desktop must be installed on the system to which the PGP Zip 
archive is being moved.  

 

Creating PGP Zip Archives 

To create a PGP Zip archive 

1 Click the PGP Zip Control box  and then click New PGP Zip. The PGP Zip Assistant 
is displayed. 

2 Do any of the following: 

 Drag and drop your files into the area specified in the assistant. 

 To add an entire directory to the PGP Zip archive you are creating, click Add 

directory . 

 To add a file to the PGP Zip archive you are creating, Add files . 

 To remove a file or directory from the PGP Zip archive you are creating, click 

Remove selected files . 

 To select additional options for the PGP Zip file that you are creating, click 

PGP Zip advanced options . The default settings are fine for most users. 

Note: To add a combination of files and folders, use a combination of the  and 

the  buttons. When you add a directory to the file list, the PGP Zip Assistant 
displays all files separately, making it easy to see all of them. If you need to add 
many files to your PGP Zip Archive, you might save time if you add an entire 
directory to the PGP Zip Archive file list first, then remove the files that you do 
not want included. If you do this, before proceeding, make sure that you have 
completely removed any files that are not intended for the PGP Zip Archive.
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When adding files to a PGP Zip file, you cannot add more than 600 files at a time. 
This number can vary depending on the number of characters in the names of the 
files being added. To work around this issue, add large numbers of files in smaller 
batches. 

3 To securely delete the original files once the PGP Zip Archive is created, select 
Shred Originals. 

Caution: If you choose to send the original files to PGP Shredder once the PGP Zip 
Archive is created, you cannot retrieve your files later—not even with a file 
recovery utility. Your files are permanently deleted and cannot be recovered. Use 
care when selecting this option. 

4 To specify special options, click PGP Zip advanced options : 

 To create separate encrypted files rather than one PGP Zip Archive package 
that contains all files in a single encrypted file, select Do not Zip (output 
files individually). 

 To create zip archives of only text files, select Convert linefeeds for text 
files. 

 To email this zip archive as a binary file, and you are using an older email 
application, select Output Text. Saving the file as ASCII text increases the 
size of the encrypted file by about 30%. This option is not available when you 
are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment. 

 To save these PGP Zip Option settings so you can use them in the future, 
select Remember these settings next time. 

 Click OK when you are done selecting special options. Click Cancel if you 
choose not to change any of these options. 

The New PGP Zip dialog box displays again. 

5 When you have finished selecting files for your PGP Zip Archive, click Next. 

6 Select the desired type of encryption and click Next.  

Tip: Move your cursor over each option to view more details in the information 
field below the option list. 

 Recipient keys. Creates a PGP Zip Archive by encrypting the files to the 
public keys of the recipient(s), ensuring that only those recipients can use 
Symantec Encryption Desktop to open the archive. This is the most secure 
option. See Encrypting to Recipient Keys (on page 214). 

 Passphrase. Creates a PGP Zip Archive by encrypting the files with a 
passphrase you specify when saving the archive. Only those persons who 
know the passphrase, and who are using Symantec Encryption Desktop can 
open the archive. See Encrypting with a Passphrase (on page 215). 

 PGP Self-Decrypting Archive. Creates a PGP Self-Decrypting Archive with a 
passphrase you specify when saving the archive. Symantec Encryption 
Desktop is not required when decrypting a PGP Self-Decrypting Archive—but 
recipients must be using a computer running the Microsoft Windows 
operating system. See Creating a PGP Self-Decrypting Archive (SDA) (on page 
217). 
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 Sign Only. Adds your PGP signature to an unencrypted zip file. Your 
recipient(s) can then open the zip archive using Symantec Encryption 
Desktop, and the included signature verifies that the zip archive came from 
you and has not been modified in transit. For more information, see Creating 
a Sign Only Archive (on page 219). 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, passphrase (conventional) encryption may be 
disabled. 

 

Encrypting to Recipient Keys 
Use Recipient keys: 

 To offer the highest possible security for your files. 

 When each of your recipients has Symantec Encryption Desktop installed on their 
computers (Windows or Mac OS X). 

 When you have a public key for each recipient (from your Keyring or a PGP 
Keyserver). 

 When you do not want to reveal a passphrase to file recipients. 

Encrypting your PGP Zip Archive by using the public keys of all of your recipients is the 
most secure option, and should be the first choice if you need top security and have the 
necessary requirements available. 

Once your files are secured, you send the resulting PGP Zip Archive file to your 
recipients however you choose. Your recipients then use Symantec Encryption Desktop 
to open the PGP Zip Archive file. Anyone whose key you included when you encrypted 
the file can open the resulting PGP Zip Archive file, and everyone sees the same items. 
If you need to have some recipients see only some items, you must create separate PGP 
Zip Archive files for each. 

To encrypt to recipient keys 

1 If you haven’t already, begin the process of creating a PGP Zip Archive as 
described in Creating PGP Zip Archives (on page 212). 

2 In the Encrypt dialog box, select Recipient keys. 

3 Click Next. The Add User Keys dialog box is displayed. 

4 Select the recipients of your PGP Zip Archive. Do any of the following: 

 To select from the list of keys that are on your keyring, click the arrow. 

 To send the file to a recipient whose key is not on your keyring, click Add. 
The Recipient Selection dialog box is displayed. 

When you are finished selecting additional names, click OK to return to the Add 
User Keys panel. 

To remove any keys, select the recipient's name and click Remove. 

5 Click Next. The Sign and Save screen is displayed. 

6 If desired, specify a private key on your keyring as a Signing Key for the PGP Zip 
archive being created. 
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This specified Signing Key is used to digitally sign the PGP Zip archive. The 
recipient(s) can verify who the archive is from by verifying the digital signature 
using the corresponding public key. 

 If you do not need to sign the file, or prefer not to, choose None from the 
Signing Key list. 

 If you choose to sign your PGP Zip Archive, choose your key from the Signing 
Key list, then enter the passphrase of the key selected for signing (not the 
passphrase used to secure the zip). To see keystrokes as you type the 
passphrase, select Show Keystrokes. 

If you have already typed your passphrase during this session using Symantec 
Encryption Desktop your passphrase might be cached, depending on your Options 
settings. A message is displayed stating that the passphrase is cached, if this is the 
case. Even if your passphrase is cached, you can still choose not to sign the PGP 
Zip Archive file. 

7 Confirm that the PGP Zip Archive is being saved in the location and with the file 
name you want. If necessary, you can: 

 Change where the file is saved by clicking Browse and choosing a location 
from the Windows File dialog box. 

 Change where the file is saved by manually typing the location where you 
would like to save the PGP Zip Archive. 

 Change the PGP Zip Archive file name by manually typing it at the end of the 
file location text string. 

The default file name for a PGP Zip Archive containing a single file, directory, or 
drive is the name of that item with .pgp appended. If the PGP Zip Archive 
contains more than one item, its file name is one of the items with .pgp appended. 
Change the PGP Zip Archive file name, if desired. 

8 If you chose the Sign Only option, click to select Save Detached Signatures. 

9 Click Next. The PGP Zip Archive is created. 

10 Click Finish. Your PGP Zip Archive is ready to be sent to the recipients whose keys 
you encrypted it to. If your key was one of the keys you used for encryption, the 
file is ready for storage wherever you want. 

 

 

Encrypting with a Passphrase 
Use Passphrase: 

 When you want to create a PGP Zip archive without using recipients' keys (this can 
be less secure than encrypting with recipients’ keys, although still highly secure). 

 When each of your recipients has Symantec Encryption Desktop installed on their 
computers (Windows or Mac OS X). 

 When you do want to reveal a passphrase to file recipients. 

 When you do not have a public key for each recipient (from your Keyring or a PGP 
Keyserver). 

Tip: Encrypting with a passphrase is also referred to as conventional encryption.
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Encrypting your PGP Zip Archive with a passphrase can be extremely secure, especially 
with a strong passphrase. However, encrypting to recipient keys does offer even higher 
security. When you encrypt to your recipients’ keys, those who possess the PGP Zip 
Archive need both their private keys and passphrases to decrypt the file (and each 
recipient’s private key has its own passphrase). 

When encrypting with a passphrase, everyone opens the file using the same 
passphrase, and no private keys are required. Anyone who possesses the file, uses 
Symantec Encryption Desktop and knows the passphrase can decrypt the file. 

Caution: Take every possible precaution to ensure that the passphrase to your PGP 
Zip Archive is revealed to no one but the intended recipients. If the passphrase is 
revealed to unauthorized persons, create a new PGP Zip Archive with a different 
passphrase. Note, however that you can do nothing to re-secure the original archive 
file and its contents. 

Once your files are secured, send the resulting PGP Zip Archive file to your recipients 
however you choose. Your recipients then use Symantec Encryption Desktop to open 
the PGP Zip Archive file. Anyone who has the file and the passphrase can open the 
resulting PGP Zip Archive file, and everyone sees the same items. If you need to have 
different recipients see different items, you must create separate PGP Zip Archive files 
for each. 

Caution: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, encrypting with a passphrase may be disabled. 

To encrypt using a passphrase 

1 If you haven’t already, begin the process of creating a PGP Zip Archive as 
described in Creating PGP Zip Archives (on page 212). Follow the instructions to 
Step 6. Once that is completed, return to this section. 

2 In the Encrypt window, select Passphrase. 

3 Click Next. The Create a Passphrase dialog box is displayed. 

4 To see keystrokes as you type the passphrase, select Show Keystrokes. 

5 In the Passphrase field, type the passphrase you want to use. 

The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating by comparing the amount of entropy in the 
passphrase you type against a true 128-bit random string (the same amount of 
entropy in an AES128 key). For more information, see The Passphrase Quality Bar 
(on page 254). 

6 Type your passphrase again in the Confirm field. 

7 Click Next. The Sign and Save dialog box is displayed. 

8 If desired, specify a private key on your keyring as a Signing Key for the PGP Zip 
archive being created. 

This specified Signing Key is used to digitally sign the PGP Zip archive. The 
recipient(s) can verify who the archive is from by verifying the digital signature 
using the corresponding public key. 

 If you do not need to sign the file, or prefer not to, choose None from the 
Signing Key list. 
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 If you choose to sign your PGP Zip Archive, choose your key from the Signing 
Key list, then enter the passphrase of the key selected for signing (not the 
passphrase used to secure the zip). To see keystrokes as you type the 
passphrase, select Show Keystrokes. 

If you have already typed your passphrase during this session using Symantec 
Encryption Desktop your passphrase might be cached, depending on your Options 
settings. A message is displayed stating that the passphrase is cached, if this is the 
case. Even if your passphrase is cached, you can still choose not to sign the PGP 
Zip Archive file. 

9 Confirm that the PGP Zip Archive is being saved in the location and with the file 
name you want. If necessary, you can: 

 Change where the file is saved by clicking Browse and choosing a location 
from the Windows File dialog box. 

 Change where the file is saved by manually typing the location where you 
would like to save the PGP Zip Archive. 

 Change the PGP Zip Archive file name by manually typing it at the end of the 
file location text string. 

The default file name for a PGP Zip Archive containing a single file, directory, or 
drive is the name of that item with .pgp appended. If the PGP Zip Archive 
contains more than one item, its file name is one of the items with .pgp appended. 
Change the PGP Zip Archive file name, if desired. 

10 Click Next. The PGP Zip Archive is created. 

11 Click Finish. Your PGP Zip Archive is ready to be sent to the recipients. Do not 
forget to communicate the passphrase to the recipients so they can open the 
archive. 

 

 

Creating a PGP Self-Decrypting Archive (SDA) 
Use PGP Self-Decrypting Archive: 

 When you want to create a PGP Zip self-decrypting archive without using 
recipients' keys (this can be less secure than encrypting with recipients’ keys, 
although still highly secure). 

 When your recipients do not have Symantec Encryption Desktop installed on their 
computers and all recipients are using Windows systems. 

 When you do want to reveal a passphrase to file recipients. 

 When you do not have a public key for each recipient (from your Keyring or a PGP 
Keyserver). 

A PGP Self-Decrypting Archive (SDA) is a PGP Zip Archive that can be opened on any 
Windows computer, even those that do not have Symantec Encryption Desktop 
installed. PGP Zip SDA files are standard Windows executable (.exe) files that you an 
open simply by double-clicking them. 

PGP Zip SDA files are slightly larger than regular PGP Zip Archive because the 
self-decrypting “mechanism” requires a certain amount of extra space (usually about 
100 KB). 
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Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, PGP Zip SDA creation may be disabled. 

Once you have created your PGP Zip SDA, send it to your recipients however you 
choose. Anyone who has the file and the passphrase can open the resulting PGP Zip 
Archive file, and everyone sees the same items. If you need to have different recipients 
see different items, you must create separate PGP Zip Archive files for each. 

Caution: Take every possible precaution to ensure that the passphrase to your PGP 
Zip SDA is revealed to no one but the intended recipients. If the passphrase is 
revealed to unauthorized persons, create a new PGP Zip SDA with a different 
passphrase. Note, however that you can do nothing to re-secure the original archive 
file and its contents. 

To create a PGP Zip SDA 

1 If you haven’t already, begin the process of creating a PGP Zip Archive as 
described in Creating PGP Zip Archives (on page 212). Follow the instructions to 
Step 6. Once that is completed, return to this section. 

2 In the Encrypt dialog box, select PGP Self-Decrypting Archive. 

3 Click Next. The Create a Passphrase dialog box is displayed. 

4 To see keystrokes as you type the passphrase, select Show Keystrokes. 

5 In the Passphrase field, type the passphrase you want to use. 

The Passphrase Quality bar provides a basic guideline for the strength of the 
passphrase you are creating by comparing the amount of entropy in the 
passphrase you type against a true 128-bit random string (the same amount of 
entropy in an AES128 key). For more information, see The Passphrase Quality Bar 
(on page 254). 

6 Type your passphrase again in the Confirm field. 

7 Click Next. 

8 Confirm that the PGP Zip Archive is being saved in the location and with the file 
name you want. If necessary, you can: 

 Change where the file is saved by clicking Browse and choosing a location 
from the Windows File dialog box. 

 Change where the file is saved by manually typing the location where you 
would like to save the PGP Zip Archive. 

 Change the PGP Zip Archive file name by manually typing it at the end of the 
file location text string. 

The default file name for a PGP Zip Archive containing a single file, directory, or 
drive is the name of that item with .pgp appended. If the PGP Zip Archive 
contains more than one item, its file name is one of the items with .pgp appended. 
Change the PGP Zip Archive file name, if desired. 

9 Click Next. The PGP Zip SDA is created. 

10 Click Finish. Your PGP Zip SDA is ready to be sent to the recipients 
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Creating a Sign Only Archive 
Use Sign Only: 

 When you do not need to encrypt your files (so you do not need to reveal a 
passphrase to recipients). 

 When you want to generate a signature file that your recipients can use to confirm 
the PGP Zip Archive came from you. Each file is processed individually and a 
separate detached sig is created for every file. 

 When each of your recipients has Symantec Encryption Desktop installed on their 
computers (Windows or Mac OS X). 

 When you want to guarantee that you have sent the file, and you want to assure 
your recipient that the file has not changed during transit. 

For times when you do not need to encrypt file(s) for your recipients, you can choose 
the Sign Only option. Instead of encrypting your files and zipping them into one PGP 
Zip Archive, this option zips them only. 

To encrypt using the Sign Only option 

1 If you haven’t already, begin the process of creating a PGP Zip Archive as 
described in Creating PGP Zip Archives (on page 212). Follow the instructions to 
Step 6. Once that is completed, return to this section. 

Note: When you are selecting the files to be zipped and signed, the Shred 
Originals option is ignored, even if you select it. 

2 In the Encrypt dialog box, select Sign Only. 

3 Click Next. The Sign and Save panel is displayed. 

4 Specify a private key on your keyring as a Signing Key for the PGP Zip archive 
being created. 

This specified Signing Key is used to digitally sign the PGP Zip archive. The 
recipient(s) can verify who the archive is from by verifying the digital signature 
using the corresponding public key. 

 If you do not need to sign the file, or prefer not to, choose None from the 
Signing Key list. 

 If you choose to sign your PGP Zip Archive, choose your key from the Signing 
Key list, then enter the passphrase of the key selected for signing (not the 
passphrase used to secure the zip). To see keystrokes as you type the 
passphrase, select Show Keystrokes. 

If you have already typed your passphrase during this session using Symantec 
Encryption Desktop, your passphrase might be cached, depending on your 
Options settings. A message is displayed stating that the passphrase is cached, if 
this is the case. Even if your passphrase is cached, you can still choose not to sign 
the PGP Zip Archive file. 

5 Confirm that the PGP Zip Archive is being saved in the location you want. If 
necessary, you can: 

 Change where the file is saved by clicking Browse and choosing a location 
from the Windows File dialog box. 
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 Change where the file is saved by manually typing the location where you 
would like to save the PGP Zip Archive. 

The default file name for a sign-only PGP Zip Archive is the name of that item with 
.sig appended.  

6 If you would prefer to have a separate signature file, along with your PGP Zip 
Archive, click to select Save Detached Signatures. 

7 Click Next. The sign-only PGP Zip Archive is created. 

8 Click Finish. 

 

 

Opening a PGP Zip Archive 
Symantec Encryption Desktop must be installed on the system to open a PGP Zip 
archive. 

To open a PGP Zip Archive 

1 Double click the PGP Zip archive file (it has a .pgp file extension).  

 If the PGP Zip archive was secured with a key, the PGP Enter Passphrase for 
Listed Key dialog box is displayed. 

 If the PGP Zip archive was secured with a passphrase, the PGP Enter 
Passphrase dialog box is displayed. 

Symantec Encryption Desktop displays the contents of the PGP Zip archive. (If the 
Symantec Encryption Desktop application is not open, it is opened with the PGP 
Zip item active.) 

2 To extract items, do the following: 

 To extract a single item, right-click the item and select Extract from the 
shortcut menu. 

 To extract multiple items, select the items, right-click one of them, and select 
Extract from the shortcut menu. 

The Browse for Folder dialog box is displayed. 

3 Locate the folder into which you want to extract the files and click OK. To create a 
new folder, New Folder. The file(s) are extracted into the location you specified. 

If you extract the decrypted files from the PGP Zip archive into the same location 
from which they originally came, the original files are overwritten. To prevent 
this, for each file, you are prompted to verify if you want to overwrite an existing 
file.  

 

Opening a PGP Zip SDA 
It is not necessary to have Symantec Encryption Desktop installed to open a PGP Zip 
SDA. 
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To open a PGP Zip SDA 

1 Double click the PGP Zip SDA file (it should have a .exe file extension). The PGP 
Self-Decrypting Archive - Enter Passphrase dialog box is displayed. 

2 Confirm that the output is to be extracted into the desired location. If not, click 
Browse to correct the location, or type it in the field. 

Note: If you direct the decrypted files from the PGP Zip SDA into the same 
location from which they originally came, the original files are overwritten. To 
prevent this, for each file, you are prompted to select a different location. You 
can also type a different file name. If you if you click Save without doing this, a 
warning dialog box displays. If you bypass it, the file from the PGP Zip SDA 
overwrites the original. 

3 Type the passphrase for the PGP Zip SDA, then click OK. The PGP Zip SDA is 
decrypted. 

 

 

Editing a PGP Zip Archive 
PGP Zip Archives are not static. At any time, you can: 

 Extract files from them. 

 Add files to them. 

 Edit the settings of the archive itself. 

To edit a PGP Zip archive 

1 In Symantec Encryption Desktop, click the PGP Zip Control box. The PGP Zip 
Control box highlights. 

2 Click the name of the PGP Zip archive you want to edit in the list of PGP Zip 
archives at the top of the PGP Zip Control box. The settings for the archive and the 
files and/or folders in the archive are displayed. 

If the PGP Zip archive you want to open is not listed, click Open a PGP Zip, 
navigate to the .pgp file, select it, then click Open. 

3 To edit the settings of the PGP Zip archive, click Edit, and make the desired 
changes: 

 To add a file to a PGP Zip archive, click Add Files in the PGP Zip Control box, 
select the file or files you want to add, then click Open. The files are added to 
the archive. 

 To add a folder in the archive and put files into that folder, click New Folder 
in the PGP Zip Control box and type a descriptive name for the new folder (if 
desired). Select the new folder, click Add Files in the PGP Zip Control box, 
select the file or files you want to add to the folder, then click Open. The files 
are added to the archive in the folder. 
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 To extract a file from an archive, right-click the file you want to extract, 
select Extract from the shortcut menu, specify a location for the file, then 
click OK. A copy of the file is created in the specified location; the original 
remains in the PGP Zip Archive. 

 To delete a file or folder from an archive, select the items you want to delete, 
then press the Delete key on your keyboard. You can also select Edit > 
Delete. The specified items are deleted. 

 To save changes to a PGP Zip archive that you have modified, click Save in 
the upper right corner or Save PGP Zip in the PGP Zip Control box. Specify a 
location and a name. If the name you select already exists at the location, 
you will be asked if you want to overwrite the existing file. Type the 
passphrase that protects the archive, then click OK. 

 To change the signing key, select the PGP Zip file you want to change in the 
PGP Zip Control Box, click Edit, and then select a new Signing Key. Click 
Save when you have finished. 

 To change the type of encryption (Key or Conventional), select the PGP Zip 
file you want to change in the PGP Zip Control Box, click Edit, and then 
select the type of encryption (Key or Conventional). Click Save when you 
have finished. 

 To add recipients to the PGP Zip archive, select the PGP Zip file you want to 
change in the PGP Zip Control Box, click Edit, and then click Add Recipients. 
In the Add Recipients dialog box, select the recipients you want to add and 
click OK. Click Save when you have finished. 

 To delete recipients from the archive, select the PGP Zip file you want to 
change in the PGP Zip Control Box, click Edit, select the recipient you want 
to remove, and click Delete Recipients. Click Save when you have finished. 

4 When you are done, click Save. You can either overwrite the PGP Zip archive to 
which you made the changes or save the modified archive using a different name. 

 

 

Verifying Signed PGP Zip Archives 
If you received a signed PGP Zip Archive, you should verify the signature so that you 
know who it came from—and that the archive was not tampered with before you got it. 

To verify a PGP Zip Archive 

1 Click the PGP Zip Control box  and then click Open a PGP Zip. The Open dialog 
box is displayed. 

2 Navigate to the signed .pgp file you want to verify, click to select it, then click 
Open. 

If the message was encrypted (in addition to being signed), you are prompted for 
the passphrase of your private key, or whichever private key it is that corresponds 
to the public key to which the message was encrypted. 

If the private key is not on your keyring, Symantec Encryption Desktop will tell 
you it is not possible to decrypt the message. Unfortunately, this also means you 
cannot verify the archive. Click Cancel to end the verification. 

3 Type the passphrase of the private key, then click OK. 
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Note: If the passphrase of the private key is cached, then you are not prompted 
for the passphrase. 

The contents of the archive are saved to the same location as the PGP Zip archive, 
and the Verification History screen shows the information about the archive you 
are verifying. 

4 To clear the list of verified archives, click Clear Verification History. All listings 
on the Verification History screen are removed. 

 

 

 





 

13 Shredding Files with PGP Shredder 

If you want to completely destroy sensitive files without leaving fragments of their data 
behind, use the PGP Shredder utility. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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Using PGP Shredder to Permanently Delete Files and 
Folders 

If you want to destroy sensitive files or folders completely, use the PGP Shredder 
feature. When you delete files or folders using PGP Shredder, all traces of the item are 
removed. 

The PGP Shredder feature works by overwriting your data with random text. It repeats 
this multiple times, or passes. You can set the number of passes that the PGP Shredder 
feature makes whenever it deletes a file—do that by opening the Disk panel of the 
Preferences screen. For more information about setting options and preferences, see 
Disk Options (on page 247). 

The shred session can be lengthy, depending on such factors as the number of passes 
you specified, the speed of the processor, and how many other applications are running. 

Note: When set for three passes, PGP Shredder exceeds the media sanitization 
requirements specified in the Department of Defense 5220.22-M standard. While 
more passes are allowed, modern disk hardware does not require more than two 
passes. Security continues to increase up to approximately 28 passes. The PGP 
Shredder feature is capable of up to 49 passes, but remember that more passes 
means more time needed for secure deletion. 

There are multiple ways to use PGP Shredder: 

 Use the PGP Shredder icon on your desktop (placed there when you installed 
Symantec Encryption Desktop). 

 Select Tools > Shred Files, then browse to the file/folder you want to shred. 
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Using PGP Shredder to Permanently Delete Files and Folders 

 Use the Windows Explorer shortcut menus (right-click the file, select Symantec 
Encryption Desktop > PGP Shredder [file name]). 

PGP Shredder does not delete the following items: 

 Windows system files or files that are read-only.  

Note that the Thumbs.db file, created when viewing thumbnail graphics in 
Windows Explorer, is a special case and can be shredded even though the file has 
the system attribute set. 

 WebDav or Sharepoint files. 

Files that can be deleted are local files and CIFS shared files. 

 Directories containing files that cannot be deleted.  

You can also use Symantec Encryption Desktop to erase free disk space that could 
contain data from previously deleted files and programs using the PGP Shredder Free 
Space Assistant. 

It is especially important to use the PGP Shredder Free Space Assistant on Journaling 
file systems such as NTFS, as such file systems make a second copy of everything 
written to disk in a file system journal. This helps the disk recover from damage, but 
requires extra work when removing sensitive data. Shredding a file does not remove 
any potential journal entries that may have been created. NTFS in particular can also 
store small (less than 1K) files in internal data structures that cannot be removed 
properly without using the PGP Shredder Free Space Assistant with the Shred NTFS 
internal data structures option. 

Tip: Consider other occurrences of the data that might linger elsewhere on your disk, 
such as temp files. For this reason, consider using Symantec Drive Encryption to 
protect all data on your system.  

 

Shredding Files using the PGP Shredder Icon on Your Desktop 

To shred files using the PGP Shredder icon on your Desktop 

1 Drag and drop the files/folders you want to shred onto the PGP Shredder icon. A 
confirmation dialog box is displayed, asking you to confirm that you want to shred 
(secure delete) the listed files and/or folders. 

2 Click Yes. The files are securely deleted from your system. 

 

 

Shredding Files From Within Symantec Encryption Desktop 

To shred files in Symantec Encryption Desktop 

1 In the Symantec Encryption Desktop main application window, select Tools > 
Shred Files. The Open dialog box is displayed. 

2 Select the files on your system you want to shred, then click Open. A confirmation 
dialog box is displayed, asking you to confirm that you want to shred (secure 
delete) the listed files and/or folders. 

3 Click Yes. The files are securely deleted from your system. 
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Using the PGP Shredder Free Space Assistant  

 

 
 

Shredding Files in Windows Explorer 

To shred files by right-clicking in Windows Explorer 

1 In Windows Explorer, right-click files/folders you want to shred. A confirmation 
dialog box is displayed, asking you to confirm that you want to shred (secure 
delete) the listed files and/or folders. 

2 Click Yes. The files are securely deleted from your system. 

 

 
 

Using the PGP Shredder Free Space Assistant 

To shred free space on your disks 

1 With Symantec Encryption Desktop open, select Tools > PGP Shredder Free 
Space. The Introduction screen of the PGP Shredder Free Space Assistant is 
displayed. 

2 Read the information, then click Next. The Gathering Information dialog box is 
displayed. 

3 In the Shred drive field, select the disk or volume you want to shred and the 
number of passes you want PGP Shredder Free Space to perform. While three 
passes with PGP Shredder are sufficient to securely delete the data, you can 
specify up to 49 passes. The recommended guidelines for number of passes are: 

 3 passes for personal use. 

 10 passes for commercial use. 

 18 passes for military use. 

 26 passes for maximum security 

4 Choose whether to shred internal NTFS data structures. This option is not 
available on all systems. 

Caution: If the selected partition is not your boot partition, you can perform an 
intensive shred operation that overwrites internal NTFS data structures that 
may hold residual data. The partition will be completely filled during this 
process, and as such you should not use the disk for anything else while the free 
space shred operation is in progress. Some of these structures are not generally 
considered free space on your drive, but the techniques employed by this option 
will cause them to be shredded. This option does not increase the risk of 
anything negative happening to your disk as a result of the shredding operation. 

5 Click Next. The Perform Shred dialog box is displayed, containing statistical 
information about the drive or volume you selected. 
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Using the PGP Shredder Free Space Assistant 

6 Do one of the following: 

 To start shredding free space immediately, click Begin Shred. The PGP 
Shredder Free Space Assistant scans and then shreds leftover fragments 
from the specified disk or volume. 

When the shred session is complete, a message is displayed near the bottom of 
the Perform Shred screen telling you the selected drive has been shredded. 

 To schedule a time for the free space shred operation, click Schedule. A 
message is displayed informing you that the Windows Task Schedule is used 
when scheduling PGP Shredder Free Space operations and that you need a 
Windows login password for the job to run.  

To schedule the job, click OK, enter your Windows login password in the PGP 
Enter Confirmed Passphrase dialog box, and then enter the scheduling 
information.  

To cancel the job and return to the Perform Shred dialog box, click Cancel. 

7 Click Next. The Completing dialog box is displayed. 

8 Click Finish. 

 

 

Scheduling Free Space Shredding 
Use the Windows Task Scheduler to schedule periodic shredding of free space on your 
system. 

To schedule free space shredding 

1 Follow the steps in Using the PGP Shredder Free Space Assistant (on page 227) until 
the Perform Shred dialog box is displayed. 

2 Click Schedule.  

3 A message is displayed informing you that the Windows Task Schedule is used 
when scheduling PGP Shredder Free Space operations and that you need a 
Windows login password for the job to run. To continue, click OK. The PGP Enter 
Confirmed Passphrase dialog box dialog box is displayed. 

4 Type your Windows login password in the first field, type it again to confirm it in 
the second field, then click OK. The Windows Task Schedule dialog box is 
displayed. 

5 In the Schedule Task area, specify how often you want the task to run: 

 Daily. This option runs your task once at the time you specify on the days 
you indicate. Click OK to close the dialog box, then enter the time you want 
to run the task each day in the Start Time text box. 

 Weekly. This option runs your task on a weekly basis at the date and time 
you specify. Enter the number of weeks you want between each disk shred in 
the text box provided, then choose a day from the Schedule Task Weekly list. 

 Monthly. This option runs your task once each month on the day and at the 
time you specify. Enter the time in the text box provided, then enter the day 
of the month on which you want the task to run. Click Select Months to 
specify which months the task will run. 
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Using the PGP Shredder Free Space Assistant  

 Once. This option runs your task exactly once on the date and at the time 
you specify. Enter the time in the text box provided, then select a month and 
a date from the lists Run On text box. 

 At System Start up. This option runs your task only upon system start up. 

 At Logon. This option runs your task when you log on to your computer. 

 When Idle. This option runs your task when your system is idle for the 
amount of time you specify in the minutes text box. 

6 In the Start Time field, enter the time of day that you want the task to start. 

7 In the Schedule Task Daily field, specify how often you want the task to run. 

8 Click Advanced to open a dialog box where you can select additional scheduling 
options, such as the start date, the end date, and the duration of the task. 

9 Click OK. A confirmation dialog box is displayed. 

Your new PGP folder or free space task is now scheduled. To edit or delete your PGP 
tasks, use the Windows Task Scheduler. 

 

 





 

14 Storing Keys on Smart Cards and 
Tokens 

This chapter applies to Windows systems running in BIOS mode. For Windows systems 
running in UEFI mode, storing keys on smart cards and tokens is not supported. For 
more information on how to determine if your Windows system is running in UEFI 
mode, see How to Determine if Your Windows System is Running in UEFI Mode (on page 
119). 

Use Symantec Encryption Desktop to create a PGP keypair on a smart card or token, or 
to copy a PGP keypair to a smart card or token. Both options give you an extra layer of 
security in that you can keep your PGP keypair with you, on your smart card or token, 
instead of leaving it on your system: a PGP keypair on a smart card or token is less 
vulnerable than the same keypair stored on your computer because you can keep the 
smart card or token with you. This section describes how to use smart cards with 
Symantec Encryption Desktop. 

When using a smart card that was initialized using the default settings, please be sure 
you insert the smart card and change the password or PIN before you enroll or attempt 
to save your key on the smart card. The default settings for most smart cards require 
that you change your PIN on first use. If you do not change your PIN, key creation on 
the smart card fails. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

y 
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About Smart Cards and Tokens 

About Smart Cards and Tokens 
In order to use Symantec Encryption Desktop with a smart card or token from a 
particular vendor, you must have a compatible smart card reader (if you are using a 
smart card) and the appropriate software drivers installed on your system (for both 
smart cards and tokens). The drivers must include the PKCS-11 (the cryptographic 
token interface standard) library. 

Symantec Corporation strongly recommends using software drivers from the vendor 
who makes your smart card or token. 

Symantec Encryption Desktop recognizes and works with a wide variety of smart cards, 
including those from AET SafeSign and SafeNet (formerly Rainbow). Symantec 
Encryption Desktop also works with Department of Defense Common Access Cards with 
the ActivCard Gold 2.0 profile. 

In addition to these vendors, Symantec Encryption Desktop recognizes and works with 
smart cards from vendors that include a standards-based PKCS-11 library in their 
software drivers. If the PKCS-11 library from a vendor is installed on your system and 
works with other PKCS-11 applications, such as Mozilla Firefox or Thunderbird, 
chances are high that Symantec Encryption Desktop will recognize and work with 
smart cards from this vendor. 

When you create and store a PGP keypair on a smart card, you access the private key 
using the PIN for the smart card, rather than a passphrase. If you have a smart card 
that handles its own authentication (for example, on its own keypad or via a biometric 
device, Symantec Encryption Desktop works with these smart cards; when Symantec 
Encryption Desktop displays a passphrase dialog, do not enter a passphrase, just click 
OK. The device should then bring up its own authentication method. 

Note: The private portion of your keypair that is generated on a smart card never 
leaves the device—it’s not exportable. Decryption and signing operations take place 
directly on the device. If you generate a keypair on your computer rather than on the 
smart card, and then copy the keypair to your smart card while leaving the keypair 
on your computer, you can still export the private portion of your keypair from your 
computer.  

Department of Defense Common Access Cards 
Department of Defense Common Access Cards (CACs) work somewhat differently than 
other smart cards. They are read-only, and they include two separate certificates: one 
for signing and one for encrypting. Symantec Encryption Desktop filters the two 
certificates based on the intended usage. For example, when you are prompted to select 
a key to sign a file, only the signing certificate of a CAC is listed. 

 

Recognizing Smart Cards 
Before you can examine the properties of a smart card you want to use with Symantec 
Encryption Desktop, or create a PGP keypair on a smart card, you need to make sure 
that Symantec Encryption Desktop recognizes that the smart card you want to work 
with is available on the system. 

The general requirements for this are: 
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Examining Smart Card Properties  

 The smart card software drivers, with PKCS-11 support, must be installed on the 
system. 

 The smart card must be installed on the system. For a USB token, this generally 
means it is inserted into a USB port. For a smart card, it generally means it is 
inserted into the appropriate smart card reader. 

Once you have installed the drivers and smart card, verify that Symantec Encryption 
Desktop recognizes the system. There are two ways to do this: 

 The easiest way to tell if Symantec Encryption Desktop “sees” a smart card is to 
open Symantec Encryption Desktop and click on the PGP Keys Control box. If 
“Smart card Keys” is listed below “All Keys” in the PGP Keys Control box, then 
Symantec Encryption Desktop sees the smart card on the system. 

 A slightly more complicated way is to open Symantec Encryption Desktop, click 
the PGP Keys Control box, and then from the File menu, select New PGP Key. 
When the PGP Key Generation Assistant screen is displayed, look towards the 
bottom. If the Generate Key on Token: <smart card information> check box is 
active, then Symantec Encryption Desktop sees the smart card on the system. This 
method has a slight advantage over the previous method in that Symantec 
Encryption Desktop shows you information about the particular smart card that it 
sees on the system. 

 

 

Examining Smart Card Properties 
A PGP key stored on a smart card is noted on the Symantec Encryption Desktop screen 
with a special key-on-a-card icon. By viewing its properties, you can find information 
regarding the smart card itself, such as the manufacturer, serial number, and key types 
it supports. 

To view the properties of a smart card 

1 Insert your smart card in your smart card reader or insert the token in a USB port. 
The key is displayed in the Smart Card Keys section of the PGP Keys Control box. 

2 Open Symantec Encryption Desktop. 

3 Highlight the key for the properties you want to view. 

Select Keys > Smart Card Properties. The PGP Smart Card Properties dialog box is 
displayed, providing information about the smart card on which the key resides: 

 Name of the manufacturer. 

 Smart card model. 

 Serial number associated with the smart card. 

 Capabilities of the mart card, including the type of PGP key that the card can 
store and the number of characters your PIN may contain. 

 Total number of private keys you currently have on the smart card, 
including subkeys. 

4 Click OK. 
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Generating a PGP Keypair on a Smart Card 

Generating a PGP Keypair on a Smart Card 
Note that keys with spaces in the user name cannot be used for authentication at PGP 
BootGuard. 

To generate a PGP keypair on a smart card 

1 Insert your smart card in your smart card reader or insert the token in a USB port. 
The key is displayed in the Smart Card Keys section of the PGP Keys Control box. 

2 Open Symantec Encryption Desktop. 

3 Click the PGP Keys Control box. If the smart card is detected, “Smart Card Keys” is 
displayed in the PGP Keys Control box. 

4 Select File > New PGP Key. The PGP Key Generation Assistant Introduction dialog 
box is displayed. 

Symantec Encryption Desktop recognizes the software drivers from one smart 
card vendor at a time. If you have the software drivers from more than one smart 
card vendor installed on your system, you need to specify which vendor’s smart 
cards you want to use with Symantec Encryption Desktop. For more information, 
see Using Multiple Smart Cards (on page 237). 

5 Select the checkbox labeled Generate Key on Token: [name of smart card on 
system], then click Next. The Name and Email Assignment dialog box is displayed. 

6 Type your name in the Full Name field and your email address in the Primary 
Email field. If you want to enter more email addresses for this key, click More and 
type the email address(es) in the Other Addresses fields. 

Tip: It is not absolutely necessary to enter your real name or email address. Using 
your real name and email address makes it easier for others to identify you as the 
owner of your public key. 

7 To specify advanced key settings, click Advanced. The Advanced Key Settings 
dialog box is displayed. Specify the settings for: 

 Key type: RSA (Diffie-Hellman/DSS keys are not supported) 

 Key size: From 1028 to 2048 

 Expiration: Never or a date you specify 

 Allowed algorithms: AES, CAST, TripleDes, IDEA, and Twofish 

 Preferred algorithm: Choose one of the allowed algorithms 

 Allowed hash: SHA-2-256, SHA-2-384, SHA-2-512, RIPEMD-160, SHA-1, 
MD-5 

 Preferred hash: Choose one of the allowed hashes 

Some settings may not be available if the smart card you are using does not 
support them. 

Click OK to save your settings and exit the Advanced Key Settings dialog box. 

8 Click Next. 
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Copying your Public Key from a Smart Card to a Keyring  

9 On the Passphrase Assignment dialog box, enter the PIN that corresponds to the 
smart card. The PIN acts as passphrase for the key. Normally, as an added level of 
security, the characters you enter for the passphrase do not appear on the screen. 
However, if you are sure that no one is watching, and you would like to see the 
characters of your passphrase as you type, select the Show Keystrokes checkbox. 

10 Click Next to begin the key generation process. Symantec Encryption Desktop 
generates your new keypair directly on your smart card. This process can take 
several minutes. 

11 When the key generation process indicates that it is done, click Next. You are 
prompted to add the public key portion of the key you just created to the PGP 
Global Directory. 

12 Read the text on the screen and do one of the following: 

 To post your public key to the PGP Global Directory, click Next.  

 To prevent your public key from being posted to the PGP Global Directory, 
click Skip. 

13 Click Done. Your new keypair is generated and stored directly on your smart card. 

Because the private portion of your keypair resides only on your smart card, when you 
remove the smart card from the system, the key icon changes to a single key to reflect 
that the public portion is left on the keyring and the private portion has been removed 
with the smart card. 

 

Copying your Public Key from a Smart Card to a Keyring 
Storing your keys on a smart card enables you to physically walk to a computer—a 
computer with a compatible smart card reader or a free USB port, and Symantec 
Encryption Desktop and the appropriate drivers installed—and automatically copy the 
public portion of your keypair to the Symantec Encryption Desktop keyring on that 
system. 

To copy your public key from your smart card to another user’s keyring: 

1 Insert your smart card in your smart card reader or insert the token in a USB port. 
The key is displayed in the Smart Card Keys section of the PGP Keys Control box. 

2 Open Symantec Encryption Desktop. 

3 Wait for your key to display in Symantec Encryption Desktop. When you see your 
key display, it indicates that your public key has been copied onto the system. 

4 Remove your smart card from the system. Your public key remains on the system. 

 

 

Copying a Keypair from Your Keyring to a Smart Card 
Use Symantec Encryption Desktop to copy an existing keypair from your system to a 
smart card. This is a good way to make a backup of your keypair and/or to distribute 
your public key. Only RSA keys can be copied to a smart card. 
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Copying a Keypair from Your Keyring to a Smart Card 

Note: You cannot copy Diffie-Hellman/DSS keys to a smart card. 

Copying your keypair to a smart card is different from creating a keypair directly on the 
smart card (which is not available for all smart cards). When you create a keypair 
directly on a smart card, you must have the smart card on the system to use your 
private key. 

When you have an existing keypair that you copy to a smart card, the private portion of 
your keypair resides on the smart card and on your system (unless you choose to delete 
the private portion of your keypair from your system). 

There are two main reasons to copy an existing keypair to a smart card: 

 To use it as a back up for the keypair on your system and to copy your public key 
from the smart card to other people’s keyrings. In this case, you would have two 
copies of the same private key: one on the system where you originally created it 
and one on the smart card. 

 To use it as your only copy of your private key, just as if you had created it directly 
onto the smart card. In this case, you need to delete the private key from your 
system (Symantec Encryption Desktop gives you the option to do this). Select the 
option to delete the private key from your system if you started using smart cards 
after you had already created your PGP keypair but wanted to have the advantages 
of having your keypair on your smart card without creating a new keypair. 

Finally, when you copy your PGP keypair to a smart card, the passphrase for the 
keypair that is on the smart card is automatically changed from whatever it was to the 
PIN of the smart card. However, the passphrase for the keypair that was already on 
your system, the keypair you copied to the smart card, does not change. You have two 
copies of the same keypair, each with its own passphrase. 

If you decide to delete the private key from your system and just keep the private key 
on your smart card, simply use the PIN of the smart card as the passphrase for your 
private key. 

To copy an existing PGP keypair to your smart card 

1 Insert your smart card in your smart card reader or insert the token in a USB port. 
The key is displayed in the Smart Card Keys section of the PGP Keys Control box. 

2 Open Symantec Encryption Desktop. 

3 Right-click the keypair you want to copy and select Add To > Smart Card Keys. A 
warning dialog box is displayed informing you that once the keypair is copied to 
the smart card, your PGP passphrase for this keypair automatically changes to the 
PIN of the smart card. 

4 Click OK to continue. The PGP Enter Passphrase dialog box is displayed. 

5 Type the passphrase for your key, then click OK. The PGP Enter Passphrase dialog 
box is displayed. 

6 Type the PIN for the smart card, then click OK. The keypair is copied to the smart 
card. Symantec Encryption Desktop asks if you want to remove the private portion 
of the keypair from your keyring so that it only resides on the smart card. 

7 Do one of the following: 

 To remove the private portion of your keypair from your keyring, click Yes. 
The private portion of your keypair is deleted from the keyring on your 
system and exists only on your smart card. 
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Wiping Keys from Your Smart Card  

 To leave the private portion of your keypair on your keyring, click No. The 
private portion is not deleted; you now have two copies of the same keypair, 
one on your system and the other on your smart card. 

 

 

Wiping Keys from Your Smart Card 
You can delete all the data stored on a smart card by using the Wipe Contents feature 
in the Smart Card properties dialog box. 

To wipe a smart card 

1 Insert your smart card in your smart card reader or insert the token in a USB port. 
The key is displayed in the Smart Card Keys section of the PGP Keys Control box. 

2 Open Symantec Encryption Desktop. 

3 In the PGP Keys box, select Smart Card Keys. The PGP keys on the smart card 
appear. 

4 Select the smart cards or tokens you want to wipe. 

5 Select Keys > Wipe Smart Card. Symantec Encryption Desktop asks for 
confirmation you want to delete all keys currently on the smart card or token. 

6 Click OK. The PGP Enter Passphrase dialog box is displayed. 

7 Type the PIN for this smart card. Normally, as an added level of security, the 
characters you enter for the passphrase do not appear on the screen. However, if 
you are sure that no one is watching, and you would like to see the characters of 
your passphrase as you type, select the Show Keystrokes checkbox. 

8 Click OK. Symantec Encryption Desktop deletes all keys stored on the smart card. 

 

 

Using Multiple Smart Cards 
Symantec Encryption Desktop is compatible with smart cards from a wide variety of 
vendors. At the same time, Symantec Encryption Desktop only works with the smart 
cards from one vendor at a time. 

On startup, Symantec Encryption Desktop automatically searches your system for 
software drivers that support the use of smart cards from a particular vendor. When it 
finds those software drivers, it loads them, assuming you have smart cards from that 
vendor and want to use them. 

If you have the software drivers from a single vendor installed on your system, this 
works perfectly; Symantec Encryption Desktop automatically finds the software drivers 
and lets you use the smart cards from that vendor. You don’t have to do anything; it just 
works. 
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Using Multiple Smart Cards 

However, there may be some occasions when you need to use the smart cards from 
more than one vendor. When this happens, and you have the software drivers from 
more than one vendor on a system, you need to tell Symantec Encryption Desktop 
whose smart cards you want to use. Otherwise, Symantec Encryption Desktop won’t 
know which software drivers to use, and may not select the ones you want. 

To specify which smart card software drivers to use 

1 Open Symantec Encryption Desktop. 

2 Select Tools > Options. The PGP Options dialog box is displayed. 

3 Click the Keys tab. 

4 In the Synchronization section, from the Synchronize with smart cards and 
tokens list, select the vendor for the software drivers you want to use: 

 When you have the software drivers from only one vendor on your system, 
use the default setting, Automatically.  

 To prevent Symantec Encryption Desktop from using the smart cards from 
any vendor, Select None . 

 To specify a vendor not on in the list, select Other. On the Select Smart Card 
Driver dialog box, navigate to the DLL file of the software drivers of your 
smart card vendor, select it, then click Open. You can now use smart cards 
supported by the software driver file you selected. 

Symantec Encryption Desktop now expects you to use smart cards from the selected 
vendor. If you add a smart card from a different vendor to your system, Symantec 
Encryption Desktop will not recognize it. You must follow this procedure to change to a 
different smart card vendor. 

 

 



 

A Setting Symantec Encryption Desktop 
Options 

Symantec Encryption Desktop is configured to accommodate the needs of most users, 
but you have the option of adjusting settings to suit your requirements. This section 
describes the options you can set in Symantec Encryption Desktop.  

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 
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Accessing the PGP Options dialog box 

To access the PGP Options 

1 Do one of the following: 

 Click the PGP Tray icon in the Windows System Tray, then select Options. 

 Open Symantec Encryption Desktop, then select Tools > Options. 

2 Select a tab and make the changes you want. When you are finished with a 
particular tab, select another tab. 

3 To save your changes and exit, click OK. To cancel any changes you have made, 
click Cancel. 
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General Options 

General Options 
The General tab contains a variety of Symantec Encryption Desktop settings. 

The options on the General tab of the Preferences dialog box are: 

 Show PGP icon in the Windows Tray. When enabled, the PGP icon is displayed in 
the Windows Tray while Symantec Encryption Desktop is active on the system. 
The PGP Tray icon provides easy access to Symantec Encryption Desktop 
functions. Deselect the checkbox to remove the PGP icon from the Windows Tray. 
To restore the PGP icon, start Symantec Encryption Desktop, then from the Tools 
menu select PGP Options. Access the General tab, and select the checkbox. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, this option may be required. 

Removing the PGP Tray icon from the Windows System Tray does not shut down 
Symantec Encryption Desktop services. Symantec Encryption Desktop services 
continue running when the PGP Tray icon is removed from the Windows System 
Tray. 

To stop PGP Services, click the PGP Tray icon. Select Exit PGP Services from the 
list of commands displayed. A warning dialog box is displayed; you must confirm 
that this is what you intend to do. 

Note: Symantec Corporation suggests that you not stop Symantec Encryption 
Desktop services unless required to do so. 

 My Passphrase. Provides options to save your passphrase. 

 Save my passphrase for the current Windows session. Automatically saves 
your passphrase in memory until you log off your computer. This is called 
caching your passphrase. If you enable this option, you are prompted for 
your passphrase once per private key. You are not prompted to type it again 
for the same key until you log off your computer. 

Caution: When this option is enabled, it is very important that you log off your 
computer before leaving it unattended. Your passphrase can remain cached for 
weeks if you never log off, allowing anyone to read your encrypted messages, or 
encrypt messages with your key, while you are away from your computer. If you 
normally remain logged on to your computer for long periods of time, consider 
choosing one of the other passphrase caching options. 

 Save my passphrase for X (hh:mm:ss). Automatically saves your passphrase 
in memory for the specified duration of time. If you enable this option, you 
are prompted for your passphrase once for the initial signing or decrypting 
task. You are not prompted to type it again until the specified time has 
elapsed. The default setting is 00:02:00 (2 minutes). 

 Do not save my passphrase. Prevents your passphrase from being stored in 
memory. If you enable this option, you must type your passphrase each time 
it is needed. 

Note that, even if you choose not to save your passphrase, you will only be 
prompted to enter your passphrase once to access all the files within a folder 
that has been added to Symantec File Share Encryption. 
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 Product Language. Use this option to select the language in which the Symantec 
Encryption Desktop user interface is presented. The options are: English (the 
default), German, French, Japanese, and Spanish. 

Note: You must log off and log back in to your system if you change to a different 
language. 

 Encryption Server Synchronization. If you are in a Symantec Encryption 
Server-managed environment, this field displays information on when policy was 
last updated and when logs were last sent. 

 

 

Keys Options 
The options on the Keys tab are: 

 Synchronization. These settings specify how you want keys on your keyrings 
synchronized with public servers. 

 Synchronize with keyservers daily. When selected, Symantec Encryption 
Desktop performs a daily synchronization of the public keys on your Keyring 
with your list of keyservers. This list includes the PGP Global Directory. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, this option may be required. 

If changed versions of the keys are available, they are downloaded 
automatically. If the keyserver notifies Symantec Encryption Desktop that a 
key is removed from the keyserver, Symantec Encryption Desktop disables that 
key on the local keyring. 

If you use Symantec Encryption Desktop to make a change to a keypair on your 
Keyring, that change is not automatically uploaded from your computer to any 
keyserver. You must manually upload the changed key to the desired 
keyserver. Symantec Encryption Desktop prompts you to upload changed keys 
when you quit Symantec Encryption Desktop. Otherwise, to send the key to the 
keyserver, right-click the changed key, select Send To from the shortcut menu 
displayed, and then select the desired keyserver from the list. 

 Automatically lookup keys when verifying signatures. When this option is 
enabled, you can specify that Symantec Encryption Desktop should search 
the configured keyservers for a verified key if the public keys are not 
available in your local keyring. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, this option is not used. Your Symantec 
Encryption Server defines whether keys are looked up and, if found, if they are 
cached. Keys found in a Symantec Encryption Server-managed environment are 
never saved to your keyring. 

 When keys are found. If the public key is found, there are three options: 

 Do not save to my keyring. Any key(s) found on the configured 
keyservers are used only once, to verify the signature with which you 
are currently working. The key is then not saved to your keyring. 
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 Ask to save to my keyring. Specifies that Symantec Encryption 
Desktop should ask if you want to save found keys to your local 
keyring. 

 Save keys to my keyring. Specifies that found keys are automatically 
saved to your local keyring. 

These options also apply to X.509 certificates included in S/MIME email 
messages. If specified, Symantec Encryption Desktop extracts and then 
imports the X.509 certificate to your keyring. If you want to encrypt email 
using imported certificates, be sure to manually sign the certificate.  

 Synchronize keyring with tokens and smart cards. Lets you specify how 
Symantec Encryption Desktop synchronizes with smart cards and tokens: 

 Automatically. Symantec Encryption Desktop automatically loads and 
uses the PKCS-11 driver from the first smart card/token vendor it finds 
on your system. If you have the PKCS-11 driver from just one smart 
card/token vendor installed on your system, choose this setting; 
Symantec Encryption Desktop will automatically recognize and use 
smart cards/tokens from that vendor. 

 Listed vendor. Symantec Encryption Desktop loads and uses the 
PKCS-11 driver from the smart card/token vendor you select from the 
list. If you have the PKCS-11 drivers of more than one smart 
card/token vendor on your system, use this setting to tell Symantec 
Encryption Desktop which vendor’s smart cards/tokens you want to 
use. 

 Other. Lets you select a PKCS-11 driver using the Select Smart Card 
Driver dialog box that is displayed. When selected, Symantec 
Encryption Desktop recognizes and uses the smart cards/tokens from 
the vendor whose PKCS-11 driver you select. Use this setting if you 
want to use the smart cards/tokens from a vendor not listed. 

If the PKCS-11 library from a smart card vendor is installed on your system 
and works with other PKCS-11 applications, such as Mozilla Firefox or 
Thunderbird, chances are high that Symantec Encryption Desktop will 
recognize and work with smart cards from this vendor. 

In those rare cases where a non-standard smart card does not work with 
Symantec Encryption Desktop, “Smart Card Keys” does not appear in the 
PGP Keys Control box when the smart card is installed on the system. 

 None. Symantec Encryption Desktop will not recognize or use any 
smart card or token on your system. 

 Keyservers. Click to display the PGP Keyservers List dialog box. Use this 
dialog box to add, edit, or remove the list of keyservers you want to use when 
automatically looking up keys.  

 Backup. These settings specify when and where you want your keys backed up. 

 Backup keys upon exiting Encryption Desktop. When enabled, Symantec 
Encryption Desktop automatically backs up your keys to the location you 
specify: 

 To my keyring folder (default). When selected, your keys are backed up 
to the default keyring folder on your system. The default location is the 
My Documents folder. 
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 To this location. When selected, your keys are backed up to the 
location on your computer that you specify. Type the full path or click 
Browse to navigate to a location. 

 

 

Master Keys Options 
The Master Key List is a set of keys that you want added by default any time you are 
selecting keys for messaging, disk encryption, Symantec File Share Encryption, and 
PGP Zip. This saves you the step of dragging the keys that you regularly use into the 
Recipients field. 

To use the Master Key List, select the Use Master Key List checkbox. You cannot add or 
remove keys from the Master Key List unless this box is selected. 

For information on how to add master keys, see Adding Keys to the Master Key List (on 
page 44). For information on deleting master keys, see Deleting Keys from the Master 
Key List (on page 44). 

Note: If you generated your key using the Setup Assistant, your key is automatically 
added to the Master Key list. If you skipped key generation and imported your key 
into Symantec Encryption Desktop, your key is not automatically added to the list. 

 

Messaging Options 
The Messaging tab contains settings that apply to email. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

The options on the Messaging tab are: 

 Secure Email. Select the Secure Email checkbox if you want Symantec Encryption 
Desktop to secure all your email accounts automatically. When enabled, Symantec 
Encryption Desktop intercepts both incoming and outgoing email messages and 
secures them based on the appropriate policies. 

Deselect the Secure Email checkbox to stop Symantec Encryption Desktop from 
securing your email accounts. 

If you select the Secure Email checkbox, you can choose these additional options: 

 Discover new accounts. Select this checkbox if you want Symantec 
Encryption Desktop to monitor your email activity and automatically 
discover new email accounts that you are using. When a new account is 
discovered, Symantec Encryption Desktop asks if you want to secure 
messages sent using that account. 
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Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, the use of a wildcard (*) binding causes this 
function to be no longer active, as all mail services will match the binding of *. 
Therefore all new accounts will automatically match policy and be created even 
if this option is deselected. 

 Automatically add my email addresses to my key. If you select this 
checkbox, Symantec Encryption Desktop automatically adds to your key the 
email addresses that you use to send messages. This option is enabled by 
default. If you are using Symantec Encryption Desktop in a Symantec 
Encryption Server-managed environment, this option may be disabled. 

Deselect this checkbox to prevent email addresses from being automatically 
added to your key. This has privacy value; for example, if you want to prevent 
someone from finding your email address. 

 Annotate incoming email. Select this checkbox if you want incoming email 
messages to be annotated with explanatory text detailing the actions that 
Symantec Encryption Desktop took when processing your incoming 
messages. You can choose three annotation levels: 

 Maximum: Verbose Annotation. Adds annotations to your incoming 
email detailing every action that Symantec Encryption Desktop has 
taken during message processing. 

 Medium: Failures and Successes. This option is the default. Provides 
annotations when there has been a processing failure, such as 
unknown key, or unknown signer. The Medium setting provides 
annotations for all decrypted and/or signed email, but does not list 
individual attached files. 

 Minimum: Failures Only. Only provides annotations when there has 
been a processing failure, such as detecting an unknown key or 
unknown signer. 

Add a comment to secured messages. When enabled, the text you type here is 
always included in messages you encrypt or sign. Comments typed in this field 
appear below the --BEGIN PGP *-- text header and Symantec Encryption 
Desktop version number of each secured message. These comments are not 
visible in decrypted email. Note that if your email environment creates 
signatures as attachments, then your email recipient must open the ".sig" 
attachment to view the comment. Whether the signature block is shown 
immediately below the email body or in an attachment depends on your email 
environment. 

 Protect sent message copies for IMAP accounts. This option is available for 
standalone installations only. Select this checkbox if you want to protect 
email messages as they are being copied to your IMAP Sent Items folder. 
This option provides additional security so you can protect sensitive emails 
that you have sent using your IMAP account. 

When you select this option, then select how you want to secure the sent 
message copies: 

 Encrypt Only (recommended). This option is the default. Select this 
option to encrypt messages as they are copied to your Sent Items 
folder. 

 Encrypt and Sign. Select this option to encrypt and sign messages as 
they are copied to your Sent Items folder. 
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 Sign Only. Select this option to sign (and not encrypt) messages as they 
are copied to your Sent Items folder. 

If the name of the folder is not a name that Symantec Encryption Desktop 
recognizes (for example, instead of "Sent Items" the folder is named "Outgoing 
Messages"), a message is displayed asking you confirm if the name of the folder 
is where your sent messages are typically stored. Note that the first message 
copied to this folder is not encrypted and/or signed, but that subsequent 
messages copied to this folder are. 

 Enable PGP encrypt and sign buttons in Outlook. Select this checkbox if 
you want to use Symantec Encryption Desktop encrypt and sign buttons in 
Microsoft Outlook. This option is not selected by default. For more 
information on the encrypt and sign buttons, see Using the Sign and Encrypt 
Buttons in Microsoft Outlook (on page 74). 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, there may already be text in this field. 

Proxy Options 
Click the Proxy Options button to access advanced messaging options. 

Email tab 

If your computer needs to have a proxy manually configured so that you can send and 
receive email, you would use this tab. 

Symantec Encryption Desktop “resides” between your email application and the mail 
server that provides your mail. This configuration enables Symantec Encryption 
Desktop to filter, or proxy, your email traffic for you automatically. Symantec 
Encryption Desktop can protect your messages, based on the applicable policy, without 
interrupting your work. 

Normally, you do not need to change the PGP Proxy settings. However, some users must 
specify proxy settings manually. Choose the setting that your network administrator 
recommends: 

 Automatic. The default, recommended setting. Your email is protected 
automatically and transparently. Symantec Corporation recommends that you 
leave this option selected unless you are instructed to use the manual proxy 
setting. 

 Manual Proxy. This option is needed if your computer is “tunneling” through SSH 
to your mail server, or if the computer on which you are running Symantec 
Encryption Desktop also functions as a mail server. For more information, see 
Configuring Manual Mode (on page 245). 

 

Configuring Manual Mode 

If you specify Manual for the email proxy, you must also configure the PGP Messaging 
settings, as well as some settings within your email client (ask your system 
administrator for the values that you should use): 

1 In the PGP Messaging Control box, select the service for which you want to use 
Manual mode. The New Service panel is displayed. 
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2 Click Server Settings. The Server Settings dialog box for the specified service is 
displayed. 

3 Select the type of server that the new service will be using: 

 Internet Mail—for standalone Symantec Encryption Desktop users who have 
a POP or IMAP mail connections. 

 Symantec Encryption Server—for Symantec Encryption Desktop users who 
are in a Symantec Encryption Server-managed environment. Contact your 
Symantec Encryption Server administrator for more details on correct 
settings. 

 MAPI/Exchange—for Symantec Encryption Desktop users who are using 
Microsoft Outlook as a client on a Microsoft Exchange/MAPI server. For 
more information on correct settings, contact your mail administrator. 

 Lotus Notes—for Symantec Encryption Desktop users who are using Lotus 
Notes as their email client with a Lotus Domino server. For more information 
on correct settings, contact your mail administrator. 

4 In the Incoming Mail Server section, type a value in the Redirect local port X to 
this server field. 

Symantec Encryption Desktop will monitor this port for email messages going 
from your mail server to your mail client. 

5 In the Outgoing Mail Server (SMTP) section, type a value in the Redirect local 
port X to this server field. 

Symantec Encryption Desktop will monitor this port for email messages going 
from your mail client to your mail server. 

6 Click OK. The Server Settings dialog box closes. 

7 Open your email client and navigate to the settings for your email account (if you 
have multiple accounts, you will need to configure each account separately). 

8 For both the Incoming mail server (POP3 or IMAP) and Outgoing mail server 
(SMTP) settings in Microsoft Outlook, enter 127.0.0.1. 

9 Click More Settings. 

10 On the Internet E-mail Settings dialog, click Advanced. The Advanced tab of the 
Internet E-mail Settings dialog box is displayed. 

11 In the Incoming server (POP3 or IMAP) box, type the same value you established 
for the incoming mail server in the Redirect local port X to this server field; Step 7 
of this procedure. 

12 In the Outgoing server (SMTP) box, type the same value you established for the 
outgoing mail server in the Redirect local port X to this server field; Step 8 of this 
procedure. 

13 Click OK, then finish configuring the account settings. Manual mode is configured 
for the selected service. 

14 When you are done configuring Manual mode for the services, restart your 
computer. 
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Symantec File Share Encryption Options 
Use the Symantec File Share Encryption options tab to change settings when you 
protect shared network files. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

 Folder Appearance. Select Overlay PGP icon on secured files and folders if you 
want a small PGP lock icon to appear on files and folders that are protected using 
Symantec File Share Encryption. 

 Advanced. Select Protect individual files to protect individual files that are 
outside of a Protected Folder using Symantec File Share Encryption. 

Note: You may be prevented from selecting this option by your Symantec 
Encryption Server administrator if you are using Symantec Encryption Desktop 
in a Symantec Encryption Server-managed environment. 

For more information about protecting individual files that are outside of Protected 
Folder using Symantec File Share Encryption, see Protecting Files Outside of a Protected 
Folder (on page 200). 

Disk Options 
The Disk tab contains settings that apply to volumes protected using the PGP Virtual 
Disk feature. The Disk tab also shows options for PGP Shredder. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, your Symantec Encryption Server administrator may 
have disabled certain features. When a feature is disabled, the control item in the left 
side is not displayed and the menu and other options for that feature are not 
available. If your Symantec Encryption Server administrator has disabled this 
functionality, this section does not apply to you. 

Note: If you are using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment, these options may already be configured. 

PGP Disk Unmounting 
The options for PGP Virtual Disk are: 

 Allow PGP Virtual Disks to unmount even while files are still open. Normally, 
you cannot automatically unmount a PGP Virtual Disk volume if any of the files in 
that volume are open. Enabling this option allows unmounting even with open 
files (called a forcible unmount). 
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 Don’t ask before unmounting allows Symantec Encryption Desktop to 
forcibly unmount a PGP Virtual Disk volume without first warning you of 
any files that may be open. 

Warning: You may lose data if you forcibly unmount a PGP Virtual Disk volume 
with open files. 

 Unmount when computer goes to sleep. When enabled, Symantec Encryption 
Desktop will automatically unmount any mounted PGP Virtual Disk volumes when 
your computer goes into any sleep modes; Standby or Hibernate, for example. 

 Select Prevent sleep if disk(s) cannot be unmounted to prevent your 
computer from sleeping if a PGP Virtual Disk cannot be unmounted. This 
option is unavailable on Microsoft Windows Vista systems ( Windows Vista 
no longer allows applications to prevent sleep). 

 

Warning: The Windows Hibernate mode is inherently insecure, because Windows 
writes sensitive data to disk if your PGP Virtual Disk is open when hibernation is 
invoked. Symantec Corporation recommends using the Symantec Drive 
Encryption feature if you use Hibernation; otherwise be sure to enable the 
Unmount when computer goes to sleep and Prevent sleep if disk(s) cannot be 
unmounted options. 

Shredding 
The PGP Shredder feature offers a secure way for you to delete sensitive files. You can 
adjust the level of security the PGP Shredder feature offers, as well as other settings. 

The options for the PGP Shredder feature are: 

 Number of passes. The PGP Shredder feature removes your file(s) securely by 
deleting them normally, then using numerous “0” characters to overwrite the disk 
space that had been occupied by the files you just deleted. 

Using this method, your files can be deleted very securely with only a few 
overwriting “passes.” For this reason, a setting of 3 is the default, and offers an 
extremely high level of security, but you can adjust this setting to reflect the level 
of security that you desire by changing this setting (to a maximum of 49 passes). 

Be aware that the cost of added security is increased time needed to shred your 
file(s), depending on several factors, particularly the speed of your computer’s 
processor.  

The recommended guidelines for number of passes are: 

 3 passes for personal use.  

 10 passes for commercial use.  

 18 passes for military use.  

 26 passes for maximum security. 

 Shred when emptying the Windows Recycle Bin. Select this checkbox to set the 
PGP Shredder feature to shred the contents of the Windows Recycle Bin whenever 
it is emptied. Use this option with care, as the PGP Shredder feature shreds all 
files in the Recycle Bin, whether sensitive or not, which can take time with very 
large files.  
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This option also automatically shreds files that you delete by bypassing the 
Recycle Bin (by holding down the Shift key when deleting the item), as well as 
System and Application "temp" files that are deleted automatically by the 
operating system. 

This automatic shredding provision uses the PGP Shredder feature settings that 
you have chosen, just like it does when you shred files manually. 

 Place PGP Shredder icon on the Desktop. Select this checkbox if you would like to 
place an icon for the PGP Shredder feature conveniently on your computer’s 
Desktop. Use this icon just as you do the Windows Recycle Bin icon: drag files into 
it. This option is selected by default. 

 Always warn me before shredding. Select this checkbox if you would like a 
confirmation dialog box to appear before any shredding takes place. This gives you 
a chance to double-check that only the files you intended are the ones that are 
shredded. This option is selected by default. 

 

Tip: Please consider other occurrences of the data that might linger elsewhere on 
your disk, such as temp files. For this reason, consider using Symantec Drive 
Encryption to protect all data on your system.  

Notifier Options 
The Notifier tab contains settings that apply to the Notifier feature, which displays 
status messages in a corner of your screen when you send or receive email messages. It 
also displays status messages when you use the Symantec Drive Encryption and the 
Symantec File Share Encryption features. 

In a Symantec Encryption Server-managed environment, your administrator may have 
specified certain notifications settings (for example, whether notifications are to be 
displayed or the location of the notifier). In this case, the Notifier tab is not available 
and not displayed. 

For more information on the Notifier feature, see Notifier alerts (on page 26). 

Usage Options 
 To enable notifiers, select Use PGP Notifier, then specify the Screen Position. 

 Screen Position: Symantec Encryption Desktop Notifications can appear at any of 
the four corners of your screen (Lower Right, Lower Left, Upper Right, or Upper 
Left). Select the corner that you want Symantec Encryption Desktop Notifications 
to appear. The default position is Lower Right. 

Messaging Options 
The settings for the Notifier feature are: 

 Notify when processing outbound email: Select this checkbox if you want 
Notifiers to appear, informing you of encryption and/or signing status when you 
send mail. Deselect this checkbox to stop Notifiers from appearing when you send 
mail. 
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 Ask me before sending email when the recipient’s key is not found: Symantec 
Encryption Desktop looks for a public key for every recipient of the email 
messages that you send. By default, if it cannot find a public key for a recipient, it 
sends that email in the clear (without encryption). If you select this Notifier 
option, you are notified that this is the case, and given a chance to block the email 
so that it is not sent. 

(For more information on the Symantec Encryption Desktop default policy 
settings, see Services and Policies (on page 76).) 

 Always ask me before sending email: You can select this checkbox if you 
would prefer approving every email that you send. You can review the 
encryption status in the Notifier, and either send or block the email. 

 Delay outbound email for n second(s) to confirm (where n is a number from 
1-30; the default is 4 seconds). To change the amount of time that outbound 
messages are delayed, and a Notifier is displayed, click the up or down 
arrows. Use the delay period to review the Notifier message. 

 Display notifications for incoming mail: For incoming email, you can choose the 
extent to which you are notified of its status upon arrival. Your choices are: 

 When receiving secured email—A Notifier is displayed whenever you receive 
secured email. The box displays who the email is from, its subject, its 
encryption and verification status, and the email address of the person 
sending it. 

 Only when message verification fails—For incoming email, you see a 
Notifier only when Symantec Encryption Desktop is unable to verify the 
signature of the incoming email. 

 Never—If you do not need or want to see a Notifier as you receive email, 
select this option. This option does not affect Notifiers for outgoing mail. 

 

 

Advanced Options 
The PGP Options Advanced settings tab provides settings that are very specific. Most 
users do not need to change these settings. 

 Keyboard Hot Keys. Symantec Encryption Desktop offers many ways you can 
create custom hot keys to help you work faster and more easily. A set of hot keys 
comes pre-configured with Symantec Encryption Desktop, but you can change 
these hot key assignments to suit your needs. Click Edit to display the Hot Keys 
dialog box. 

 Symantec Encryption Server. Use an HTTPS proxy to communicate with 
Symantec Encryption Server. Do not change these settings unless you are 
instructed to by your network administrator. 

If your Symantec Encryption Server installation requires a secure client/server 
connection via a proxy, you can use these option settings to specify that. Your 
administrator can supply you with the server name, the correct communications 
port, your user ID, and your password, so you can configure this section correctly. 

 To change your key (or key mode), click Reset Key. For more information on key 
modes, see Key Modes (on page 100). This option is available only if you are using 
Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment. 
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 Activate FIPS 140-2 operational and integrity checks. Select this option if you or 
your organization require FIPS 140-2 checks, but be aware that it slows down your 
computer’s performance. You must reboot your computer for this setting to take 
effect. This option is available only in standalone installations. 

 Ignore embedded suggested filenames when encrypting. Select this option to 
ignore suggestions Symantec Encryption Desktop makes when encrypting files. 

If you are using version 8.1 in a international setting (such as Japan), Symantec 
Encryption Desktop incorrectly encodes the suggested file name. This setting 
must be checked for proper interaction between version 8.1 and 9.x when 
decrypting files in version 9.x that were encrypted with version 8.1. 

 

 





 

B Working with Passwords and 
Passphrases 

Passwords and passphrases are used to protect things. In general, passphrases are 
longer and use a wider variety of characters than do passwords. 

For example, a simple password might be four-letter two words concatenated: 
“whenjobs” without the quotes. A stronger password could use uppercase characters as 
well: WhenJobs. A stronger yet password could add numbers: When9Jobs4. 

Passphrases, in comparison, are longer and use a wider variety of characters. For 
example, a simple passphrase might be: “Mb&1a>ttA.” without the quotes, but 
including the period. This passphrase might seem difficult to remember easily, but in 
fact it’s based on a simple phrase that is much easier to remember. 

Passphrases can also be simple phrases, perhaps from a familiar book, that include the 
punctuation and capitalization: “Because that’s not golf, I replied” including the quotes. 
Although this may not seem like a strong passphrase, it is in fact at least twice as strong 
as any of the other examples. 

This section describes the differences between passwords and passphrases, tells you 
about the Passphrase Quality Bar in Symantec Encryption Desktop, and provides some 
guidelines for creating strong passphrases. 

In This Chapter 

Choosing whether to use a password or passphrase..............................................253

The Passphrase Quality Bar.......................................................................................254

Creating Strong Passphrases.....................................................................................255

What if You Forget Your Passphrase?......................................................................256

 
 

Choosing whether to use a password or passphrase 
So how do you know whether to choose a password or a passphrase? It depends on what 
you are trying to protect. The more valuable the information you are protecting, the 
stronger the protection should be. 

Most Word documents are not protected at all; the content is not valuable enough to 
justify the effort. When you access your bank account online, some banks require only a 
four-letter PIN; depending on the amount of money in that account, this very well may 
be very poor security. You may use a free Hotmail email account for unimportant 
correspondence; a simple password is adequate security. With your corporate email 
account you send and receive proprietary product, customer, or financial information. 

With Symantec Encryption Desktop, for example, you create passphrases for both your 
PGP keypair and for your PGP Virtual Disk volumes. If you create a weak passphrase for 
your PGP keypair, and an attacker managed to get physical control of your private key 
file, all they would need to do to be able to read your messages and send messages that 
appear to be coming from you would be to figure out that passphrase. 
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The Passphrase Quality Bar 

The Passphrase Quality Bar 
When you create passphrases in Symantec Encryption Desktop, the Passphrase Quality 
bar provides a basic guideline for the strength of the passphrase you are creating. 
Nevertheless, it is a much better guideline than just number of characters. 

In general, the longer the bar, the stronger the passphrase. But what does the length of 
the Passphrase Quality bar actually mean? 

The Passphrase Quality bar compares the amount of randomness (entropy) in the 
passphrase you enter against a true 128-bit random string (the same amount of entropy 
in an AES128 key). This is called 128 bits of entropy. 

(Entropy is a measure of the difficulty in determining a password or key.) 

So if the passphrase you create fills up approximately half the Passphrase Quality bar, 
then that passphrase has approximately 64 bits of entropy. And if your passphrase fills 
the Passphrase Quality bar, then that passphrase has approximately 128 bits of 
entropy. 

So how strong is 128 bits of entropy? In the late 1990s, specialized “DES cracker” 
computers were built that could recover a DES key in a few hours by trying all possible 
key values. 

Assuming you could build a computer that could recover a DES key in one second (the 
computer would have to be able to try 255 keys per second), then it would take that 
computer approximately 149 trillion (thousand billion) years to crack one 128-bit AES 
key. In comparison, the universe is believed to be less than 20 billion years old. 

How is the entropy of a particular character measured? The answer is, the bigger the 
pool of characters there is to choose from when picking a particular character, the more 
entropy is assigned to the chosen character. 

For example, if you are told to choose a numeric PIN, you are restricted to the numbers 
zero through nine; a total of 10 characters. This is a rather small pool, so the entropy 
for a chosen character is relatively low. 

When you are choosing a passphrase using the English version of Symantec Encryption 
Desktop, however, things are different. You have three pools of characters to choose 
from: uppercase and lowercase letters (52 characters), numbers zero through nine (10 
characters), and the punctuation characters on a standard keyboard (32 characters). 

When you enter a character, Symantec Encryption Desktop determines the entropy 
value for that character based on the pool it is in and applies that value to the 
Passphrase Quality bar. 

The same concept applies to the character sets of other languages; the larger the pool, 
the more entropy per character. So if you were using an Asian or Arabic character set, 
for example, some of which have hundreds of characters in the set, the amount of 
entropy for a selected character would be correspondingly higher, and thus fill up the 
Passphrase Quality bar that much faster. 
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Creating Strong Passphrases  

Creating Strong Passphrases 
Creating a good passphrase is a trade-off between ease of use and strength of the 
passphrase. Longer passphrases, with a mixture of uppercase and lowercase letters, 
numbers, and punctuation characters, are stronger, but they are also harder to 
remember. 

Studies have shown that passphrases that are harder to remember are more frequently 
written down, which defeats the purpose of having a strong passphrase. It’s better to 
have a somewhat shorter strong passphrase that you will remember than a longer 
strong passphrase that you will write down or forget. 

One common system for generating strong passphrases takes a phrase and reduces it to 
individual characters. For example, the phrase: 

My brother and I are greater together than apart.

becomes the passphrase: 

Mb&1a>ttA.

This passphrase has 10 characters, and is a mix of uppercase and lowercase letters, 
numbers, and punctuation characters. At 10 characters, this is a relatively short 
passphrase. If you think 10 characters is not enough, consider either creating another 
passphrase using the same method and then use both together or simply use a longer 
phrase to start with. 

Another approach is to use simple phrases that include punctuation and capitalization. 
For example: 

Edited by John Doe (not John Doe, Editor)

While not overly long or complicated, this is a strong passphrase. If you decide to use a 
phrase from a familiar book, make sure not to lose the book. 

When creating a passphrase in Symantec Encryption Desktop, you can use up to 255 
characters, including spaces. 

Another approach is to concatenate many short, common words. A method called 
Diceware™ uses dice to select words at random from a special list called the Diceware 
Word List, which contains 7776 short English words, abbreviations, and 
easy-to-remember character strings. If you put together enough of these, you can create 
a strong passphrase. The Diceware FAQ states you may achieve 128 bits of entropy 
using a 10-word Diceware passphrase. 

For more information about Diceware, see the Diceware Passphrase Home Page 
(http://world.std.com/~reinhold/diceware.html). 

When it comes to creating passphrases, here are some things you should do: 

 Use a phrase that is in your long-term memory. You are less likely to forget it that 
way. 

 Make your passphrase at least eight characters long. Length is not the best 
indicator of strength, but it’s still better than shorter. 

 Use a mixture of uppercase and lowercase letters, numbers, and punctuation 
characters. 

 

http://world.std.com/%7Ereinhold/diceware.html
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What if You Forget Your Passphrase? 

Caution: Try to use only ASCII characters, if possible. This is particularly 
important when using international keyboards, as some special characters are 
not supported (for example, “§”) in passphrases. 

 Change your passphrase on a regular basis; every three months is a good rule of 
thumb. The longer you use the same passphrase, the more time there is for 
someone to figure it out. 

Here are some things you should not do when creating passphrases: 

 Do not write down your passphrase. 

 Do not give your passphrase to anyone. 

 Do not let anyone see you entering your passphrase. 

 Do not use “password” or “passphrase.” 

 Do not use patterns. Not “abcdefgh” or “12345678” or “qwertyui” or “88888888” 
or “AAAAAAAA.” 

 Do not use common words. Almost any skilled attacker is using a 
password-cracking dictionary that tries regular words. Don’t put two common 
words together, don’t use the plural of a common word, don’t use a common word 
with the first letter capitalized. 

 Do not use numbers that pertain to you. If anyone knows these numbers, then an 
attacker could find out. Don’t use your birthday, your phone number, your social 
security number, or your street address. 

 Do not use names. Not the names of people, not the names of fictional characters, 
not your pet’s name. Not where you vacationed last winter, not your login name, 
not your company’s name. Not your favorite team’s name, not a body part, not a 
name from any book, especially the Bible. 

 Do not use any of the above backwards, or with a preceding or following single 
digit. 

 

 

What if You Forget Your Passphrase? 
If you forget your passphrase, you will never again be able to decrypt any information 
encrypted to your key. You can, however, reconstruct your key if your Symantec 
Encryption Server administrator has implemented a key restoration policy for your 
company. For more information, see PGP Key Reconstruction (see "Reconstructing Keys 
with Symantec Encryption Server" on page 65, "If You Lost Your Key or Passphrase" on 
page 65) and contact your Symantec Encryption Server administrator. 

 

 



 

C Using Symantec Encryption Desktop 
with Symantec Encryption Server 

Symantec Encryption Server allows enterprises to automatically and transparently (to 
end users) protect email messages based on configurable policies the Symantec 
Encryption Server administrator establishes to enforce the organization’s security 
policies. Symantec Encryption Server also lets Symantec Encryption Server 
administrators manage Symantec Encryption Desktop deployments to users in their 
organization. 

Using Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment gives you proven PGP encryption technology all the way to your desktop, 
plus the other security features in Symantec Encryption Desktop: Symantec Drive 
Encryption, PGP Virtual Disk volumes, PGP Zip archives, and PGP Shredder, among 
others. 

To use Symantec Encryption Desktop in a Symantec Encryption Server-managed 
environment, you must install Symantec Encryption Desktop using an installer 
application you receive from your Symantec Encryption Server administrator. 

If you are using a version of Symantec Encryption Desktop you purchased for home use, 
and are not using it in a corporate environment, you are likely using a standalone 
version, and this section does not apply to you. 

Caution: If you are using Symantec Encryption Desktop in a corporate environment 
and you obtained your Symantec Encryption Desktop installer from a different 
source other than your Symantec Encryption Server administrator, you should check 
with your Symantec Encryption Server administrator before installing or using that 
version of Symantec Encryption Desktop. 

This section describes how using Symantec Encryption Desktop is different in a 
Symantec Encryption Server-managed email domain. 

In This Chapter 

Overview .......................................................................................................................257

For Symantec Encryption Server Administrators .................................................258

Manually binding to a Symantec Encryption Server.............................................259

 
 

Overview 
Your Symantec Encryption Desktop installer will have been configured by your 
Symantec Encryption Server administrator in one of the following ways: 

 No policy settings. Your copy of Symantec Encryption Desktop will not have any 
built-in settings; you can use any feature your license supports. 
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For Symantec Encryption Server Administrators 

 Auto-detect policy settings. Your copy of Symantec Encryption Desktop will 
contact the Symantec Encryption Server that created the installer and download 
the appropriate settings. The settings it receives may require you to use Symantec 
Encryption Desktop features in specific ways. 

 Preset policy settings. Your copy of Symantec Encryption Desktop will have the 
appropriate settings built in. These settings may require you to use Symantec 
Encryption Desktop features in specific ways. 

The result of your copy of Symantec Encryption Desktop receiving settings from a 
Symantec Encryption Server means you may have to use Symantec Encryption Desktop 
features in specific ways. This includes: 

 You may have to take certain actions when you install Symantec Encryption 
Desktop: you may have to whole disk encrypt your boot drive or create a PGP 
Virtual Disk volume, for example. 

 You may be allowed or required to use Symantec Encryption Desktop features in 
certain ways: for example, you may be allowed to automatically shred files when 
deleting them. 

 You may be prevented from using certain Symantec Encryption Desktop features: 
you may be prevented from using conventional encryption and creating 
self-decrypting archives (SDAs), for example. 

 You may be required to use to certain messaging policies: you may have to encrypt 
and sign messages to certain email domains, for example. 

 You may have certain features disabled, such as PGP Messaging or Symantec File 
Share Encryption (on Windows systems), or you may have a customized Symantec 
Drive Encryption BootGuard screen (on Windows systems). For more information, 
see Features Customized by Your Symantec Encryption Server Administrator (on 
page 2). 

Those features of Symantec Encryption Desktop that can be managed by a Symantec 
Encryption Server administrator in a Symantec Encryption Server-managed 
environment are noted in their descriptions throughout this User’s Guide. 

Contact your Symantec Encryption Server administrator for more information about 
the differences when using Symantec Encryption Desktop in a Symantec Encryption 
Server-managed environment. 

 

For Symantec Encryption Server Administrators 
If you are a Symantec Encryption Server administrator managing the rollout of 
Symantec Encryption Desktop to some or all users in your organization, Symantec 
Corporation recommends you allow your Symantec Encryption Desktop users to 
manage their own keys, called Client Key Mode. 

When you are preparing to create the Symantec Encryption Desktop installers on your 
Symantec Encryption Server, you can control whether your Symantec Encryption 
Desktop users are able to manage their own keys, Client Key Mode, or whether the 
Symantec Encryption Server will manage their keys, called Server Key Mode. 

These settings are established in the Key Management section of the Key Setup: Default 
screen, which is part of the configuration of the default user group policy for internal 
users (User Group > Policy Options > Key Setup: Default in the Symantec Encryption 
Server’s administrative interface). 

For Symantec Encryption Desktop users, Client Key Mode is the better choice because: 
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Manually binding to a Symantec Encryption Server  

 Many Symantec Encryption Desktop features require the user to have control of 
their private key. If the Symantec Encryption Server is managing that private key, 
those features will be unavailable to your Symantec Encryption Desktop users. 

 If you specify Server Key Mode, certain options you pre-configure for your 
Symantec Encryption Desktop users will not be available. For example, the 
automatic creation of PGP Virtual Disks is not possible. 

 

 

Manually binding to a Symantec Encryption Server 
If you manually bind to a Symantec Encryption Server using Symantec Encryption 
Desktop (when viewing a Messaging Service, click Server Settings) and enroll, you will 
download only the email policy and not the consumer policy. Your Symantec 
Encryption Server administrator may have specified other options in the consumer 
policy (such as key modes, forcing the encryption of disks, and so on). To be fully 
managed and enforce consumer policy you need to use a Symantec Encryption Server 
"stamped" installation. Contact your administrator to obtain a stamped installation if 
you do not have one. 

In addition, when you manually bind to a Symantec Encryption Server, the file 
orgkey.asc does not exist in C:\Documents and Settings\AllUsers\Application 
Data\PGPCorporation\PGP. If you want to manually bind to a Symantec Encryption 
Server, you will need to create this file and ensure that the user ID of the organization 
key in that file matches the server specified by the PGPSTAMP (the domain name and 
IP address must match).  
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with IBM Lotus Notes 

This section describes use of Symantec Encryption Desktop with Lotus Notes, including 
MAPI. 
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About Lotus Notes and MAPI Compatibility 
Once set up correctly, Symantec Encryption Desktop messaging with Lotus Notes and 
MAPI email clients in a Symantec Encryption Server-protected environment works the 
same as with POP or IMAP email clients, as described in Securing Email Messages (on 
page 69). The information in this appendix supplements the information in that 
chapter. 

Lotus Notes is a groupware application that provides messaging, calendaring, and 
scheduling capabilities. Refer to the Symantec Encryption Desktop for Windows Release 
Notes for information on compatible Lotus Notes email clients. 

MAPI (Messaging Application Programming Interface) is a messaging architecture and 
a client interface used in Microsoft Exchange environments. 

Lotus Notes and MAPI compatibility in Symantec Encryption Desktop means you get 
your messaging protected by PGP technology while using your existing email client, 
plus the other features Lotus Notes and MAPI make available to you. 

Symantec Encryption Desktop installation is compatible with both Lotus Notes 
Single-User and Multi-User installation. 

Using Symantec Encryption Desktop with Lotus Notes 
This section provides an overview of the interoperability of Symantec Encryption 
Desktop and Symantec Encryption Server in a Lotus Notes environment. 
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Binding to a Symantec Encryption Server 

Sending email to recipients inside your Lotus Notes organization 
Within the Lotus Notes environment Symantec Encryption Desktop supports the use of 
both SMTP and Notes addressing. 

Using Notes Addresses 

Lotus Notes clients using Symantec Encryption Desktop can use Notes addresses for 
key lookup. When a Lotus Notes email client sends an email, the Symantec Encryption 
Desktop client recognizes this and automatically adds the Notes address to the key. 
This key is then synchronized with Symantec Encryption Server to facilitate the lookup 
of keys by Notes address. 

All Symantec Encryption Server keys have an SMTP email address associated with 
them (for example, josem@example.com). The keys of internal Lotus Notes email client 
users have their Notes address on their key in addition to a SMTP email address: 
CN=josem/O=notes6@notes6, for example. (External users will never have a Notes 
address on their key, as contact with external users is always using their SMTP email 
addresses.) The keys of internal Lotus Notes email client users have both addresses, the 
SMTP email address and the Notes address. 

Using SMTP Addresses to a recipient with Symantec Encryption Desktop 

Lotus Notes clients using Symantec Encryption Desktop can use SMTP IDs for key 
lookup inside the organization. Some Lotus Notes enterprises utilize SMTP IDs for all 
internal communication, while others offer their employees a choice. Symantec 
Encryption Desktop interoperates within both configurations. In this scenario Lotus 
Notes typically constructs the email in MIME and the Symantec Encryption Desktop 
Proxy performs S/MIME. 

Sending email to recipients outside your Lotus Notes organization 
Lotus Notes clients using Symantec Encryption Desktop will use SMTP IDs for email 
routing and key lookup outside the organization. Symantec Encryption Desktop 
interoperates within both configurations. In this scenario Notes constructs the email in 
MIME and the Symantec Encryption Desktop proxy performs S/MIME or PGP/MIME. 
The recipient receives and decrypts the email. 

Binding to a Symantec Encryption Server 
When using Lotus Notes or MAPI email clients with Symantec Encryption Desktop in a 
Symantec Encryption Server-protected environment, there may be an extra setup step 
required because both Lotus Notes and MAPI email clients must directly connect to 
their Domino or Exchange mail servers, respectively. 

This section does not apply if you are using Symantec Encryption Desktop 
standalone; that is, outside of a Symantec Encryption Server-managed environment.

 

mailto:josem@example.com
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Binding to a Symantec Encryption Server  

In addition to communicating with you mail servers, you must also have a relationship 
with your Symantec Encryption Server. Both requirements are met by having a policy 
for the respective mail server and a second policy that includes both the mail server and 
the Symantec Encryption Server. 

This is called binding, and it allows your email client to access its mail server to send 
and receive mail and its Symantec Encryption Server to get keys and policies. As 
mentioned, binding is achieved through Symantec Encryption Desktop messaging 
policies. 

There are two ways the necessary Symantec Encryption Desktop messaging policies can 
be created to support binding: pre-binding and manual binding. 

Pre-Binding 
With pre-binding, the Symantec Encryption Server administrator configures the 
Symantec Encryption Desktop installer with the information needed to create the 
binding in the Symantec Encryption Desktop messaging policies. So with pre-binding, 
the right policies come configured in Symantec Encryption Desktop. 

Manual Binding 
With manual binding, the Symantec Encryption Server administrator does not 
configure the Symantec Encryption Desktop installer with the information needed to 
create the binding in the Symantec Encryption Desktop messaging policies; you have to 
create these policies yourself. 

To manually bind a mail server and a Symantec Encryption Server, you must first 
create a service for the Symantec Encryption Server and then create another service for 
the mail server that includes a reference to the Symantec Encryption Server. 

To manually bind a mail server and a Symantec Encryption Server using Symantec 
Encryption Desktop messaging policies 

1 Open Symantec Encryption Desktop. 

2 Click the PGP Messaging Control Box. 

3 Under existing standalone service, click Symantec Encryption Server <none> and 
select Create new. 

4 In the New PGP Universal Service menu, type your Symantec Encryption Server 
name and click OK. 

5 Using your email client, send yourself a message. For MAPI users, doing this may 
not be necessary. If not, go to step 8. 

6 Click OK on the Operation stopped by your request dialog box. 

7 From your in-box, read the email from “PGP Universal.” The PGP Key Generation 
Wizard dialog box is displayed. 

8 Click Next. 

9 Choose a Key Mode from the Key Management Selection, then click Next. 

10 In Key Source Selection, choose Symantec Encryption Desktop key, if you are 
using Symantec Encryption Desktop as a standalone application. Otherwise, select 
New key or Import Key. 
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Notes Addresses 

11 Click Next. 

12 Select the key set and click Next. 

13 Click Finish. 

 

 

Notes Addresses 
Symantec Encryption Desktop keys generally have at least one SMTP email address 
associated with them: josem@example.com, for example. 

The Symantec Encryption Desktop keys of Lotus Notes email client users in a Symantec 
Encryption Server-managed environment may have their Notes address on their key in 
addition to a SMTP email address: CN=josem/O=notes6@notes6, for example. 
(Standalone Symantec Encryption Desktop users do not have a Notes ID on their key; 
they always use their SMTP email addresses.) 

If you are using Symantec Encryption Desktop and a Lotus Notes email client in a 
Symantec Encryption Server-managed environment and want to know more 
information, contact your Symantec Encryption Server administrator. 

Notes Client Settings 
If you are using Symantec Encryption Desktop with a Lotus Notes email client, you need 
to make sure that on the Home/Mail Server Setting field of your email client’s location 
record, the Servers tab has the full Notes name (host/orgName), and not just the WINS 
host. 

Symantec Corporation recommends that you fill in the Internet mail address field on 
the Basics tab of the current Location document. OCNOTES relies on this field to 
determine the user's SMTP email address. If the field is missing, Symantec Encryption 
Desktop constructs an SMTP email address for the user based on the Domino Server's 
Global Domain document. 

If you are in "Island mode" and Symantec Encryption Desktop fails to look up keys for 
some or all recipients, Symantec Encryption Desktop tries to encrypt the message again 
by looking for keys when the replicator pushes the message to your home server.  

If Symantec Encryption Desktop fails to look up a key for some recipients and the Notes 
native encryption option is checked, Symantec Encryption Desktop allows the Lotus 
Notes client to encrypt the message to the recipients which PGP failed to encrypt. 

 

The Notes.ini Configuration File 
Symantec Encryption Desktop updates the notes.ini configuration and adds the 
following entry: 

EXTMGR_ADDINS=nPGPNote.dll

Be sure that this entry is not modified or removed. Symantec Encryption Desktop scans 
the notes.ini file every time it starts. If this entry is missing, it will add the entry 
again. 
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Using Lotus Notes Native Encryption 
Lotus Notes Native Encryption enables Notes users to send internal email encrypted to 
the user's Notes key. When Symantec Encryption Desktop is configured to use Notes 
native encryption, confidential information can be sent encrypted to internal users by 
selecting a checkbox when composing the message. All Lotus Notes users have a Notes 
key. 

If the email address in the To: field matches the Lotus Notes format (CN=Alice 
Cameron/O=Example Corp) and Notes native encryption is enabled, Symantec 
Encryption Desktop allows the email to be sent encrypted using Lotus Notes. If the 
email address in the To: field is an SMTP address (acameron@example.com), Symantec 
Encryption Desktop encrypts the email to your PGP key. 

Notes Native Encryption is available for both Symantec Encryption Server-managed 
environments as well as standalone environments. For more information, go to the 
Symantec Knowledgebase and search for TECH149530 
https://support.symantec.com/en_US/article.TECH149530.html, "HOW TO: Enable 
Lotus Notes Native Encryption with PGP Desktop". 

Symantec Encryption Desktop applies the messaging policies for Sign and Encrypt 
Buttons to all outgoing Lotus Notes messages when the options to Sign and/or Encrypt 
have been selected. For information on these policies, see Security Policy Information 
and Examples (on page 90). If the policies do not exist in your standalone environment, 
you will need to create them. 

To use Notes native encryption 

1 Compose the message in Lotus Notes. 

2 Select the boxes for Sign and/or Encrypt in the message toolbar (if available in the 
template). If not, choose Delivery Options and under the Security Options section, 
select the boxes for Sign and/or Encrypt. 

Note: These boxes must be selected each time you want to send an email using 
Notes native encryption. 

3 Send the message.  

 If mail policy is set to encrypt and the email recipient is a Notes user, the 
message is sent encrypted using Notes native encryption. Click More on the 
notifier message to verify the message is processed and encrypted using 
Lotus Notes. When the recipient opens the message, there is no Symantec 
annotation included. 

 If mail policy is set to encrypt and the email recipient is an SMTP address, 
Symantec Encryption Desktop looks up the PGP key and the message is sent 
encrypted using Symantec Encryption Desktop. When the recipient opens 
the message, the standard Symantec annotation is included. 

 If mail policy is set to encrypt and the email recipient is an SMTP address 
and you are connected to the Lotus Notes Domino server, Lotus Notes tries to 
resolve the SMTP address to the Lotus Notes address. If successful, the 
message is then sent using Notes native encryption. Click More on the 
notifier message to verify the message is processed and encrypted using 
Lotus Notes. When the recipient opens the message, there is no Symantec 
annotation included. 

 

mailto:acameron@example.com
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Using Lotus Notes Native Encryption 

 If mail policy is set to sign, Lotus Notes signs the message with the senders 
Notes key. No encryption occurs using Lotus Notes or Symantec Encryption 
Desktop. Note that if the box to Sign the message is not selected, Symantec 
Encryption Desktop signs the message using the sender's PGP key. 
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